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Safety

Before installing this product, read the Safety Information.

Antes de instalar este produto, leia as Informações de Segurança.

Læs sikkerhedsforskrifterne, før du installerer dette produkt.

Lees voordat u dit product installeert eerst de veiligheidsvoorschriften.

Ennen kuin asennat tämän tuotteen, lue turvaohjeet kohdasta Safety Information.

Avant d'installer ce produit, lisez les consignes de sécurité.

Vor der Installation dieses Produkts die Sicherheitshinweise lesen.

Prima di installare questo prodotto, leggere le Informazioni sulla Sicurezza.
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Les sikkerhetsinformasjonen (Safety Information) før du installerer dette produktet.

Antes de instalar este produto, leia as Informações sobre Segurança.

Antes de instalar este producto, lea la información de seguridad.

Läs säkerhetsinformationen innan du installerar den här produkten.

Safety statements
These statements provide the caution and danger information used in this
documentation.

Important:

Each caution and danger statement in this documentation is labeled with a
number. This number is used to cross reference an English-language caution or
danger statement with translated versions of the caution or danger statement in
the Safety Information document.

For example, if a caution statement is labeled “Statement 1,” translations for that
caution statement are in the Safety Information document under “Statement 1.”

Be sure to read all caution and danger statements in this documentation before you
perform the procedures. Read any additional safety information that comes with
your system or optional device before you install the device.

Statement 1
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DANGER

Electrical current from power, telephone, and communication cables is
hazardous.

To avoid a shock hazard:

v Do not connect or disconnect any cables or perform installation,
maintenance, or reconfiguration of this product during an electrical storm.

v Connect all power cords to a properly wired and grounded electrical outlet.

v Connect to properly wired outlets any equipment that will be attached to
this product.

v When possible, use one hand only to connect or disconnect signal cables.

v Never turn on any equipment when there is evidence of fire, water, or
structural damage.

v Disconnect the attached power cords, telecommunications systems,
networks, and modems before you open the device covers, unless
instructed otherwise in the installation and configuration procedures.

v Connect and disconnect cables as described in the following table when
installing, moving, or opening covers on this product or attached devices.

To Connect: To Disconnect:

1. Turn everything OFF.

2. First, attach all cables to devices.

3. Attach signal cables to connectors.

4. Attach power cords to outlet.

5. Turn device ON.

1. Turn everything OFF.

2. First, remove power cords from outlet.

3. Remove signal cables from connectors.

4. Remove all cables from devices.

Statement 2

CAUTION:
When replacing the lithium battery, use only IBM® Part Number 33F8354 or an
equivalent type battery recommended by the manufacturer. If your system has a
module containing a lithium battery, replace it only with the same module type
made by the same manufacturer. The battery contains lithium and can explode if
not properly used, handled, or disposed of.

Do not:

v Throw or immerse into water

v Heat to more than 100°C (212°F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.
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Statement 3

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or
transmitters) are installed, note the following:

v Do not remove the covers. Removing the covers of the laser product could
result in exposure to hazardous laser radiation. There are no serviceable parts
inside the device.

v Use of controls or adjustments or performance of procedures other than those
specified herein might result in hazardous radiation exposure.

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser diode.
Note the following.

Laser radiation when open. Do not stare into the beam, do not view directly
with optical instruments, and avoid direct exposure to the beam.

Class 1 Laser Product
Laser Klasse 1
Laser Klass 1
Luokan 1 Laserlaite
Appareil A Laser de Classe 1`

Statement 4

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)

CAUTION:
Use safe practices when lifting.
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Statement 5

CAUTION:
The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The device
also might have more than one power cord. To remove all electrical current from
the device, ensure that all power cords are disconnected from the power source.

Statement 8

CAUTION:
Never remove the cover on a power supply or any part that has the following
label attached.

Hazardous voltage, current, and energy levels are present inside any component
that has this label attached. There are no serviceable parts inside these
components. If you suspect a problem with one of these parts, contact a service
technician.

Statement 11
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CAUTION:
The following label indicates sharp edges, corners, or joints nearby.

Statement 12

CAUTION:
The following label indicates a hot surface nearby.

Statement 13

DANGER

Overloading a branch circuit is potentially a fire hazard and a shock hazard
under certain conditions. To avoid these hazards, ensure that your system
electrical requirements do not exceed branch circuit protection requirements.
Refer to the information that is provided with your device for electrical
specifications.

Statement 15

CAUTION:
Make sure that the rack is secured properly to avoid tipping when the server
unit is extended.

Statement 17
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CAUTION:
The following label indicates moving parts nearby.

Statement 26

CAUTION:
Do not place any object on top of rack-mounted devices.

Statement 37

DANGER

When you populate a rack cabinet, adhere to the following guidelines:

v Always lower the leveling pads on the rack cabinet.

v Always install the stabilizer brackets on the rack cabinet.

v Always install the heaviest devices in the bottom of the rack cabinet.

v Do not extend multiple devices from the rack cabinet simultaneously,
unless the rack-mounting instructions direct you to do so. Multiple devices
extended into the service position can cause your rack cabinet to tip.

v If you are not using the IBM 9308 rack cabinet, securely anchor the rack
cabinet to ensure its stability.

Attention: This product is suitable for use on an IT power distribution system
whose maximum phase to phase voltage is 240 V under any distribution fault
condition.

Safety xvii
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About this document

This document provides information about setting up, installing, configuring, and
working with the IBM System Storage® premium features that assist with Copy
Services: FlashCopy®, Enhanced FlashCopy, VolumeCopy, Enhanced Global
Mirroring and Enhanced Remote Mirroring. These features are used with IBM DS
Storage Manager software and are for the following storage subsystems: DS3500,
DS5020, DS3950, DS5100, DS5300, DCS3700, DCS3700 storage subsystem with
Performance Module Controllers, DS4200, DS4700, and DS4800.

Use this guide to accomplish the following tasks:
v Determine the hardware and software that are required to install the copy

services features
v Install, enable, and activate the IBM FlashCopy, Enhanced FlashCopy,

VolumeCopy, and Enhanced Remote Mirroring Option premium features
v Troubleshoot hardware and software problems

Note:

v Depending on the version of the DS Storage Manager, the SMclient instructions
and screen captures in this document might be different from the menu paths in
the SMclient software GUI that you are using.

v The VolumeCopy premium feature is only supported in Storage Manager
version 8.4 or later, in conjunction with controller firmware versions 05.40.xx.xx
and 06.1x.xx.xx or later.

v Enhanced Remote Mirroring, Remote Mirror, and Remote Mirroring are used
interchangeably throughout this document, the client software, and the online
help system to describe remote mirroring functionality. Although these terms are
used interchangeably, their functionality is not the same.

v The Enhanced Remote Mirroring Option premium feature is only supported
with controller firmware versions 06.1x.xx.xx or later.

v The Enhanced FlashCopy premium feature is only supported with controller
firmware versions 7.83.xx.xx or later.

What's new in this release
The IBM DS Storage Manager Version 10.84 provides the following new features:
v Enhanced Global Mirroring premium feature
v Enhanced Remote Mirroring premium feature

Who should read this document
This guide is intended for system administrators who are responsible for operating
and maintaining storage systems, with an emphasis on disaster prevention and
recovery.

How this document is organized
Chapter 1, “Introduction,” on page 1 provides information about how to enable,
view, and disable the premium features.
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Chapter 2, “Overview of FlashCopy,” on page 15 provides information about the
FlashCopy feature, how to enable the feature, plan, create, and reuse FlashCopy
logical drives, and how to complete some common FlashCopy tasks.

Chapter 3, “Overview of Enhanced FlashCopy,” on page 43 provides information
about the Enhanced FlashCopy feature, how to enable the feature, plan, create, and
reuse Enhanced FlashCopy logical drives, and how to complete some common
Enhanced FlashCopy tasks.

Chapter 4, “Overview of consistency groups,” on page 59 provides information
about consistency groups, and how to create and work with consistency groups.

Chapter 5, “Common procedures for FlashCopy and Enhanced FlashCopy
premium features,” on page 65 provides procedures that are common to FlashCopy
and Enhanced FlashCopy premium features.

Chapter 6, “Overview of VolumeCopy,” on page 93 provides information about the
VolumeCopy feature, how to use the Create Copy wizard and the Copy Manager
to copy, back up, and restore data.

Chapter 7, “Managing VolumeCopy,” on page 109 provides information to help
you manage your VolumeCopies. It also provides information about how to recopy,
stop, or remove a VolumeCopy, modify the attributes of a logical drive, view the
status of a VolumeCopy operation, and determine what logical drives are involved
in a VolumeCopy operation.

Chapter 8, “Troubleshooting VolumeCopy,” on page 121 provides information
about troubleshooting some of the more common problems encountered when you
use the VolumeCopy feature.

Chapter 9, “Overview of the Enhanced Remote Mirroring Option,” on page 127
provides an introduction to the Remote Mirror Option and describes the hardware
and software requirements for using the Remote Mirror Option. It also provides
information about configuration types, describes how the Remote Mirror Option
interfaces with other premium features (such as Storage Partitioning, FlashCopy,
and Enhanced FlashCopy), and provides a hardware and software checklist to
make sure that all the requirements are met before you install and configure your
systems.

Note: The terms Enhanced Remote Mirroring, Remote Mirror Option, and Remote
Mirroring are used interchangeably throughout this document to describe the
remote mirroring functionality. Although these terms are used interchangeably,
their functionality is different.

Chapter 10, “Installing hardware and software for the Enhanced Remote Mirroring
Option,” on page 151 provides information about preparing the site and
instructions for installing key hardware and software components to run the
Remote Mirror Option.

Chapter 11, “Using the Enhanced Remote Mirroring Option,” on page 175 provides
step-by-step instructions for enabling and activating the Remote Mirror Option,
creating a mirror relationship, and maintaining a mirror relationship.

Chapter 15, “Disaster recovery,” on page 211 provides a number of scenarios about
how the Remote Mirror Option can help prevent data loss, and assist with the
recovery of critical data if a disaster or unrecoverable error occurs.
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Chapter 16, “Troubleshooting the Enhanced Remote Mirroring Option,” on page
217 provides information for troubleshooting hardware and software components,
and describes the events that might be logged when using the Remote Mirror
Option.

Appendix A, “Upgrading controller firmware,” on page 231 describes the
procedure that you must follow to upgrade controller firmware to make sure that
the Remote Mirror Option works properly.

Appendix B, “Accessibility,” on page 233 provides information about the Storage
Manager accessibility features such as alternate keyboard navigation and how to
enable the screen reader software interface.

“Notices” on page 239 provides product notices and trademark information.

Notices used in this document
This document contains the following notices designed to highlight key
information:
v Note: These notices provide important tips, guidance, or advice.
v Important: These notices provide information that might help you avoid

inconvenient or problem situations.
v Attention: These notices indicate possible damage to programs, devices, or data.

An attention notice is placed just before the instruction or situation in which
damage could occur.

Finding Storage Manager software, controller firmware, and readme
files

Storage Manager is available on the product CD. You can also download Storage
Manager and the latest controller firmware from the IBM Support website.

Important: Before you install the Storage Manager software, consult the readme
file. Updated readme files contain the latest device driver versions, firmware levels,
limitations, and other information not found in this document.

Storage Manager readme files are found on the web, at the following address:

www.ibm.com/servers/storage/support/disk/
1. On the Support for IBM System Storage and TotalStorage products page,

from the Product family menu, select Disk systems. From the Product menu,
select your product (for example, DS5100 Midrange Disk System). Click Go.

2. In the Support & downloads box, again click Download. The Software and
device drivers page opens.

3. In the Storage Manager section of the table, locate your operating system and
version level (for example, IBM DS5000 Storage Manager v10.xx.xx.xx for
AIX® - IBM System Storage), and click the version link in the right column.
The DS5000 Storage Manager download page opens.

4. On the download page, in the table under File details, click the *.txt file link,
and the readme file opens in your web browser.
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IBM System Storage Productivity Center
The IBM System Storage Productivity Center (SSPC) is an integrated hardware and
software solution that provides a single point of entry for managing IBM System
Storage disk storage systems, SAN Volume Controller clusters, and other
components of your data storage infrastructure. Therefore, you can use the IBM
System Storage Productivity Center to manage multiple IBM System Storage
product configurations from a single management interface.

To learn how to incorporate the Storage Manager with the IBM System Storage
Productivity Center, see the IBM System Storage Productivity Center Information
Center at the following website:

publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp

Essential websites for support information
The most up-to-date information about IBM storage subsystems and the Storage
Manager, including documentation and the most recent software, firmware, and
NVSRAM downloads, can be found at the following websites:

IBM System Storage Disk Storage Systems
Find links to software and firmware downloads, readme files, and support
pages for all IBM System Storage disk storage systems:

http://www.ibm.com/systems/support/storage/disk/

IBM System Storage Interoperation Center (SSIC)
Find technical support information for your specific storage
subsystem/host configuration, including the latest firmware versions for
your system, with this interactive web-based utility:

www.ibm.com/systems/support/storage/config/ssic/index.jsp

IBM DS3000, DS4000®, DS5000, and BladeCenter® Premium Feature Activation
Activate a premium feature with this web-based utility:

www-912.ibm.com/PremiumFeatures

IBM System Storage Productivity Center
Find the latest documentation that supports the IBM System Storage
Productivity Center, a new system that is designed to provide a central
management console for IBM System Storage DS3000, DS4000, DS5000,
DS8000®, and SAN Volume Controller:

publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp

IBM System Storage Support
Find the latest support information for host operating systems, HBAs,
clustering, storage area networks (SANs), Storage Manager software and
controller firmware:

www.ibm.com/systems/support/storage

Storage Area Network (SAN) Support
Find information about using SAN switches, including links to SAN user
guides and other documents:

www.ibm.com/systems/support/storage/san
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Support for IBM Power, System p®, and BladeCenter servers
Find the latest support information for IBM Power, System p, and
BladeCenter servers with AIX, Linux, or IBM i operating system:

www.ibm.com/systems/support/supportsite.wss/
brandmain?brandind=5000025

Support for IBM System x® servers
Find the latest support information for System x, Intel, and AMD servers:

http://www.ibm.com/systems/x/

System p and AIX Information Center
Find everything you need to know about using AIX with System p and
POWER® servers:

publib.boulder.ibm.com/infocenter/pseries/index.jsp?

Power and IBM i Information Center
Find everything you need to know about using IBM i with POWER
servers:

http://publib.boulder.ibm.com/infocenter/iseries/v6r1m0/index.jsp?

Fix Central
Find fixes and updates for your system software, hardware, and host
operating system:

www.ibm.com/eserver/support/fixes

IBM System Storage products
Find information about all IBM System Storage products:

www.ibm.com/systems/storage

IBM Publications Center
Find IBM publications:

www.ibm.com/shop/publications/order/

Fire suppression systems
A fire suppression system is the responsibility of the customer. The customer's own
insurance underwriter, local fire marshal, or a local building inspector, or both,
should be consulted in selecting a fire suppression system that provides the correct
level of coverage and protection. IBM designs and manufactures equipment to
internal and external standards that require certain environments for reliable
operation. Because IBM does not test any equipment for compatibility with fire
suppression systems, IBM does not make compatibility claims of any kind nor
does IBM provide recommendations on fire suppression systems.
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Chapter 1. Introduction

This chapter introduces the Storage Manager premium features that assist with
copy services:

FlashCopy
You use the FlashCopy feature to create and manage FlashCopy logical
drives. A FlashCopy is the logical equivalent of a complete physical copy,
but is created more quickly and requires less disk space. It is host
addressable, so you can complete backups using FlashCopy while the base
logical drive is online and user-accessible. When the backup completes,
you can delete the FlashCopy logical drive or save it for reuse. For more
information, see Chapter 2, “Overview of FlashCopy,” on page 15.

For controllers with firmware version 7.83.xx.xx and later, the FlashCopy
logical drive can be rolled back to the base logical drive as a new
FlashCopy option.

Enhanced FlashCopy

v You can use the Enhanced FlashCopy feature to take a logical copy of
the content of a standard logical drive or a thin logical drive at a
particular point in time. These point-in-time images of logical drives are
named Enhanced FlashCopy images.

v This premium feature is an alternate method of creating and organizing
FlashCopies. It coexists with the FlashCopy premium feature in the same
subsystem. Any references to this premium feature always have
'Enhanced' as a prefix to 'FlashCopy'.

For more information, see Chapter 3, “Overview of Enhanced FlashCopy,”
on page 43.

Note: This feature is available with only certain models such as DS3500,
DCS3700, and DCS3700 storage subsystem with Performance Module
Controllers. These models support the IBM DS Storage Manager version
10.83 and later.

VolumeCopy
The VolumeCopy feature is a storage subsystem controller firmware-based
mechanism that you use to copy data from one logical drive (the source
logical drive) to another logical drive (the target logical drive) in a single
storage subsystem. Once defined, the combination of the source and target
logical drives in a VolumeCopy relationship is referred to as a VolumeCopy
logical drive pair. For more information about VolumeCopy, see Chapter 6,
“Overview of VolumeCopy,” on page 93.

The VolumeCopy feature can be used to complete the following tasks:
v Copy data from arrays that use smaller capacity drives to arrays that use

larger capacity drives
v Back up data

The VolumeCopy feature includes a Create Copy wizard that is used to
create a VolumeCopy, and a Copy Manager that is used to monitor logical
drive pairs after they are created.

Important: During the VolumeCopy data transfer operation, any write
requests to the source logical drive are rejected. If the source logical drive
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is used in a production environment, the FlashCopy feature must be
enabled and the FlashCopy of the logical drive must be specified as the
VolumeCopy source logical drive instead of using the actual logical drive
itself. This requirement is to prevent the logical drive from being
inaccessible to the users.

Enhanced Remote Mirroring Option
With Enhanced Remote Mirroring, you can create remote logical drive
mirror pairs with two features: Global Copy, and the write consistency
group option. Enhanced Global Mirroring with the consistency group
option is called Global Mirroring, and Enhanced Remote Mirroring without
the consistency group option is called Global Copy. Mirroring that uses the
synchronous write mode is called Metro Mirroring. For more information
about remote mirroring, see Chapter 9, “Overview of the Enhanced Remote
Mirroring Option,” on page 127

Note: Enhanced Remote Mirroring, Remote Mirror, and Remote Mirroring
are used interchangeably throughout this document, the online client, and
online help system to describe remote mirroring. Although these terms are
used interchangeably, this usage does not mean that they are identical.

Receiving product updates and support notifications
Be sure to download the latest versions of the following packages at the time of
initial installation and when product updates become available:
v Storage Manager host software
v Storage subsystem controller firmware
v Storage expansion enclosure ESM firmware
v Drive firmware

Important

Keep your system up-to-date with the latest firmware and other product updates
by subscribing to receive support notifications.

For more information about how to register for support notifications, see the
following IBM Support web page:

http://www.ibm.com/systems/support/storage/subscribe/

You can also check the Stay Informed section of the IBM Disk Support website, at
the following address:

www.ibm.com/systems/storage/support/disk/index.html

Supported features
Table 1 on page 3 indicates the support for FlashCopy, Enhanced FlashCopy,
VolumeCopy, and the Enhanced Remote Mirror features on the DS3500 storage
subsystems.

See Table 2 on page 4 for information about the FlashCopy, VolumeCopy, and the
Remote Mirror support on the DS4000 storage subsystems, Table 3 on page 5 for
information about the FlashCopy, VolumeCopy, and the Remote Mirror support on
the DS5000 storage subsystems, or Table 4 on page 5 for information about the
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FlashCopy, VolumeCopy, and the Remote Mirror support on the DCS3700 storage
subsystems, or Table 5 on page 6 for information about FlashCopy, VolumeCopy,
and Remote Mirror support on the DCS3700 storage subsystem with Performance
Module Controllers.

Table 1. DS3500 Storage Subsystem Copy Services feature support

Feature DS3500 (controller
firmware version
07.77.xx.xx or later)

DS3500 (controller
firmware version before
07.77.xx.xx)

FlashCopy supported? Yes Yes

v Maximum number of logical drives that can be defined 512 256

v Maximum total FlashCopy logical drives (see note 1.) 256 64

v Maximum FlashCopy logical drives per base RAID logical
drive (see note 4)

8 8

Enhanced FlashCopy supported? Yes - with firmware
version 7.83 and later

No

v Maximum number of Enhanced FlashCopy images 512 -

v Maximum number of Enhanced FlashCopy groups per base
logical drive

4 -

v Maximum number of Enhanced FlashCopy logical drives 256 -

VolumeCopy supported? (see note 5) Yes Yes

v Maximum number of VolumeCopy target logical drives for a
specific source logical drive

256 128

v Maximum copy relationships per storage subsystem 256 128

v Maximum running copies per storage subsystem (see note 3.) 8 8

Remote Mirror Option supported? (see note 2.)
Yes Yes

v Total Remote Mirror logical drives (see note 6.) 16 8

Note:

1. The total number of FlashCopy logical drives is limited to one half of the total number of logical drives.

2. For more information about the DS Storage Manager controller firmware support for the various storage
subsystems, see the IBM System Storage DS Storage Manager Version 10 Installation and Host Support Guide (for DS
Storage Manager V10.77 or earlier) or the IBM System Storage DS Storage Manager Version 10.8 Installation and
Host Support Guide (for DS Storage Manager V10.83 or later) for the applicable host operating system.

3. Refers to logical drives in the copy-in-progress state.

4. FlashCopy premium feature supports 4 FlashCopy logical drives. A four to eight FlashCopy logical drive
premium feature can be purchased to achieve the maximum of eight FlashCopy logical drives.

5. Requires the installation of the FlashCopy premium feature.

6. 16 Remote Mirror logical drives are supported with controller firmware 7.77.xx.xx and later. An 8 - 16 Remote
Mirror logical drive premium feature upgrade can be purchased to achieve the maximum of 16 Remote Mirror
logical drives per subsystem.

7. Enhanced Remote Mirroring is not supported on single-controller models.

Table 2 on page 4 indicates the support for FlashCopy, VolumeCopy, and the
Enhanced Remote Mirror features on the DS4000 storage subsystems. This support
matrix requires that the DS4200, DS4700, and DS4800 storage subsystem controller
firmware is at version 07.10.xx.xx or later and the DS4100, DS4300, DS4400, the
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DS4500 storage subsystem controller firmware is at version 06.1x.xx.xx or later and
the Storage Manager host software is at version 10.10 or later.

Table 2. DS4000 Storage Subsystem Copy Services feature support
Feature DS4100Base DS4200 DS4300Base DS4300Turbo DS4400 DS4500 DS4700 DS4800

FlashCopy supported? Yes Yes Yes Yes Yes Yes Yes Yes

v Maximum number
of logical drives that
can be defined

1024 1024 1024 1024 2048 2048 1024 2048

v Maximum total
FlashCopy logical
drives (see note 4)

512 512 512 512 1024 1024 512 1024

v Maximum
FlashCopy logical
drives per base
RAID logical drive

4 8 4 4 4 4 8 16

VolumeCopy
supported? (see note 7)

Yes (see note
3)

Yes No Yes Yes Yes Yes Yes

v Maximum number
of VolumeCopy
target logical drives
for a specific source
logical drive (see
note 2)

1023 1023 N/A 1023 2047 2047 1023 2047

v Maximum copy
relationships per
storage subsystem

1023 1023 N/A 1023 2047 2047 1023 2047

v Maximum running
copies per storage
subsystem (see note
6)

8 8 N/A 8 8 8 8 8

Remote Mirror Option
supported? (see notes 1
and 5)

Yes Yes No Yes Yes Yes Yes Yes

v Total Remote Mirror
logical drives

32 64 N/A 32 64 64 64 128

Note:

1. Enhanced Remote Mirroring is not available for DS4100 single-controller storage subsystems, or for DS4300 standard and single-controller storage
subsystems. Please contact IBM representatives or resellers for availability of such support in the future.

2. When using firmware version 05.xx.xx.xx or later, the firmware reserves one logical drive for use by the system. For firmware version 05.2x.xx.xx
or later, the maximum number of logical drives includes the FlashCopy repository logical drives, the VolumeCopy target logical drive and the
Remote Mirror logical drives in addition to the standard data logical drives. If the Remote Mirror Option is enabled, two logical drives are
reserved for use by the system.

3. VolumeCopy is supported with DS4100 controller firmware version 06.12.1x.xx or later.

4. The total number of FlashCopy logical drives is limited to one half of the total number of logical drives.

5. For more information about the DS Storage Manager controller firmware support for the various storage subsystems, see the IBM System Storage
DS Storage Manager Version 10 Installation and Host Support Guide for the applicable host operating system.

6. Refers to logical drives in the copy-in-progress state.

7. Requires the installation of the FlashCopy premium feature.

Table 3 on page 5 indicates the support for FlashCopy, VolumeCopy, and the
Enhanced Remote Mirror features on the DS3950, DS5020, DS5100, and DS5300
storage subsystems. This support matrix requires that the DS3950 and DS5020
storage subsystem controller firmware is at version 07.60.xx.xx or later and the
Storage Manager host software is at version 10.60 or later. In addition, this support
matrix requires that the DS5100 and DS5300 storage subsystem firmware is at
version 7.30.xx.xx or later and the Storage Manager host software is at version
10.30 or later.
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Table 3. DS5000 Storage Subsystem Copy Services feature support

Feature DS3950 DS5020 DS5100 DS5300

FlashCopy supported? Yes Yes Yes Yes

v Maximum number of logical drives that
can be defined

1024 1024 2048 2048

v Maximum total FlashCopy logical drives
(see note 1)

512 512 1024 1024

v Maximum FlashCopy logical drives per
base RAID logical drive

8 8 (see note 5) 16 16

VolumeCopy supported? (see note 4) Yes Yes Yes Yes

v Maximum number of VolumeCopy
target logical drives for a specific source
logical drive

1023 1023 2047 2047

v Maximum copy relationships per
storage subsystem

1023 1023 2047 2047

v Maximum running copies per storage
subsystem (see note 3)

8 8 8 8

Remote Mirror Option supported? (see
note 2)

Yes Yes Yes Yes

v Total Remote Mirror logical drives 64 64 128 128

Note:

1. The total number of FlashCopy logical drives is limited to one half of the total number of logical drives.

2. For more information about the DS Storage Manager controller firmware support for the various storage
subsystems, see the IBM System Storage DS Storage Manager Version 10 Installation and Host Support Guide for the
applicable host operating system.

3. Refers to logical drives in the copy-in-progress state.

4. Requires the installation of the FlashCopy premium feature.

5. FlashCopy premium feature supports 4 FlashCopy logical drives. A four to eight FlashCopy logical drive
premium feature can be purchased to achieve the maximum of eight FlashCopy logical drives.

Table 4 indicates the support for FlashCopy, VolumeCopy, and the Enhanced
Remote Mirror features on the DCS3700 storage subsystem. This support matrix
requires that the DCS3700 storage subsystem controller firmware is at version
07.77.xx.xx or later and the Storage Manager host software is at version 10.77 or
later.

Table 4. DCS3700 Storage Subsystem Copy Services feature support

Feature DCS3700

FlashCopy supported? Yes

v Maximum number of logical drives that can be defined 512

v Maximum total FlashCopy logical drives (see note 1.) 256

v Maximum FlashCopy logical drives per base RAID logical drive 8

Enhanced FlashCopy supported? Yes - with firmware version
7.83 and later

v Maximum number of Enhanced FlashCopy images 512
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Table 4. DCS3700 Storage Subsystem Copy Services feature support (continued)

Feature DCS3700

v Maximum number of Enhanced FlashCopy groups per base logical drive 4

v Maximum number of Enhanced FlashCopy logical drives 256

VolumeCopy supported? Yes

v Maximum number of VolumeCopy target logical drives for a specific source
logical drive

511

v Maximum copy relationships per storage subsystem 511

v Maximum running copies per storage subsystem (see note 3.) 8

Remote Mirror Option supported? (see note 2.)
Yes

v Total Remote Mirror logical drives 16

Note:

1. The total number of FlashCopy logical drives is limited to one half of the total number of logical drives.

2. For more information about the DS Storage Manager controller firmware support for the various storage
subsystems, see the IBM System Storage DS Storage Manager Version 10 Installation and Host Support Guide (for DS
Storage Manager V10.77 or earlier) or the IBM System Storage DS Storage Manager Version 10.8 Installation and
Host Support Guide (for DS Storage Manager V10.83 or later) for the applicable host operating system.

3. Refers to logical drives in the copy-in-progress state.

Table 5. DCS3700 storage subsystem with Performance Module Controllers - Copy Services
feature support

Feature See note 1

DCS3700 storage subsystem with
Performance Module Controllers

FlashCopy supported? Yes

Maximum number of logical drives that can
be defined

2048

Maximum total FlashCopy logical drives 256

Maximum FlashCopy logical drives per base
RAID logical drive

8

Enhanced FlashCopy supported? Yes

Maximum number of Enhanced FlashCopy
images

2048

Maximum number of Enhanced FlashCopy
groups per base logical drive

4

Maximum number of Enhanced FlashCopy
logical drives

1024

VolumeCopy supported? Yes

Maximum number of VolumeCopy target
logical drives for a specific source logical
drive

1024

Maximum copy relationships per storage
subsystem

1024

Maximum running copies per storage
subsystem See note 2

8

Remote Mirror Option supported? Yes
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Table 5. DCS3700 storage subsystem with Performance Module Controllers - Copy Services
feature support (continued)

Feature See note 1

DCS3700 storage subsystem with
Performance Module Controllers

Total Remote Mirror logical drives 16

Note:

1. For more information about the DS Storage Manager controller firmware support for the
various storage subsystems, see the IBM System Storage DS Storage Manager Version 10
Installation and Host Support Guide (for DS Storage Manager V10.77 or earlier) or the IBM
System Storage DS Storage Manager Version 10.8 Installation and Host Support Guide (for DS
Storage Manager V10.83 or later) for the applicable host operating system.

2. Refers to logical drives in the copy-in-progress state.

Enabling premium features using firmware version 6.xx.xx or earlier
You must complete the following tasks to enable a premium feature on your
storage subsystem that has firmware version 6.xx.xx or earlier installed:
v “Obtaining the feature enable identifier using firmware version 6.xx.xx or

earlier”
v “Generating the feature key file” on page 8
v “Enabling the premium feature using firmware version 6.xx.xx or earlier” on

page 8
v “Verifying that the premium feature is enabled using firmware version 6.xx.xx or

earlier” on page 8

To obtain the storage subsystem feature enable identifier, make sure that your
controller unit and storage expansion enclosures are connected, powered on, and
managed using the SMclient. Continue with the next section.

Obtaining the feature enable identifier using firmware version
6.xx.xx or earlier

Each storage subsystem has its own unique feature enable identifier. This identifier
makes sure that a particular feature key file is applicable only to that storage
subsystem. Complete the following steps to obtain the feature enable identifier:
1. Click Start → Programs → Storage Manager 10 Client. The Enterprise

Management window opens.
2. In the Enterprise Management window, double-click the storage subsystem for

which you want to enable the premium feature. The Subsystem Management
window opens for the selected storage subsystem.

3. In the Subsystem Management window, click Storage Subsystem → Premium
Features → List. The List Premium Features window opens and displays the
feature enable identifier.

4. Record the feature enable identifier.
5. Close the List Premium Features window.

Continue to next section, “Generating the feature key file” on page 8.

Note: To check the status of an existing premium feature, select Storage
Subsystem → Premium Features → List from the menu.
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Generating the feature key file
To generate the feature key file, you need the following information:
v Premium feature activation code: This code is available on the upper-right

corner of the web activation flyer that is shipped with your premium feature.
v The storage subsystem Feature Key Identifier: For details, see “Obtaining the

feature enable identifier using firmware version 6.xx.xx or earlier” on page 7.
v The machine type, model information, and serial number for the storage

subsystem: This information is on the enclosure chassis. It might also be
available in the shipping paper work that is associated with your order.

You can generate the feature key file with the Premium Feature activation tool that
is available at the following website: IBM System Storage: Storage subsystem
solutions and premium features: activation and expansion module feature
registration.

The premium feature key generation process:
1. Follow the steps provided on the website. After you complete all steps, the

Feature key file is sent to you by email, if an email address was provided
during the activation process.

2. On your hard disk drive, create a directory that you can find easily (for
example, you can name the directory FlashCopy feature key.)

3. Save the feature key file in the new directory.

Enabling the premium feature using firmware version 6.xx.xx
or earlier

In the Storage Manager Subsystem Management window:
1. In the menu, click Premium Features → Enable.
2. Browse to the appropriate key file in the directory you saved it to in the

previous task, “Generating the feature key file.”
3. Click OK.
4. Confirm that the premium feature is enabled. See the next section, “Verifying

that the premium feature is enabled using firmware version 6.xx.xx or earlier.”

Verifying that the premium feature is enabled using firmware
version 6.xx.xx or earlier
Complete the following steps to see a list of those premium features that are
enabled on your storage subsystem:
1. In the Subsystem Management window, click Storage Subsystem → Premium

Features → List

The List Premium Features window opens (see Figure 1 on page 9).
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The dialog lists the following items:
v The premium features that are enabled on the storage subsystem
v The feature enable identifier

2. Click Close to close the window.

Disabling premium features using firmware version 6.xx.xx or
earlier

In normal system operations, you do not need to disable the premium features.
However, if you want to disable a premium feature, make sure that you have the
key file or the IBM premium feature entitlement card with the premium feature
activation code for generating the key file. You need this key file to re-enable the
premium feature at a later time.

Complete the following steps to disable a premium feature on the storage
subsystem:
1. In the Subsystem Management window, click Storage Subsystem → Premium

Features → Disable.
The Disable Premium Feature window opens, listing all the premium features
that are enabled.

2. Select one item in the list, and then click OK.
A confirmation dialog displays.

3. Click Yes.
The Working dialog displays while the feature is being disabled. When the
feature is disabled, the Working dialog closes.
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Figure 1. Listing premium features
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Note:

1. If you want to enable the premium feature in the future, you must reapply the
Feature Key file for that feature.

2. You can disable the Remote Mirror Option without deactivating the feature. If
the feature is disabled but activated, you can complete all mirroring operations
on existing remote mirrors. However, when the feature is disabled you cannot
create any new remote mirrors. For more information about activating the
Remote Mirror Option, see the Storage Manager Copy Services Guide or see
“Using the Activate Remote Mirroring" wizard in the Storage Manager online
help.

3. If a premium feature is disabled, you can use the saved premium feature key
file to reactivate the premium feature. Alternatively, you can access the IBM
premium feature key website (IBM System Storage: Storage subsystem solutions
and premium features: activation and expansion module feature registration) to
reactivate the premium feature key. Ensure that the machine type, model
information, and serial number are the same as those of the storage subsystem
that you used to generate the original premium feature key.

For any additional assistance, contact your local IBM service provider. Ensure that
you have the information listed in “Enabling the premium feature using firmware
version 6.xx.xx or earlier” on page 8.

Enabling premium features using firmware version 7.xx.xx or later
You must complete the following tasks to enable a premium feature on your
storage subsystem that has firmware version 7.xx.xx or later installed:
v “Obtaining the feature enable identifier using firmware version 7.xx.xx or later”
v “Generating the feature key file” on page 8
v “Enabling the premium feature or feature pack using firmware version 7.xx.xx or

later” on page 11
v “Verifying that the premium feature is enabled using firmware version 7.xx.xx or

later” on page 12

To obtain the storage subsystem feature enable identifier, make sure that your
controller unit and storage expansion enclosures are connected, powered on, and
managed using the SMclient. Continue with the next section.

Obtaining the feature enable identifier using firmware version
7.xx.xx or later

Each storage subsystem has its own unique feature enable identifier. This identifier
makes sure that a particular feature key file is applicable only to that storage
subsystem. Complete the following steps to obtain the feature enable identifier:
1. Click Start → Programs → DS Storage Manager 10 Client. The Enterprise

Management window opens.
2. In the Enterprise Management window, double-click the storage subsystem for

which you want to enable the premium feature. The Subsystem Management
window opens for the selected storage subsystem.

3. In the Subsystem Management window, click Storage Subsystem → Premium
Features. The Premium Features and Feature Pack window opens and displays
the feature enable identifier.

4. Record the feature enable identifier.
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Note: You can highlight the feature enable identifier, press CNTRL+C key to
copy it and then in the appropriate field in the premium feature key website,
press CNTRL+V to paste it.

5. Close the Premium Features and Feature Pack window.

Continue to next section, “Generating the feature key file” on page 8.

Note: To check the status of an existing premium feature, select Storage
Subsystem → Premium Features from the menu.

Generating the feature key file
To generate the feature key file, you need the following information:
v Premium feature activation code: This code is available on the upper-right

corner of the web activation flyer that is shipped with your premium feature.
v The storage subsystem Feature Key Identifier: For details, see “Obtaining the

feature enable identifier using firmware version 7.xx.xx or later” on page 10.
v The machine type, model information, and serial number for the storage

subsystem: This information is on the enclosure chassis. It might also be
available in the shipping paper work that is associated with your order.

You can generate the feature key file with the Premium Feature activation tool that
is available at the following website: IBM System Storage: Storage subsystem
solutions and premium features: activation and expansion module feature
registration.

The premium feature key generation process:
1. Follow the steps provided on the website. After you complete all steps, the

Feature key file is sent to you by email, if an email address was provided
during the activation process.

2. On your hard disk drive, create a directory that you can find easily (for
example, you can name the directory FlashCopy feature key.)

3. Save the feature key file in the new directory.

Enabling the premium feature or feature pack using firmware
version 7.xx.xx or later

Perform the following steps to enable a premium feature or feature pack:
1. In the Storage Manager Subsystem Management window, click Storage

Subsystem → Premium Features. A Premium Features and Feature Pack
window is displayed.
v To activate a premium feature for controller firmware versions 7.10.xx.xx to

7.77.xx.xx, select the premium feature in the Premium Feature list, and click
Enable.

v To activate a premium feature for controller firmware versions 7.83.xx.xx or
later, click Use Key File.

v To activate a software feature pack, click Change.
2. Browse to the appropriate key file in the directory you saved it to in the

previous task, “Generating the feature key file” on page 8.
3. Click OK.
4. Click Yes to use the key file to enable the premium feature or software feature

pack.
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Important: When a feature pack is enabled, both controllers will be rebooted.
5. Confirm that the premium feature is enabled. See the next section, “Verifying

that the premium feature is enabled using firmware version 7.xx.xx or later.”

Verifying that the premium feature is enabled using firmware
version 7.xx.xx or later
Complete the following steps to see a list of those premium features that are
enabled on your storage subsystem:
1. In the Subsystem Management window, click Storage Subsystem → Premium

Features

The Premium Features and Feature Pack window opens. The dialog lists the
following items:
v The premium features that are available on the storage subsystem
v The premium features that are enabled on the storage subsystem
v The feature enable identifier

2. Click Close to close the window.

Disabling premium features using firmware version 7.xx.xx or
later

In normal system operations, you do not need to disable the premium features.
However, if you want to disable a premium feature, ensure that you have the key
file or the IBM premium feature entitlement card with the premium feature
activation code for regenerating the key file. You need this key file to re-enable the
premium feature at a later time.

You must remove any configuration that is associated with the premium feature
that is to be disabled. If you fail to do so, the storage subsystem moves to the
premium feature out-of-compliance state. In this state, the subsystem cannot have
new activities (such as creating an array) until the configuration that is associated
with the premium feature is removed or the premium feature is re-enabled.

Complete the following steps to disable a premium feature on the storage
subsystem:
1. In the Subsystem Management window, click Storage Subsystem → Premium

Features

The Premium Features and Feature Pack window opens, listing all the
premium features that are enabled.

2. For controller firmware versions 7.10.xx.xx to 7.77.xx.xx, select one item in the
list, and then click Disable. For controller firmware version 7.83 or later, click
Disable in the same display box as the premium feature.
A confirmation dialog displays.

3. Click Yes.
The Working dialog is displayed while the feature is being disabled. When the
feature is disabled, the Working dialog closes.

Note:

1. You cannot disable a feature pack in the using the Storage Manager GUI. You
can disable the feature pack by using the Storage Manager CLI command
disable storageSubsystem featurePack. When a feature pack is disabled, both
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controllers are rebooted. You must schedule downtime to disable a premium
feature pack. You do not have to schedule downtime when you disable a
premium feature.

2. If you want to enable the premium feature in the future, you must reapply the
Feature Key file for that feature.

3. You can disable the Remote Mirror Option without deactivating the feature. If
the feature is disabled but activated, you can complete all mirroring operations
on existing remote mirrors. However, when the feature is disabled you cannot
create any new remote mirrors. For more information about activating the
Remote Mirror Option, see the Storage Manager Copy Services Guide or see
“Using the Activate Remote Mirroring" wizard in the Storage Manager online
help.

4. If a premium feature is disabled, you can use the saved premium feature key
file to reactivate the premium feature. Alternatively, you can access the IBM
premium feature key website (IBM System Storage: Storage subsystem solutions
and premium features: activation and expansion module feature registration) to
reactivate the premium feature key. Ensure that the machine type, model
information, and serial number are the same as those of the storage subsystem
that you used to generate the original premium feature key.

For any additional assistance, contact your local IBM service provider. Ensure that
you have the information that is listed in the “Generating the feature key file” on
page 8 section handy.
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Chapter 2. Overview of FlashCopy

Important: This FlashCopy premium feature is the original or existing FlashCopy
premium feature that is available for purchase with the DS storage subsystem that
has controller firmware earlier than 7.83.xx.xx installed on it. It is also available for
purchase with the DS storage subsystem with controller firmware version
7.83.xx.xx or later installed on it. Enhanced FlashCopy is a new premium feature
that is available with only certain models such as DS3500, DCS3700, and DCS3700
storage subsystem with Performance Module Controllers. These models have
controller firmware version 7.83.xx.xx or later installed on them in conjunction
with the IBM DS Storage Manager version 10.83 and later. It is an alternate method
of creating and organizing FlashCopies.

Use the FlashCopy premium feature to create and manage FlashCopy logical
drives. A FlashCopy logical drive is a point-in-time image of a standard logical
drive in your storage subsystem. The logical drive that is copied is called a base
logical drive. The FlashCopy premium feature can be used with arrays only. It does
not support disk pools.

When you make a FlashCopy, the controller suspends write operations to the base
logical drive for a few seconds while it creates a FlashCopy repository logical drive,
which is a physical logical drive where FlashCopy metadata and copy-on-write
data are stored.

Depending on the version of the DS Storage Manager, the SMclient instructions
and screen captures in this document might be different from the menu paths in
the SMclient software GUI that you are using.

Note: To obtain an accurate FlashCopy view of the base logical drive, you must
follow the procedures that are described in “Preparing the host operating system
before creating FlashCopy logical drive or Enhanced FlashCopy image” on page
70.

Depending on the subsystem, you can create up to 16 FlashCopies of a base logical
drive, and then write data to the FlashCopy logical drives to complete testing and
analysis. For example, before upgrading a database management system, you can
use FlashCopy logical drives to test different configurations. In addition, the
maximum number of FlashCopies per logical drive varies depending on the
subsystem model and whether FlashCopy per logical drive premium feature
upgrade is purchased and enabled. See Table 1 on page 3, Table 2 on page 4,
Table 3 on page 5, or Table 4 on page 5 for more information.

You can create FlashCopy logical drives for repeated reuse (frequent or nightly
backups) or for one-time use (speculative change or upgrade testing).

This chapter describes the following procedures:
v “Enabling FlashCopy” on page 16
v “Planning a FlashCopy logical drive” on page 16
v “Creating a FlashCopy logical drive” on page 26
v “Reusing an Enhanced FlashCopy logical drive” on page 28
v “FlashCopy related tasks” on page 28
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You can complete these procedures from the SMclient GUI, or with the
command-line interface (SMcli) and the script editor. For more information, click
the Help tab in the Enterprise Management window, and then search for SMcli or
script editor.

Note:

1. FlashCopy is not supported on a DS4300 that is running firmware version
05.33.xx.xx.

2. Making a FlashCopy of a "Dynamic Disk" type of logical drive is not supported
on Windows operating systems.

Enabling FlashCopy
Before you begin, obtain the following information:
v Your Feature Activation Code, which is printed on the IBM FlashCopy premium

feature web activation instructions.
v Your controller unit IBM serial number, machine type, and model number. For

some storage subsystems, this information is printed on a black label on the
front-left mounting flange of the controller. The location of this information
varies depending on your subsystem model. To locate the information that is
specific to your subsystem, refer to the related 'Installation, User's, and
Maintenance Guide'.

v The 32 alphanumeric-character feature enable identifier (see “Obtaining the
feature enable identifier using firmware version 6.xx.xx or earlier” on page 7 or
“Obtaining the feature enable identifier using firmware version 7.xx.xx or later”
on page 10 depending on whichever version is applicable to your storage
subsystem.)

To enable FlashCopy, follow the instructions that are applicable to your controller
firmware version. For details, see “Enabling premium features using firmware
version 6.xx.xx or earlier” on page 7 or “Enabling premium features using
firmware version 7.xx.xx or later” on page 10.

To obtain the storage subsystem feature enable identifier, ensure that your
controller unit and storage expansion enclosures are connected, powered on, and
managed by the SMclient.

For information about viewing the list of premium features that are enabled on
your storage subsystem, see “Verifying that the premium feature is enabled using
firmware version 6.xx.xx or earlier” on page 8 or “Verifying that the premium
feature is enabled using firmware version 7.xx.xx or later” on page 12 depending
on whichever version is applicable to your storage subsystem.

Planning a FlashCopy logical drive
Before you create a FlashCopy logical drive, ensure that you are familiar with the
following concepts:
v Specifying FlashCopy repository logical drive settings
v Estimating FlashCopy repository logical drive capacity
v Estimating FlashCopy repository life

For more information about these concepts, see “Planning a FlashCopy or an
Enhanced FlashCopy logical drive” on page 65
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See “Overview of the FlashCopy Logical Drive wizard” for descriptions of the
parameters that you need to specify in the FlashCopy Logical Drive Wizard.

Overview of the FlashCopy Logical Drive wizard
This section contains descriptions of the parameters that you specify on the
following FlashCopy Logical Drive wizard panels:

Important: The instructions and screen shots provided in this section vary
depending on the version of your controller firmware.
v “Introduction panel”
v “Allocate Capacity panel” on page 18
v “Specify Logical Drive Parameters panel” on page 20
v “Specify Array Parameters panel” on page 21
v “Specify Names panel” on page 22
v “Specify FlashCopy Repository Logical Drive Capacity panel” on page 24
v “Preview panel” on page 25

Note: See the FlashCopy Logical Drive wizard online help for additional
information.

Introduction panel
The Introduction panel, shown in Figure 2 on page 18, provides a definition of a
FlashCopy logical drive and describes its physical components.
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On this panel you can select one of the following options:

Simple
You can use this option if there is free capacity in the array in which the
base logical drive is allocated and the free capacity is at least 8 MB plus
one percent (1%) of the base logical drive capacity. Select this option to
specify basic FlashCopy parameters with default settings for FlashCopy
logical drive mappings.

Advanced
You can use this option if you want to specify the following factors:
v Where the FlashCopy repository logical drive will be created
v All of the customizable FlashCopy settings

Note: The screens will appear differently, depending on the installed version of the
controller firmware.

Allocate Capacity panel
On the Allocate Capacity panel, shown in Figure 3 on page 19, you can specify
where to allocate the repository storage capacity.
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Figure 2. FlashCopy Logical Drive Wizard Introduction panel
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Free Capacity
You can choose Free Capacity on same array as base or Free capacity on
different array. These paths take you to the Specify Logical Drive
Parameters panel, where you can define the mapping and repository
logical drive parameters.

Unconfigured Capacity
This path takes you to the Specify Array Parameters panel, where you can
specify a new array on which the repository resides and choose the RAID
level of the array.

Specifying schedule

For a storage subsystem with controller firmware 7.77.xx.xx or later, you can define
a schedule to create the FlashCopy logical drive. For more information, see
“Creating a schedule for a FlashCopy or an Enhanced FlashCopy logical drive” on
page 90.
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Figure 3. Allocate Capacity panel
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Specify Logical Drive Parameters panel
Use the Specify Logical Drive Parameters panel, shown in Figure 4, to specify the
action that you want the system to complete when a FlashCopy repository logical
drive reaches its capacity and becomes full.

FlashCopy logical drive parameters
In this section of the panel you can specify one of the following options for
logical drive-to-LUN mapping:

Automatic
If you choose this option, the system maps the FlashCopy logical
drive automatically.

Map later with Storage Partitioning
If you choose this option, follow the procedure described in
“Mapping the FlashCopy or Enhanced FlashCopy logical drive to
the host” on page 72 after you have finished using the wizard.

Repository logical drive parameters
In this section of the panel you can specify the threshold warning level and
repository fail policy.
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Figure 4. Specify Logical Drive Parameters panel
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Percent (%) full

This field specifies the threshold warning level for the FlashCopy
repository logical drive. Storage Manager provides a warning
message when the FlashCopy repository logical drive exceeds the
threshold level that you specify.

Important: This warning is the only notification that you receive
before the repository becomes full.

The threshold warning level for the FlashCopy repository logical
drive is initially set to 50%. If you are not sure how high to set the
threshold warning level, accept this default setting.

You can specify one of the following actions that you want Storage
Manager to complete when the repository becomes full:

Fail FlashCopy logical drive
If you specify this option, the FlashCopy logical drive data is not
recoverable when the FlashCopy repository logical drive becomes
full, and the FlashCopy cannot be accessed. In this case, the only
possible action is to delete the FlashCopy logical drive or re-create
the FlashCopy logical drive to create a new point-in-time image.

This is the default option.

Fail writes to base logical drive
If you specify this option, the FlashCopy logical drive data is
accessible when the FlashCopy repository logical drive becomes
full. However, the FlashCopy repository logical drive capacity must
be increased so that writes to the base logical drive are not
rejected.

Attention: AIX and IBM i do not support the "Fail writes to base
logical drive" option. Selecting this option might cause data loss on
the base logical drive. If you are using AIX or IBM i, select the
"Fail FlashCopy logical drive" option, which is the default. Be sure
to monitor the capacity of the FlashCopy repository logical drive,
because you cannot access the FlashCopy if the repository logical
drive becomes full.

See “Specifying FlashCopy or Enhanced FlashCopy repository logical drive
settings” on page 65 for more information about repository capacity and settings.

When you click Next, the Preview panel opens and displays the parameters that
you specified. Click Back to return to the previous panels to edit the repository
parameters or click Finish to proceed to the Specify Names panel.

Specify Array Parameters panel
If you specified the Unconfigured Capacity option on the Allocate Capacity panel,
the Specify Array Parameters panel shown in Figure 5 on page 22, displays. On
this panel you can specify a new array on which to place the repository logical
drive. You can also specify the RAID level of the array that meets the FlashCopy
repository logical drive data storage and protection requirements.
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Click Next to go to the Specify Names panel.

Specify Names panel
On the Specify Names panel, shown in Figure 6 on page 23, you can define the
FlashCopy logical drive name and the name of its associated FlashCopy repository
logical drive.
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Figure 5. Specify Array Parameters panel
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The default naming convention for the first FlashCopy uses the base logical drive
name and adds a suffix of "-1" for the FlashCopy logical drive and "-R1" for the
FlashCopy logical repository drive. The second FlashCopy increments this number
to 2, and so on, up to the four logical drives.

For example, if you are creating the first FlashCopy logical drive for a base logical
drive called DataVol, then the default FlashCopy logical drive name is DataVol-1.
The associated FlashCopy repository logical drive default name is DataVol-R1. The
default name of the next FlashCopy logical drive that you create based on DataVol
is DataVol-2, and the corresponding FlashCopy repository logical drive name is
DataVol-R2.

Change the default names if required.

The following are tips when changing names:
v You must choose a unique name for the FlashCopy and FlashCopy repository

logical drives. Otherwise, the system displays an error message.
v Regardless of whether you use the software-supplied sequence number that (by

default) populates the FlashCopy logical drive name or FlashCopy repository
logical drive name field, the next default name for a FlashCopy or FlashCopy
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Figure 6. Specify Names panel
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repository logical drive still receives a sequence number determined by the
software. For example, you might name the first FlashCopy of base logical drive
DataVol DataVolMay28, without using the software-supplied sequence number of
-1. Regardless, the software assigns a default name for the next FlashCopy as
DataVol-2.

v The next available sequence number is based on the number of existing
FlashCopies of a base logical drive. If you delete a FlashCopy logical drive, the
assigned sequence number becomes available again.

v Names have a 30-character limit, including spaces. When you reach this limit in
either the FlashCopy logical drive name or FlashCopy repository logical drive
name field, no more input is accepted. If the base logical drive name contains 30
characters, the default names for the FlashCopy and its associated FlashCopy
repository logical drive use the base logical drive name truncated just enough to
add the sequence string. For example, for “Host Software Engineering Group
GR-1”, the default FlashCopy name would be “Host Software Engineering
GR-1”. The default repository name would be “Host Software Engineering
G-R1.”

Click Next to go to the Specify FlashCopy Repository Logical Drive Capacity
panel.

Specify FlashCopy Repository Logical Drive Capacity panel

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

On the Specify FlashCopy Repository Logical Drive Capacity panel, shown in
Figure 7 on page 25, you can set the repository drive capacity as a percentage of
the capacity of the base logical drive.
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percent (%) of base logical drive
This field sets the FlashCopy repository logical drive capacity as a
percentage of the base logical drive. The default is 20%.

If you calculate a different capacity using the procedure described in
“Estimating a FlashCopy or an Enhanced FlashCopy repository logical
drive capacity” on page 67, you can increase or decrease the percentage in
this field until the FlashCopy Repository Logical Drive Capacity value
matches the estimated capacity that you calculated. You might need to
round up the number.

Preview panel
The Preview panel, shown in Figure 8 on page 26, displays the parameters that you
have specified for the FlashCopy logical drive and the FlashCopy repository logical
drive. If you click Finish on this panel, the FlashCopy logical drive create process
initiates.
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Figure 7. Specify Repository Logical Drive Capacity panel
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Creating a FlashCopy logical drive
This section describes how to create a FlashCopy logical drive by completing the
following procedures, in the order that they are listed:
1. “Preparing the host operating system before creating FlashCopy logical drive or

Enhanced FlashCopy image” on page 70
2. “Creating a FlashCopy logical drive by using the FlashCopy Logical Drive

wizard” on page 27
3. “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host” on

page 72
4. “Configuring the host for the FlashCopy logical drive” on page 77

Attention: Failure to complete the procedures that are required for your host
operating system can result in an inaccurate point-in-time image of the base logical
drive.
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Figure 8. Preview panel
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Creating a FlashCopy logical drive by using the FlashCopy
Logical Drive wizard

After you prepare the host operating system, create a FlashCopy logical drive by
using the FlashCopy Logical Drive wizard, which you access through SMclient.

Before you begin, see “Overview of the FlashCopy Logical Drive wizard” on page
17 to view screen captures of the FlashCopy Logical Drive wizard panels and read
descriptions of the parameters.

To create a FlashCopy logical drive, complete the following steps:
1. Right-click the logical drive in either the Logical/Physical, Logical, or Storage

& Copy Services tab of the subsystem management window, depending on the
controller firmware version installed in the storage subsystem.

2. Select Create FlashCopy Logical Drive or Create -> FlashCopy in the
pull-down menu.

Note: If the FlashCopy logical drive is to be based on the root disk of the host
operating system, the final point-in-time image might not be consistent with the
base logical drive.

3. Review the information in the initial panel. Click OK to proceed to the
Introduction screen of the wizard.

4. For controller firmware versions 7.77.xx.xx and later, select whether you want
to create a schedule and click Next.
a. To create a schedule, specify the scheduling parameters. For more

information, see “Creating a schedule for a FlashCopy or an Enhanced
FlashCopy logical drive” on page 90.

5. Allocate capacity for the FlashCopy repository logical drive and click Next.
6. Specify parameters for the Enhanced FlashCopy logical drive and the

FlashCopy repository logical drive and click Next.
7. Review the information that is displayed on the Preview screen and click

Finish to create the FlashCopy logical drive.
8. The FlashCopy drives are now displayed in either the Logical/Physical,

Logical, or Storage & Copy Service tab of the Subsystem Management
window.

9. Restart the host application. After you create one or more FlashCopy logical
drives, mount the base logical drive and restart the host application by using
that base logical drive.

If you did not choose automatic mapping when using the wizard, go to “Mapping
the FlashCopy or Enhanced FlashCopy logical drive to the host” on page 72. If you
chose automatic mapping, go to “Configuring the host for the FlashCopy logical
drive” on page 77.

Note: You are not done creating the FlashCopy logical drive until you complete
the procedure described for your host operating system in “Configuring the host
for the FlashCopy logical drive” on page 77.

Note: Click Help in a wizard panel to view more information about that panel.
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Reusing an Enhanced FlashCopy logical drive
Typically, after a FlashCopy logical drive is created, the point-in-time view of the
logical drive is preserved until a new point-in-time image of the same base logical
drive is needed.

To re create a point-in-time image of the same base logical drive, complete the
procedure that is applicable for your host operating system. For details, see
“Reusing a FlashCopy or an Enhanced FlashCopy logical drive” on page 84.

FlashCopy related tasks
This section describes the following FlashCopy related tasks:
v “Viewing the FlashCopy logical drive status”
v “Disabling a FlashCopy logical drive” on page 32
v “Recreating a FlashCopy logical drive” on page 34
v “Resizing a FlashCopy repository logical drive” on page 36
v “Deleting a FlashCopy drive” on page 38

Viewing the FlashCopy logical drive status
You can determine the status of the FlashCopy logical drive by viewing the icons.
The icons change depending of the state of the drive. The logical drive component
property display is also useful in determining the state of the logical drives.

Use the FlashCopy Repository Logical Drive - Properties window to view the
FlashCopy repository logical drive base and capacity properties. You can also use
this window to specify the capacity percentage full and the action to be taken if
the FlashCopy repository logical drive becomes full.

The progress of the modification operations is displayed at the bottom of the
window.

FlashCopy icon states
To view the FlashCopy icon, open the Storage Management Device Manager GUI
Physical/Logical view. The icon states are shown in Figure 9 on page 29.
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What to do if the FlashCopy repository logical drive becomes full
If the FlashCopy repository logical drive becomes full, you must first view the
current FlashCopy logical drive properties and then specify the action to be taken
when the repository drive is full, or increase the capacity of the repository logical
drive.

Viewing the current FlashCopy logical drive properties:
Complete the following steps to view the current FlashCopy logical drive
properties.
1. Select a FlashCopy repository logical drive in the Logical view of the

Subsystem Management window.
2. Click Logical Drive → Properties. The FlashCopy Repository Logical Drive -

Properties window opens. See Figure 10 on page 30.
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Figure 9. FlashCopy icon states
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3. Click the Capacity tab to view the currently defined settings, as shown in
Figure 11 on page 31.
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Figure 10. FlashCopy repository logical drive properties
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Changing FlashCopy repository logical drive properties:
If the repository full policy is set to Fail FlashCopy logical drive (default setting),
the data is not recoverable when the drive becomes full and FlashCopy cannot be
accessed. If this situation occurs, you can complete one of the following actions:
v Delete theFlashCopy logical drive
v Re-create the FlashCopy logical drive to create a new point-in-time image

If the repository full policy is set to "Fail writes to base logical drive," the data is
accessible. However, all write requests to the base logical drive are rejected until
the FlashCopy repository logical drive capacity is increased.

Attention: AIX does not support the "Fail writes to base logical drive" option of
the repository full policy. Selecting this option might cause data loss on the base
logical drive. If you are using AIX make sure that the default option, "Fail
FlashCopy logical drive," is selected. Be sure to monitor the capacity of the
FlashCopy repository logical drive, because the you cannot access the FlashCopy if
the repository logical drive becomes full.
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Figure 11. Repository capacity settings
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For information about increasing the capacity of a FlashCopy repository logical
drive, see “Resizing a FlashCopy repository logical drive” on page 36.

Note:

1. Deleting a FlashCopy logical drive automatically deletes the associated
FlashCopy repository logical drive.

2. Deleting a FlashCopy repository logical drive automatically deletes the
associated FlashCopy logical drive.

3. Deleting a FlashCopy logical drive, and then creating it again, forces you to
stop the host application and unmount the base logical drive while the
FlashCopy is being created again.

4. If you re-create a FlashCopy logical drive, you do not need to create a
FlashCopy repository logical drive, or remap the assigned logical drive-to-LUN
mappings between the FlashCopy logical drive and the host.

5. After you re-create the FlashCopy logical drive, you can change parameters on
the FlashCopy repository logical drive through the appropriate menu options.

6. To avoid another FlashCopy repository logical drive full failure, increase the
capacity of the FlashCopy repository logical drive. For more information, see
“Resizing a FlashCopy repository logical drive” on page 36.

Viewing the progress of a modification operation
The progress bar at the bottom of the FlashCopy Repository Logical Drive
Properties window shows the progress of an operation. You can view the progress
of the following operations:
v Copyback
v Reconstruction
v Initialization
v RAID level change
v Dynamic logical drive expansion
v Capacity increase
v Defragmentation
v Segment size change

Note: The storage management software cannot obtain progress information
from the storage subsystem controllers if the network management connection to
the controllers is down or if the storage subsystem is partially managed. For
more information about a partially managed storage subsystem or an
unresponsive controller or storage subsystem condition, see the Enterprise
Management window online help.

Disabling a FlashCopy logical drive
If you no longer need a FlashCopy logical drive, you might want to disable it.
Until a FlashCopy logical drive is in enabled state, your storage subsystem
performance can be impacted by copy-on-write activity that is directed to the
associated FlashCopy repository logical drive. The copy-on-write activity ends
when you disable a FlashCopy logical drive.

If you disable a FlashCopy logical drive instead of deleting it, you can retain it and
its associated repository for future use. When you need to create a different
FlashCopy of the same base logical drive, you can use the Re-Create option to
re-enable the previously disabled FlashCopy. Re-enabling the FlashCopy takes
lesser time than creating a FlashCopy.
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When you disable a FlashCopy logical drive, note the following points:
v You cannot use that FlashCopy logical drive again until you use the Re-Create

option on that logical drive.
v Only that FlashCopy logical drive is disabled. All other FlashCopy logical drives

remain functional.

If you do not intend to re-create a FlashCopy, you can delete that FlashCopy
logical drive instead of disabling it.

Complete the following steps to disable a FlashCopy logical drive:
1. Select the FlashCopy logical drive. Right-click and select Disable, as shown in

Figure 12.

2. The Disable FlashCopy Logical Drive confirmation window opens, as shown in
Figure 13 on page 34. In this window, type Yes and click OK to begin the
disable operation.
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Figure 12. Choosing to disable the FlashCopy drive
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The FlashCopy icon in the Physical/Logical view is now displayed as disabled.

Recreating a FlashCopy logical drive
Recreating a FlashCopy logical drive takes lesser time than creating a new one. If
you have a FlashCopy logical drive that you no longer need, instead of deleting it,
you can reuse it (and its associated FlashCopy repository logical drive) to create a
different FlashCopy logical drive of the same base logical drive.

Starting with controller firmware version 7.77.xx.xx, a schedule can be defined to
automatically re-create the FlashCopy logical drive at intervals. For more
information, see “Creating a schedule for a FlashCopy or an Enhanced FlashCopy
logical drive” on page 90.

When you re-create a FlashCopy logical drive, note the following points:
v The FlashCopy logical drive must be in either an optimal or a disabled state.

If the FlashCopy logical drive is in an optimal state, the process first disables,
and then re-creates the FlashCopy logical drive. This process invalidates the
current FlashCopy .

v All copy-on-write data on the FlashCopy repository logical drive is deleted.
v When you use the Re-Create option, the previously configured FlashCopy name,

parameters, and FlashCopy repository logical drive are used.
FlashCopy and FlashCopy repository logical drive parameters remain the same
as the previously disabled FlashCopy logical drive and its associated FlashCopy
repository logical drive. After you re-create a FlashCopy logical drive, you can
change parameters on its associated FlashCopy repository logical drive through
the appropriate menu options.

v The system retains the original names for the FlashCopy and FlashCopy
repository logical drives. You can change these names, however, after the
Re-Create option completes.
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Figure 13. Disable FlashCopy confirmation window
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Before you re-create a FlashCopy logical drive, go to “Preparing the host operating
system before creating FlashCopy logical drive or Enhanced FlashCopy image” on
page 70 and complete the procedure to prepare your host operating system. Then,
complete the following steps to re-create a FlashCopy drive:
1. Select the FlashCopy logical drive. Right-click and select Re-Create, as shown

in Figure 14.

2. The Re-Create FlashCopy Logical Drive window opens. Type Yes and click OK.

This disables and re-creates the FlashCopy logical drive (if it had not been
previously disabled) and displays it in the Logical view in an Optimal state. The
creation timestamp shown on the FlashCopy Logical Drive Properties window is
updated to reflect the new point-in-time image. Copy-on-write activity resumes to
the associated FlashCopy repository logical drive.
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Figure 14. Recreating a FlashCopy logical drive
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Resizing a FlashCopy repository logical drive
Use this option to increase the storage capacity of an existing FlashCopy repository
logical drive. Typically, this option is used when you receive a warning that the
FlashCopy repository logical drive is in danger of becoming full.

You can achieve an increase in storage capacity with one of the following methods:
v Use the free capacity that is available on the array of the FlashCopy repository

logical drive.
v Add unconfigured capacity (in the form of unused drives) to the array of the

FlashCopy repository logical drive. Use this method when no free capacity exists
on the array.

Note: A maximum of two drives can be added at one time to increase
FlashCopy repository logical drive capacity.

The storage capacity of a FlashCopy repository logical drive cannot be increased if
any of the following conditions exists:
v One or more hot-spare drives are in use in the logical drive.
v The logical drive has a non-optimal status.
v Any logical drive in the array is in any state of modification.
v The controller that owns this logical drive is in the process of adding capacity to

another logical drive. Each controller can add capacity to only one logical drive
at a time.

v No free capacity exists in the array.
v No unconfigured capacity (in the form of drives) is available to add to the array.

Complete the following steps to resize a FlashCopy repository drive:
1. Select a FlashCopy repository logical drive in the Logical view of the

Subsystem Management window.
2. Click Logical Drive → Increase Capacity.

Note: If no free capacity or unconfigured capacity is available, the Increase
Capacity option is not available.
An Additional Instructions window opens. Read the information, and click OK
if you still want to increase capacity. The Increase Repository Capacity window
opens.
You can see the FlashCopy repository logical drive name, the associated
FlashCopy logical drive name, the associated base logical drive name, the
current capacity, and the amount of free capacity that is available for the
selected repository.
If free capacity is available, the maximum free space is shown in the Increase
Capacity by field. If there is no free capacity on the array, the value that is
shown in the Increase Capacity by field is 0. Add drives to create free capacity
on the array of the standard logical drive.

3. Use one of the following two methods to increase capacity:
v Using the free capacity on the array of the FlashCopy repository logical

drive:
a. Accept the final capacity increase or use the Increase Capacity by field to

adjust the capacity. Click OK.
b. A confirmation window displays. Type Yes and click OK to continue.
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The Logical view is updated. The FlashCopy repository logical drive with
its capacity increased shows a status of Operation in Progress, together
with its original capacity and the total capacity being added.

c. The Free Capacity node involved shows a reduction in capacity. If all of
the free capacity is used to increase the logical drive size, then the Free
Capacity node involved is removed from the Logical view.

v Adding unconfigured capacity (drives) to the array of the FlashCopy
repository logical drive:
a. If there are no unassigned drives available and empty slots in the storage

expansion enclosures are available, insert new drives.
If there are no unassigned drives available, and there are no empty slots
available in the storage expansion enclosures, install another storage
expansion enclosure and additional drives.

b. Click Add Drives.
The Increase Repository Capacity - Add Free Capacity window opens.
Details about storage expansion enclosure, slot, and usable capacity for
the available free drives are displayed.

Note: The drives that are displayed have a capacity that is either
equivalent to or larger than those that are already employed by the array.

c. Select a single drive, or two drives, to be added:
– Press Ctrl+Enter to select the nonadjacent drives.
– Press Shift+Enter to select the adjacent drives.

d. Click Add.
The Add Free Capacity window closes. Check the Drives to add
[enclosure, slot] field to make sure that the correct drives are added.

e. Accept the final capacity or use the Increase Capacity by field to adjust
the capacity.

f. Click OK.
g. A confirmation window opens. Type Yes to confirm the operation, and

click OK to continue.
The Logical view is updated. The FlashCopy repository logical drive that is
having its capacity increased shows a status of Operation in Progress. It
also shows its original capacity and the total capacity that is being added.
The Free Capacity node involved in the increase shows a reduction in
capacity.
If all of the free capacity is used to increase the size of the logical drives,
then the Free Capacity node that is involved is removed from the Logical
view.
If a Free Capacity node did not exist before you added capacity and not all
of the capacity that is added will be used to increase the capacity of the
FlashCopy repository logical drive, a new Free Capacity node is created and
displayed in the Logical view.
Unassigned drives (unconfigured capacity) that are added to increase the
FlashCopy repository logical drives capacity change in the Physical view to
assigned drives. They become associated to the array of the FlashCopy
repository logical drive.

4. View the progress of the capacity increase process. Select the FlashCopy
repository logical drive. Click Logical Drive → Properties.
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The FlashCopy Repository Logical Drive - Properties window opens. A
progress bar at the bottom of the window indicates the status of the capacity
increase.

Deleting a FlashCopy drive
Use this option to delete a FlashCopy logical drive that is no longer needed for
backup or application testing purposes. This option results in an increase of free
capacity in the array or additional unconfigured capacity.

Note:

1. When you delete a logical drive, all data on the logical drive is lost. Back up
the data and stop all I/O before you complete this operation, if necessary.

2. If a file system is mounted on the logical drive, unmount it before you
complete this operation.

3. When you delete a base logical drive, the associated FlashCopy logical drive
and FlashCopy repository logical drive are automatically deleted.

Complete the following steps to delete a FlashCopy drive:
1. Select the FlashCopy logical drive in the Logical view.
2. Click Logical Drive → Delete, as shown in Figure 15 on page 39.
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3. The Delete FlashCopy Logical Drive window opens, as shown in Figure 16 on
page 40. Type Yes and click OK.
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Figure 15. Deleting the FlashCopy logical drive
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The FlashCopy logical drive and the FlashCopy repository logical drive are
deleted and all the data is destroyed.

Rollback of FlashCopy logical drive
Controller firmware versions 7.83.xx.xx or later support rollback of the FlashCopy
logical drive. The base logical drive content can roll back to the point-in-time
image that was captured when the FlashCopy logical drive was created. This
rollback includes all the writes made to the FlashCopy logical drive, from the time
the drives were created until they are rolled back. In other words, the rolled-back
image might not be an exact image of the base logical drive, which was generated
when the FlashCopy logical drive was created.

The base logical drive can perform I/O operations during rollback. It is
immediately accessible for read and write operations (with the 'rolled-back
content') after acceptance of the Rollback request by the controller firmware, even
while the actual data transfer operation is still in progress. The controller performs
only one rollback operation per base logical drive at a time; any additional rollback
requests are rejected. While a Rollback is in progress, the FlashCopy logical drive
that is being used for the Rollback cannot be deleted or disabled. You must first
cancel the Rollback operation to delete or disable the FlashCopy logical drive.

CAUTION:
Deleting or disabling the FlashCopy logical drive while a rollback is in progress
might leave the content of the base logical drive in an undetermined state.
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Figure 16. Delete FlashCopy Logical Drive window
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Additional FlashCopy repository logical drive space might also be required for the
rollback operations. The maximum required space can be twice as large as the size
of the base logical drive. Storage Manager and controller firmware was modified to
support repository drive with 220% capacity of the base logical drive. Therefore, to
ensure that the worst-case scenario is addressed, when you create or expand a
FlashCopy repository logical drive from the Storage Manager GUI or CLI, consider
increasing the repository drive capacity to 220% of the capacity of the associated
base logical drive or as close to that capacity limit as possible. In such a situation,
a 'FlashCopy repository logical drive full' condition does not arise and a Host
WRITE operation is not rejected during a Rollback operation. After the rollback
operation is complete, the existing FlashCopy logical drive can be deleted and then
re-created with a smaller capacity FlashCopy repository logical drive.

There are five levels of the rollback priority – lowest, low, medium, high, and
highest. The higher the priority, the more the controller resources and time to be
dedicated to the rollback operation, which can affect the performance of the inputs
to other logical drives in the subsystem. The recommended level is Medium.

To start the rollback operation:

Right-click the FlashCopy logical drive in the Storage & Copy Services tab of the
Subsystem Management window and select Rollback > Start. The Confirm
rollback FlashCopy logical drive window opens. Read the caution statement, select
the rollback modification priority, type yes, and click OK to start the rollback.
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Chapter 3. Overview of Enhanced FlashCopy

Enhanced FlashCopy is a new chargeable premium feature that is supported by
controller firmware version 7.83 and later. It is an enhanced version of the existing
FlashCopy feature, which uses the same 'Copy-on-Write' algorithm to preserve an
instance view of the thin or standard logical drive. This thin or standard logical
drive is called as the 'base logical drive'. The Enhanced FlashCopy was designed to
allow creation of many Enhanced FlashCopy images with minimum
'Copy-on-write' operations. Thus, the storage subsystem performance is maintained
even in cases where many FlashCopy images of the same base logical drive are
active at the same time. Currently, Enhanced FlashCopy is supported only on the
DS3500 and DCS3700 storage subsystems, and the DCS3700 storage subsystems
with Performance Module Controllers.

Contact IBM resellers or representatives for additional support.

Enhanced FlashCopy premium feature can be used with both arrays and disk
pools. However, an array can not have both enhanced FlashCopy Images and
FlashCopy Logical drives at he same time. Enhanced FlashCopy provides the
following newer capabilities:
v “Enhanced FlashCopy image”
v “Enhanced FlashCopy logical drive” on page 45
v “Consistency group” on page 46
v “Rollback of Enhanced FlashCopy images” on page 47
v “Convert FlashCopy to Enhanced FlashCopy” on page 48

Enhanced FlashCopy image

Enhanced FlashCopy image is a logical drive image that represents a 'point-in-time'
instance or content of a standard or thin logical drive, also called as base logical
drive. Each base logical drive can have up to four Enhanced FlashCopy groups of
32 Enhanced FlashCopy images each. Each Enhanced FlashCopy group has a
dedicated Enhanced FlashCopy group repository logical drive for storing the
Enhanced FlashCopy images that belong to that Enhanced FlashCopy group. The
repository logical drive can be created with capacity equal up to 220% of the base
logical drive's capacity.

Note: Enhanced FlashCopy image and Enhanced FlashCopy group are sometimes
referred to as Point in Time (PiT) and PiT group, respectively.

The Enhanced FlashCopy image can be created manually by using the DS Storage
Manager GUI or CLI script, or automatically by creating a schedule. The Enhanced
FlashCopy images within an Enhanced FlashCopy group are treated as a sequence
of images, from the oldest (the first Enhanced FlashCopy image taken in an
Enhanced FlashCopy group) to the newest (the last Enhanced FlashCopy image
taken in an Enhanced FlashCopy group). The “Copy-on-write” operations occur
only for the newest Enhanced FlashCopy image in an Enhanced FlashCopy group.
Read operations of the older Enhanced FlashCopy images might require reading
preserved data from newer Enhanced FlashCopy images. Using this operation, you
can create multiple FlashCopies of a base logical drive, with only one
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“Copy-on-write” operation for those FlashCopies. The Enhanced FlashCopy images
cannot be mapped to the host for read or write operations. (see Enhanced
FlashCopy logical drive.)

Because the Enhanced FlashCopy images in an Enhanced FlashCopy group are
treated as a sequence of related images, you can delete Enhanced FlashCopy
images in the order of creation only, starting with the oldest one. An error is
displayed when deleting any other Enhanced FlashCopy image that is not the
oldest one. No data movement is required to delete an Enhanced FlashCopy
image. These images are deleted to free space in the repository drive for newer
Enhanced FlashCopy images or to reduce the number Enhanced FlashCopy image
usage. The Enhanced FlashCopy premium feature is entitled as the number of
Enhanced FlashCopy images allowed per storage subsystems. If the total number
of Enhanced FlashCopy images created is equal to the maximum Enhanced
FlashCopy images allowed, no more Enhanced FlashCopy images can be created
until some of the existing ones are deleted. The following figure shows Enhanced
FlashCopy images and groups relationship to base logical drive.
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Figure 17. Enhanced FlashCopy Images and Groups
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Enhanced FlashCopy logical drive

Because Enhanced FlashCopy images cannot be mapped to a host for I/O
operations, an Enhanced FlashCopy logical drive must be created for every
Enhanced FlashCopy image that you want to map to a host for read-only or
read/write operations. No repository logical drive is required if the Enhanced
FlashCopy logical drive is to be used as read-only. For read/write access, a
repository logical drive is required to store any changes from the host to the
Enhanced FlashCopy image, allowing the data in the original Enhanced FlashCopy
image to remain unchanged. Up to 256 Enhanced FlashCopy logical drives can be
created in a storage subsystem. Up to four Enhanced FlashCopy logical drives can
be created for an Enhanced FlashCopy image to allow different host usages of the
Enhanced FlashCopy image. Deleting the Enhanced FlashCopy image also deletes
the content of any associated Enhanced FlashCopy logical drives. However, the
Enhanced FlashCopy logical drive definitions that are associated with a deleted
Enhanced FlashCopy image, are preserved so that they can be re-created for
another Enhanced FlashCopy image. These Enhanced FlashCopy logical drive
definitions are displayed with the status Disable. You must manually delete the
Enhanced FlashCopy logical drive definitions if they are not needed.

Note: The Enhanced FlashCopy logical drive(s) is sometimes referred to as the
view(s) of the Enhanced FlashCopy image or PiT view, in short.

The following figure shows two Enhanced FlashCopy logical drives created from
an Enhanced FlashCopy image and mapped to two different hosts as read/write
capable.
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Status of the Enhanced FlashCopy feature

The status of Enhanced FlashCopy features such as Enhanced FlashCopy images,
groups, or logical drives, are displayed in the table in the Storage & Copy Service
tab of the Subsystem Management window.

Consistency group

Consistency group is a collection of base logical drives in a storage subsystem.
These base logical drives, which are the source of a FlashCopy image, are also
called as member logical drives of a consistency group. For m ore information, see
Chapter 4, “Overview of consistency groups,” on page 59.

Enhanced
FlashCopy
Logical Drive
(up to 4)

Enhanced
FlashCopy
Group
(up to 4)

d
3
m

m
0
0
0
2

Base
Logical
Drive

Enhanced
FlashCopy
Image
(up to 32)

...

Host

Repository Logical
Drive for Enhanced
FlashCopy Logical
Drive

Figure 18. Enhanced FlashCopy Logical Drives
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Rollback of Enhanced FlashCopy images

Any of the Enhanced FlashCopy images can be rolled back and the content of the
base logical drive can be replaced at any time. The base logical drive can receive
I/O operations during a rollback operation. However, performance might be
affected because other defined Enhanced FlashCopy groups for that base logical
drive processes “Copy-on-Writes”, which are caused by rolling back the base
logical drive.

The rollback operation removes all data modifications that were made to a base
logical drive after the specified Enhanced FlashCopy image was taken. The host
can continue to access the base logical drive for I/O operations during the rollback
operation. All of the created Enhanced FlashCopy images and groups for the base
logical drive are preserved during the rollback. However, the managing of these
images and groups will required additional space in the repository logical drive.
Consider deleting unused Enhanced FlashCopy images and groups and increasing
the amount of space before initiating a rollback operation.

You can start a rollback from an Enhanced FlashCopy image or a consistency
group an Enhanced FlashCopy image. When you perform a rollback operation on
an Enhanced FlashCopy image, the system rolls back the base logical drive that is
associated with an Enhanced FlashCopy group to a previous state. The rollback
operation does not change the content of the Enhanced FlashCopy images that are
associated with the base logical drive. When you roll back a consistency group
Enhanced FlashCopy image, the system rolls back all or select member logical
drives of the consistency group to a previous state.

Before you use the Start Rollback option:
v Ensure that there is enough capacity in the repository to start a rollback

operation. The minimum repository capacity is 32 MB + 0.5% of the base logical
drive and the maximum repository capacity is 220% of the base logical drive
capacity to as close to the 220% of the base logical drive capacity as possible. It
is recommended that you add more repository logical drive capacity to prevent
any failures during the rollback.

v Ensure that the selected Enhanced FlashCopy image is in an Optimal state. If the
Enhanced FlashCopy image is in a Purged state or is automatically deleted due
to the Auto-Delete Limit, the system displays an error message. Ensure that the
selected logical drive is in an Optimal state. You cannot start a rollback
operation on a failed logical drive.

v Ensure that the selected logical drive does not have a rollback operation already
in progress. You cannot start more than one rollback operations for a base logical
drive at a time.

v Rollback is not allowed when the specified Enhanced FlashCopy image has an
associated Enhanced FlashCopy logical drives view(s), as the rollback operation
deletes the specified Enhanced FlashCopy image.

Keep in mind these guidelines before you start a rollback operation:
v During a rollback operation, you cannot delete the Enhanced FlashCopy image

that is being used for the rollback.
v During a rollback operation, you cannot create a new Enhanced FlashCopy

image for a base logical drive that is participating in a rollback operation.
v During a rollback operation, you cannot change the Repository-Full Policy of the

associated Enhanced FlashCopy group.

Chapter 3. Overview of Enhanced FlashCopy 47



v You cannot start a rollback operation when a Dynamic Capacity Expansion
(DCE), Dynamic Logical Drive Expansion (DVE), a Dynamic RAID Migration
(DRM), or a Dynamic Segment Size (DSS) operation is in progress.

v You cannot start a rollback operation if the base logical drive is participating in a
VolumeCopy or in a enhanced remote mirroring logical drive pair.

v You cannot start a rollback operation if the base logical drive is a secondary
logical drive in a remote mirror. However, if the base logical drive is the primary
logical drive in a remote mirror, you can start a rollback operation. Additionally,
you cannot perform a role reversal in a remote mirror if the primary logical
drive is participating in a rollback operation.

v A rollback operation fails if any of the used capacity in the associated Enhanced
FlashCopy repository logical drive has unreadable sectors.

Convert FlashCopy to Enhanced FlashCopy

Use the Convert to Enhanced FlashCopy Group option to convert a FlashCopy
logical drive and its associated repository to an Enhanced FlashCopy group. The
system performs the following actions for each converted FlashCopy logical drive:
v Deletes the FlashCopy logical drive definition and creates an Enhanced

FlashCopy group (the new Enhanced FlashCopy group is created empty with no
Enhanced FlashCopy images). The current content of the FlashCopy logical drive
is deleted.

v Converts the associated FlashCopy repository logical drive to an Enhanced
FlashCopy group repository.

v Retains the same schedule (if a schedule is defined) for the new Enhanced
FlashCopy group.

v Creates a read-only FlashCopy logical drive with a Paused status. The new
Enhanced FlashCopy logical drive inherits the worldwide name (WWN) and
host mappings as the converted FlashCopy logical drive.

Note: If the number of FlashCopies that exist for a base logical drive exceeds the
maximum number of allowed Enhanced FlashCopy groups per base logical drive,
a conversion request for that base logical drive is rejected. Any excess FlashCopy
beyond the limit must be deleted before you can perform the conversion process.

Keep in mind the following guidelines when you use the Convert to Enhanced
FlashCopy Group option:
v The conversion process is done on a base logical drive and applies to all

Enhanced FlashCopies of a base logical drive.
v FlashCopy logical drive and Enhanced FlashCopy groups cannot exist on the

same base logical drive; therefore, the FlashCopy logical drive for the base
logical drive that you do not select for conversion will be deleted from the
storage subsystem.

v If a base logical drive has FlashCopy images created as part of an online
VolumeCopy operation, those VolumeCopy definitions must be deleted before
you attempt to convert a FlashCopy image to an Enhanced FlashCopy image.

v You can perform the conversion operation only for those FlashCopy logical
drives that are in the Stopped state.
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Differences between FlashCopy and Enhanced FlashCopy
FlashCopy and Enhanced FlashCopy premium features can coexist in the same
storage subsystem. Each feature can be used to create FlashCopy of the base logical
drives. Differences between the FlashCopy and Enhanced FlashCopy premium
features are as follows:
v Traditional arrays support both FlashCopy and Enhanced FlashCopy premium

features. Disk pools support only Enhanced FlashCopy premium feature.
v FlashCopy logical drives, and Enhanced FlashCopy images and its associated

logical drives cannot be created at the same time in an array. The array must
have either FlashCopy logical drives or Enhanced FlashCopy images and its
associated logical drives.

v Thin logical drive supports the Enhanced FlashCopy feature only.
v The creation of FlashCopy images of the base logical drives is not supported in

FlashCopy. However, you can create up to 16 FlashCopy logical drives of a base
logical drive, depending on the storage subsystem model and the premium
feature. Each FlashCopy logical drive has its own repository drive. A
“Copy-on-Write” operation is performed for each of the FlashCopy logical drive.
FlashCopy logical drive can be deleted in any order.

In contrast, up to 32 Enhanced FlashCopy images can be created for a base
logical drive in an Enhanced FlashCopy group. Only one 'Copy-on-write (CoW)'
operation is performed per Enhanced FlashCopy group of an Enhanced
FlashCopy image, which improves FlashCopy operations when working with
large amount of active FlashCopies for a base logical drive. In other words, in
the current enhanced FlashCopy implementation, when a write is made to the
base logical drive, 32 FlashCopy images in an enhanced FlashCopy group have
only one 'CoW' operation as compared to having one 'CoW' for each of the
defined FlashCopy images. However, because the FlashCopy images are built
onto each other as they are captured in sequence of time, the Enhanced
FlashCopy images must be deleted in the order of creation, starting with the
oldest one. In addition, an additional repository logical drive must be created for
Enhanced FlashCopy images that need to be mapped to the host for read/write
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Figure 19. FlashCopy Logical Drives of a Base Logical Drive
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operations. The following figure shows the structure of the Enhanced FlashCopy.

v The repository logical drive of the FlashCopy logical drive can be in the same
array or in a different array than the one in which the base logical drive resides.
The repository logical drive of the Enhanced FlashCopy logical drive can only be
in the same array or disk pool in which the base logical drive resides. You must
add capacity to the array or disk pool if there is not enough space to create the
required repository drives.

v The Enhanced FlashCopy premium feature is entitled by the number of the
Enhanced FlashCopy images that can be created in a storage subsystem. The
FlashCopy premium feature is entitled by the number of FlashCopy logical
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drives that can be created for a base logical drive and the maximum number of
FlashCopy logical drives that can be created in a storage subsystem.

Enabling Enhanced FlashCopy premium feature
Before you begin, gather the following information:
v Your Feature Activation Code, which is printed on the IBM Enhanced FlashCopy

premium feature web activation instructions.
v Your controller unit IBM serial number, machine type, and model number, which

are printed on a black label on the front-left mounting flange of the controller.

Note: To see the mounting flange, you must remove the front bezel.
v The 32 alphanumeric-character feature enable identifier (see “Obtaining the

feature enable identifier using firmware version 7.xx.xx or later” on page 10).

To obtain the storage subsystem feature enable identifier, ensure that your
controller unit and storage expansion enclosures are connected, powered on, and
managed using the SMclient.

For information about how to view the list of premium features that are enabled
on your storage subsystem, see “Verifying that the premium feature is enabled
using firmware version 7.xx.xx or later” on page 12.

To enable Enhanced FlashCopy, you must complete the following tasks in the
following order:

Generate the feature key file and enable Enhanced FlashCopy. This procedure is
described in detail in “Generating the feature key file” on page 8 and “Enabling
the premium feature or feature pack using firmware version 7.xx.xx or later” on
page 11.

Planning an Enhanced FlashCopy logical drive
Before you create an Enhanced FlashCopy logical drive, ensure that you are
familiar with the following concepts:
v Specifying Enhanced FlashCopy repository logical drive failure settings
v Estimating Enhanced FlashCopy repository logical drive capacity
v Estimating Enhanced FlashCopy repository life
v Overview of the FlashCopy Logical Drive wizard

For details, see “Planning a FlashCopy or an Enhanced FlashCopy logical drive”
on page 65

Planning an Enhanced FlashCopy image
Before you create the first Enhanced FlashCopy image of a base logical drive,
consider the following points:
v “Repository logical drive space” on page 52
v “Enhanced FlashCopy group repository logical drive full alert setting” on page

52
v “Policies for full Enhanced FlashCopy group repository logical drive” on page

52
v “Enhanced FlashCopy image schedule” on page 53
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v “FlashCopy logical drives” on page 53

Repository logical drive space

The Enhanced FlashCopy group repository logical drive is created in the same
array or disk pool as the base logical drive. You must “add capacity” to the array
or disk pool if there is not enough space. The repository logical drive space
depends on the number of locations in the base logical drive changed after the
Enhanced FlashCopy images are taken. The default space allocation is 40% of the
size of the base logical drive disk space. The maximum repository capacity is 220%
of the base logical drive disk space. Assign extra space for the Enhanced
FlashCopy group repository logical drive if several locations in the base logical
drive are to be modified. You can also increase the repository logical drive space
‘on-the-fly’, as required. This information applies to the Enhanced FlashCopy
logical drive repository drive too.

Enhanced FlashCopy group repository logical drive full alert
setting

The default setting is 75% full. An alert is sent when the Enhanced FlashCopy
group repository logical drive space usage reaches 75% of the total capacity. When
the alert is generated, you can either change the alert setting to a higher value or
increase the capacity of the repository logical drives. This information applies to
the Enhanced FlashCopy logical drive repository drive too.

Policies for full Enhanced FlashCopy group repository logical
drive

When the repository is full, select one of these options:
v Purge the oldest Enhanced FlashCopy images. By doing so, the oldest images

are deleted to free up repository space. This instruction also applies when only
one Enhanced FlashCopy image exists in the Enhanced FlashCopy group, which
is the default setting.

v Reject writes to the base logical drives to ensure that Enhanced FlashCopy
images are valid. But, it might cause problems in the host because of the failed
writes, which is not the recommended full repository setting.

Attention: The 'Fail writes to base logical drive' option is not supported on AIX
or IBM i. Selecting this option might cause data loss on the base logical drive. If
you are using AIX or IBM i, select the 'Fail FlashCopy logical drive' option, which
is the default. Ensure that you monitor the capacity of the FlashCopy repository
logical drive, because you cannot access the FlashCopy if the repository logical
drive becomes full.
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Enhanced FlashCopy image schedule

Determine whether a schedule is needed to automatically create Enhanced
FlashCopy images. For information about creating schedules, see “Creating a
schedule for a FlashCopy or an Enhanced FlashCopy logical drive” on page 90.

FlashCopy logical drives

If any FlashCopy logical drives are created, determine the course of action for
these logical drives (backing up or rolling back to the base logical drive) and then
delete them. FlashCopy logical drives and Enhanced FlashCopy images cannot be
created on a the same array.

Figure 21. Create Enhanced FlashCopy Image
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Creating an Enhanced FlashCopy logical drive
Overview

To create an Enhanced FlashCopy logical drive, complete the following procedures:
1. “Preparing the host operating system before creating FlashCopy logical drive or

Enhanced FlashCopy image” on page 70
2. “Creating an Enhanced FlashCopy group”
3. “Creating an Enhanced FlashCopy image”
4. “Creating an Enhanced FlashCopy logical drive” on page 55
5. “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host” on

page 72
6. “Configuring the host for the Enhanced FlashCopy logical drive” on page 56

Attention: Failure to complete the procedures that are required for your host
operating system can result in an inaccurate point-in-time image of the base logical
drive.

Creating an Enhanced FlashCopy group

To create the enhanced FlashCopy group, right-click the disk pool or array in the
Storage & Copy Services tab and select Create -> Enhanced FlashCopy Group.
Follow the instruction in the pop up wizard to create the Enhanced FlashCopy
Group.

Creating an Enhanced FlashCopy image

To create the Enhanced FlashCopy image of a base logical drive:
1. In the Storage & Copy Services tab, right-click the base logical drive and from

the menu, select Create > Enhanced FlashCopy Image.
2. If an Enhanced FlashCopy group is not created for this base logical drive,

create a new Enhanced FlashCopy group. The Enhanced FlashCopy image is
created in the newly created Enhanced FlashCopy group. If there are Enhanced
FlashCopy groups already created for this base logical drive, you can create the
Enhanced FlashCopy image in one of the existing groups.
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Creating an Enhanced FlashCopy logical drive

To create an Enhanced FlashCopy logical drive of an Enhanced FlashCopy image
to map to a host for I/O operations:
1. Right-click the Enhanced FlashCopy image in the Enhanced FlashCopy images

list for a base logical drive, and select Create Enhanced FlashCopy logical
drive. The Enhanced FlashCopy logical Drive Settings window opens.

2. Specify the name of the Enhanced FlashCopy logical drive, the host to map the
Enhanced FlashCopy logical drive to (or select to map to host at a later time),
the access mode of the Enhanced FlashCopy logical drive, and the repository
logical drive if the selected access-mode is read/write.

Figure 22. Create Enhanced FlashCopy Image
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3. Click Finish.

Configuring the host for the Enhanced FlashCopy logical drive

After you create the Enhanced FlashCopy logical drive for the Enhanced
FlashCopy image, and map the Enhanced FlashCopy logical drive to the host, you
must complete some additional steps to configure the host operating system.

Complete the procedure that is applicable for your host operating system:
v “Instructions for AIX” on page 77
v “Instructions for HP-UX” on page 79
v “Instructions for Solaris” on page 81
v “Instructions for Windows” on page 82
v “Instructions for Novell NetWare” on page 83
v “Instructions for Linux” on page 83

Attention: You must complete the procedure described for your host operating
system in this section. Failure to do so can result in an inaccurate point-in-time
image of the base logical drive.

Figure 23. Create Enhanced FlashCopy Logical Drive
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Reusing a FlashCopy logical drive
Typically, after an Enhanced FlashCopy logical drive for an Enhanced FlashCopy
image is created, it is used to track changes to that Enhanced FlashCopy image,
until it is reused to track changes to another Enhanced FlashCopy image, of the
same base logical drive.

To re create a point-in-time image of the same base logical drive, complete the
procedure that is applicable for your host operating system. For details, see
“Reusing a FlashCopy or an Enhanced FlashCopy logical drive” on page 84.

What to do if the Enhanced FlashCopy repository logical drive
becomes full

Depending on the usage, two types of Enhanced FlashCopy repository logical
drives can become full - Enhanced FlashCopy group and Enhanced FlashCopy
logical drive repository.

If any of the Enhanced FlashCopy repository logical drives becomes full, you must
first view the current Enhanced FlashCopy logical drive properties, and then either
raise the warning threshold, increase the repository logical drives, delete the
Enhanced FlashCopy images, or specify automatic Enhanced FlashCopy image
deletion policy when repository drive is full.

The status of the Enhanced FlashCopy images, groups, or logical drives are
indicated by appropriate icons in the Status column under the Storage & Copy
Services tab. For more information about the Enhanced FlashCopy images, groups,
or logical drives, right-click the Enhanced FlashCopy image, group, or logical drive
in the Storage & Copy Services tab and select Properties.
v To increase the Enhanced FlashCopy repository logical drive utilization alert

threshold to a higher value: Right-click the Enhanced FlashCopy group or the
Enhanced FlashCopy logical drive and select Change Settings. In the window
that appears, change the alert threshold.

Note: The default alert threshold is 75% of the repository logical drive capacity.
v To increase the Enhanced FlashCopy repository logical drive capacity: Right-click

the Enhanced FlashCopy group or the Enhanced FlashCopy logical drive and
select Overall Repository -> Increase Capacity. In the Increase Repository
Capacity window, enter the appropriate information to increase the repository
logical drive capacity.

v To enable automatic deletion of Enhanced FlashCopy images in an Enhanced
FlashCopy group: Right-click the Enhanced FlashCopy group and select Change
Settings. In the window that appears, enable automatic deletion of the Enhanced
FlashCopy images.
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Chapter 4. Overview of consistency groups

A consistency group is a feature of the enhanced FlashCopy premium feature. It is
a collection of up to 32 base logical drives in your storage subsystem. These base
logical drives, which are the sources of the Enhanced FlashCopy images are
referred to as member logical drives of a consistency group.

The purpose of a consistency group is to take simultaneous Enhanced FlashCopy
images of multiple base logical drives, thus ensuring consistent images of a
collection of base logical drives at a particular point in time. For example, you can
create a consistency group if you want to take a synchronized FlashCopy image of
several logical drives that are in different arrays or disk pools in a storage
subsystem. Using the consistency group mechanism is ideal for applications that
span multiple logical drives. For example, a database application that has the logs
on one logical drive and the database on another logical drive.

Every base logical drive that belongs to a consistency group is referred to as a
member logical drive of the consistency group. A member logical drive is either a
standard logical drive in a disk pool or an array, or a thin logical drive in a disk
pool. A member logical drive must not have any FlashCopy logical drives defined.
If any FlashCopy logical drives are defined in a member logical drive, then delete
them before that logical drive is a part of a consistency group. This requirement
does not apply to Enhanced FlashCopy logical drives. A consistency group
member logical drive might have its own Enhanced FlashCopy images in addition
to the Enhanced FlashCopy images as part of the consistency group.

A consistency group Enhanced FlashCopy image, which is sometimes referred to
as consistency group PiT, is a logical point-in-time image of the content of each
member logical drive in the consistency group at the same point in time. This
action creates synchronized Enhanced FlashCopy images of all the logical drives in
a consistency group. Consistency group Enhanced FlashCopy images are stored
consecutively based on creation time, with the oldest Enhanced FlashCopy image
at the top of the list.

Before creating an Enhanced FlashCopy image for each member in a consistency
group, the controllers suspend all pending I/O operations for each member logical
drive of the consistency group. If the controller software cannot create an
Enhanced FlashCopy image for any one member logical drives, because of I/Os
can't be suspended no new consistency group Enhanced FlashCopy image is
created.

After Enhanced FlashCopy images are created for a consistency group, if you add
a member logical drive, the existing member logical drives will have a different
number of stored Enhanced FlashCopy images as compared to the newly added
member logical drive. If you roll back an Enhanced FlashCopy image that was
taken before new member logical drives were added to a consistency group, the
rollback affects only the member logical drives that are in the consistency group
only before the new logical drives are added to the consistency group.

The consistency group Enhanced FlashCopy image cannot be mapped to a host for
I/O operations because the consistency group Enhanced FlashCopy image is used
to save only the original data from the member logical drive. A consistency group
Enhanced FlashCopy logical drive, which is sometimes referred to as consistency
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group Enhanced FlashCopy view or consistency group PiT view, must be created
for each consistency group Enhanced FlashCopy image that is mapped to the host.
As in the case with the Enhanced FlashCopy image logical drive, the consistency
group Enhanced FlashCopy logical drive does not need to have the associated
repository drive created, if the host access is read-only. If the host access is
read-write, a consistency group Enhanced FlashCopy logical drive repository
logical drive must be created along with the consistency group Enhanced
FlashCopy logical drive. The consistency group Enhanced FlashCopy logical drive
repository is used to save any subsequent modifications made by the host
application to the member logical drive, without affecting the referenced
consistency group Enhanced FlashCopy image.

Guidelines to create a consistency group Enhanced FlashCopy
image
v You cannot create an Enhanced FlashCopy image for a consistency group that

has reached its maximum number of Enhanced FlashCopy images. You must
enable auto-delete for the consistency group or manually delete one or more
Enhanced FlashCopy images from the consistency group, and then try to create
Consistency Group Enhanced FlashCopy images again.

v You cannot create an Enhanced FlashCopy image of a failed logical drive.
v If a logical drive is a member of a consistency group, then the storage

management software creates an Enhanced FlashCopy group for that member
logical drive. This Enhanced FlashCopy group counts towards the maximum
number of Enhanced FlashCopy groups that are allowed on a base logical drive.

v Depending on the number of member logical drives in a consistency group, each
consistency group Enhanced FlashCopy image creation increases the Enhanced
FlashCopy image usage count for a storage subsystem by that amount. For
example, the consistency group Enhanced FlashCopy image creation for a
consistency group of 10 member logical drives increases the Enhanced
FlashCopy image usage count by 10.
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v When you add a member logical drive to a consistency group, the system
automatically creates an associated member repository and an Enhanced
FlashCopy group for the member logical drive.

Characteristics of consistency groups

Some of the characteristics of consistency groups are:
v There is a maximum limit to the number of member logical drives that can

belong to a consistency group (depending on the configuration). For DS3500 and
DCS3700, it is 32. For the DCS3700 storage subsystem with Performance Module
Controllers, it is 64.

v You can schedule the Enhanced FlashCopy image creation for all member logical
drives of a consistency group.

v You can roll back member logical drives for a consistency group.
v A member logical drive can belong to several consistency groups.

Guidelines for creating a consistency group
v If a member logical drive resides in an array, the member repository for any

associated consistency group can reside on either a disk pool or an array.
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v If a member logical drive resides on a disk pool, the member repository for any
associated consistency group must reside on the same disk pool as the member
logical drive.

v You cannot add a failed member logical drive to a consistency group.
v An Enhanced FlashCopy group exists for each member logical drive that is

associated with a consistency group. You cannot individually manage an
Enhanced FlashCopy group that is associated with a consistency group. Instead,
you must manage operations (for example, delete Enhanced FlashCopy image
and roll back Enhanced FlashCopy image) at the consistency group level.

v The consistency group repository logical drive must have the same T10PI and
Quality of Service (QoS) settings as the associated member logical drive. For
example, if a member logical drive of a consistency group is T10PI enabled, then
the associated consistency group repository logical drive must be T10PI enabled.

When you add a base logical drive, which is a member of a consistency group, to
an Enhanced Global Remote Mirror group, the system automatically changes the
Repository Full Policy to automatically purge the oldest Enhanced FlashCopy
image and sets the auto-delete limit to the maximum Enhanced FlashCopy image
limit for a consistency group. All member logical drives in a consistency group that
also belong to an Enhanced Global Mirror Group must belong to the same
Enhanced Global Mirror Group. You can use consistency groups for Enhanced
FlashCopy and remote mirroring, so it is good practice to define separate and
specific consistency groups for Enhanced FlashCopy images and remote mirroring.

Creating a consistency group
To create a consistency group:
1. Right-click the Consistency Groups node in the tree view of the Storage &

Copy Services tab and select Create or select the menu option Copy Services >
Consistency group > Create. The Consistency Group Setting window appears
in which you can select member logical drives for the consistency group.

2. To select multiple logical drives, press the CTRL key or SHIFT key and select
the logical drives from the Eligible logical drives list. An Enhanced FlashCopy
logical drive repository is created for each of the selected logical drive using
the following default criteria:
v Capacity is 40% of the associated base logical drive
v Undersized repositories are allowed
v Mismatch in QoS attributes are allowed
v Alert is sent when repository is 75% full
v Automatic deletion of oldest images when the taken image limit per

consistency group is reached. The current limit of images per consistency
group is 32.

Note: You can manually specify the repository drive characteristics.
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3. Click Finish.

The context menu after you right-click a consistency group also has following
options: adding or removing member logical drives from a consistency group,
renaming a consistency group, changing auto-delete settings and repository full
policies, and deleting a consistency group. Similar subsystem window menu
options are provided under Copy Services menu in conjunction with the selection
of the consistency group name.

Working with consistency groups
Before you begin, prepare the host operating system. For details, see “Preparing
the host operating system before creating FlashCopy logical drive or Enhanced
FlashCopy image” on page 70.

Figure 25. Consistency Group Settings Window
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After the consistency group is created, you can manually create or set up a
schedule to automatically create the consistency group Enhanced FlashCopy
images.

To create the consistency group Enhanced FlashCopy image manually:
1. In the tree view of the Storage & Copy Services tab, expand the Consistency

Groups node.
2. Right-click the consistency group and from the context menu, select

Consistency Group Enhanced FlashCopy Image > Create. The consistency
group Enhanced FlashCopy image is created.

To set up a schedule to create the consistency group Enhanced FlashCopy image:
1. In the tree view of the Storage & Copy Services tab, expand the Consistency

Groups node.
2. Right-click the consistency group and from the context menu, select

Consistency Group Enhanced FlashCopy Image > Create/Edit Schedule. The
Edit Enhanced FlashCopy Schedule window appears. You can then create, edit,
and enable the schedule. For more information, see “Creating a schedule for a
FlashCopy or an Enhanced FlashCopy logical drive” on page 90.

For a consistency group, you can use the context menu to add or delete member
logical drives, rename the consistency group, delete the consistency group, and
modify the auto-delete setting and policy for full repositories.

These options are also available from the Copy Services menu.
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Chapter 5. Common procedures for FlashCopy and Enhanced
FlashCopy premium features

This chapter describes the procedures that are common to FlashCopy and
Enhanced FlashCopy premium features:
v “Planning a FlashCopy or an Enhanced FlashCopy logical drive”
v “Preparing the host operating system before creating FlashCopy logical drive or

Enhanced FlashCopy image” on page 70
v “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host” on

page 72
v “Configuring the host for the FlashCopy logical drive” on page 77
v “Reusing a FlashCopy or an Enhanced FlashCopy logical drive” on page 84
v “Creating a schedule for a FlashCopy or an Enhanced FlashCopy logical drive”

on page 90

Planning a FlashCopy or an Enhanced FlashCopy logical drive

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

Before you create a FlashCopy logical drive, ensure that you are familiar with the
following concepts, which are described in this section:
v “Specifying FlashCopy or Enhanced FlashCopy repository logical drive settings”
v “Estimating a FlashCopy or an Enhanced FlashCopy repository logical drive

capacity” on page 67
v “Estimating FlashCopy or an Enhanced FlashCopy repository life” on page 69

Specifying FlashCopy or Enhanced FlashCopy repository
logical drive settings

When you create a FlashCopy logical drive or Enhanced FlashCopy group, you
also create and define the parameters of a physical logical drive that is called the
FlashCopy or Enhanced FlashCopy repository logical drive. The repository logical
drive is where FlashCopy data and copy-on-write data are stored.

Because the repository logical drive is normally created with a fraction of the base
logical drive capacity, there are repository logical drive settings that can be
specified to either alert the user when the repository logical drive is getting full or
tell the controllers how to act when the repository logical drive is full. You specify
these settings when you create an Enhanced FlashCopy group or the FlashCopy
Logical Drive.

Read this section before you create a FlashCopy logical drive, so that you have a
better understanding of these settings when you create them initially.

For information about changing the properties of an existing FlashCopy repository
logical drive, see “Changing FlashCopy repository logical drive properties” on
page 31.
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Repository capacity usage threshold warning level
When you create the FlashCopy or Enhanced FlashCopy repository logical drive,
you can also specify its capacity usage threshold warning level. The storage
subsystem controller uses this threshold to send a critical alert when the repository
logical drive usage reaches the threshold level. The default values are 50% of the
repository drive capacity for FlashCopy and 75% for Enhanced FlashCopy. This
threshold level can also be modified at a later time by right-clicking on either the
FlashCopy repository logical drive or the enhanced FlashCopy group and selecting
Manage Settings for FlashCopy or Change Settings for Enhanced FlashCopy.

The threshold warning is the only warning that is given before the FlashCopy
repository logical drive becomes full, so do not ignore it. When you receive the
Threshold Exceeded warning, you can complete one of the following two actions:
v Increase the capacity of the FlashCopy repository logical drive
v Increase the FlashCopy repository logical drive threshold capacity warning level

Important: Increasing the threshold capacity warning level reduces the amount of
time that you have to complete the necessary tasks to prevent the FlashCopy
repository logical drive from becoming full when you receive a Threshold Exceeded
warning.

See “Specifying FlashCopy or Enhanced FlashCopy repository logical drive
settings” on page 65 for information about setting the capacity threshold warning
level for the FlashCopy repository logical drive.

If you are not sure how high to set the threshold warning level, accept the default
setting.

Repository full policy
When you create the repository logical drive, you can specify the action that you
want the system to complete when the repository logical drive reaches its capacity
and is full. The repository full policy is slightly different between the FlashCopy
and Enhance FlashCopy repository logical drive. For the FlashCopy repository
logical drive, you can choose from the following two options:

Fail FlashCopy logical drive
When the FlashCopy repository logical drive becomes full, FlashCopy
logical drive data is not recoverable and the FlashCopy cannot be accessed.
In this case, the only possible action is to delete the FlashCopy logical
drive or re-create the FlashCopy logical drive to create a new point-in-time
image.

This is the default option.

Fail writes to base logical drive
When the FlashCopy repository logical drive becomes full, the FlashCopy
logical drive data is still accessible. However, all write requests to the base
logical drive are rejected until the FlashCopy repository logical drive
capacity is increased.

Attention: The Fail writes to base logical drive option is not
supported on AIX or IBM i. Selecting this option might cause data loss on
the base logical drive. If you are using AIX or IBM i, select the "Fail
FlashCopy logical drive" option, which is the default. Be sure to monitor
the capacity of the FlashCopy repository logical drive, because you cannot
access the FlashCopy if the repository logical drive becomes full.
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For Enhanced FlashCopy, you can specify -

Purge oldest Enhanced FlashCopy images. With this option, the controller
will automatically delete the oldest Enhanced FlashCopy images to make
room for the new Enhanced FlashCopy image.

This is the default option.

Fail writes to base logical drive
When the repository logical drive becomes full, all write requests to the
base logical drive are rejected until the Enhanced FlashCopy repository
logical drive capacity is increased. However, The Enhanced FlashCopy
logical drive data is still accessible.

Attention: The Fail writes to base logical drive option is not
supported on AIX or IBM i. Selecting this option might cause data loss on
the base logical drive. If you are using AIX or IBM i, select the "Fail
Enhanced FlashCopy logical drive" option, which is the default. Be sure to
monitor the capacity of the Enhanced FlashCopy repository logical drive,
because you cannot access the Enhanced FlashCopy if the repository
logical drive becomes full.

For more information about increasing the storage capacity of an existing
FlashCopy repository logical drive, see “Resizing a FlashCopy repository logical
drive” on page 36. In addition, to help manage the space usage in the Enhanced
FlashCopy repository logical drive, you can specify automatic deletion of the oldest
Enhanced FlashCopy image when certain number of the Enhanced FlashCopy
images were taken in a Enhanced FlashCopy group.

Estimating a FlashCopy or an Enhanced FlashCopy repository
logical drive capacity

If numerous I/O requests are written to the base logical drive, the repository
logical drive can eventually exceed the base logical drive capacity if all the original
data blocks are changed.

Note: Different operating systems might deal with data modifications, such as
deleting, replacing, adding only, or deleting only, differently. For example, if you
continuously delete and re-create a 10 MB file, the operating system might use
only new disk blocks each time the file is created which causes the FlashCopy
repository logical drive to become full with the original data. So, instead of
generating the 10 MB worth of data in the FlashCopy repository logical drive, it
might generate data up to the size of the base logical drive in the FlashCopy
repository logical drive.

You can estimate the FlashCopy repository logical drive capacity by calculating the
amount of expected management overhead and the space required for
copy-on-write data.

Note: You must re-estimate the repository logical drive capacity periodically. You
can estimate the FlashCopy repository logical drive capacity by calculating the
following figures:
v The amount of expected management overhead
v The space required for copy-on-write data
v The rate that the FlashCopy repository logical drive is filled up with the

copy-on-write data
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Considerations
The following information can help you to determine the appropriate capacity of
the FlashCopy repository logical drive:
v The minimum capacity of a FlashCopy repository logical drive is 8 MB and

Enhanced FlashCopy is 32MB (+0.5% of the base logical drive capacity).
v The amount of write activity to the base logical drive that takes place after the

FlashCopy logical drive has been created determines the size of a repository
logical drive. As the amount of write activity to the base logical drive increases,
the number of original data blocks that need to be copied from the base logical
drive to the repository logical drive also increases.

v The longer a FlashCopy logical drive remains enabled, the higher the risk of the
repository logical drive reaching its maximum capacity. For more information,
see “Estimating FlashCopy or an Enhanced FlashCopy repository life” on page
69.

v There is not necessarily a one-to-one correlation between the number of data
blocks that change on the base logical drive and the amount of copy-on-write
data that is stored on the FlashCopy or Enhanced FlashCopy repository logical
drive. The controller might copy over a full set of 32 blocks for performance
reasons, even if only one set of blocks has changed. Keep this in mind when
determining the percentage of the capacity of the base logical drive that can be
copied to the repository logical drive. Rollback operation might require the
repository logical drive capacity to be 220% of the base logical drive capacity.

Calculating estimated repository capacity
The following formula can be used merely as a guide. When you estimate the
FlashCopy repository logical drive capacity, keep in mind the information listed in
“Considerations.”

Note: When completing this calculation, you must convert the bytes to kilobytes,
the kilobytes to megabytes, and the megabytes to gigabytes.

Use the following formula to calculate the amount of expected management
overhead:

192 KB + (X / 2000)

where X is the capacity of the base logical drive in bytes.

Then, add this amount to the amount of space that is required for copy-on-write
data. The result is the estimated FlashCopy repository logical drive capacity.

About Enhanced FlashCopy:
The management overhead for Enhanced FlashCopy repository logical drive is
32MB + (0.5% of the base capacity for roll-back processing) + (0.5% of the base
capacity for each Enhanced FlashCopy image taken)

Sample logical drive capacity calculation for Enhanced FlashCopy repository
logical drive:

On a base logical drive of 5GB, 30% of the data blocks on the base logical drive are
expected to change, up to 10 Enhanced FlashCopy images will be taken.
1. Calculate the amount of management overhead:

a. Overhead for 10 Enhanced FlashCopy images: 0.5 % of 10 Enhanced
FlashCopy images of 5 GB each = 0.25 GB
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b. Overhead for roll-back processing: 0.5 % of 5 GB = 0.025 GB
c. Total Management overhead: 32 MB + 25 MB + 250 MB = 307 MB

2. Determine the amount of space (in gigabytes) that is required for copy-on-write
data, using the percentage of the base logical drive that is expected to change
(30%). 30% of 5 GB = 1.5 GB

3. Adding the two 1.5 GB and 0.307 GB is 1.807 GB.

Sample logical drive capacity calculation for FlashCopy repository logical
drive::
On a base logical drive of 5 GB, 30% of the data blocks on the base logical drive
are expected to change.
1. Calculate the amount of management overhead that is required.

a. Convert the capacity of the base logical drive to bytes.
5 GB = 5 368 709 120 bytes

b. Divide the capacity of the base logical drive (in bytes) by 2000.
5 368 709 120 / 2000 = 2 684 354.56 bytes

c. Convert the result from step 1b (in bytes) to kilobytes (KB).
2 684 354.56 bytes = 2621.44 KB

d. Add 192 KB to the results from step 1c.
192 KB + 2621.44 KB = 2813.44 KB

e. Convert the result from step 1d to megabytes (MB), then to gigabytes (GB).
2813.44 KB = 2.75 MB = 0.002686 GB

Result: The amount of required management overhead is 0.002686 GB.
2. Determine the amount of space (in gigabytes) that is required for copy-on-write

data, using the percentage of the base logical drive that is expected to change
(30%).
30% of 5 GB = 1.5 GB

Result: The amount of space that is required for copy-on-write data is 1.5 GB.
3. Add the result from step 2 to the result from step 1e.

1.5 GB + 0.002686 GB = 1.502686 GB

Result: The estimated FlashCopy repository logical drive capacity is 1.502686 GB.

For more information about estimating the FlashCopy repository logical drive
capacity, see "Learn About Estimating FlashCopy Repository Logical Drive
Capacity" in the FlashCopy online help.

Estimating FlashCopy or an Enhanced FlashCopy repository
life

When you initially define the properties of the FlashCopy or Enhanced FlashCopy
repository logical drive, keep in mind the kind of usage that is planned for the
FlashCopy logical drive or the Enhanced FlashCopy logical drive group or images.
Understanding how the FlashCopy logical drive or the Enhanced FlashCopy
logical drive group or images will be used can help you to estimate the life
expectancy of the repository logical drive.

After you have created the FlashCopy or Enhanced FlashCopy repository logical
drive and some usage data is available, you can estimate its life expectancy using
the following procedure as a guide. You can then change the properties of the
FlashCopy or Enhanced FlashCopy repository logical drive, if necessary.
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Note: The life expectancy of a repository logical drive must be reestimated
periodically.
1. In the Subsystem management window, use the appropriate menu function to

retrieve the current capacity usage of the repository drive. Depending on the
controller firmware version, the menu function to display the current repository
logical drive usage differs. Refer to the subsystem management window online
help.

2. Record the creation timestamp day and time. If not available online, use your
records.

3. Record the capacity used (GB) and the available capacity (GB).
4. Determine the elapsed time (t) by subtracting the creation time from the current

time, expressing the elapsed time in either minutes, hours, or days.
5. The total time (Tr) that the repository is available for copy-on-write data can

now be estimated, based on the current usage. Multiply the elapsed time (t) by
the available capacity (Ct), and then divide the resultant number by the
capacity used (Cu).
Use the following formula:
Tr =(t *Ct)/Cu

Where:

Tr Total time available

t Elapsed time

Ct Available capacity

Cu Capacity used

Note: The total time available (Tr) indicates the total usage time for the FlashCopy
repository logical drive.

Using the result of these calculations, you can decide whether to increase the
capacity of the FlashCopy repository logical drive. If the repository capacity
becomes 100% full during the expected lifetime of the FlashCopy, then you must
increase the capacity of the FlashCopy repository logical drive.

For more information, see “Resizing a FlashCopy repository logical drive” on page
36.

Preparing the host operating system before creating FlashCopy logical
drive or Enhanced FlashCopy image

Before you create the FlashCopy logical drive or Enhanced FlashCopy images, you
must prepare the host operating system. Read the following information, then
complete the “Steps for preparing the host operating system” on page 71.

Flushing the operating system cached I/Os to disk

The FlashCopy function provides fast replication of data from the base
logical drive to the target logical drive, and copies all data that has been
successfully written to the storage subsystem by the host. In some
environments, data is stored in server memory cache and written to disk at
some later time. Two examples of these types of environments are:
v Buffers for a database management subsystem (DBMS)
v Metadata for a journaled file system (JFS)
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If buffers from the DBMS or metadata from the journaled file system are
not flushed before a FlashCopy operation copies a base to a target, you
might have to re-create the FlashCopy. In addition, you might also need to
back out of current transactions (for DBMS), or run the fsck utility (for
JFS).

To avoid these types of restart actions, ensure that all of the data that is
related to the FlashCopy source logical drive is written to disk before you
complete the FlashCopy operation. For a DBMS, you can accomplish this
by quiescing the subsystem or with a DBMS command such as DB2® LOG
SUSPEND. For a journaled file system, you can accomplish this by
unmounting the FlashCopy base logical drive.

Stopping I/O to the base logical drive

In the following procedure, “Steps for preparing the host operating
system,” you will need to stop I/O by either stopping the host application
that is accessing the base logical drive, or by placing the application in
backup mode.

If you choose to place the application in backup mode, make sure that the
application recovery files, such as rollback and redo logs, reside in different
physical disk storage or on different logical drives from the FlashCopy
base logical drive. Then, back up the application recovery files.

Note: If the recovery files are on the base logical drive, placing the
application in backup mode will not stop I/O to the base logical drive.

Steps for preparing the host operating system

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

Complete the following steps to prepare the host operating system immediately
before you create a FlashCopy logical drive. If you plan to use the FlashCopy
logical drive at a later date, wait to complete these steps until immediately prior to
creating the FlashCopy.
1. Stop the host application that is accessing the base logical drive, or place the

application in backup mode.

Note: Placing the application in backup mode requires some additional
preparation. For more information, see the "Stopping I/O to the base logical
drive" section of “Preparing the host operating system before creating
FlashCopy logical drive or Enhanced FlashCopy image” on page 70.

2. Synchronize the file system and flush the operating system cached I/Os to
disks by unmounting the base logical drive. For more information, see the
"Flushing the operating system cached I/Os to disk," section of “Preparing the
host operating system before creating FlashCopy logical drive or Enhanced
FlashCopy image” on page 70.

Note: In Microsoft Windows environments, you can use the SMrepassist utility
to flush the operating system cache I/Os, instead of unmounting the base
logical drive. For more information on the SMrepassist utility, see the
"SMrepassist" topic in the Storage Manager online help.

The Microsoft Windows operating system also provides a means for applications to
issue calls to flush I/Os and to make FlashCopy without having to shut down the
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applications. The Microsoft Virtual Disk Service (VDS) and Microsoft Volume
Shadow-copy Service (VSS) are storage management interfaces for Microsoft
Windows. VDS and VSS enable your storage array to easily interact with
third-party applications that use the VDS or VSS Application Programming
Interface (API). Microsoft VDS/VSS is included in the Windows installation. The
Storage Manager VDS hardware provider is a Windows Dynamic Linked Library
(DLL). It is loaded by VDS and used as a communication channel to your storage
array. With the Storage Manager VDS hardware provider installed, third-party
applications can send management commands to your storage array. Creating
logical drives, deleting logical drives, and unmasking logical drives are some the
commands supported. It is also possible for third-party applications to obtain
status and configuration information on the storage array. The Storage Manager
VSS hardware provider is a Windows service (.exe). VSS attaches to the service and
uses it to coordinate the creation of FlashCopy logical drives on the storage array.
VSS-initiated FlashCopy logical drives can be triggered through third-party backup
tools. For information on installing and using Storage Manager VDS/VSS, see the
readme file. See “Finding Storage Manager software, controller firmware, and
readme files” on page xxi to learn how to access the storage subsystem readme
files on the web.

Additional information for hosts that use ADT/AVT: Make sure that the base
logical drive and its associated FlashCopy logical drives are both on the same
controller ownership/preferred path in host operating system environments that
use the automatic logical drive transfer (ADT) feature to failover and failback
logical drives. Otherwise, the base logical drive and its associated FlashCopylogical
drives can move back and forth between controllers, causing logical unit number
(LUN) access problems.

Note: ADT is sometimes also referred to as automatic volume transfer (AVT).

The preferred path can be either Controller A or Controller B, if you ensure that
the base logical drive, FlashCopy logical drive, and FlashCopy repository logical
drive are owned by the same controller, and that the controller owner is configured
as the preferred path from the hosts.

Note: If a path failure causes one of the logical drives to fail over to the other
controller, so that the base and FlashCopy logical drives are no longer on the same
controller, complete one of the following steps:
v Manually move either the base or the FlashCopy logical drive so that both are

on the same controller again.
v Correct the failing path immediately.

After you have prepared the host operating system, you can create a FlashCopy
logical drive using the wizard.

Mapping the FlashCopy or Enhanced FlashCopy logical drive to the
host

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

Use the Mappings view in the SMclient to assign logical drive-to-LUN mappings
between the FlashCopy logical drive and the host that will access the FlashCopy
logical drive.
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Note: Because the FlashCopy logical drive is an exact copy of the original base
logical drive, if you map both a base logical drive and its associated FlashCopy
logical drives to the same host, it can result in conflicts if the host operating
systems or the logical volume manager software depend on the data in the logical
drive to identify it. For more information on how to properly configure your host
operating system, see “Configuring the host for the FlashCopy logical drive” on
page 77.

Complete the following steps to map the FlashCopy logical drive to a host:
1. In the SMclient, open the Mappings view of the Subsystem Management

window, as shown in Figure 26. The newly created FlashCopy logical drive
displays in the undefined mapping section.

2. Right-click the host or host group to which you want to map the drive, click
Define Additional Mapping, or Add LUN Mapping, as shown in Figure 27 on
page 74, depending on the installed configuration firmware version.
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Figure 26. Undefined FlashCopy disk
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3. In the Define Additional Mapping window, specify the following options, as
shown in Figure 28 on page 75.
v Select the host or host group.
v Set the LUN number.
v Select the FlashCopy logical drive.
v Click Add.
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Figure 27. Define Additional Mapping
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When you are finished, the FlashCopy logical drive is available to the host or
host group, as shown in Figure 29 on page 76.

d
s
s
0
0
0
1
2

Figure 28. The Define Additional Mapping window
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In the mapping example shown in Figure 28 on page 75 and Figure 29, the
FlashCopy logical drive named DataVol-1 is made available to the backup
server host group. This enables the backup server to access and mount the
drive as part of its own file system. It also allows a local backup to be
completed by the backup application software.
It is possible to map the FlashCopy logical drive to the same server that owns
the base logical drive. However, immediately after you create the FlashCopy,
the two logical drives are exactly the same (a block-by-block copy). Many
operating systems do not tolerate seeing an exact duplicate logical drive. You
might need to complete other steps, such as restarting your computer or
running the Hot_Add utility, before you can access the FlashCopy logical drive.
For more information about DS Storage Manager V10.77 or earlier, see the IBM
System Storage DS Storage Manager Version 10 Installation and Host Support Guide
for your operating system. For more information about DS Storage Manager
V10.83 or later, see the IBM System Storage DS Storage Manager Version 10.8
Installation and Host Support Guide for your operating system.

Note: If you use this FlashCopy on a regular basis (for example, for backup
purposes), use the Disable FlashCopy and Re-Create FlashCopy options to
reuse the FlashCopy. Using these options preserves the existing mappings to
the FlashCopy logical drive. For more information, see “Disabling a FlashCopy
logical drive” on page 32 and “Recreating a FlashCopy logical drive” on page
34.

After you have mapped the FlashCopy logical drive, configure the host, as
described in “Configuring the host for the FlashCopy logical drive” on page 77.
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Figure 29. Mapped FlashCopy logical disk
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Configuring the host for the FlashCopy logical drive
After you use the Create FlashCopy Logical Drive wizard to create the FlashCopy
logical drive and map the FlashCopy logical drive to the host, you must complete
some additional steps to configure the host operating system.

Complete the procedure that is applicable for your host operating system:
v “Instructions for AIX”
v “Instructions for HP-UX” on page 79
v “Instructions for Solaris” on page 81
v “Instructions for Windows” on page 82
v “Instructions for Novell NetWare” on page 83
v “Instructions for Linux” on page 83

Attention: You must complete the procedure described for your host operating
system in this section. Failure to do so can result in an inaccurate point-in-time
image of the base logical drive.

Using the script editor and the command-line interface
If you are using an AIX, HP-UX, Linux or Solaris host, you must use the script
editor or command line interface (SMcli) to configure your host for the new
FlashCopy logical drive.

You can use the script editor to create or edit a script file, save a script file to the
local disk of the management station, or load a script file from disk. You can also
use SMcli to issue individual commands to the scripting engine from the host
operating system command shell or to call complete pre-written scripts.

For more information about how to use SMcli and the script editor, click the Help
tab on the Enterprise Management window.

Instructions for IBM i
Instructions for using IBM i are provided in the IBM i and IBM System Storage: A
Guide to Implementing External Disks Redbook. To download a copy of this
Redbook, go to http://www.redbooks.ibm.com/abstracts/sg247120.html?Open.

Instructions for AIX

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

Use the following procedures on a host that is running AIX using Logical Volume
Manager (LVM).

Restrictions:

v FlashCopy logical drives can be created only for AIX arrays. If an array has
more than one logical drive, you must create a FlashCopy logical drive for each
logical drive in the array.

v AIX does not support the "Fail writes to base logical drive" option of the
repository full policy. Selecting this option might cause data loss on the base
logical drive. You must make sure that the repository full policy is set to the
default option, "Fail FlashCopy logical drive."
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For information about how to set the repository full policy, see “Changing
FlashCopy repository logical drive properties” on page 31.

Before you begin, complete the following:
v Read the information in “Planning a FlashCopy logical drive” on page 16 and

“Using the script editor and the command-line interface” on page 77.
v Complete the procedures that are described in the previous sections:

1. “Preparing the host operating system before creating FlashCopy logical drive
or Enhanced FlashCopy image” on page 70

2. “Creating a FlashCopy logical drive by using the FlashCopy Logical Drive
wizard” on page 27

3. “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host”
on page 72

To configure the AIX host for the new FlashCopy logical drives, complete the
following steps:
1. Log in to the host as root.
2. Ensure that the host operating system recognizes the FlashCopy logical drives.

At the host prompt, type the following command, and then press Enter.

cfgmgr

Several minutes might pass while the operating system accesses the drives.
When the operation completes, a window opens with the following message:

Device nodes have been updated

The new logical drives are now available from the operating system.
3. At the host prompt, type the following command, and then press Enter.

lspv

A list of the physical drives that are recognized by the operating system
displays.

4. Look for the operating system device name of your FlashCopy logical drive in
the list. The list shows a physical logical drive ID (PVID) for the FlashCopy
logical drive. This is the same as the PVID for the associated base logical
drive, because the FlashCopy logical drive contains the same array data
structures as the base logical drive.

5. Clear the PVID for the FlashCopy logical drives. At the host prompt, type the
following command, and then press Enter.

chdev -l os_device_name -a pv=clear

where os_device_name is the operating system device name of the FlashCopy
logical drive.
Repeat this step for each FlashCopy logical drive in the AIX array.

6. Re-create a new array using the re-createvg command. This command reads
the array data structure inside a logical drive and reconstructs it. It also
allocates new physical logical drive identifiers (PIDs) to the FlashCopy logical
drives and enables access to the FlashCopy logical drive for the selected host.
At the host prompt, type the following command, and then press Enter:

re-createvg -y logical drivegroupname -L /directoryname os_device_name
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where:
v logical drivegroupname is the name that you want to assign to the FlashCopy

array.
v directoryname is the name of the directory where you want to mount the

FlashCopy logical drive.
v os_device_name is the operating system device name of the FlashCopy logical

drive. If your AIX array contains more than one FlashCopy logical drive,
add an os_device_name for each logical drive.

The array is re-created, and contains the FlashCopy logical drive or drives.
7. Mount the FlashCopy logical drive to its intended host. At the host prompt,

type the following command, and then press Enter.

mount mount-point

where mount-point is the name of the file system that is being mounted.
Include the directoryname that was used in step 6 on page 78.

8. Make sure that the logical drives are back online. At the host prompt, type the
following command, and then press Enter.

df -k

A list of the mounted disks displays.
9. Use the FlashCopy logical drive with your backup application or with another

application.
10. When the FlashCopy logical drive is no longer required, unmount the file

system. At the host prompt, type the following command, and then press
Enter.

umount mount-point

11. Disable or delete the FlashCopy logical drive after it is no longer needed.
If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This
takes less time than creating a new FlashCopy logical drive and avoids any
reduction in performance that might occur if the FlashCopy logical drive
remains available.
To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable
or Delete.

12. Delete the array that you created in step 6 on page 78, that contains the
FlashCopy logical drives. At the host prompt, type the following commands,
and then press Enter.

varyoffvg logical drivegroupname exportvg logical drivegroupname

where logical drivegroupname is the name of the FlashCopy array.

Instructions for HP-UX

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.
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Use the following procedures on a host that is running HP-UX 11.0 (or later) and
uses LVM (or later). Failure to complete the steps listed can result in an inaccurate
point-in-time image of the base logical drive.

Before you begin, complete the following:
v Read the information in “Planning a FlashCopy logical drive” on page 16 and

“Using the script editor and the command-line interface” on page 77.
v Complete the procedures that are described in the previous sections:

1. “Preparing the host operating system before creating FlashCopy logical drive
or Enhanced FlashCopy image” on page 70

2. “Creating a FlashCopy logical drive by using the FlashCopy Logical Drive
wizard” on page 27

3. “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host”
on page 72

To configure the HP-UX host for the new FlashCopy logical drives, complete the
following steps:
1. At the host prompt, type the following command, and then press Enter.

ioscan -fn

A list of the mapped devices that are recognized by the host displays.

Note: If the required device names are not displayed with this command, type
the following command at the host prompt, and then press Enter.

insf

2. Remount the base logical drive to its original host.

Note: If I/O activity to the base logical drive was stopped or data transfer was
suspended, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

3. Complete the following steps to import the FlashCopy logical drives into the
LVM:
a. Create a new directory for the new array, as shown in the following

example.

mkdir /dev/vg02

b. Create a group node for the new array, as shown in the following example.

mknod /dev/vg02/group c 64 -0x020000

c. Import the FlashCopy logical drive LUNs. At the host prompt, type the
following command, and then press Enter.

vgimport /dev/vg02 FlashCopy-block-node-1 FlashCopy-block-node-2

The following example addresses how to handle redundancy with multiple
paths. The two paths or nodes represent the primary and alternate paths of
the FlashCopy logical drive.

vgimport /dev/vg02 /dev/dsk/c66t0d1 /dev/dsk/c69t0d1
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Note: You must verify that the /dev/dsk device files exist on the FlashCopy
logical drive. Use the SMdevices utility or the HP-UX ioscan utility to
complete the verification.
The system displays a warning indicating that a backup of the array that is
being imported might not exist on the host. This message is only a warning
and requires no response. The import operation continues and completes
successfully.
The backup for this array is created later, when it is exported.

d. Activate the new array, as shown in the following example:

vgchange -a y /dev/vg02

4. If a file system existed on the base logical drive, then it also exists on the
FlashCopy logical drive. Before you mount the FlashCopy logical drive,
however, complete a file system check to make sure that the file system is
consistent, for example:

fsck /dev/vg02/lvol01

5. Mount the FlashCopy logical drive to its intended host.
6. Use the FlashCopy logical drive with your backup application or with another

application.
7. Unmount the FlashCopy logical drive.
8. Disable or delete the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and avoids any reduction
in performance that might occur if the FlashCopy logical drive remains
available.
To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable
or Delete.

Instructions for Solaris
Use the following procedure on a host that is running Solaris 7 and 8. Failure to
complete the steps listed can result in an inaccurate point-in-time image of the base
logical drive.

Before you begin, complete the following:
v Read the information in “Planning a FlashCopy logical drive” on page 16 and

“Using the script editor and the command-line interface” on page 77.
v Complete the procedures that are described in the previous sections:

1. “Preparing the host operating system before creating FlashCopy logical drive
or Enhanced FlashCopy image” on page 70

2. “Creating a FlashCopy logical drive by using the FlashCopy Logical Drive
wizard” on page 27

3. “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host”
on page 72

To configure your operating system, complete the following steps:
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1. At the host prompt, type the following command, and then press Enter.

/etc/raid/bin/hot_add

This step makes sure that the operating system is aware of the newly-created
logical drives, without having to restart the host.

2. Run the SMdevices utility to associate the LUN with a host operating system
device and to make sure that the FlashCopy logical drive is recognized by the
host.
This step makes sure that the logical drive name and the operating system
device name (assigned by the operating system) correlate.

3. If you plan to use the FlashCopy logical drive immediately, go to step 4. If you
plan to use the FlashCopy logical drive at a later date, disable the FlashCopy
logical drive now. Click Logical Drive → FlashCopy → Disable in the Subsystem
Management window.

Note: If I/O activity to the base logical drive was stopped or data transfer was
suspended, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

4. Mount the FlashCopy logical drive to its intended host.
5. Use the FlashCopy logical drive with your backup application, for speculative

testing, or with another application.
6. Unmount the FlashCopy logical drive.
7. Disable or delete the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.
To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable
or Delete.

Instructions for Windows
You cannot add the FlashCopy logical drive to the same Windows server that the
FlashCopy base logical drive is mapped to. You must add the FlashCopy logical
drive to another Windows server, or unmap the base logical drive from the server
that it is mapped to.

Note: Making a FlashCopy of a Dynamic Disk type of logical drive is not
supported on Windows operating systems.

Complete the following steps to configure your host for the new FlashCopy logical
drives:
1. Run the hot_add utility to let the system recognize the newly-added FlashCopy

logical drive.

Note: If the system does not recognize the FlashCopy logical drive after you
run the hot_add utility, restart the server.

2. In the System Management window, open the Disk Management directory and
assign a drive letter or mount point to the new FlashCopy logical drive.

82 IBM System Storage DS Storage Manager Version 10: Copy Services User's Guide



3. When you no longer need the FlashCopy logical drive, remove the drive letter
or mount point from the Disk Management directory before you delete the
FlashCopy logical drive.

Instructions for Novell NetWare

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

You cannot add the FlashCopy logical drive to the same NetWare server where the
FlashCopy base logical drive is located. You must add the FlashCopy logical drive
to another NetWare server, or unmap the base logical drive from the server that it
is mapped to.

Complete the following steps to configure your host for the new FlashCopy logical
drive:
1. Run the hot_add utility to let the system recognize the newly-added FlashCopy

logical drive.

Note: If the system does not recognize the FlashCopy logical drive after you
run the hot_add utility, restart the server.

2. Type the logical drive in the command window, or use the Disk Management
menu in the ConsoleOne window to verify that the drive is added.

Instructions for Linux
Use the following procedure on a host that is running Linux. Failure to complete
the steps listed can result in an inaccurate point-in-time image of the base logical
drive.

Before you begin, complete the following:
v Read the information in “Planning a FlashCopy logical drive” on page 16 and

“Using the script editor and the command-line interface” on page 77.
v Complete the procedures that are described in the previous sections:

1. “Preparing the host operating system before creating FlashCopy logical drive
or Enhanced FlashCopy image” on page 70

2. For FlashCopy, see “Creating a FlashCopy logical drive by using the
FlashCopy Logical Drive wizard” on page 27. For Enhanced FlashCopy, see
“Creating an Enhanced FlashCopy logical drive” on page 54.

3. “Mapping the FlashCopy or Enhanced FlashCopy logical drive to the host”
on page 72

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

To configure your operating system, complete the following steps:
1. Run the hot_add utility to allow the system to recognize the newly added

FlashCopy logical drive. At the host prompt, type the following command, and
then press Enter:
/usr/sbin/hot_add

Note: The hot_add utility is enabled after loading the Linux RDAC multipath
driver.
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This step makes sure that the operating system is aware of the newly created
logical drives, without having to restart the host.

2. Run the SMdevices utility to associate the LUN with a host operating system
device and to make sure that the FlashCopy logical drive is recognized by the
host.
This step makes sure that the logical drive name and the operating system
device name (assigned by the operating system) correlate.

3. If you plan to use the FlashCopy logical drive immediately, go to step 4. If you
plan to use the FlashCopy logical drive at a later date, disable the FlashCopy
logical drive now. Click Logical Drive → FlashCopy → Disable in the Subsystem
Management window.

Note: If I/O activity to the base logical drive was stopped or data transfer was
suspended, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

4. Mount the FlashCopy logical drive to its intended host.
5. Use the FlashCopy logical drive with your backup application, for speculative

testing, or with another application.
6. Unmount the FlashCopy logical drive.
7. Disable or delete the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.
To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable
or Delete.

Reusing a FlashCopy or an Enhanced FlashCopy logical drive

Note: The following procedures refer to FlashCopy. They are also applicable for
Enhanced FlashCopy.
v “Instructions for AIX”
v “Instructions for HP-UX” on page 86
v “Instructions for Solaris” on page 88
v “Instructions for Windows” on page 88
v “Instructions for Novell NetWare” on page 89
v “Instructions for Linux” on page 89

Instructions for IBM i
Instructions for using IBM i are provided in the IBM i and IBM System Storage: A
Guide to Implementing External Disks Redbook. To download a copy of this
Redbook, go to http://www.redbooks.ibm.com/abstracts/sg247120.html?Open.

Instructions for AIX
Before you begin, stop all I/O activity to the base logical drive, or suspend data
transfer. This makes sure that you capture an accurate point-in-time image of the
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base logical drive. For more information, see “Preparing the host operating system
before creating FlashCopy logical drive or Enhanced FlashCopy image” on page
70.

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

To create a new point-in-time image of the same base logical drive, complete the
following steps:
1. Unmount the file systems in the array on which the FlashCopy logical drive is

to be based. At the host prompt, type the following command, and then press
Enter.

umount mount-point

where mount-point is the name of the file system that is being unmounted.
2. In the Storage Manager Subsystem Management window, re-create the

FlashCopy logical drive. Click Logical Drive → FlashCopy → Re-Create in the
Subsystem Management window.

3. Ensure that the host operating system recognizes the FlashCopy logical drive.
At the host prompt, type the following command, and then press Enter.

cfgmgr

Several minutes might pass while the operating system accesses the drives.
When the operation completes, the host prompt displays again. The new logical
drives are now available from the operating system.

4. Clear the PVID for the FlashCopy logical drives. At the host prompt, type the
following command, and then press Enter.

chdev -l os_device_name -a pv=clear

where os_device_name is the operating system device name of the FlashCopy
logical drive.
Repeat this step for each FlashCopy logical drive in the AIX array.
Attention: Before specifying clear with the chdev command, verify that you
are specifying the correct device name. If you specify a different device name,
all of the data on that device becomes inaccessible. To verify the correct device
name, use the fget config command.

5. Re-create a new array. At the host prompt, type the following command, and
then press Enter:

re-createvg -y logical drivegroupname -L /directoryname os_device_name

where:
v logical drivegroupname is the name that you want to assign to the FlashCopy

array.
v directoryname is the name of the directory where you want to mount the

FlashCopy logical drive.
v os_device_name is the operating system device name of the FlashCopy logical

drive. If your AIX array contains more than one FlashCopy logical drive, add
an os_device_name for each logical drive.

The array is re-created and contains the FlashCopy logical drive or drives.
6. Mount the file system to its intended host. At the host prompt, type the

following command, and then press Enter:
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mount mount-point

where mount-point is the name of the file system that is being mounted. Include
the directoryname that was used in step 5 on page 85.

7. Ensure that the logical drives are back online. At the host prompt, type the
following command, and then press Enter:

df -k

A list of the mounted disks displays.
8. Use the FlashCopy logical drive with your backup application or other

application.
9. Disable the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.

Instructions for HP-UX
Before you begin, stop all I/O activity to the base logical drive, or suspend data
transfer. This makes sure that you capture an accurate point-in-time image of the
base logical drive.

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

To create a new point-in-time image of the same base logical drive, complete the
following steps:
1. Start the storage management software. The Enterprise Management window

opens.
2. Launch a Subsystem Management window using one of the following

methods:
v Select the storage subsystem in either the Device Tree view or from the

Device Table. Then, click Manage Device on the toolbar or click Tools→
Manage Device.

v Right-click the storage subsystem in the Device Tree view or from the
Device Table, and click Manage Device.

v Double-click a storage subsystem node in the Device Table.
v Select the storage subsystem in the Device Tree view or from the Device

Table, and then press Enter.

The Subsystem Management window opens in a separate window.
3. Unmount the base logical drive.
4. In the storage management software, re-create the FlashCopy logical drive.

Click Logical Drive → FlashCopy → Re-Create in the Subsystem Management
window.

5. Remount the base logical drive to its original host.
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Note: If you stopped I/O activity to the base logical drive or suspended a
data transfer, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

6. Complete the following steps to import the FlashCopy logical drives into the
Logical Volume Manager:
a. Create a new directory for the new array, as shown in the following

example.

mkdir /dev/vg02

b. Create a group node for the new array, as shown in the following example.

mknod /dev/vg02/group c 64 -0x020000

c. Import the FlashCopy logical drive LUNs. At the host prompt, type the
following command, and then press Enter.

vgimport /dev/vg02 FlashCopy-block-node-1 FlashCopy-block-node-2 ...

An alternate command can be used, as shown in the following example.

vgimport /dev/vg02 /dev/dsk/c66t0d1 /dev/dsk/c69t0d1

Note: You must verify that the /dev/dsk device files exist on the FlashCopy
logical drive. Use the SMdevices utility or the HP-UX ioscan utility to
complete this verification.
A warning displays indicating that a backup of the array that is being
imported might not exist on the host. This message is only a warning and
can be ignored. The import operation continues and completes successfully.
The backup for this array is created when it is exported later.

d. Activate the new array, as shown in the following example.

vgchange -a y /dev/vg02

7. If a file system existed on the base logical drive, then it also exists on the
FlashCopy logical drive. However, before you mount the FlashCopy logical
drive, complete a file system check to make sure that the file system is
consistent. For example

fsck /dev/vg02/lvol01

8. Mount the FlashCopy logical drive to its intended host.
9. Use the FlashCopy logical drive with your backup application or other

application.
10. Unmount the FlashCopy logical drive.
11. Disable the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This
takes less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.
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Instructions for Solaris

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

To create a new point-in-time image of the same base logical drive, complete the
following steps:
1. Unmount the base logical drive.
2. In the storage management software, re-create the FlashCopy logical drive.

Click Logical Drive → FlashCopy → Re-Create in the Subsystem Management
window.

3. Remount the base logical drive to its original host.
4. Mount the FlashCopy logical drive to its intended host.

Note: If you stopped I/O activity to the base logical drive or suspended data
transfer, resume I/O activity to the base logical drive or re-enable data transfer
at this time.

5. Use the FlashCopy logical drive with your backup application or with another
application.

6. Unmount the FlashCopy logical drive.
7. After the FlashCopy logical drive is no longer needed, disable the FlashCopy

logical drive.
If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.

Instructions for Windows

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

To create a new point-in-time image of the same base logical drive, complete the
following steps:
1. Stop the host application or suspend data transfer.
2. Run SMrepassist -f on the host where the FlashCopy logical drive resides.
3. Disable the FlashCopy logical drive.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.
To disable or delete a FlashCopy logical drive, right-click the icon for that
FlashCopy logical drive in the Subsystem Management window, and select
either Disable or Delete.

4. Run SMrepassist -f on the host where the base logical drive resides.
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5. Re-create the FlashCopylogical drive. For instructions about how to re-create a
FlashCopy logical drive, see “Recreating a FlashCopy logical drive” on page 34.

6. Restart the host application or re-enable data transfer. The FlashCopy logical
drive is ready to use.

7. Disable the FlashCopy logical drive until it is required again.

Instructions for Novell NetWare

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

Complete the following steps to create a new point-in-time image of the same base
logical drive:
1. Stop the host application or suspend data transfer.
2. Unmount the base logical drive.
3. Re-create the FlashCopy logical drive. For instructions about how to re-create a

FlashCopy logical drive, see “Recreating a FlashCopy logical drive” on page 34.
4. Remount the base logical drive.
5. Restart the host application.
6. Remount the FlashCopy logical drive. The FlashCopy logical drive is ready to

use (for backup, speculative test, or upgrades).
7. Unmount the FlashCopy logical drive.
8. Disable the FlashCopy logical drive until it is required again.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.
To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable
or Delete.

Instructions for Linux

Note: This procedure refers to FlashCopy. It is also applicable for Enhanced
FlashCopy.

To create a new point-in-time image of the same base logical drive, complete the
following steps:
1. Unmount the base logical drive.
2. In the storage management software, re-create the FlashCopy logical drive.

Click Logical Drive → FlashCopy → Re-Create in the Subsystem Management
window.

3. Remount the base logical drive to its original host.
4. Mount the FlashCopy logical drive to its intended host.

Note: If you stopped I/O activity to the base logical drive or suspended data
transfer, resume I/O activity to the base logical drive or re-enable data transfer
at this time.
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5. Use the FlashCopy logical drive with your backup application or with another
application.

6. Unmount the FlashCopy logical drive.
7. After the FlashCopy logical drive is no longer needed, disable the FlashCopy

logical drive.
If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.

Creating a schedule for a FlashCopy or an Enhanced FlashCopy
logical drive

Starting with controller firmware version 7.77.xx.xx, you can define a schedule to
automatically re-create FlashCopy logical drives at specific intervals.

To define a schedule, you must specify the following parameters:
v Select days of the week: Select all days of the week or only specific days of the

week
v Number of re-creates a day: Select a value between 1 - 24
v Time between re-creates: Select a value in increments of 0.5 hours, between 0.5 -

12 hours
v Start and end dates of the schedule: Select the start date and time, and the end

date for the schedule.

A schedule can be disabled and enabled again, or modified, as needed.

Important: You must specify the start and end date for the schedule. For a
schedule to be valid, the combination of the start time, the number of re-creates
per day, and the time between re-creates must not result in any re-creates outside a
24-hour time-frame, starting at 00:00. Use the following formula to verify whether
the schedule is valid:

((number of re-creates per day - 1) x (time between re-creates)) + (start
time of the first re-create) < 24

Ensure that you specify the start time in the formula using the 24-hour clock. For
example, for 1:00 PM use 13:00, for 6:00 PM use 18:00.

Consider these examples:
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Table 6. Examples of Scheduling Scenarios.

Scheduling parameters Result of schedule Description

Re-create start time: 1 PM
(13.00 in the 24-hour format)

Number of re-creates: 2

Time between re-creates: 12
hours

This schedule is incorrect
and must be revised.

((2-1) * 12) + 13 = 12 + 13 =
25, which is a value greater
than 24.

Re-create start time: 9.30 AM

Number of re-creates: 2

Time between re-creates: 8
hours

This schedule is correct. ((2-1) * 8) + 9.30 = 8 + 9.30 =
17.30, which is a value less
than 24.
Note: The re-creates will be
performed at 9:30 AM and
5:30 PM.

Re-create start time: 8.00 AM

Number of re-creates: 16

Time between re-creates: 0.5
hours

This schedule is correct. ((16-1) * 0.5) + 8.00 = 7.5 +
8.00 = 15.50, which is a value
less than 24.
Note: The re-creates will be
performed starting at 8:00
AM with 0.5 hour intervals
between re-creates.

Re-create start time: 8.00 AM

Number of re-creates: 5

Time between re-creates: 5
hours

This schedule is incorrect
and needs to be revised.

((5-1) * 5) + 8.00 = 20 + 8.00
= 28, which is a value greater
than 24.

Note: If the specified schedule is incorrect, an error displays in the DS Storage
Manager. Only after entering a valid schedule can you proceed to the next step in
the wizard.
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Chapter 6. Overview of VolumeCopy

VolumeCopy is a premium feature that comes with the Storage Manager software
and is enabled by purchasing a premium feature key. VolumeCopy is used in
conjunction with FlashCopy and, therefore, it can be purchased together with
FlashCopy as a single copy service option, or at a later time as an enhancement to
FlashCopy.

Depending on the version of the DS Storage Manager, the SMclient instructions
and screen captures in this document might be different from the menu paths in
the SMclient software GUI that you are using.

The VolumeCopy feature is a firmware-based mechanism that you use to copy data
from one logical drive (the source logical drive) to another logical drive (the target
logical drive) in a single storage subsystem. The source logical drive and the target
logical drive in a VolumeCopy operation that are located on the same storage
subsystem can also be referred to as a VolumeCopy pair.

Important: If the logical drive that you want to copy is used in a production
environment, the FlashCopy feature must be enabled. A FlashCopy of the logical
drive must be created, and then specified as the VolumeCopy source logical drive,
instead of using the actual logical drive itself. This requirement allows the original
logical drive to continue to be accessible during the VolumeCopy operation.

With VolumeCopy, you can also copy data from arrays that use smaller capacity
drives to arrays that use larger capacity drives, back up data, or restore FlashCopy
logical drive data to the base logical drive. The VolumeCopy feature includes a
Create Copy wizard that you use to create a VolumeCopy operation, and a Copy
Manager that you use to monitor logical drive copies after they have been created.

The VolumeCopy feature is useful for the following tasks:

Copying data for greater access
As your storage requirements for a logical drive change, you can use
VolumeCopy to copy data to a logical drive in an array that uses larger
capacity disk drives within the same storage subsystem. You can move
data to larger drives (for example, 73 GB to 146 GB), change to drives with
a higher data transfer rate (for example, 1 Gbps to 2 Gbps), or change to
drives that use new technologies for higher performance.

Backing up data
With VolumeCopy you can create a backup of a logical drive by copying
data from one logical drive to another logical drive in the same storage
subsystem. You can use the target logical drive as a backup for the source
logical drive, for system testing, or to back up to another device, such as a
tape drive.

Restoring FlashCopy logical drive data to the FlashCopy base logical drive
If you need to restore data to the FlashCopy base logical drive from its
associated FlashCopy logical drive, you can use the VolumeCopy feature to
copy the data from the FlashCopy logical drive to another logical drive
(the VolumeCopy target logical drive) first. Then, copy the data on the
VolumeCopy target logical drive back to the FlashCopy base logical drive.
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For more information about FlashCopy, see Chapter 2, “Overview of
FlashCopy,” on page 15.

Using VolumeCopy with FlashCopy and Enhanced FlashCopy
VolumeCopy is used with FlashCopy or Enhanced FlashCopy. It can be purchased
together with FlashCopy or Enhanced FlashCopy as a single copy service option,
or at a later time as an enhancement to the FlashCopy or Enhanced FlashCopy
premium feature.

Before you create a VolumeCopy, you first create a FlashCopy of the logical drive
that you want to copy by using either the FlashCopy or the Enhanced FlashCopy
functions. During the VolumeCopy operation, use the FlashCopy logical drive as
the source logical drive of the VolumeCopy pair.

Note: A VolumeCopy operation will fail all FlashCopy or Enhanced FlashCopy
logical drives that are associated with the target logical drive, if any exist. You
must disable all FlashCopy or Enhanced FlashCopy logical drives that are
associated with the base logical drive before you can select the base logical drive
as a target logical drive. Otherwise, you cannot use the base logical drive as a
target logical drive.

Using VolumeCopy and thin logical drive

This logical drive is a thin logical drive and is supported with controller firmware
version 7.83.xx.xx or later. A thin logical drive cannot be used as a target of the
VolumeCopy. It can be used only as a source of the VolumeCopy.

For migrating to another storage subsystem, it is recommended that you use the
VolumeCopy feature to make a copy of the existing thin logical drive.

Enabling the VolumeCopy feature
Before you begin, gather the following information:
v Your Feature Activation Code, which is printed on the IBM VolumeCopy

premium feature web activation instructions.
v Your controller unit IBM serial number, machine type, and model number, which

are printed on a black label on the front-left mounting flange of the controller.

Note: To see the mounting flange, you must remove the front bezel.
v The 32 alphanumeric-character feature enable identifier (see “Obtaining the

feature enable identifier using firmware version 6.xx.xx or earlier” on page 7).

To enable VolumeCopy, follow the instructions that are applicable to your
controller firmware version. For details, see “Enabling premium features using
firmware version 6.xx.xx or earlier” on page 7 or “Enabling premium features
using firmware version 7.xx.xx or later” on page 10.

To obtain the storage subsystem feature enable identifier, make sure that your
controller unit and storage expansion enclosures are connected, powered on, and
managed using the SMclient.

For information about how to view a list of those premium features that are
enabled on your storage subsystem, see “Verifying that the premium feature is
enabled using firmware version 6.xx.xx or earlier” on page 8.
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If the VolumeCopy feature is disabled, but VolumeCopy pairs exist, all of the
options in the Copy Manager (stop copy, remove copy pairs, start copy, enable and
disable read-only) will still be available. However, you will not be permitted to
create any new VolumeCopies.

Create Copy wizard
The Create Copy wizard guides you through the VolumeCopy process. The Create
Copy wizard helps you to select a source logical drive from a list of available
logical drives, select a target logical drive from a list of available logical drives,
and set the copy priority for the VolumeCopy operation. When you have
completed the wizard panels, the VolumeCopy operation starts and data is read
from the source logical drive and written to the target logical drive.

Creating a VolumeCopy
The process of creating a VolumeCopy (copying data from the source logical drive
to the target logical drive) is managed by the controllers and is transparent to host
machines and applications. This section describes how you use the storage
management software to copy data with VolumeCopy, and the actions taken by the
controllers during the creation of a VolumeCopy.

The Create Copy wizard guides you through the steps to create a new
VolumeCopy.

Before you begin, create a FlashCopy or an Enhanced FlashCopy of the logical
drive that you want to copy. During the VolumeCopy operation, use the FlashCopy
or Enhanced FlashCopy logical drive as the source logical drive of the
VolumeCopy pair.

For information about how to create a FlashCopy, see “Creating a FlashCopy
logical drive” on page 26. For information about how to create an Enhanced
FlashCopy, see “Creating an Enhanced FlashCopy logical drive” on page 54.

Note: If you are using the Enhanced FlashCopy feature, you must first create the
Enhanced FlashCopy image and then the Enhanced FlashCopy logical drive of that
Enhanced FlashCopy image.

For DS Storage Manager version 10.77 or earlier

To create a VolumeCopy using the Create Copy wizard, complete the following
steps:
1. Stop all I/O activity to the target logical drive.

For more information about what types of logical drives are acceptable for
source and target logical drives, see “Selecting the source logical drive” on page
97 and “Selecting the target logical drive” on page 98.

2. Unmount any file systems on the target logical drive.
3. Select the source logical drive (the FlashCopy that you just created) in the

Logical view of the Subsystem Management window.
4. Click Logical Drive → VolumeCopy → Create.

The Create Copy Wizard - Introduction panel displays.
Select the source logical drive from the list of valid source logical drives on the
storage subsystem.
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Note: If the FlashCopy logical drive that you selected to start the wizard is a
valid source logical drive, it is highlighted in the table.

5. Click Next. The Select Target Logical Drive and Copy Priority panel opens.
6. Select the target logical drive for the VolumeCopy operation and set the copy

priority.
The copy priority determines how much of the resources of the controller are
used to complete the VolumeCopy operation versus to fulfill I/O activity. For
more information about selecting a target logical drive, see “Selecting the target
logical drive” on page 98. For more information about the copy priority, see
“Setting the copy priority” on page 101.
Click Next. The Preview panel opens.

7. Review the source logical drive, the target logical drive and copy priority that
you specified in the previous steps. If all the information is correct, type yes
and click Finish to start the VolumeCopy operation.

Note: For more information about the Preview panel, see “The Preview panel
of the Create Copy wizard” on page 102.

While a VolumeCopy operation has a status of In Progress, Pending, or Failed:
v The source logical drive is available for read I/O activity only.
v The target logical drive is not available for read or write I/O activity.

After the VolumeCopy operation completes:
v The source logical drive is available for both read and write I/O activity.
v The target logical drive is available for read I/O activity, unless the Read-Only

attribute has been disabled. For more information about setting the Read-Only
attribute on the target logical drive, see “Setting the target logical drive
read-only attribute option” on page 114.

For DS Storage Manager version 10.83 or later

To create a VolumeCopy using the Create Copy wizard, complete the following
steps:
1. Stop all I/O activity to the target logical drive.

For more information about what types of logical drives are acceptable for
source and target logical drives, see “Selecting the source logical drive” on page
97 and “Selecting the target logical drive” on page 98.

2. Unmount any file systems on the target logical drive.
3. Select the source logical drive (the FlashCopy that you just created) in the

Logical view of the Subsystem Management window.
4. Click Logical Drive → VolumeCopy → Create.

The Select Copy Type (Create Copy) screen displays.

Note: The logical drive that you select before you clicking the Create menu
option is the source of the VolumeCopy.

5. Select whether you want the source logical drive to be available for any I/O
operations during the copy operation or not.

6. Click Next. The Select Target Logical Drive screen displays.
7. Select the target logical drive for the VolumeCopy operation and click Next.
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8. If you select Online as the copy type in the first screen of the Wizard, then
specify the settings to create the FlashCopy repository logical drive and click
Next. The Confirmation screen displays.

9. Review the source and target logical drive details and specify the copy priority.
If all the information is correct, type yes and click Finish to start the
VolumeCopy operation.
When the copy operation begins, an information message is displayed.

When you have completed the wizard tasks, the VolumeCopy operation starts and
the preferred controller of the source logical drive reads data from the source
logical drive and writes it to the target logical drive. Operation in Progress icons
display on the source logical drive and target logical drive while the VolumeCopy
operation completes.

Important: A maximum of eight VolumeCopy copies can be In Progress at one
time. If you create more than eight VolumeCopy copies, they will have a status of
Pending until one of the VolumeCopies with a status of In Progress completes.

While a VolumeCopy operation is In Progress, the same controller must own both
the source logical drive and target logical drive. If the same controller does not
own both the source logical drive and target logical drive before you begin the
VolumeCopy operation, ownership of the target logical drive is automatically
transferred to the controller owner of the source logical drive.

When the VolumeCopy operation completes or is stopped, ownership of the target
logical drive is restored to its preferred controller. If ownership of the source
logical drive changes during the VolumeCopy operation, ownership of the target
logical drive also changes.

Selecting the source logical drive

Important: This section is applicable only if your controller firmware version is
7.77.xx.xx or earlier.

The first panel of the Create Copy wizard is the Introduction panel. The
Introduction panel defines what a VolumeCopy is and allows you to select a source
logical drive. The table that displays on the Introduction panel contains all the
valid source logical drives on the storage subsystem, including the logical drive
that you selected to start the wizard.

Note: Before you start the VolumeCopy operation, use the FlashCopy feature to
create a FlashCopy of the logical drive that you want to copy, and use it as the
source logical drive of the VolumeCopy pair.

The source logical drive is a FlashCopy logical drive that accepts host I/O requests
and stores application data. When the VolumeCopy operation is started, all data
from the source logical drive is copied to the target logical drive.

The source logical drive is available for read I/O activity only while a
VolumeCopy operation has a status of In Progress, Pending, or Failed. Write
requests are allowed after the VolumeCopy operation is completed.

All valid source logical drives on the storage subsystem are displayed in the list in
the Introduction panel. The logical drive that you selected to start the wizard is
highlighted.
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Note: In addition to the FlashCopy logical drives that are listed in the Introduction
panel, standard logical drives and Remote Mirror primary logical drives are also
displayed. However, do not use standard or Remote Mirror primary logical drives
as source logical drives for a VolumeCopy.

The following logical drives are not valid source logical drives and do not display
on the list:
v A Remote Mirror secondary logical drive
v A Remote Mirror repository logical drive
v A FlashCopy repository logical drive or Enhanced FlashCopy repository logical

drive
v A failed logical drive
v A missing logical drive
v A logical drive that is currently in a modification operation
v A logical drive that is holding a legacy or persistent reservation
v A logical drive that is a source logical drive or target logical drive in another

VolumeCopy operation with a status of In Progress, Failed, or Pending

v An Enhanced FlashCopy logical drive

From the Introduction panel, you can open the View Drives window to view drive,
slot, and capacity of the selected source logical drive. You can use this information
to copy high-access logical drives to different arrays for increased accessibility, or
to copy logical drives to an array that uses larger capacity drives.

Note: After the VolumeCopy operation completes for a VolumeCopy pair, you do
not need to complete any additional processing or synchronization between the
source and the target logical drives. If you recopy, it causes the VolumeCopy to
start copying from the beginning of the source logical drive. Therefore, a source
logical drive can be in as many VolumeCopy pairs as there are eligible target
logical drives in the storage subsystem.

Selecting the target logical drive

Important: The instructions and screen captures provided in this section vary
depending on the version of your controller firmware.

In the Create Copy wizard: Select Target Logical Drive and Copy Priority panel,
you can select the target logical drive for the VolumeCopy and set the copy
priority. For more information about setting the copy priority, see “Setting the copy
priority” on page 101.
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A target logical drive is a standard logical drive in a VolumeCopy logical drive
pair that contains a copy of the data from the source logical drive. Read and write
requests to the target logical drive do not take place while the VolumeCopy
operation has a status of In Progress, Pending, or Failed.

Note: The target logical drive capacity must be equal to or greater than the usable
capacity of the original source logical drive (not the FlashCopy of the original
logical drive).

Important: A VolumeCopy overwrites data on the target logical drive and
automatically makes the target logical drive read-only to hosts.

When a VolumeCopy operation is started, the data from the source logical drive is
written to the target logical drive. However, if the VolumeCopy operation is
stopped, and then restarted by using the Re-Copy option, the data on the source
logical drive might not be the same as the data on the target logical drive. If hosts
are mapped to the source logical drive before the VolumeCopy operation was
restarted, the data that is copied to the target logical drive when you recopy might
change since the previous VolumeCopy was created. So the VolumeCopy operation
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Figure 30. Select Target Logical Drive and Copy Priority panel of the Create Copy wizard
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always copies the image of the source logical drive at the time the copy operation
starts, not a second earlier or a second later.

Important: A VolumeCopy operation overwrites data on the target logical drive
and automatically make the target logical drive read-only to hosts. After the
VolumeCopy operation completes, use the Copy Manager to disable the read-only
attribute for the target logical drive. If you used the target logical drive in a
VolumeCopy operation before, ensure that you no longer need that data or create
its backup. For more information about the read-only attribute, see “Setting the
target logical drive read-only attribute option” on page 114.

All valid target logical drives on the storage subsystem are displayed in the list in
the Select Target Logical Drive window.

The following drives can be used as a target logical drive:
v A standard logical drive
v A Remote Mirror primary logical drive
v A base logical drive of a disabled or failed FlashCopy logical drive. A base

logical drive that has no Enhanced FlashCopy group or images defined can be
used as a VolumeCopy target logical drive.

Note: You must disable all FlashCopy logical drives that are associated with the
base logical drive before you can select it as a target logical drive. Otherwise, the
base logical drive cannot be used as a target logical drive.

The following logical drives are not valid target logical drives and do not display
on the list:
v A Remote Mirror secondary logical drive
v A Remote Mirror repository logical drive
v A FlashCopy or an Enhanced FlashCopy logical drive
v A FlashCopy or an Enhanced FlashCopy repository logical drive
v A base logical drive of an optimal FlashCopy logical drive
v A base logical drive with Enhanced FlashCopy features defined
v A failed logical drive
v A missing logical drive
v A logical drive with a status of Degraded
v A logical drive that is currently in a modification operation
v A logical drive that is holding a legacy or persistent reservation
v A logical drive that is a source logical drive or target logical drive in another

VolumeCopy operation that has a status of In Progress, Failed, or Pending

v A logical drive that is already defined as a target logical drive for another
VolumeCopy pair

v A thin logical drive from a disk pool
v An Enhanced FlashCopy logical drive

A thin logical drive can be used as a source logical drive in a VolumeCopy logical
drive pair. It cannot be used as a target of a VolumeCopy logical drive pair.

You can also create a target logical drive specifically for the VolumeCopy
operation. For more information, see “Creating a Storage Subsystem Logical Drive”
in the Subsystem Management online help.
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Note: After you select or create a target logical drive, give it a unique name so
that it is easily recognizable in the Logical view. For example, if the source logical
drive name is Accounting, name the target logical drive Accounting-Copy. That way
you can quickly identify the source logical drives and target logical drives that are
available on the storage subsystem.

From the Select Target Logical Drive and Copy Priority panel, you can open the
View Drives window to view drive, slot, and capacity of the target logical drive.
You can use this information to copy high-access logical drives to different arrays
for increased accessibility, or to copy logical drives to an array that uses larger
capacity drives.

For more information about source logical drives and target logical drives, see
“Restrictions” on page 109.

Setting the copy priority
In the Select Target Logical Drive and Copy Priority panel you can set the copy
priority for the VolumeCopy operation as shown in Figure 30 on page 99.

Several factors contribute to system performance including the following factors:
v I/O activity

VolumeCopy diverts controller processing resources from I/O activity. The copy
priority defines how much of the system resources are used to complete a
VolumeCopy operation versus fulfill I/O requests.

v The logical drive RAID level
v The logical drive configuration

The number of drives in the array or cache parameters
v The logical drive type

FlashCopy logical drives might take more time to copy than standard logical
drives.

v The source logical drive capacity
All the data in the source logical drive copies to the target logical drive.

v The number of other VolumeCopy operations being performed at the same time
v The hard drive family type
v The number of hard drives that make up the logical drive

You can set the priority of each active VolumeCopy operation in the Create Copy
wizard with respect to other tasks in the storage subsystem. You can use the Copy
Manager to change the copy priority after it is set and you can change the priority
of the VolumeCopy operation while it is actively copying.

The following copy priority rates are available:
v Lowest
v Low
v Medium
v High
v Highest

The Highest priority rate supports the VolumeCopy operation, but I/O activity
might be affected. The Lowest priority rate supports I/O activity, but the
VolumeCopy operation will take longer.

Chapter 6. Overview of VolumeCopy 101



For more information, see “Changing Copy Priority” on the How To tab in the
Subsystem Management window online help.

The Preview panel of the Create Copy wizard
The Preview panel provides an overview of the selected source logical drive, target
logical drive, and copy priority for the VolumeCopy operation as shown in
Figure 31.

You can also return to previous panels to edit the parameters you have chosen.

When you type Yes in the text box and click Finish, the Copy Started window
opens to verify that the VolumeCopy operation has begun.

Note: You can also click Back to change your choices.

You can create a new VolumeCopy operation or exit the wizard. To close the Copy
Started window, you must select one of the following options:
v Yes - Create a new VolumeCopy
v No - Exit the wizard

Icons that show the progress of the operation display on the source logical drive
and target logical drive while the VolumeCopy operation has a status of In
Progress or Pending. For more information about copy status, see “Copy status” on
page 110.

The progress of the VolumeCopy operation displays in the status bar at the
bottom-right of the Copy Manager. The status bar shows the estimated time
remaining for the VolumeCopy operation to complete. You can view the progress
of a VolumeCopy operation in the Copy Manager only when a VolumeCopy
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Figure 31. The Preview panel of the Create Copy wizard
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operation has a status of In Progress. For more information about the Copy
Manager and how to access it, see Chapter 7, “Managing VolumeCopy,” on page
109.

Viewing drives
The View Drives panel displays the drive enclosure, slot, and capacity information
for the selected source logical drive or target logical drive. The View Drives panel
is available in the Create Copy Wizard - Introduction and Create Copy Wizard -
Select Target Logical Drive panels.

Content for this panel will automatically update dynamically if you select a
different source logical drive or target logical drive in the Copy Wizard panel
while the View Drives panel is open.

The information presented in the View Drives panel can be used to copy
high-access logical drives to different logical arrays for increased accessibility, or to
copy logical drives to a logical array that uses drives with a greater capacity.

Accessing the VolumeCopy target logical drive on the host
To access the target logical drive after you have created the VolumeCopy, you must
complete some steps on the host, as described in the following sections:
v “Accessing the VolumeCopy target logical drive on an AIX host”
v “Accessing the VolumeCopy target logical drive on an HP-UX or Solaris host”

on page 105
v “Accessing the VolumeCopy target logical drive on a Windows NT host” on

page 105
v “Accessing the VolumeCopy target logical drive on a Novell NetWare host” on

page 106

Accessing the VolumeCopy target logical drive on an IBM i
host

Instructions for using IBM i are provided in the IBM i and IBM System Storage: A
Guide to Implementing External Disks Redbook. To download a copy of this
Redbook, go to http://www.redbooks.ibm.com/abstracts/sg247120.html?Open.

Accessing the VolumeCopy target logical drive on an AIX host
To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, then mount the target logical drive to a
directory.

Complete the following steps to change the target permissions to Disable
read-only:
1. In the Logical view of the SMclient Subsystem Management window, right-click

the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change → Target Volume Permissions → Disable
read-only.

Complete the following steps to configure the AIX host for the new VolumeCopy
logical drive:
1. Log in to the host as root.
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2. Make sure that the host operating system recognizes the VolumeCopy logical
drive. At the host prompt, type the following command, and then press Enter.

cfgmgr

Several minutes might pass while the operating system accesses the drive.
When the operation completes, the host prompt displays again.The new logical
drive is now available from the operating system.

3. At the host prompt, type the following command, and then press Enter.

lspv

A list of the physical drives that are recognized by the operating system
displays.

4. Look for the operating system device name of your VolumeCopy logical drive
in the list. The list shows a physical logical drive ID (PVID) for the
VolumeCopy logical drive. This is the same as the PVID for the associated base
logical drive, because the VolumeCopy logical drive contains the same array
data structures as the base logical drive.

5. Clear the PVID for the VolumeCopy logical drives. At the host prompt, type the
following command, and then press Enter.

chdev -l os_device_name -a pv=clear

where os_device_name is the operating system device name of the VolumeCopy
logical drive.
Repeat this step for each VolumeCopy logical drive in the AIX array.
Attention: Before specifying clear with the chdev command, verify that you
are specifying the correct device name. If you specify a different device name,
all of the data on that device becomes inaccessible. To verify the correct device
name, use the fget config command.

6. Re-create a new array using the re-createvg command. This command reads the
array data structure inside a logical drive and reconstructs it. It also allocates
new physical logical drive identifiers (PIDs) to the VolumeCopy logical drive
and enables access to the VolumeCopy logical drive for the selected host.
At the host prompt, type the following command, and then press Enter:

re-createvg -y logical drivegroupname -L /directoryname
os_device_name

where:
v logical drivegroupname is the name that you want to assign to the

VolumeCopy array.
v directoryname is the name of the directory where you want to mount the

VolumeCopy logical drive.
v os_device_name is the operating system device name of the VolumeCopy

logical drive. If your AIX array contains more than one VolumeCopy logical
drive, add an os_device_name for each logical drive.

The array is re-created, and contains the VolumeCopy logical drive or drives.
7. Mount the VolumeCopy logical drive to its intended host. At the host prompt,

type the following command, and then press Enter.

mount mount-point

where mount-point is the name of the file system that is being mounted. Include
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the directoryname that was used in step 6 on page 104.
8. Make sure that the logical drives are back online. At the host prompt, type the

following command, and then press Enter.

df -k

A list of the mounted disks displays.

Accessing the VolumeCopy target logical drive on an HP-UX
or Solaris host

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, then mount the target logical drive to a
directory.

Complete the following steps to change the target permissions to Disable
read-only:
1. In the Logical view of the SMclient Subsystem Management window, right-click

the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change → Target Volume Permissions →Disable
read-only.

Next, complete the following steps on your HP-UX or Solaris host to access the
VolumeCopy target logical drive:

Create a directory for the mount point (the target logical drive) in the root
directory. At the command prompt, type the following command:

#mkdir /target_directory

where target_directory is the name of the directory that you want to create.
Mount the target logical drive to the new directory, using the following command:

#mount /target_logical_drive/target_directory /target_directory

where target_logical_drive is the target logical drive for the VolumeCopy, and
target_directory is the name of the directory that you created in step 105.

Accessing the VolumeCopy target logical drive on a Windows
NT host

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, and then mount the target logical drive to a
drive letter or mount point.

Complete the following steps to change the target permissions to Disable
read-only:
1. In the Logical view of the SMclient Subsystem Management window, right-click

the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change → Target Volume Permissions → Disable
read-only.

Complete the following steps to configure your host for the new VolumeCopy
target logical drive:
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1. Run the hot_add utility to let the system recognize the newly added
VolumeCopy target logical drive.

Note: If the system does not recognize the VolumeCopy target logical drive
after you run the hot_add utility, restart the server.

2. Resolve duplicate logical drive signatures by navigating to the following
directory: C:\Program Files\IBM_DS4000\util and typing the following
command in the Windows command line window:

SMrepassist -r

3. In the NT4 Disk Administrator window, assign a drive letter to the new
VolumeCopy target logical drive.

4. When you no longer need the VolumeCopy target logical drive, open the NT4
Disk Management window and remove the drive letter before you delete the
VolumeCopy target logical drive.

Accessing the VolumeCopy target logical drive on a Novell
NetWare host

You cannot map the VolumeCopy target logical drive to the same Novell NetWare
servers that the VolumeCopy source logical drive is mapped to. You must use
another server, or unmap the VolumeCopy source logical drive from the server.

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, and then mount the target logical drive to a
drive letter or mount point.

Complete the following steps to change the target permissions to Disable
read-only:
1. In the Logical view of the SMclient Subsystem Management window, right-click

the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change → Target Volume Permissions → Disable
read-only.

Complete the following steps to configure your host for the new VolumeCopy
target logical drive:
1. Run the hot_add utility to let the system recognize the newly added

VolumeCopy target logical drive.

Note: If the system does not recognize the VolumeCopy target logical drive
after you run the hot_add utility, restart the server.

2. Type the logical drive in the command window, or use the Disk Management
menu in the ConsoleOne window to verify that the drive is added.

SMrepassist utility for Windows
SMrepassist (replication assistance) is a host-based utility for Windows. It must be
used before you create a VolumeCopy on Windows.

Running the SMrepassist utility makes sure that all the memory-resident data for
file systems on the target logical drive are flushed. If you are creating a
VolumeCopy on Windows NT, you also use this utility after you map the
VolumeCopy target logical drive to the same Windows NT server that the
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VolumeCopy source logical drive is mapped to. This resolves the duplicate disk
signatures and system partition table information.

Important: You cannot map the VolumeCopy target logical drive to the same
Windows 2000, Windows Server 2003, or Windows Server 2008 servers that the
VolumeCopy source logical drive is mapped to. You must use another server, or
unmap the VolumeCopy source logical drive from the server.

The command to run this utility is:

SMrepassist -f [filesystem-identifier] | -r [filesystem-identifier]- list

where:
v -f flushes all the memory-resident data for the file system indicated by

[filesystem-identifier]

v [filesystem-identifier] specifies a unique file system in the following syntax:
drive-letter: [mount-point-path]

The file system might include only a drive letter, or a drive letter plus a mount
point

v -r (Windows NT operating system only) resolves any duplicate signatures and
partition table information. You must write a unique boot block signature to
each logical drive that has a duplicate signature. Make sure that the driver
rereads the partition table for the logical drive to avoid a restart of the operating
system.
The -r option by itself causes the utility to find and resolve all FlashCopy
logical drive and VolumeCopies on the storage array having duplicate
signatures. The utility will only modify the signature on a FlashCopy logical
drive or a VolumeCopy, not the base logical drive or standard logical drive, even
where there are more than two logical drives that share a common signature.

An error message is provided in the command line and the logical drives are listed
as a logical drive set when the utility cannot distinguish between the following
logical drives:
v Base logical drive and FlashCopy logical drive (for example, if the FlashCopy

logical drive has been removed)
v Standard logical drive and VolumeCopy (for example, if the VolumeCopy has

been removed)

Locating associated logical drives
The Go To option can be used to quickly jump to an associated source logical drive
or target logical drive displayed in the Logical view of the Subsystem Management
Window.

Important: The Go To option is available only if the VolumeCopy feature has been
enabled, or if VolumeCopy copies currently exist on the storage array. It is not
accessible using the Mappings view of the Subsystem Management Window.

To locate an associated source logical drive or target logical drive, complete the
following steps:
1. Select a source logical drive or target logical drive in the Logical view of the

Subsystem Management window.
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2. Complete one of the following actions, based on the logical drive type that you
have selected:

Source logical drive
Click View → Go To → Source Logical Drive.

The selection jumps to the associated source logical drive in the Logical
view of the Subsystem Management window.

Target logical drive
Click View →Go To →Target Logical Drive.

The selection jumps to the associated target logical drive in the Logical
view of the Subsystem Management window.
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Chapter 7. Managing VolumeCopy

After you create a VolumeCopy with the Create Copy wizard, you can monitor the
VolumeCopy operation through the Copy Manager. You can complete the
following tasks from the Copy Manager:
v Recopy, stop, or remove a VolumeCopy
v Modify the attributes of a logical drive, including the copy priority and the

target logical drive read-only attribute
v View the status of a VolumeCopy operation
v Determine what logical drives are involved in a VolumeCopy operation. You can

also use the Storage Subsystem Profile to determine what logical drives are
involved in a VolumeCopy operation.

Copy Manager displays information for all of the logical drive copies on the
storage subsystem. This information includes the following items:
v The source logical drive
v The target logical drive
v The status of the VolumeCopy operation
v A timestamp for any completed copies
v The VolumeCopy priority assigned to the VolumeCopy

If a target logical drive is read-only to hosts, a lock icon displays in the Target
Logical Drive column.

Complete the following steps to access and use the Copy Manager:
1. Click Select Logical Drive → Copy → Copy Manager.

The Copy Manager window opens.
2. Click the VolumeCopy pair or press Enter to select the VolumeCopy pair in the

table.
3. Select an option from the menu.

Restrictions
The following restrictions apply to the source logical drive, target logical drive, and
the storage subsystem:
v The source logical drive is available for read I/O activity only while a

VolumeCopy operation has a status of In Progress or Pending. Write requests
are allowed after the VolumeCopy operation is completed.
Before you start the VolumeCopy operation, create a FlashCopy of the logical
drive that you want to copy, and then use the FlashCopy as the source logical
drive of the VolumeCopy pair.

v A logical drive can be used as a target logical drive in only one VolumeCopy
operation at a time.

v The maximum number of VolumeCopies that are allowed per storage subsystem
depends on the number of target logical drives that are available on your
storage subsystem.

v A storage subsystem can have up to eight logical drive copies running at any
given time.
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v The target logical drive capacity must be equal to or greater than the source
logical drive capacity.

v The target logical drive capacity must be equal to or greater than the usable
capacity of the original source logical drive.

v A target logical drive can be a standard logical drive, a base logical drive of a
disabled or failed FlashCopy logical drive, or a Remote Mirror primary logical
drive.

Note: You must disable all FlashCopy logical drives that are associated with the
base logical drive before you can select it as a target logical drive. Otherwise, the
base logical drive cannot be used as a target logical drive.

Logical drives that have the following statuses cannot be used as a source logical
drive or target logical drive:
v A logical drive that is reserved by the host
v A logical drive that is in a modification operation
v A logical drive with a status of Failed or Degraded

v A thin logical drive can be used as a source logical drive in a VolumeCopy
logical drive pair. It cannot be used as a target of a VolumeCopy logical drive
pair.

Note: A logical drive can be defined as the source logical drive of multiple
VolumeCopy logical drive pairs even when the status of the VolumeCopy logical
drive pair is In Progress or Failed. After a logical drive is defined as a target
logical drive in a VolumeCopy logical drive pair, it is not available to participate in
any other VolumeCopy logical drive pairs as a target logical drive regardless of the
VolumeCopy logical drive pair status. After a VolumeCopy operation is completed,
the logical drive, which is defined as a target logical drive in a VolumeCopy logical
drive pair, is available to participate in any other VolumeCopy logical drive pairs
as the source logical drive role only.

Copy status
The progress of the VolumeCopy operation displays in the status bar at the
bottom-right of the Copy Manager. The status bar shows the estimated time
remaining for the VolumeCopy operation to complete. You can view the progress
of a VolumeCopy operation in the Copy Manager only when a VolumeCopy
operation has a status of In Progress.

There are three possible copy statuses:

Copy Pending
The Copy Pending status displays in the Copy Manager when a
VolumeCopy operation has been created, but system resources do not
allow it to start. For example, if there are already eight logical drive copies
with a status of In Progress, any subsequent VolumeCopy that you create
will have a status of Pending until one of the other eight logical drive
copies has completed. In addition, a modification operation on another
logical drive in the array might need to complete before the VolumeCopy
operation can begin.

While in the Copy Pending status, the host has read-only access to the
source logical drive, and read and write requests to the target logical drive
do not take place until the VolumeCopy operation has completed.
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Copy In Progress
The Copy In Progress status displays in the Copy Manager while data on
the source logical drive is being read, and then written to the target logical
drive. While in the Copy In Progress status, the host has read-only access
to the source logical drive, and read and write requests to the target logical
drive do not take place until the VolumeCopy operation has completed.

Copy Failed
The Copy Failed status displays in the Copy Manager when an error
occurs while the VolumeCopy is being created. A status of Copy Failed can
occur because of a read error from the source logical drive, a write error to
the target logical drive, or a failure on the storage subsystem that affects
the source logical drive or target logical drive (such as a Remote Mirror
role reversal). A critical event is logged in the Major Event Log (MEL) and
a Needs-Attention icon displays.

While a VolumeCopy operation has the Copy Failed status, the host has
read-only access to the source logical drive, and read and write requests to
the target logical drive will not take place until the failure is fixed.

When a VolumeCopy operation fails, you must use the Stop Copy option
in the Copy Manager to stop the operation and use the Recovery Guru to
fix the problem.

You can use the Re-Copy option to restart the VolumeCopy operation from
the beginning.

Note:

1. If there are eight logical drive copies with a status of In Progress, any
subsequent VolumeCopy operation will have a status of Pending until one of
the eight logical drive copies completes.

2. If a modification operation is running on a source logical drive or target logical
drive, and the VolumeCopy operation has a status of In Progress, Pending, or
Failed, then the VolumeCopy operation will not take place.

3. If a modification operation is running on a source logical drive or target logical
drive after a VolumeCopy has been created, then the modification operation
must complete before the VolumeCopy operation can start. If a VolumeCopy
operation has a status of In Progress, then any modification operation will not
take place.

Viewing VolumeCopy properties

Important: This section is applicable for storage subsystems with controller
firmware versions earlier than 7.xx.xx.xx. For storage subsystems with controller
firmware version 7.xx.xx.xx and later: Click the source or target logical drive in the
tree view of the Logical or the Storage & Copy Service tabs and view the
information about the VolumeCopy operation in the Properties pane.

Use the Logical Drive Properties window, shown in Figure 32 on page 112, to view
the following information about a selected source logical drive or target logical
drive:
v The role of the logical drive: either source or target
v The copy status: Pending, In Progress, Completed, Stopped, Failed
v The copy priority: Lowest, Low, Medium, High, Highest
v The start timestamp: in the format MM/DD/YY HH/MM/SS
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v Completion timestamp: in the format MM/DD/YY HH/MM/SS
v The read-only attribute: Enabled or Disabled (only if a target logical drive is

selected)
v Source or target logical drive ID: WWN
v Source or target logical drive name
v The online or offline status for subsystems that support online and offline

VolumeCopy operations

Note: You can only view the progress of a VolumeCopy operation with a status of
In Progress.

Complete the following steps to view the VolumeCopy properties:
1. Select the source logical drive or target logical drive in the Logical view.
2. Click Logical Drive → Properties.

The Logical Drive Properties window opens.
3. Click the Copying tab.

The Copy Properties tab displays.
If a source logical drive has multiple target logical drives, then the details will
be repeated for each target logical drive.

4. Click Close to close the window.
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Figure 32. The Logical Drive Properties window
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Changing copy priorities
You can change the copy priority to balance I/O activity with VolumeCopy
operation activity on a storage subsystem. You can set the copy priority to a rate
that will have the least impact on I/O activity. There are five copy priority rates
available: lowest, low, medium, high, and highest. If the copy priority is set at the
lowest rate, I/O activity is prioritized and the VolumeCopy operation will take
longer. If the copy priority is set to the highest priority rate, the VolumeCopy
operation is prioritized, but I/O activity for the storage subsystem might be
affected.

You can change the copy priority for a VolumeCopy pair before the VolumeCopy
operation begins, while the VolumeCopy operation has a status of In Progress, or
after the VolumeCopy operation has completed (for a recopy). Complete the
following steps to change the copy priority:
1. For DS Storage Manager version 10.77 or earlier, click Select Logical Drive →

Copy → Copy Manager. The Copy Manager window opens as shown in
Figure 33.

For DS Storage Manager version 10.83 or later, click Copy services >
VolumeCopy > Manage Copies. The Copy Manager window opens.
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Figure 33. Copy Manager window

Chapter 7. Managing VolumeCopy 113



2. Select one or more VolumeCopy pairs in the table. You can select more than
one VolumeCopy pair by pressing Ctrl and the left mouse button.

3. Click Change → Copy Priority.
The Change Copy Priority window opens.

4. In the Copy Priority field, use the slider bar to select the appropriate copy
priority, depending on your system performance needs.
For more information about the copy priority, see “Setting the copy priority” on
page 101.

5. Click OK.
The Change Copy Priority - Progress window opens.

6. Click OK.
The copy priority for the selected VolumeCopy pair is changed.

Setting the target logical drive read-only attribute option
The target logical drive read-only attribute determines how read and write requests
to the target logical drive are handled after a VolumeCopy operation is complete or
if the VolumeCopy operation fails before it completes. After the VolumeCopy
operation has completed, the target logical drive automatically becomes read-only
to hosts, and write requests to the target logical drive do not take place. You might
want to keep this attribute enabled in order to preserve the data on the target
logical drive. The following situations are examples of when you might want to
keep the read-only attribute enabled:
v If you are using the target logical drive for backup purposes
v If you are copying data from one array to a larger array for greater accessibility
v If you are using the data on the target logical drive to copy back to the base

logical drive of a disabled or failed FlashCopy logical drive

If you decide not to preserve the data on the target logical drive after the
VolumeCopy operation is completed, use the Copy Manager to disable the
read-only attribute for the target logical drive.

Complete the following steps to enable the read-only attribute:
1. For DS Storage Manager version 10.77 or earlier, click Select Logical Drive →

Copy → Copy Manager.

Figure 34. Copy Manager window
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For DS Storage Manager version 10.83 or later, click Copy services >
VolumeCopy > Manage Copies.
The Copy Manager window opens.

2. Select one or more VolumeCopy pairs in the table. You can select more than
one copy pair by pressing Ctrl and the left mouse button.

3. Click Change → Target Logical Drive Permissions → Enable Read-Only.
The read-only attribute is enabled on the target logical drive. Write requests to
the target logical drive are rejected.

Complete the following steps to disable the read-only attribute:
1. Click Select Logical Drive → Copy → Copy Manager.

The Copy Manager window opens.
2. Select one or more VolumeCopy pairs in the table. You can select more than

one VolumeCopy pair by pressing Ctrl and the left mouse button.
3. Click Change → Target Logical Drive Permissions → Disable Read-Only.

The read-only attribute is disabled on the target logical drive. Write requests to
the target logical drive are permitted.

When the read-only attribute for a target logical drive is enabled, a lock icon
displays in the Target Logical Drive column of the Copy Manager. The read-only
attribute can be changed in the Copy Manager only after the VolumeCopy
operation completes.

Recopying the source logical drive in a VolumeCopy pair
When you recopy the source logical drive in a VolumeCopy Pair, you create a new
copy of the source logical drive data on an associated target logical drive. You can
use Re-Copy to create a new copy from the beginning if the original VolumeCopy
operation fails, was stopped, or has completed. You can also use Re-Copy for
backup purposes; for instance, if the data on the source logical drive changes, you
can use Re-Copy to duplicate any new data to the target logical drive.

Attention: Recopying overwrites existing data on the target logical drive and
makes the target logical drive read-only to hosts until you disable the read-only
attribute in the Copy Manager.

Important: Note the following points before you recopy logical drives:
v If hosts have been mapped to the source logical drive, the data that is recopied

to the target logical drive might have changed since the previous VolumeCopy
was created.

v To use Re-Copy, select only one VolumeCopy in the Copy Manager.
v See “Selecting the source logical drive” on page 97 and “Selecting the target

logical drive” on page 98 for information about what types of logical drives you
can use as source and target logical drives.

Complete the following steps to create a new VolumeCopy of the data on a
selected VolumeCopy pair:
1. Stop all I/O operations to the source logical drive and target logical drive.
2. Unmount any file systems on the source logical drive and target logical drive.
3. For DS Storage Manager version 10.77 or earlier, click Select Logical Drive →

Copy → Copy Manager.
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For DS Storage Manager version 10.83 or later, click Copy services >
VolumeCopy > Manage Copies.
The Copy Manager window opens.

4. Click the VolumeCopy pair or press Enter to select the VolumeCopy pair in the
table.

5. Click Copy → Re-Copy.
The Re-Copy window opens.

6. Set the copy priority.
See “Setting the copy priority” on page 101 for more information.

7. Type Yes and click OK.
The VolumeCopy operation begins.

Note: You can view the progress of a VolumeCopy operation in the Copy
Manager only when a VolumeCopy operation has a status of In Progress.

Stopping a VolumeCopy operation
You can stop a VolumeCopy operation with a status of Pending, In Progress, or
Failed. If you decide not to use a particular logical drive as a source logical drive
or target logical drive, you can stop the VolumeCopy operation before it completes.
Then after you delete the VolumeCopy pair definition, the logical drives can be
used in a new VolumeCopy pair.

Note: If you stop a VolumeCopy operation with a status of Failed, the
Needs-Attention condition on a storage subsystem is cleared.

Important: Note the following points before you stop a VolumeCopy operation:
v If the copying process was stopped prematurely, there is no guarantee that the

target logical drive will be in a usable state.
v Select only one copy pair in the Copy Manager.
v When the VolumeCopy operation is stopped, all mapped hosts will have write

access to the source logical drive. If data is written to the source logical drive,
the data on the target logical drive will no longer match the data on the source
logical drive.

Complete the following steps to stop a VolumeCopy operation:
1. For DS Storage Manager version 10.77 or earlier, click Select Logical Drive →

Copy → Copy Manager.
For DS Storage Manager version 10.83 or later, click Copy services >
VolumeCopy > Manage Copies.
The Copy Manager window opens.

2. Click the VolumeCopy pair or press Enter to select the VolumeCopy pair in the
table.

3. Click Copy → Stop.
The Stop Copy window opens.

4. Click Yes.
The VolumeCopy operation stops.

116 IBM System Storage DS Storage Manager Version 10: Copy Services User's Guide



Removing copy pairs
You can remove one or more VolumeCopies from the Copy Manager. Any
VolumeCopy copy-related information for the source and target logical drive is
removed from the Logical Drive Properties and Storage Subsystem Profile
windows. After you remove the VolumeCopy, you can use the source logical drive
and target logical drive in a new VolumeCopy. When you remove the VolumeCopy,
the read-only attribute for the target logical drive is also removed.

After the VolumeCopy is removed from the Copy Manager, you can select the
target logical drive as a source logical drive or target logical drive for a new
VolumeCopy.

If you remove a VolumeCopy, the source logical drive and target logical drive are
no longer displayed in the Copy Manager.

Important: Note the following points before you remove VolumeCopy pairs:
v This action does not delete the data on the source logical drive or target logical

drive.
v If the VolumeCopy operation has a status of In Progress, it must be stopped

before you can remove the VolumeCopy pair from the Copy Manager.

Complete the following steps to remove VolumeCopy pairs from the Copy
Manager:
1. For DS Storage Manager version 10.77 or earlier, click Select Logical Drive →

Copy → Copy Manager.
For DS Storage Manager version 10.83 or later, click Copy services >
VolumeCopy > Manage Copies.
The Copy Manager window opens.

2. Select one or more VolumeCopy pairs in the table. You can select more than
one VolumeCopy pair by pressing Ctrl and using the left mouse button to
select multiple VolumeCopy pairs.

3. Click Copy → Remove Copy Pairs.
The Remove Copy Pairs window opens.

4. Click Yes to confirm that you want to continue with the VolumeCopy pair
removal.
The VolumeCopy pair is removed.

VolumeCopy and other premium features
This section describes how VolumeCopy can be used with other premium features
that are available with Storage Manager. This section covers Storage Partitioning,
FlashCopy, and the Remote Mirroring Option premium features. Although Storage
Partitioning is not covered in this guide, it is a premium feature that is offered
with Storage Manager. For more information about Storage Partitioning, see your
operating system installation and user's guide or see the Storage Manager online
help.

Storage Partitioning and VolumeCopy

Note: Storage Partitioning is not a copy services premium feature. This guide does
not describe how to enable and use the storage partitioning feature. For more

Chapter 7. Managing VolumeCopy 117



information about Storage Partitioning, see the IBM System Storage DS Storage
Manager Version 10 Installation and Support Guide for your operating system.

Storage Partitioning is a feature that enables hosts to share access to logical drives
in a storage subsystem. A storage partition is created when you define a collection
of hosts (a host group) or a single host, and then define a logical drive-to-LUN
mapping.

This mapping allows you to define what host group or host will have access to a
particular logical drive in the storage subsystem.

After a VolumeCopy has been created, the target logical drive automatically
becomes read-only to hosts to make sure that the data is preserved. Hosts that
have been mapped to a target logical drive do not have write access to the logical
drive, and any attempt to write to the read-only target logical drive results in a
host I/O error.

If you want hosts to have write access to the data on the target logical drive, use
the Copy Manager to disable the read-only attribute for the target logical drive. For
more information about changing the target logical drive read-only attribute, see
“Setting the target logical drive read-only attribute option” on page 114.

FlashCopy, Enhanced FlashCopy, and VolumeCopy
A FlashCopy or Enhanced FlashCopy logical drive is a point-in-time image of a
standard or base logical drive and is typically created so that an application, such
as a backup application, can access the FlashCopy logical drive and read the data
while the base logical drive remains online and accessible to hosts.

Always use a FlashCopy or an Enhanced FlashCopy logical drive as the source
logical drive for a VolumeCopy. The Enhanced FlashCopy images cannot be the
source or target of a VolumeCopy pair. To create a VolumeCopy of the Enhanced
FlashCopy image, you must create an Enhanced FlashCopy logical drive of the
Enhanced FlashCopy image first and then select it as the source logical drive. The
Enhanced FlashCopy logical drive of the Enhanced FlashCopy image cannot be the
target logical drive in a VolumeCopy pair.

Important: If you choose the base logical drive of a FlashCopy logical drive as
your target logical drive, you must disable all FlashCopy logical drives that are
associated with the base logical drive before you can select it as a target logical
drive.

When you create a FlashCopy logical drive, a FlashCopy repository logical drive is
automatically created. The FlashCopy repository logical drive stores information
about the data that has changed since the FlashCopy logical drive was created.
FlashCopy repository logical drives cannot be selected as source logical drives or
target logical drives in a VolumeCopy pair.

FlashCopy can be used with VolumeCopy to back up data on the same storage
array, and to restore the data on the FlashCopy logical drive back to its original
base logical drive.

You can perform an online VolumeCopy operation.

118 IBM System Storage DS Storage Manager Version 10: Copy Services User's Guide



The Remote Mirror Option and VolumeCopy
The Remote Mirror Option is used for online, real-time replication of data between
storage subsystems over a remote distance. In the event of a disaster or a
catastrophic failure of one storage subsystem, you can promote a second storage
subsystem to take over responsibility for computing services.

When you create a remote mirror, a mirrored logical drive pair is created,
consisting of a primary logical drive at the primary storage subsystem and a
secondary logical drive at a secondary, remotely located storage subsystem. The
mirroring process and I/O completion notification to the host is different,
depending on whether the write mode selected is synchronous or asynchronous.
The description below is for mirroring with Metro Mirror selected. See “Metro
Mirroring” on page 133 and “Asynchronous write mode (Global Copy and Global
Mirroring)” on page 134 for more information on the differences between the two
modes.

The primary logical drive is the logical drive that accepts host I/O and stores data.
When the mirror relationship is initially created, data from the primary logical
drive is copied in its entirety to the secondary logical drive. This process is known
as a full take synchronization and is directed by the controller owner of the
primary logical drive. During a full synchronization, the primary logical drive
remains fully accessible for all normal I/O activity.

The controller owner of the primary logical drive initiates remote writes to the
secondary logical drive to keep the data on the two logical drives synchronized.
Whenever the data on the primary logical drive and the secondary logical drive
becomes unsynchronized, the controller owner of the primary logical drive initiates
a full synchronization.

The secondary logical drive maintains a mirror of the data on its associated
primary logical drive. The controller owner of the secondary logical drive receives
remote writes from the primary logical drive controller owner. It will accept host
read requests, but all host write requests will be blocked by the controller.

Note: The Host OS file I/O caching might briefly give the impression that one can
write to the secondary logical drive. However, these attempted writes will be
rejected when the Host OS tries to flush them from server cache memory to the
logical drive.

The secondary logical drive remains unavailable (except for read requests in
servers that can mount the secondary logical drive as read-only) to host
applications while mirroring is in progress. In the event of a disaster or
catastrophic failure at the primary site, you can complete a role reversal to promote
the secondary logical drive to a primary role. Hosts are then able to access the
newly promoted logical drive and business operations can continue.

A primary logical drive in a remote mirror relationship can be selected as the
source logical drive for a VolumeCopy. However, a secondary logical drive in a
remote mirror relationship cannot be selected as a source logical drive or target
logical drive and is not available in the Create Copy wizard when you create a
VolumeCopy. If a copy of a secondary logical drive is required, you can complete a
role reversal to change the secondary logical drive to a primary logical drive. For
more information about remote mirror role reversals, see “Role reversals” on page
146.
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Note: Another method you can use to produce a copy of the secondary logical
drive is to create a FlashCopy of the secondary logical drive, then create a
VolumeCopy of the FlashCopy logical drive. This method eliminates the need to
complete a role reversal on the secondary logical drive.

If a primary logical drive in a remote mirror is selected as the source logical drive
for a VolumeCopy, any VolumeCopies that have a status of In Progress or Pending
when a role reversal takes place fail, and cannot be started again until the primary
logical drive is demoted back to its original remote mirror secondary logical drive
role.

For more information about the Remote Mirror Option, see Chapter 9, “Overview
of the Enhanced Remote Mirroring Option,” on page 127 or the Subsystem
Management window online help.
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Chapter 8. Troubleshooting VolumeCopy

This chapter provides information about troubleshooting some of the more
common problems encountered when you use the VolumeCopy feature. The
troubleshooting topics that are included are general VolumeCopy problems and
premium feature troubleshooting topics. Locate the section that is directly related
to your problem, or consult the section that describes general troubleshooting
techniques. If your problem is not discussed in any of the sections in this chapter,
contact technical support.

General troubleshooting
Table 7 describes some of the typical problems you might encounter when you use
the VolumeCopy feature. The information in this section is presented in sequence,
from the time the feature is enabled to problems that you might encounter when
you use the VolumeCopy feature.

Information about the probable cause and suggested resolution for each problem
are provided. If your problem is not addressed in this chapter, contact technical
support.

Table 7. General troubleshooting for the VolumeCopy feature

Problem Cause Resolution

The VolumeCopy menu options in
the Subsystem Management window
are not available.

The VolumeCopy feature is not
enabled.

Enable the VolumeCopy feature. You
must use a Feature Key File to enable
premium features. If one has not
been supplied, contact your storage
supplier.

For step-by-step instructions about
enabling the VolumeCopy feature, see
“Enabling the VolumeCopy feature”
on page 94 or the Subsystem
Management Window online help.

The VolumeCopy icon in the
premium status area is marked with
a red line and is not available.

The VolumeCopy feature is not
enabled.

Enable the VolumeCopy feature. You
must use a Feature Key File to enable
premium features. If one has not
been supplied, contact your storage
supplier.

For step-by-step instructions about
enabling the VolumeCopy feature, see
“Enabling the VolumeCopy feature”
on page 94 or the Subsystem
Management Window online help.
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Table 7. General troubleshooting for the VolumeCopy feature (continued)

Problem Cause Resolution

The wizard failed to start an online
VolumeCopy operation.

The FlashCopy premium feature or
the Enhanced FlashCopy premium
feature is not enabled or the feature
is enabled but the FlashCopy usage
has reached the maximum limit for
that storage subsystem.

Enable the FlashCopy or Enhanced
FlashCopy premium feature, if it is
disabled. Delete the existing
FlashCopy logical drives. If the
storage subsystem has both
FlashCopy and Enhanced FlashCopy
premium features enabled, then the
wizard uses the Enhanced FlashCopy
logical drives. Hence, delete the
Enhanced FlashCopy images to
reduce the number of FlashCopies
that are used in the subsystem.

The Create Copy option is not
available after selecting a source
logical drive in the Logical view.

The logical drive that you have
chosen to be the source logical drive
for the VolumeCopy is not a valid
source logical drive.

See “Selecting the source logical
drive” on page 97 for more
informations on source logical drives.

Select a valid source logical drive,
which can be one of the following:

v A standard logical drive

v A FlashCopy logical drive

v A base logical drive of a
FlashCopy logical drive

v A primary logical drive that is
participating in a Remote Mirror

The source logical drive or target
logical drive displays as being a
missing logical drive.

A physical drive on which the
VolumeCopy depends (such as a
source logical drive or target logical
drive) has been removed, and the
logical drive is now displayed under
the Missing Logical Drive node in the
Logical view of the Subsystem
Management window.

If logical drives are missing because
of a power loss to the drive
enclosures or because drives have
accidentally been removed, you can
recover these logical drive by
completing the following steps:

1. Reinsert the drives into the drive
enclosure.

2. Make sure that the power
supplies for the drive enclosure
are properly connected to an
operating power source and have
an Optimal status.

Important: Deleting a missing logical
drive is a permanent action. Any
associated logical drives or logical
drive-to-LUN mappings will also be
deleted.

For more information about
troubleshooting missing logical
drives, use the Recovery Guru or
contact technical support. If the
missing logical drive is no longer
required, it can be deleted.
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Table 7. General troubleshooting for the VolumeCopy feature (continued)

Problem Cause Resolution

The controller owner for the source
logical drive or target logical drive
changes after the VolumeCopy
operation has completed.

When the VolumeCopy operation
started, the preferred controller did
not have ownership of both the
source logical drive and target logical
drive.

During a VolumeCopy operation, the
same controller must own both the
source logical drive and the target
logical drive. If both logical drives do
not have the same preferred
controller when the VolumeCopy
operation starts, the ownership of the
target logical drive automatically
transfers to the preferred controller of
the source logical drive.

When the VolumeCopy operation
completes or is stopped, ownership
of the target logical drive is restored
to its preferred controller. If
ownership of the source logical drive
changes during the VolumeCopy
operation, ownership of the target
logical drive also changes.

A VolumeCopy that includes a source
logical drive that is participating in a
remote mirror has a status of In
Progress, Pending, or Completed, but
has failed.

In response to a catastrophic failure
at the primary storage subsystem, a
role reversal has occurred. The
secondary logical drive in the
mirrored pair was promoted to the
primary logical drive role, while the
primary logical drive was demoted to
the secondary logical drive role.

After the preferred controller of the
primary logical drive can be
contacted, a role reversal will
automatically take place and you can
then restart the VolumeCopy
operation.

For more information about role
reversals, see “Role reversals” on
page 146.
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Table 7. General troubleshooting for the VolumeCopy feature (continued)

Problem Cause Resolution

The error message indicates that the
VolumeCopy feature is out of
compliance.

The VolumeCopy feature is out of
compliance.

This normally occurs if an array with
existing VolumeCopies has been
moved into a storage subsystem
where the feature is not authorized,
or if you have disabled the feature on
a storage subsystem where the
feature is authorized, and you have
existing VolumeCopies present.

v If the VolumeCopy feature is not
authorized for this storage
subsystem and you want to
authorize it, or the VolumeCopy
feature is authorized for this
storage subsystem but you have
disabled it, complete the following
steps to clear the error:

1. Obtain a new Feature Key File
for this feature, or retrieve the
existing Feature Enable
Identifier by clicking Storage
Subsystem → Premium
Features → List in the
Subsystem Management
window.

2. Enable the VolumeCopy
feature. For step-by-step
instructions, see “Enabling the
VolumeCopy feature” on page
94 or the Subsystem
Management window online
help.

v If the VolumeCopy feature is not
authorized for this storage
subsystem and you do not want to
authorize it, disable the
VolumeCopy feature by clicking
Storage Subsystem → Premium
Features → Disable in the
Subsystem Management window.

For more information about disabling
premium features, see to the
Subsystem Management window
online help.
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Table 7. General troubleshooting for the VolumeCopy feature (continued)

Problem Cause Resolution

The error message indicates that the
selected source logical drive has a
reservation placed on it.

Logical drives that are configured
with a legacy or persistent
reservation cannot be selected as a
source logical drive or a target logical
drive for a VolumeCopy.

Clear the reservation for the selected
logical drive, and then re-create the
VolumeCopy.

1. Click Advanced → Persistent
Reservations to open the
Persistent Reservations window.

Make sure that the View
Associated Registrations check
box is deselected in the upper left
corner of the Persistent
Reservations window.

2. clicke or more desired logical
drives. To select all logical drives,
click Select All. The selected
logical drives or all logical drives
are highlighted, depending on
your selection.

3. Click Clear.

The Clear Registrations/
Reservations window opens.

4. Type Yes in the confirmation field.

The OK button is enabled.

5. Click OK, or click Cancel to
return to the main Persistent
Reservations window without
clearing any reservations.

The reservations and registrations
that are associated with the logical
drives that you highlighted in the
upper pane are cleared.

VolumeCopy critical events
Critical major event Log (MEL) events are generated when an error occurs that can
affect data availability or that results in a degraded mode of operation. The storage
management software responds by alerting the appropriate administrators by
email, SNMP trap, or other configured mechanisms.

Because administrative action is required to correct the problem, the storage
subsystem generally enters a Needs Attention status. Therefore, the appropriate
indications are presented through the storage management software and an
associated Recovery Guru procedure displays when requested.

Table 8 on page 126 provides a description of critical MEL events, with a brief
explanation of what caused the event, and the event resolution. If your critical
MEL event is not included in this section, contact technical support.
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Table 8. VolumeCopy critical events

Problem Cause Resolution

Event 6600 - VolumeCopy Operation
Failed

This event is logged when a
VolumeCopy with a status of In
Progress or Pending fails. A Needs
Attention status is also reported for
the storage subsystem.

This failure can be caused by a read
error on the source logical drive, a
write error on the target logical drive,
or because of a failure that occurred
on the storage subsystem that affects
the source logical drive or target
logical drive.

For specific recovery procedures, see
the Recovery Guru.
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Chapter 9. Overview of the Enhanced Remote Mirroring
Option

The Enhanced Remote Mirroring is supported with controller firmware 06.xx.xx.xx
or later. The supported storage subsystems are:
v The DS3500 with firmware version 07.70.xx.xx or later
v The DCS3700 with firmware 07.77.xx.xx or later
v The DCS3700 storage subsystem with Performance Module Controllers with

firmware version 07.83.xx.xx or later
v The DS4100 standard option with firmware version 06.12.xx.xx or later
v The DS4300 with Turbo option, DS3950, DS4200, DS4400, DS4500, DS4700,

DS4800, DS5020, DS5100, and DS5300 versions.

The maximum number of mirror pairs is 32 for the DS4100 standard dual
controller model and DS4300 Turbo models. The maximum number of mirror pairs
is 16 for the DS3500, DCS3700, and DCS3700 storage subsystem with Performance
Module Controllers; 64 for the DS3950, DS4200, DS4400, DS4500, DS4700, and
DS5020; and 128 for the DS4800, DS5100, and DS5300 models.

Enhanced Remote Mirroring Implementation Requirement
v The Bandwidth Estimator Tool is required to architect an Enhanced Remote

Mirroring solution. To acquire the Bandwidth Estimator Tool, please contact your
IBM Marketing representative or IBM Business Partner.

v In addition, have an IBM SAR (Solutions Assurance Review) performed on your
Enhanced Remote Mirroring solution, before implementation.

v In certain conditions and environments, Enhanced Remote Mirroring has been
shown to support link speeds as low as 2 Mbps.

Note: Link speeds as low as 2 Mbps are not supported in every environment.

Basic concepts of the Enhanced Remote Mirroring Option
The Remote Mirror Option is a premium feature that comes with the Storage
Manager software and is enabled by purchasing a premium feature key. The
Remote Mirror Option is used for online, real-time replication of data between
storage subsystems over a remote distance. In the event of a disaster or
unrecoverable error at one storage subsystem, the Remote Mirror Option enables
you to promote a second storage subsystem to take over responsibility for normal
I/O operations.

Remote Mirroring supports only 10 km maximum distance synchronous (metro
mirroring) Remote Mirroring pairs. Remote Mirroring is supported with controller
firmware versions 05.20.xx.xx (DS4400 only), 05.30.xx.xx and 05.40.xx.xx (DS4400
and DS4500), and 05.41.xx.xx (DS4500). The DS4400 and DS4500 are supported
storage subsystems. The maximum number of mirror pairs is 32 for DS4400 and
DS4500.

Enhanced Remote Mirroring is an enhanced version of Remote Mirroring; therefore
providing an enhancement of the existing 10 km maximum distance synchronous
Remote Mirror Option. The Enhanced Remote Mirroring supports the 10 km
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maximum distance synchronous Remote Mirroring pairs. The Enhanced Remote
Mirroring also supports Enhanced Global Remote Mirroring with the write
consistency (Global Mirroring) option or without the write consistency (Global
Copy) option.

The Enhanced Remote Mirroring is supported with controller firmware 06.xx.xx.xx
or later. The supported storage subsystems are the DS3500 with firmware version
07.70.xx.xx or later, the DCS3700 with firmware 07.77.xx.xx or later, DS4100
standard option with firmware version 06.12.xx.xx or later, DS4300 with Turbo
option, DS3950, DS4200, DS4400, DS4500, DS4700, DS4800, DS5020, DS5100, and
DS5300. The maximum number of mirror pairs is 32 for the DS4100 standard dual
controller model and DS4300 Turbo models. The maximum number of mirror pairs
is 16 for the DS3500 and DCS3700; 64 for the DS3950, DS4200, DS4400, DS4500,
DS4700, and DS5020; and 128 for the DS4800, DS5100, and DS5300 models.

Enhanced Remote Mirroring is not supported on single-controller models. It is
supported on dual-controller storage subsystems only.

The maximum number of storage subsystems that can participate in a remote
mirror configuration is two. The two storage subsystems are called primary and
secondary storage subsystems or local and remote storage subsystems. These names
are used interchangeably to describe remote mirror setups or concepts. The names
do not describe the location of storage subsystems or to the role that storage
subsystems have in a remote mirror relationship.

Primary and secondary logical drives on a remote mirror
setup

This section introduces you to primary and secondary logical drives, and describes
how they interact to replicate data between storage subsystems using the Remote
Mirror Option. When you create a remote mirror, a mirrored logical drive pair is
defined and consists of a primary logical drive at the primary storage subsystem,
and a secondary logical drive at a secondary storage subsystem. A standard logical
drive might only be defined in one mirrored logical drive pair. The maximum
number of supported mirrored logical drive pairs is determined by the storage
subsystem model.

The primary and secondary role in a remote mirror setup is implemented at the
logical drive level instead of at the storage subsystem level. All logical drives that
participate in a remote mirror relationship on a storage subsystem can be in either
a primary or secondary role only. The storage subsystem can also have a
combination of logical drives in a primary role and logical drives in a secondary
role. Whether the logical drive is in a primary or secondary role, it counts towards
the maximum number of mirror logical drive pairs that can be defined in a storage
subsystem.

There are no requirements for having a certain number of logical drives be of a
certain role in a remote mirror relationship for a given storage subsystem. For
example, a storage subsystem with a maximum of 16 remote mirror relationship
pairs might have logical drives in any one of the remote mirror relationship
combinations shown in Table 9 on page 129.
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Table 9. Remote Mirror drives in primary and secondary roles

Remote mirror
drives in a
primary role

Remote mirror
drives in a
secondary role

Description

16 0 This local storage subsystem has data in 16 logical
drives mirrored in 16 logical drives in a separate
(remote) storage subsystem.

8 8 This local storage subsystem has data in eight logical
drives mirrored in eight logical drives in a remote
storage subsystem. It also has eight logical drives
that are used to store the mirrored data from eight
logical drives in a remote storage subsystem.

4 12 There are four logical drives that are used to store
the mirrored data from four logical drives in a
remote storage subsystem. It also has 12 logical
drives that are used to store the mirrored data from
12 logical drives in a remote storage subsystem.

0 16 This local storage subsystem has 16 logical drives
that are used to store the mirrored data from 16
logical drives in a remote storage subsystem.

Note:

1. With the Enhanced Remote Mirroring premium feature, there is a maximum of
16 remote mirror pairs for the DS3500, DCS3700, and DCS3700 storage
subsystem with Performance Module Controllers, 32 remote mirror pairs for
DS4100 and DS4300 Turbo models, and 64 remote mirror pairs for the DS3950,
DS4200, DS4400, DS4500, DS4700, and DS5020. The DS4800, DS5100, and
DS5300 support 128 remote mirror pairs.

2. For firmware version 05.3x.xx.xx or later, the maximum number of logical
drives include the FlashCopy repository logical drives, the VolumeCopy target
logical drive, and the Remote Mirror logical drives, in addition to the standard
data logical drives. If the Remote Mirror Option is enabled, two logical drives
are reserved for use by the system.

3. There is no Remote Mirror support for DS4100 single controller models, or
DS4300 base/standard and single controller unit.

4. There is a maximum of eight remote mirror pairs for the DS4400 and DS4500,
with the Remote Mirroring premium feature option.

5. When using firmware version 05.xx.xx or later, the firmware reserves one
logical drive for the system to use.

6. There is a maximum of four FlashCopy logical drives for each standard logical
drive.

7. The host-agent management method uses a special logical drive, called an
access logical drive, to communicate with the controllers on the storage
subsystem. The access logical drive uses one of the available LUNs. Therefore,
managing storage subsystems with the host-agent software limits you to one
fewer LUN than the maximum number that is supported by the operating
system and the host adapter.
For controller firmware 05.4x.xx.xx or later the maximum number of logical
drives per storage mapping partition is 256. However, depending on the
operating system limitations, the actual number of supported LUNs logical
drives per storage mapping partition is less than 256.
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The primary logical drive is the drive that accepts host computer I/O and stores
program data. When you first create the mirror relationship, data from the primary
logical drive is copied (becomes a mirror image) in its entirety to the secondary
logical drive. This process is known as a full synchronization and is directed by the
controller owner of the primary logical drive. During a full synchronization, the
primary logical drive remains fully accessible for all normal I/O operations.

When a write request is made to the primary logical drive, the controller owner of
the primary logical drive also initiates a remote write request to the secondary
logical drive. The timing of the write I/O completion indication that is sent back to
the host depends on the write mode option that is selected. Metro Mirror requires
the primary-side controller to wait for the acknowledgment of the write operation
from the secondary-side controller before returning the write I/O request
completion to the host. Global Copy, which is a new Remote Mirror feature, allows
the primary-side controller to return the write the I/O request completion to the
host server before data has been successfully written by the secondary-side
controller. See “Write options” on page 133 for more information.

The secondary logical drive is used to store data that is copied from its associated
primary logical drive. The controller owner of the secondary logical drive receives
remote writes from the controller owner of the primary logical drive and will not
accept host write requests. The Enhanced Remote Mirror Option allows the host
server to issue read requests to the secondary logical drive.

Note: In some instances, you can map the secondary logical drive to a host to
make read-only access possible. Many operating systems, such as Microsoft
Windows and AIX, write a signature or "dirty bit" when they mount a logical
drive; when this occurs, no direct access is possible. To manage this situation, you
can create a FlashCopy of the secondary logical drive.

The secondary logical drive is normally unavailable to host computer programs
while mirroring is performed. In the event of a disaster or unrecoverable error of
the primary storage subsystem, a role reversal is performed to promote the
secondary logical drive to the primary logical drive. Host computers will then be
able to access the newly-promoted logical drive and normal operations can
continue.

Figure 35 on page 131 shows the primary and secondary logical drives displayed
in the Subsystem Management window for the primary storage subsystem and the
secondary storage subsystem.
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Mirror repository logical drives
A mirror repository logical drive is a special logical drive in the storage subsystem.
It is created as a resource for the controller owner of the primary logical drive in a
remote logical drive mirror. The controller stores mirrored information on this
logical drive, including information about remote write requests that are not yet
written to the secondary logical drive. The controller can use this information to
recover from controller resets or if the storage subsystems are accidentally turned
off.

When you activate the Remote Mirror Option on the storage subsystem, two
mirror repository logical drives are created, one for each controller in the storage
subsystem. An individual mirror repository logical drive is not needed for each
mirror logical drive pair.

When you create the mirror repository logical drives, you specify their location.
You can either use existing free capacity (shown in Figure 36 on page 132) or you
can create an array for the logical drives from the unconfigured capacity, and then
specify the RAID level.

Because of the critical nature of the data that is stored, the RAID level of mirror
repository logical drives must be nonzero. The required size of each logical drive is
128 MB for each mirror repository logical drive (256 MB total). If you are
upgrading from the previous version of Remote Mirror, you must upgrade the size
of the repository logical drive from 4M to 128M (see “Upgrading mirror repository
logical drives” on page 175) in order to support a maximum of 64 Remote Mirror
pairs. A maximum of only 32 Remote Mirror pairs is supported with the 4M
repository logical drive.

Important: For each mirrored pair that you create, leave a minimum of 0.25 GB
free capacity in the same array as the mirror repository logical drives. If you
someday deactivate the mirrored pair, this will make sure that you have enough
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Subsystem Management window
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Management window for the
secondary storage subsystem.

SJ001109

Figure 35. Primary and secondary logical drives displayed in the Subsystem Management
window
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capacity to reestablish the mirrored pair from the deactivated state. Otherwise, if
there is no free capacity available on the storage subsystem, you might not be able
to reestablish the mirrored pair.

Figure 36 shows mirror repository logical drives displayed in the Subsystem
Management window for the primary storage subsystem.

Using arrays and logical drives with T10PI functionality
For Controller firmware 7.77.xx.xx, logical drives can be created with T10PI
functionality using T10PI drives.

If you want to remote mirror logical drives with T10PI functionality, ensure that
the T10PI functionality of both the primary and secondary logical drives is
enabled.

The performance of the Remote mirroring logical drives with T10PI functionality
depends on the IOs pattern to the primary logical drive. There is no impact on the
performance if the IOs pattern to the primary logical drive is of small and random
workload (for example, 4 Kbyte random IO). However, the performance can
degrade up to 20% if the IO pattern to the primary logical drive is of large and
sequential workload (for example, 256 Kbyte sequential IO) as compared to the
remote mirrors using logical drives without T10PI functionality. Contact IBM
Solution Assurance Review (SAR) if you have any concerns or questions about
using logical drives with T10PI functionality in remote mirroring environment.

Note: If you use local T10PI-capable drives but do not have the T10PI functionality
enabled, you will not have the previously mentioned performance degradation in a
remote mirroring environment.

Using thin logical drives

For controller firmware version 7.83.xx.xx or later, thin logical drives can be created
in a disk pool. Thin logical drives are not supported as the primary or secondary
logical drives in a remote mirrored relation.
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Figure 36. Mirror repository logical drives displayed in the Subsystem Management window
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Mirror relationships
Before you define a mirror relationship, the Remote Mirror Option must be
enabled on both the primary and secondary storage subsystems. A secondary
standard logical drive candidate must be created on the secondary storage
subsystem if one does not already exist. It must be a standard logical drive and be
at least the same size or larger than the primary logical drive.

When secondary logical drive candidates are available, you can define a mirror
relationship in the storage management software by identifying the storage
subsystem that contains the primary logical drive and the storage subsystem that
contains the secondary logical drive.

When you set up the mirror relationship, a full synchronization occurs as data
from the primary logical drive is copied in its entirety to the secondary logical
drive. For more information about establishing mirror relationships, see“Creating
mirror relationships” on page 177.

Data replication
This section describes how data is replicated between storage subsystems that are
participating in remote logical drive mirroring, and the actions that are taken by
the controller owner of the primary logical drive if a link interruption occurs
between storage subsystems. Data replication between the primary logical drive
and the secondary logical drive is managed by the controllers and is transparent to
host computers and programs.

Note: When a read request is received from a host computer, the controller owner
of either the primary or secondary logical drive manages the request, depending
on whether the read is issued to the primary or secondary logical drive,
respectively. No communication takes place between the primary and secondary
storage subsystems.

Write options
When the controller owner of the primary logical drive receives a write request
from a host computer, the controller first logs information about the write request
to its mirror repository logical drive, and then writes the data to the primary
logical drive. The controller then initiates a remote write operation to copy the
affected data blocks to the secondary logical drive at the secondary storage
subsystem.

There are two write mode options that affect the timing that the I/O completion
indication is sent back to the host:
v “Metro Mirroring”
v “Asynchronous write mode (Global Copy and Global Mirroring)” on page 134

Metro Mirroring
When Metro Mirroring (also known as Synchronous Write Mode) is selected, any
host write requests are written to the primary logical drive, and then copied to the
secondary logical drive. After the host write request has been written to the
primary logical drive and the data is successfully copied to the secondary logical
drive, the controller removes the log record on the mirror repository logical drive
and sends an I/O completion indication back to the host computer.
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In the event of a communication failure, Metro Mirror offers the best chance of full
data recovery from the secondary logical drive. In Metro Mirror, host I/O
performance is slower than it is in Global Copy.

Metro Mirror is selected by default and is the preferred write mode when the
maximum distance between the storage subsystems in an Enhanced Remote
Mirroring configuration is 10 km.

Figure 37 shows the data replication process for Metro Mirror.

Asynchronous write mode (Global Copy and Global Mirroring)
When Global Copy is selected, host write requests are written to the primary
logical drive, and the controller then sends an I/O completion indication back to
the host system regardless of when the data was successfully copied to the
secondary logical drive.

There are two types of mirroring that use asynchronous write mode: Global Copy
and Global Mirroring. See “Write consistency groups” on page 135 for a
description of each type.

Note: Remote mirroring using synchronous write mode is referred to as Metro
Mirroring.

Asynchronous write mode offers faster host I/O performance than synchronous
write mode, but does not guarantee that the copy has been successfully completed
before processing the next write request. This is the preferred mode when the
maximum distance between the storage subsystems in an Enhanced Remote
Mirroring configuration is more than 10 km.
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Figure 37. Data replication between primary and secondary storage subsystems: Metro Mirror
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Figure 38 shows the data replication process for asynchronous write mode.

Write consistency
Write consistency, a configuration option available for any primary or secondary
logical drives in a remote mirror relationship using Global Copy, preserves write
orders.

In Global Copy, write requests are not guaranteed to be completed in the same
order on the secondary logical drive as they are on the primary logical drive. If the
order of write requests is not retained, data on the secondary logical drive might
become inconsistent with the data on the primary logical drive. This can jeopardize
any attempt to recover data if a disaster occurs on the primary storage subsystem.

You can avoid this by selecting the write consistency option for multiple mirror
relationships on the same storage subsystem. When you select write consistency,
the order in which the data is synchronized is preserved. For example: In a remote
mirror pair, the write for Mirror 1 is always performed before the write for Mirror
2.

Note: Selecting write consistency for a single mirror relationship does not change
the process in which data is replicated. More than one mirror relationship must
reside on the primary storage subsystem for the replication process to change.

Write consistency groups
When multiple mirror relationships on a single storage subsystem have been
configured to use Global Copy and to preserve write consistency, they are
considered to be an interdependent group known as a write consistency group. In a
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Figure 38. Data replication between primary and secondary storage subsystems:
Asynchronous write mode (Global Copy/Global Mirroring)
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write consistency group, all mirror relationships maintain the same order when
sending writes from the primary logical drives to their corresponding secondary
logical drives.

The data on the secondary, remote storage subsystem cannot be considered fully
synchronized until all remote mirrors in the write consistency group are
synchronized. If one mirror relationship in a write consistency group becomes
unsynchronized, all of the mirror relationships in the write consistency group will
become unsynchronized. In this case, write activity to the remote, secondary
storage subsystem is prevented, in order to protect the consistency of the remote
data set.

Note: Care must be taken in selecting the number of logical drives that are in a
write consistency group to minimize the impact when multiple simultaneous
remote writes becomes single-thread because of write consistency requirement.

Example of a write consistency group:
On a campus site, the Remote Mirror Option has been configured between two
storage subsystems. At the primary site, the primary storage subsystem has three
defined mirror relationships (RMO-A, RMO-B, and RMO-C), with each mirror
relationship configured to copy data to the secondary storage subsystem.

All three mirror relationships have been configured to use Global Copy and to
preserve write order. If the mirrored pair RMO-A becomes unsynchronized due to
a link interruption, the controller will automatically transition RMO-B and RMO-C
into an Unsynchronized state until communication can be resumed.

Global Copy and Global Mirroring:
There are two types of Enhanced Global Mirroring:

Global Copy
Refers to a remote logical drive mirror pair that is set up using Global
Copy without the write consistency group option. This is also referred to as
Enhanced Global Mirroring without Consistency Group.

Global Copy does not make sure that write requests to multiple primary
logical drives are carried out in the same order on the secondary logical
drives as they are on the primary logical drives. If it is critical that writes
to the primary logical drives are carried out in the same order in the
appropriate secondary logical drives, use Global Mirroring instead of
Global Copy.

Global Mirroring
Refers to a remote logical drive mirror pair that is set up using Global
Copy with the write consistency group option. This is also referred to as
Enhanced Global Mirroring with Consistency Group.

Global Mirroring makes sure that write requests to multiple primary
logical drives are carried out in the same order on the secondary logical
drives as they are on the primary logical drives, preventing data on the
secondary logical drives from becoming inconsistent with the data on the
primary logical drives.

Note: In Global Mirroring mode, the controller handles write requests
similar to the way logical drive mirror pairs are set up using Metro Mirror.
Remote mirroring performance may be impacted when there are a large
number of logical drives in the write consistency group and when the
bandwidth between the remote mirroring sites is limited or slow.
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Resynchronization methods
Data replication between the primary logical drive and secondary logical drive in a
mirror relationship is managed by the controllers, and is transparent to host
machines and applications. When the controller owner of the primary logical drive
receives a write request from a host, the controller persistently logs information
about the write to a mirror repository logical drive, then writes the data to the
primary logical drive. The controller then initiates a write operation to copy the
affected data to the secondary logical drive on the secondary storage subsystem.

If a link interruption or logical drive error prevents communication with the
secondary storage subsystem, the controller owner of the primary logical drive
transitions the mirrored pair into an Unsynchronized state and sends an I/O
completion to the host that sent the write request. The host can continue to issue
write requests to the primary logical drive, but remote writes to the secondary
logical drive do not take place. These write requests are persistently logged in the
primary-side remote mirror repository logical drive.

When connectivity is restored between the controller owner of the primary logical
drive and the controller owner of the secondary logical drive, resynchronization
takes place. To minimize the resynchronization effort, the Enhanced Remote
Mirroring Option will copy only the blocks of data that were changed on the
primary logical drive during the link interruption to the secondary logical drive.

If the remote mirror logical drive pair becomes unsynchronized due to the lost of
mirror repository logical drives, full synchronization will be required when the
mirror repository logical drives is restored.

Attention: Multiple communication disruptions and restore cycles that occur
between the primary and secondary storage subsystems during resynchronization
can result in a mix of new and old data on the secondary logical drive. If this
happens, the data is unusable in a disaster recovery situation.

This section describes the two resynchronization methods that you can use:
v “Manual resynchronization”
v “Automatic resynchronization” on page 138

Important: Manual resynchronization is the preferred setting for all mirror
relationships in a write consistency group. If automatic resynchronization is
selected for a mirror relationship in a write consistency group, resynchronization
will start as soon as communication is reestablished, which does not preserve
consistency in the write consistency group.

Manual resynchronization
When you select manual resynchronization and a communication failure occurs
between the primary and secondary storage subsystems, resynchronization of the
data on the primary logical drive and secondary logical drive can be started
manually after communication has been restored to the unsynchronized mirrored
pair.

Important: Only the blocks of data that were changed on the primary logical drive
during the link interruption are copied to the secondary logical drive.

Selecting the manual resynchronization option allows you to manage the
resynchronization process in a way that provides the best opportunity for
recovering data. When this option is selected and a communication failure occurs
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between the primary and secondary logical drives, the mirror relationship
transitions to an Unsynchronized state. Any write requests to the primary logical
drive are logged and the storage subsystem is placed in a Needs Attention state.

After the controller owner of the primary logical drive detects that communication
has been restored, the mirror relationship will remain in an Unsynchronized state
until you select Logical Drive → Remote Mirror Option → Resume in the
Subsystem Management window.

Automatic resynchronization
When the automatic resynchronization option is selected and a communication
failure occurs between the primary and secondary storage subsystems, the
controller owner of the primary logical drive will start resynchronizing the primary
and secondary logical drives immediately after detecting that communication has
been restored.

Important: Only the blocks of data that have changed on the primary logical drive
during the link interruption are copied to the secondary logical drive.

Link interruptions or secondary logical drive errors
In the course of processing write requests, a primary controller might be able to
write only to the primary logical drive while a link interruption prevents
communication with the remote secondary controller.

After a link interruption, the remote write operation cannot complete to the
secondary logical drive and the primary and secondary logical drives are no longer
correctly mirrored. The primary controller transitions the mirrored pair into an
Unsynchronized state and sends an I/O completion message to the primary host
computer, as shown in Figure 39. The primary host computer can continue to write
to the primary logical drive but remote write operations do not take place.

When connectivity is restored between the controller owner of the primary logical
drive and the controller owner of the secondary logical drive, a resynchronization
either happens automatically or must be started manually, depending on which
method you chose when you set up the mirror relationship. During the
resynchronization, only the blocks of data that were changed on the primary
logical drive during the link interruption are copied to the secondary logical drive.
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Figure 39. Mirrored logical drive pair showing Unsynchronized status
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After the resynchronization begins, the mirrored pair transitions from an
Unsynchronized state to a Synchronization-in-Progress state, as shown in
Figure 40.

The primary controller places the mirrored pair in an Unsynchronized state when a
logical drive error on the secondary storage subsystem prevents a remote write
operation from completing. For example, an offline or failed secondary logical
drive can cause the remote mirror to be placed in an Unsynchronized state. When
the secondary logical drive is placed online or is recovered to an Optimal state, a
manual or automatic resynchronization is required, and the mirrored pair
transitions to a Synchronization-in-Progress state.

For more information about Remote Mirror Option status, see Chapter 11, “Using
the Enhanced Remote Mirroring Option,” on page 175.

Connectivity and I/O
The Remote Mirror Option requires a dedicated host port for mirroring data
between storage subsystems. This section describes three configurations that you
can use to connect storage subsystems for remote logical drive mirroring, controller
ownership of logical drives within storage subsystems, the maximum storage
subsystem distance permitted, and some general performance considerations. If
these configurations do not meet your remote mirror configuration requirement,
contact your IBM technical-support representative.

For the DS3500 with each controller configured with four Fibre Channel host ports
and two SAS host ports, controller host ports A6 and B6 are dedicated for
mirroring options when the Enhanced Remote Mirroring premium feature is
enabled. See Figure 41 on page 140 for the location of the DS3500 controller host
ports.
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Figure 40. Mirrored logical drive pair showing Synchronization-in-Progress status
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For the DS3950 with each controller configured with two Fibre Channel host ports
or two Fibre Channel host ports and two iSCSI host ports, controller host ports A2
and B2 are dedicated for mirroring options when the Enhanced Remote Mirroring
premium feature is enabled. See Figure 42 for the location of the DS3950 controller
host ports.

The Remote Mirror Option is supported on DS4000 or DS5000 storage subsystems
that have at least two Fibre Channel host ports per controller (DS4400, DS4300, and
DS4500). When the Remote Mirror Option is activated, one Fibre Channel host-side
I/O port on each controller is dedicated only to mirroring operations. For example,
in the primary storage subsystem, controller host ports A2 and B2 are dedicated to
mirroring operations. In the secondary storage subsystem, controller host ports A2
and B2 are also dedicated to mirroring operations. See Figure 43 on page 141 for
the location of the controller host ports for DS4400, and see Figure 44 on page 141
for the location of controller host ports for DS4300.

Figure 41. Controller A and Controller B host ports, DS3500 configured with two controllers
and four Fibre Channel and two SAS host ports in each controller

Controller B

Controller A
Host
port A2

Host
port B2

Figure 42. Controller A and Controller B host ports, DS3950 configured with two Fibre
Channel or two Fibre Channel and two iSCSI host ports
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For the DS4800, controller host ports A4 and B4 are dedicated for mirroring
options when the Enhanced Remote Mirroring premium feature is enabled. For
DS4700/DS4200, controller host port 2 in DS4700 model 70A/H, and DS4200 and
port 4 in model DS4700 72A/H are dedicated for mirroring options when the
Enhanced Remote Mirroring premium feature is enabled. See Figure 45 on page
142 for the location of controller host ports for DS4800, and Figure 46 on page 142
and Figure 47 on page 142 for DS4700 and DS4200.
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Figure 44. Controller A and Controller B host ports, DS4300
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For the DS5020 with each controller configured with two Fibre Channel host ports
or two Fibre Channel host ports and two iSCSI host ports, controller host ports A2
and B2 are dedicated for mirroring options when the Enhanced Remote Mirroring
premium feature is enabled. See Figure 48 on page 143 for the location of the
DS5020 controller host ports.

Host port B4

Host port A4

Controller A

Controller B

Figure 45. Controller A and Controller B host ports, DS4800

Figure 46. Controller A and Controller B host ports, DS4700 Model 70 and DS4200

Figure 47. Controller A and Controller B host ports, DS4700 Model 72
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For the DS5020 with each controller configured with four Fibre Channel host ports,
controller host ports A4 and B4 are dedicated for mirroring options when the
Enhanced Remote Mirroring premium feature is enabled. See Figure 49 for the
location of the DS5020 controller host ports.

For the DS5100 and DS5300 configured with a single Fibre Channel host interface
card (HIC) or one Fibre Channel and one iSCSI HIC, controller host ports A4 and
B4 of HIC 1 are dedicated for mirroring options when the Enhanced Remote
Mirroring premium feature is enabled. See Figure 50 on page 144 for the location of
controller host ports for DS5100 and DS5300 with a single HIC.

For the DS5300 configured with dual Fibre Channel host interface cards, controller
host ports A4 and B4 of HIC 2 are dedicated for mirroring options when the
Enhanced Remote Mirroring premium feature is enabled. See Figure 51 on page
144 for the location of controller host ports for the DS5300 with dual HICs.

Controller B

Controller A
Host
port A2

Host
port B2

Figure 48. Controller A and Controller B host ports, DS5020 configured with two Fibre
Channel or two Fibre Channel and two iSCSI host ports
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Figure 49. Controller A and Controller B host ports, DS5020 configured with four Fibre
Channel host ports
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For DS4400, each of the controller host ports is connected to a mini-hub. Each
mini-hub has two small form-factor pluggable (SFP) or gigabit interface converter
(GBIC) port slots. If the first mini-hub SFP or GBIC port slot is connected to a Fibre
Channel switch port as part of remote mirror setup, the second mini-hub port must
not be occupied.

Host-initiated I/O operations are refused by the dedicated port. Requests that are
received on this dedicated port are only accepted from a controller that is
participating in the remote mirror relationship.

Controller ports that are dedicated to the remote logical drive mirror must be
attached to a Fibre Channel fabric environment with support for the Directory
Service and Name Service interfaces.

Logical drive ownership
The controller owner of the primary logical drive attempts to communicate with
only its mirrored controller in the secondary storage subsystem. As shown in
Figure 52 on page 145, controller A in the primary storage subsystem attempts to
communicate with controller A in the secondary storage subsystem.

The controller (A or B) that owns the primary logical drive determines the
controller owner of the secondary logical drive. Regardless of the secondary logical
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Figure 50. Controller A and Controller B host ports, Single HIC DS5100 and DS5300
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Figure 51. Controller A and Controller B host ports, Dual HIC DS5300
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drive controller ownership, if the primary logical drive is owned by controller A on
the primary storage subsystem, the secondary logical drive is then owned by
controller A on the secondary storage subsystem. If primary controller A cannot
communicate with secondary controller A, no controller ownership changes take
place and the remote mirror link is broken for that mirror logical drive pair. When
primary controller A can communicate with secondary controller A, the next I/O
request to the primary logical drive results in a secondary drive ownership change.
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When an I/O path error causes a logical drive ownership change on the primary
storage subsystem, or if the storage administrator changes the controller owner of
the primary logical drive, the next remote write request that is processed
automatically starts an ownership change on the secondary storage subsystem.

As shown in Figure 53 on page 146, if a primary logical drive is owned by
controller A and the controller owner is changed to controller B, the next remote
write operation changes the controller owner of the secondary logical drive from
controller A to controller B.
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Figure 52. Controller A shown as the controller owner
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Because controller ownership changes on the secondary storage subsystem are
controlled by the primary controller, they do not require any special intervention
and you cannot manually change them.

Note: Create the primary and secondary mirrors on the same primary path.

Primary and secondary storage subsystem connection
distance

The maximum connection distance that is permitted between storage subsystems
that are participating in a mirror relationship is governed by the distance limits of
the Fibre Channel interswitch links (ISL). With the previous Remote Mirror Option
using standard single-mode fiber technology, the maximum link distance was 10
km (6.25 mi) between storage subsystems. In addition, the ISL link must be a
standard Fibre Channel connection using single-mode Fibre Channel cables
between two longwave GBICs or SFPs that are inserted into the Fibre Channel
switch port slots. With the Enhanced Remote Mirroring Option, link distances
between storage subsystems of more than 5150 km (3200 mi) can be achieved.

Role reversals
A role reversal is the act of promoting the secondary logical drive to be the
primary logical drive of the mirrored logical drive pair, and demoting the primary
logical drive to the secondary logical drive role.

In the event of a disaster at the storage subsystem that contains the primary logical
drive, you can fail over to the secondary site by performing a role reversal to
promote the secondary logical drive to the primary logical drive role. This allows
business operations to continue and hosts to continue accessing data.

You can use one of the following methods to complete a role reversal:
v Click Volume → Remote Mirroring → Change → Role to Primary to change a

secondary logical drive to a primary logical drive.
This option promotes the selected secondary logical drive to become the primary
logical drive of the mirrored pair, and can be used when a catastrophic failure
has occurred. For step-by-step instructions, see the Subsystem Management
window online help.

v Click Volume → Remote Mirroring → Change → Role to Secondary to change a
primary logical drive to a secondary logical drive.
This option demotes the selected primary logical drive to the secondary logical
drive role, and can be used during normal operating conditions. For step-by-step
instructions, see the Subsystem Management Window online help.

If the primary storage array is recovered but is unreachable due to a link failure, a
forced promotion of the secondary logical drive results in both the primary and
secondary logical drives viewing themselves in the primary logical drive role
(dual-primary condition). If this occurs, the VolumeCopy in which the primary
logical drive is participating will be unaffected by the role change.

General performance considerations
Note the following general performance considerations when you create remote
mirrors:

Figure 53. Controller B shown as controller owner
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v The controller owner of a primary logical drive performs a full synchronization
in the background while processing local I/O write operations to the primary
logical drive and associated remote write operations to the secondary logical
drive. Because a full synchronization diverts controller processing resources from
I/O activity, this can impact performance to the host computer program.
To reduce the performance impact, you can set the synchronization priority to
establish how the controller owner prioritizes a full synchronization relative to
other I/O activity. The following are some basic guidelines for setting the
synchronization rate:
– A full synchronization at the lowest synchronization priority rate takes

approximately eight times as long as a full synchronization at the highest
priority synchronization rate.

– A full synchronization at the low synchronization priority rate takes
approximately six times as long as a full synchronization at the highest
priority synchronization rate.

– A full synchronization at the medium synchronization priority rate takes
approximately three and a half times as long as a full synchronization at the
highest priority synchronization rate.

– A full synchronization at the high synchronization priority rate takes
approximately twice as long as a full synchronization at the highest priority
synchronization rate.

For more information about setting the synchronization priority, see Chapter 11,
“Using the Enhanced Remote Mirroring Option,” on page 175.

v When the mirror logical drive pair is in the Synchronization-in-Progress state,
all host computer write data is copied to the remote system in processing the
I/O. Controller I/O bandwidth and I/O latency affect host computer write
performance. Host read performance is not affected by the mirror relationship.

v The overall storage subsystem performance is impacted by the number of
remote mirrors defined in the mirroring configurations and the number of write
requests that need to be performed at a given time for all of the defined mirrors.
The greatest impact occurs when the maximum number of Remote Mirroring
pairs are defined and the I/Os to the primary LUNs are write only at the
maximum I/O rate. Use the appropriate performance monitor to optimally
define the maximum Remote Mirroring pairs for your applications.

Using other premium features with the Remote Mirror Option
This section describes how you can use the Remote Mirror Option with Storage
Partitioning and FlashCopy .

For information about using the Remote Mirror Option with VolumeCopy, see
“The Remote Mirror Option and VolumeCopy” on page 119.

Storage Partitioning and the Remote Mirror Option
Storage Partitioning is a premium feature which enables host computers to share
access to logical drives in a storage subsystem. A storage partition is created when
you define a collection of host computers (a host group) or a single host computer,
and then define a logical drive to LUN map. This map enables you to define what
host group or host computer has access to a particular logical drive in your storage
subsystem.

Note: Storage partitioning is not a copy services premium feature. This guide does
not describe how to enable and use the Storage Partitioning feature. For more
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information about storage partitioning, see the IBM System Storage DS Storage
Manager Version 10 Installation and Support Guide for your operating system.

Figure 54 shows the Mappings view of the Subsystem Management window, where
primary logical drive Accounting is included in a partition that is accessible by
host group Campus East, and secondary logical drive Accounting 2 is included in a
partition that is accessible by host group Campus West.

The storage partition definitions for the primary and secondary storage subsystems
are independent of each other. If the storage partition definitions are put in place
while the logical drive is in the secondary role, the storage partition reduces the
administrative effort that is associated with storage subsystem recovery if it
becomes necessary to promote the secondary logical drive to the primary role.
However, depending on the host operating system and application, the secondary
logical drive might not be assigned to the same host that the primary logical drive
is mapped to. For more information about defining storage partitions, see the
Subsystem Management window online help.

Storage partition definitions can be performed using the Create command in the
Storage Manager Script window or the CLI. For more information, see the
Enterprise Management window online help.

FlashCopy, Enhanced FlashCopy and the Remote Mirror
Option

FlashCopy and Enhanced FlashCopy are premium features that are available with
the DS Storage Manager software. You can enable this premium feature by
purchasing the FlashCopy or Enhanced FlashCopy option depending on whichever
is applicable. A FlashCopy or an Enhanced FlashCopy logical drive is a
point-in-time (real-time) image of a base logical drive and is created so that a
program, such as a backup program, can access the FlashCopy or Enhanced
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Figure 54. Mappings view of the Subsystem Management window showing storage
partitioning
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FlashCopy logical drive and read the data while the base logical drive remains
online and is accessible to host computers.

When Enhanced FlashCopy or FlashCopy is enabled, you can have the Enhanced
FlashCopy group or images or FlashCopy logical drives that are based on the
primary or secondary logical drive of a mirrored logical drive pair.

The logical drive for which the point-in-time image is created is known as the base
logical drive and must be a standard logical drive in the storage subsystem. For
remote logical drive mirroring, only the base logical drive of a FlashCopy or
Enhanced FlashCopy logical drive is permitted to be a candidate for the primary
logical drive in a mirror relationship. Figure 55 shows the primary logical drive
(also the base logical drive for the FlashCopy logical drive), the secondary logical
drive, and the FlashCopy repository logical drive in the Subsystem Management
window for the primary storage subsystem.

Important: The base logical drive of a FlashCopy logical drive cannot be a
candidate for the secondary logical drive role in a mirror relationship. Otherwise,
the FlashCopy logical drive fails when the remote mirror relationship is created.

Primary logical drive (also the basic logical drive)

Secondary logical drive

FlashCopy logical drive

Logical/Physical View

Logical

Unconfigured Capacity (8.44 GB)

Storage Subsystem Primary Site

Logical Drive Group 1 (RAID 5)

Mirror Repository 1 (0.004 GB)

Mirror Repository 2 (0.004 GB)

Free Capacity (10.873 GB)

Accounting (5 GB/0 GB usable)

Accounting 2

Accounting-1 (5 GB)

Accounting-R1 (0.466 GB)

SJ001114

]

Dynamic Volume Expansion
Dynamic Volume Expansion (DVE) is a modification operation that you can use to
increase the capacity of a standard logical drive or a FlashCopy repository logical
drive. To increase the capacity, a DVE operation uses the free capacity that is
available on the array of the logical drive.

Figure 55. FlashCopy logical drive included in a mirror relationship
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The operation is considered to be "dynamic" because you can continuously access
data on arrays, logical drives, and disk drives during the operation.

You can complete a DVE operation on both a primary and secondary logical drive
in a remote mirror relationship.

You can expand either end. The key is that new capacity is not available until both
ends have been expanded (assuming they start out the same size).

During mirror creation, you can select a secondary logical drive that has more
capacity than the primary logical drive. When this happens, the effective mirror
logical drive capacity is that of the primary logical drive. The usable capacity
becomes the smaller of the two logical drives. The primary could then be
expanded, and the secondary would already have capacity.

Note: After expansion of the remote logical drive occurs, the GUI will not reflect
that expansion until a host write goes through. This can lead to some confusion
because if there are no writes to the primary logical drive, the primary side AMW
will not report that the secondary expansion has completed.

You cannot complete a DVE operation on a mirror repository logical drive. If the
mirror repository logical drive exists from a previous release of Storage Manager
and needs to be upgraded, see “Upgrading mirror repository logical drives” on
page 175.

Important: DVE (Dynamic Volume expansion) is not possible on a logical drive
that is in an active mirror relationship and whose write-mode is 'Asynchronous not
write-consistent'. The DVE is possible if the write-mode is 'Synchronous' or
'Asynchronous write-consistent'. The DVE is not possible on either the primary or
the secondary logical drive. DVE is also not possible on a FlashCopy Repository of
the secondary logical drive. This is because the attribute of the write-mode on the
primary logical drive (mirrored to the secondary) is given to the FlashCopy
Repository Logical Drive of the secondary's FlashCopy Logical Drive.

A workaround is to set the write-mode of the mirrored primary logical drive, from
'Asynchronous not write-consistent' to 'Asynchronous write-consistent' or
'Synchronous' to run DVE. After DVE is over, reset the write-mode to
'Asynchronous not write-consistent'.
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Chapter 10. Installing hardware and software for the
Enhanced Remote Mirroring Option

This chapter contains the information that you need to install the hardware and
software to run the Remote Mirror Option. The first section contains the steps that
you must complete before you install the hardware and software. In the next
section, hardware installation procedures are presented, followed by software
installation procedures. Complete the procedures in this chapter sequentially, from
beginning to end.

Preinstallation considerations
This section provides the following information that you must review and
complete before you begin the hardware or software installation procedures:
v Site preparation
v Hardware requirements
v Software requirements
v Host operating systems
v Switch zoning overview

Site preparation
The Remote Mirror Option uses Fibre Channel switches to create a fabric
environment for data replication. These Fibre Channel switches require only
minimal additional site preparation beyond basic storage subsystem operation.

For basic site preparation considerations including the use of Fibre Channel cables
and connections, see the IBM System Storage DS Storage Manager Version 10
Installation and Support Guide for your operating system.

For additional site preparation considerations concerning the Fibre Channel
switches, including power requirements and physical dimensions and
requirements, see the documentation provided with the fabric switch.

Hardware requirements
The following list contains the minimum hardware requirements for configuring
your system to use the Enhanced Remote Mirror Option. The list includes the
components that are supplementary to the standard requirements of a basic storage
subsystem environment. For more information, see the IBM System Storage DS
Storage Manager Version 10 Installation and Support Guide for your operating system.
v IBM System Storage Storage Subsystems

Enhanced Remote Mirroring is currently supported on the DS3500, DS3950,
DS4100, DS4200, DS4300, DS4400, DS4500, DS4700, DS4800, DS5020, DS5100, and
DS5300 Storage Subsystems. For information about other storage subsystems
that might be supported in the future, contact your IBM service representative.
It is possible to have different storage subsystems in each of the two nodes of
the Remote Mirror Option. For example, the local storage subsystem can be the
IBM DS4400 Storage Subsystem and the remote storage subsystem can be the
IBM DS4500 Storage Subsystem and vice-versa.
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However, because the IBM DS4400 and IBM DS4500 Storage Subsystems are
different sets of hardware with different performance characteristics, the storage
subsystem and its associated drives and storage expansion enclosures in each of
the nodes of the remote mirror setup must be the same for optimal and reliable
performance.

v Fibre Channel switches

Use these devices to connect multiple host computers with multiple storage
subsystems in a storage area network (SAN) fabric environment.
For Metro Mirroring (synchronous write mode), the Fibre Channel switches must
be used to connect the storage subsystem controller ports that are dedicated for
remote mirroring operations together (see “Connectivity and I/O” on page 139).
For Global Copy and Global Mirroring (asynchronous write mode), use either
the Fibre Channel switches or the Fibre Channel IP (FC-IP) routers for
connecting the storage subsystem controller ports that are dedicated for remote
mirroring operations together. If the FC-IP routers are used, make sure that
minimum speed between the FC-IP router is 10 MB per second. (At this
minimum speed, reduce the maximum number of active mirrors to eight.)
For a list of certified Fibre Channel switches to use with the Remote Mirror
Option, see the Storage Subsystem System Storage Interoperation Center at the
following website:
www.ibm.com/systems/support/storage/config/ssic/

v Multimode Fibre Channel cables

Use these cables to connect the host computers and the storage subsystems to
the Fibre Channel switches. Multimode Fibre Channel cables are used with
shortwave SFP to complete Fibre Channel connections between any two nodes.

v Single-mode Fibre Channel cables

Use these cables to connect between Fibre Channel switches to complete
long-distance Fibre Channel connections between Fibre Channels switches.
Singlemode Fibre Channel cables must also be used with longwave SFPs.

v Fibre Channel host bus adapters (HBAs)

For a list of certified HBAs to use with the Remote Mirror Option, see the
Storage Manager readme file for your host operating system. See “Finding
Storage Manager software, controller firmware, and readme files” on page xxi to
learn how to access the storage subsystem readme files on the web.

v Ethernet switches and network

Use these devices to connect the storage subsystems to the storage subsystem
management station. To create remote mirror logical drive pairs, the
management station must have either in-band or out-of-band management
connections to both storage subsystems where the logical drives reside.
The management station with the Storage Manager client program that is used
to manage an Enhanced Remote Mirror setup must have management
connections to both the primary and the secondary storage subsystem setups.
For example, both the primary and the secondary storage subsystems must have
optimal entries in the Enterprise Management window of the Storage Manager
client program. You must make sure that the management station, and the
primary and secondary storage subsystems are in the same Ethernet subnet.

Software requirements
When configuring your host computer to use the new Enhanced Remote Mirroring
Option, ensure that the following minimum software requirements are met:
v IBM DS Storage Manager version 9.x or later
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v Controller firmware version 07.60.xx.xx or later for DS3950
v Controller firmware version 06.10.xx.xx or later for DS4300 Turbo Option,

DS4400, and DS4500 (version 06.12.xx.xx or later is preferred)
v Controller firmware version 06.12.1x.xx or later for DS4100
v Controller firmware version 06.14.xx.xx or later for DS4800 (version 06.15.xx.xx

or later is preferred)
v Controller firmware version 06.16.4x.xx or later for DS4700
v Controller firmware version 06.16.8x.xx or later for DS4200
v Controller firmware version 07.30.xx.xx or later for DS5100 and DS5300
v Controller firmware version 07.60.xx.xx or later for DS5020
v Controller firmware version 07.70.xx.xx or later for DS3500
v Controller firmware version 07.77.xx.xx or later for DCS3700
v Controller firmware version 07.83.xx.xx or later for DCS3700 storage subsystem

with Performance Module Controllers
v IBM Enhanced Remote Mirror Premium Feature Key (one for each storage

subsystem)

When configuring your host computer to use the previous, synchronous-mode-only
version of Remote Mirror Option, ensure that the following minimum software
requirements are met:
v IBM DS Storage Manager Version 9.x
v Controller firmware version 05.20.xx.xx or later for DS4400. Controller firmware

version 05.30.xx.xx or later for DS4500.
v IBM Remote Mirror Premium Feature Key (one for each storage subsystem)

Host operating systems
Host computers that access mirrored logical drives must have one of the following
operating systems installed to use the Remote Mirror Option. (For the most
up-to-date information, see the most recent Storage Manager readme file for the
appropriate host operating system. See “Finding Storage Manager software,
controller firmware, and readme files” on page xxi to learn how to access the
storage subsystem readme files on the web.)
v Microsoft Windows Server 2003
v Microsoft Windows Server 2008
v Solaris Version 2.8 (Solaris 8), Solaris 9, and Solaris 10
v HP-UX Version 11.23 and 11.31
v IBM i 6.1 with Licensed Internal Code (LIC) 6.1.1 or later
v AIX Version 5.1 or later
v Linux Red Hat Advance Server 4.0 and 5.0, and Novell SLES 9, 10, and 11
v Linux on POWER-based operating systems Red Hat Enterprise Linux 4 and 5,

and Novell SLES 9, 10, and 11
v Novell NetWare Version 6.5

Switch zoning overview
This section describes how to create zones for Remote Mirroring. For host server
zoning, see the DS Storage Manager Installation and Support Guide for your host
operating system, in addition to the installation and user’s guide provided by the
switch manufacturer.
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To create switch zoning configurations for Remote Mirroring, use the management
software that comes with the Fibre Channel switch.

The Enhanced Remote Mirroring Option requires two dedicated controller host
port connections for each storage subsystem that will participate in Enhanced
Remote Mirroring. When the Enhanced Remote Mirroring Option is activated on a
storage subsystem, one of the host ports in each of the controllers is dedicated for
Remote Mirroring. You cannot use this port for other types of I/O to the storage
subsystem. In storage subsystems that have a maximum of two host ports on each
controller, the second host port of each controller is the port that is dedicated for
Remote Mirroring operations. See the Storage Subsystem Installation, User's and
Maintenance Guide for your storage subsystem for information about Remote
Mirroring dedicated ports.

You must create at least two zones – one zone that consists of the host ports in
controller A of the Enhanced Remote Mirroring pair primary and secondary
storage subsystems that are dedicated for mirroring operations, and similarly, one
zone that consists of the host ports in controller B of the primary and secondary
storage subsystems that are dedicated for mirroring operations. This configuration
is required to make sure that one port on the controller is fully dedicated to remote
mirroring operations. However, for best practices, also zone server HBA
connections so that a single host bus adapter in a server can access only one
controller per storage subsystem.

Important:

1. Establish one-to-one zones between the storage subsystems in the mirrored
pair. The zoning and cabling procedures described in this section are for
illustrative purposes only, and might not show one-to-one zoning. Adjust the
procedures for your specific installation.

2. Do not zone the ISL port that connects (cascades) switches within a fabric
environment.

3. Although the ports that are dedicated for remote mirroring operations are
known as host ports, in a remote mirror setup you do not connect them to a
host server. Instead, you connect them to the other storage subsystems in the
mirrored pair.

When two or more Fibre Channel switches are cascaded together, each switch
shares a common view of the SAN fabric. For example, if two 16-port Fibre
Channel switches are physically connected (cascaded) with a Fibre Channel cable,
the switch management software manages these two switches as if they are a
single switch with 32 ports (0 - 31), rather than as two separate Fibre Channel
switches with 16 ports each (0 - 15). Therefore, a zone that is created containing
any of these ports exists on multiple cascaded Fibre Channel switches.

Note: This is usually, but not always the case, depending on the switch
manufacturer. Some switch software might write over, rather than merge the
switches.

In the top illustration in Figure 56 on page 155, the Fibre Channel switches are on
the same network and cascaded. Therefore, there are two zones that span across
two switches (Zone 1 and Zone 2). Zone 1 is the same zone on Switch 1A as Zone
1 on Switch 1B.

In the bottom illustration in Figure 56 on page 155, the Fibre Channel switches are
on the same network, but are not cascaded. Therefore, in this configuration, there
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are four different zones — two zones on Switch 1 and two zones on Switch 2. The
zones on Switch 1 are independent of the zones on Switch 2.

For more information about Fibre Channel switch zoning or setting up a zone
configuration, see the documentation that comes with the switch.

Installing the hardware
This section describes the procedures that are necessary to properly connect and
configure one or more storage subsystems for use with the Remote Mirror Option.

For a checklist to make sure that all the required hardware components are
configured properly, see “Hardware and software checklists” on page 171.

The following Remote Mirroring configurations are examples of configurations that
IBM Corporation supports. Contact your IBM representative or reseller if you have
questions about the implementation of your Remote Mirroring requirements.

Host 1

HA1 HA2

Host 1

HA1 HA2

Fabric 1
10 Km Max

Switch 1A

Switch 1

Zone 1
0 2 4 6 8 10 12 14

1 3 5 7 9 11 13 15
Zone 1 Zone 2

0 2 4 6 8 10 12 14

1 3 5 7 9 11 13 15
Zone 1 Zone 2

0 2 4 6 8 10 12 14

1 3 5 7 9 11 13 15
Zone A Zone B

Zone 2

Switch 1B

Switch 2

16 18 20 22 24 26 28 30

17 19 21 23 25 27 29 31

B1 B2

A1 A2

B1 B2

A1 A2

Figure 56. Switch zoning in cascaded (top) and noncascaded (bottom) Fibre Channel
switches
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Highest Availability Campus configuration
This configuration has two Fibre Channel switches at both the primary and
secondary sites to provide complete failover and redundancy in the Fibre Channel
switches and fabrics, in addition to all storage subsystem components and host
computers. Two Fibre Channel switches at each site also provide redundancy to
the local site in addition to a fully redundant remote configuration. There is no
single point of failure in the hardware components. Therefore, data
synchronization can continue for any single switch failure. This simplifies the
disaster recovery process.

Use Metro Mirroring (synchronous write mode) for distance less than 10 km and
Global Mirroring for distance of greater than 10 km. Additional hardware and/or
Fibre Channel switch licensing might be required to support distances greater than
10 km.

Important:

1. Establish one-to-one zones between the storage subsystems in the mirrored
pair. The zoning and cabling procedures described in this section are for
illustrative purposes only, and might not show one-to-one zoning. Adjust the
procedures for your specific Highest Availability Campus installation.

2. The Highest Availability Campus configuration is the preferred configuration
for the Remote Mirror Option.

Figure 57 on page 157 shows the Highest Availability Campus configuration after
installation is complete.
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Switch zoning for the Highest Availability Campus configuration
This configuration provides a separate zone for each reserved port for the Remote
Mirroring Option.

You do not need to zone the Fibre Channel switches exactly as presented in this
sample configuration. However, the following are requirements when zoning
switches for the Highest Availability Campus configuration:
v The remote mirror host port connections cannot be zoned together. You must

create two zones:
– The first zone consists of the Remote Mirroring-dedicated host ports from

Controllers A of the primary and secondary host subsystems.
– The second zone consists of the Remote Mirroring-dedicated host ports from

Controllers B of the primary and secondary host subsystems.
v The uplink port must not be zoned on any Fibre Channel switch.
v For best practices, zone server HBA connections so that a single host adapter can

access only one controller per storage subsystem fabric.

Figure 57. Highest Availability Campus configuration
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Important: The Fibre Channel switches in Figure 57 on page 157 contain 16 ports
each, which leaves many unused ports per switch. If you are performing switch
zoning using the Fibre Channel host port number, instead of the WWNN of the
SAN fabric logged-in ports, do not include Fibre Channel switch ports with no
Fibre Channel connections in the zone definition. If you include these unused ports
in your zones, unauthorized access to the SAN might result.

Figure 57 on page 157 shows how the four Fibre Channel switches are cabled for
this Highest Availability Campus configuration. The zones are configured on the
switch to allow one port per zone for a storage subsystem connection, and one
HBA port per zone for each host. There are four zones in the following
configuration example.
v Zone 1 and Zone 3 exist on Fabric 1 (switch 1A at the primary site, and switch

1B at the secondary site)
v Zone 2 and Zone 4 exist on Fabric 2 (switch 2A at the primary site, and switch

2B at the secondary site.

Before proceeding to the next section, make sure that all four Fibre Channel
switches are properly zoned. For more information about zoning Fibre Channel
switches, see “Switch zoning overview” on page 153.

Cabling examples for the Highest Availability Campus
configuration
Table 10 and Table 11 on page 159 show examples of the Fibre Channel cabling
connections in the Highest Availability Campus configuration. See the examples
before you complete the procedure in “Setting up the Highest Availability Campus
configuration” on page 159.

Important: Establish one-to-one zones between the storage subsystems in the
mirrored pair. The examples shown in these tables are for illustrative purposes
only, and do not show one-to-one zoning.

Table 10. Highest Availability Campus configuration connections (Primary site)

Primary site

Switch 1A Switch 2A

Zone Port Connection to and from: Zone Port Connection to and from:

1 0 Host 1, HBA 1 (HA1) 2 0 Host 2, HBA 2 (HB2)

1 Controller port A1 1 Host 1, HBA 2 (HA2)

2 Host 2, HBA 1 (HB1) 2 Controller port B1

3 Additional host, HBA 1 (optional) 3 Additional host, HBA 2 (optional)

4 Additional host, HBA 1 (optional) 4 Additional host, HBA 2 (optional)

5 Additional host, HBA 1 (optional) 5 Additional host, HBA 2 (optional)

6 Additional host, HBA 1 (optional) 6 Additional host, HBA 2 (optional)

7 Additional host, HBA 1 (optional) 7 Additional host, HBA 2 (optional)
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Table 10. Highest Availability Campus configuration connections (Primary site) (continued)

Primary site

3 8 Unused 4 8 Controller port B2 (dedicated
remote mirror port)

9 Controller port A2 (dedicated
remote mirror port)

9 Unused

10 Unused 10 Unused

11 Unused 11 Unused

12 Unused 12 Unused

13 Unused 13 Unused

N/A 14 Spare (can be added to either
zone)

N/A 14 Spare (can be added to either
zone)

N/A 15 Uplink with Switch 1B N/A 15 Uplink with Switch 2B

Table 11. Highest Availability Campus configuration connections (Secondary site)

Secondary site

Switch 1B Switch 2B

Zone Port Connection from and to: Zone Port Connection from and to:

N/A 16 Uplink with Switch 2A N/A 16 Uplink with Switch 1A

N/A 17 Spare (can be added to either
zone)

N/A 17 Spare (can be added to either
zone)

1 18 Host 3, HBA 1 (HC1) 2 18 Controller port B1

19 Controller port A1 19 Host 4, HBA 2 (HD2)

20 Host 4, HBA 1 (HD1) 20 Additional host, HBA 1 (optional)

21 Additional host, HBA 1 (optional) 21 Host 3, HBA 2 (HD2)

22 Additional host, HBA 1 (optional) 22 Additional host, HBA 1 (optional)

23 Additional host, HBA 1 (optional) 23 Additional host, HBA 1 (optional)

3 24 Unused 4 24 Controller port B2 (dedicated
remote mirror port)

25 Controller port A2 (dedicated
remote mirror port)

25 Unused

26 Unused 26 Unused

27 Unused 27 Unused

28 Unused 28 Unused

29 Unused 29 Unused

30 Unused 30 Unused

31 Unused 31 Unused

Setting up the Highest Availability Campus configuration
Complete the steps in this procedure to set up the Highest Availability Campus
configuration for the Remote Mirror Option. Adjust the steps for your specific
installation.

Before you begin, note the following information:
v It is good practice to establish one-to-one zones between the storage subsystems

in the mirrored pair. The zoning and cabling procedures described in this section
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are for illustrative purposes only, and might not show one-to-one zoning. Adjust
the procedures for your specific Highest Availability Campus installation.

v See Figure 57 on page 157 as you complete the steps in this procedure.
v Begin the installation at the primary site. Repeat these steps for the secondary

site when instructed to do so.
v All connections are completed using Fibre Channel cables of appropriate length.
v If you are adding the Remote Mirror Option hardware to an existing storage

subsystem environment that stops I/O from all host computers, begin with step
1. If this is a new storage subsystem installation, begin with step 2.

1. Power down all storage subsystems, host computers, Fibre Channel switches,
and all other hardware in the storage subsystem environment.

2. Make sure that the cabling between all storage subsystems and storage
expansion enclosures is complete.

Note: Depending on which site you are configuring, Switch 1 represents
Switch 1A for the primary site and Switch 1B for the secondary site. Repeat
the same configuration for Switch 2.

3. Connect the primary host bus adapter (Hx1) for each local host to an available
port in Zone 1 of Switch 1.

Note: You can connect the cables to any port in the proper zone of the switch.
4. Connect the secondary host bus adapter (Hx2) for each host at this site to an

available port in Zone 2 of Switch 2.
5. Connect controller port A1 of the storage subsystem to an available port in

Zone 1 of Switch 1.
6. Connect controller port B1 of the storage subsystem to an available port in

Zone 2 of Switch 2.
7. Connect controller port A2 of the storage subsystem to an available port in

Zone 3 of Switch 1.
8. Connect controller port B2 of the storage subsystem to an available port in

Zone 4 of Switch 2.

Note: Controller ports A2 and B2 are reserved for mirror relationship
synchronization when the Remote Mirror Option is activated. For more
information, see “Connectivity and I/O” on page 139.

9. If the primary site cabling and the secondary site cabling is complete, go to
step 10. Otherwise, repeat step 1 through step 8 for the secondary site.

10. Complete the Fabric 1 environment for Switch 1 by connecting Switch 1A with
Switch 1B. Connect each end of a long range Fibre Channel cable (that can
support a distance up to 10 Km (6.25 mi)) to an unzoned port in each switch.

11. Repeat step 10 for Switch 2A and 2B to complete the Fabric 2 environment for
Switch 2.

12. Cabling for this Highest Availability Campus configuration is complete.
Repeat step 3 through step 9 for any additional storage subsystems that use
the Remote Mirror Option.

13. Power on all storage subsystems, host computers, Fibre Channel switches, and
any other hardware at both sites that were powered down in step 1.

14. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to “Installing the
software” on page 168.
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Campus configuration
The Campus configuration offers the same functionality as the Highest Availability
Campus configuration, but contains only one switch at each site, rather than two.
The configuration is still redundant for host bus adapters, controllers, and remote
logical drive mirroring ports, but is a single point of failure for Fibre Channel
switches. If a switch at either site fails, the Remote Mirror Option cannot function.
For this reason, the Highest Availability Campus configuration is preferred for total
environment redundancy. Figure 58 shows the Campus configuration after
installation is complete.

Use Metro Mirroring (synchronous write mode) for distance less than 10 km and
Global Mirroring for distance of greater than 10 km. Additional hardware and/or
Fibre Channel switch licensing might be required to support distances greater than
10 km.

Important: Establish one-to-one zones between the storage subsystems in the
mirrored pair. The zoning and cabling procedures described in this section are for
illustrative purposes only, and might not show one-to-one zoning. Adjust the
procedures for your specific Campus installation.

Figure 58. Campus configuration
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Switch zoning for the Campus configuration
This configuration provides a separate zone for each reserved port for the Remote
Mirroring Option.

For an example of how to zone the Fibre Channel switches, see “Switch zoning for
the Highest Availability Campus configuration” on page 157. Remember that the
Campus configuration uses two Fibre Channel switches and one 10Km (6.2 mi)
ISL.

There are a total of four zones in this configuration.
v All zones exist on the Fabric 1 environment (Switch 1A at the primary site, and

Switch 1B at the secondary site).
v Zone 3 and Zone 4 are reserved for the dedicated Remote Mirror Option

connections.

Important: The Fibre Channel switches in Figure 58 on page 161 contain 16 ports
each, which leaves many unused ports per switch. If you are performing switch
zoning using the Fibre Channel host port number, instead of the WWNN of the
SAN fabric logged-in ports, do not include Fibre Channel switch ports with no
Fibre Channel connections in the zone definition. If you include these unused ports
in your zones, unauthorized access to the SAN might result.

Before proceeding to the next section, make sure that both Fibre Channel switches
are properly zoned. For more information about zoning Fibre Channel switches,
see “Switch zoning overview” on page 153.

Cabling examples for the Campus configuration
Table 12 and Table 13 on page 163 show examples of the Fibre Channel cabling
connections in the Campus configuration. See the examples before you complete
the procedure in “Setting up the Campus configuration” on page 163.

Important: Establish one-to-one zones between the storage subsystems in the
mirrored pair. The examples shown in these tables are for illustrative purposes
only, and do not show one-to-one zoning.

Table 12. Campus configuration connections (Primary site)

Primary site

Switch 1A

Zone Port Connection to and from:

1 0 Host 1, HBA 1

1 Controller port A1

2 Host 2, HBA 1

3 Additional host, HBA 1 (optional)

4 Additional host, HBA 1 (optional)

5 Additional host, HBA 1 (optional)
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Table 12. Campus configuration connections (Primary site) (continued)

Primary site

2 6 Host 1, HBA 2

7 Controller port B1

8 Host 2, HBA 2

9 Additional host, HBA 2 (optional)

10 Additional host, HBA 2 (optional)

11 Additional host, HBA 2 (optional)

3 12 Controller port A2 (dedicated remote mirror port)

4 13 Controller port B2 (dedicated remote mirror port)

N/A 14 Spare

N/A 15 Uplink with Switch 2

Table 13. Campus configuration connections (Secondary site)

Secondary site

Switch 1B

Zone Port Connection to and from:

1 16 Uplink with Switch 1

17 Spare

18 Host port, HBA 1

19 Controller port A1

20 Host 4, HBA 1

21 Additional host, HBA 1 (optional)

22 Additional host, HBA 1 (optional)

23 Additional host, HBA 1 (optional)

2 24 Host 3, HBA 2

25 Controller port B1

26 Host 4, HBA 2

27 Additional host, HBA 2 (optional)

28 Additional host, HBA 2 (optional)

29 Additional host, HBA 2 (optional)

3 30 Controller port A2 (dedicated remote mirror port)

4 31 Controller port B2 (dedicated remote mirror port)

Setting up the Campus configuration
Complete the steps in this procedure to set up the Campus configuration for the
Remote Mirror Option.

Before you begin, note the following information:
v Establish one-to-one zones between the storage subsystems in the mirrored pair.

The zoning and cabling procedures described in this section are for illustrative
purposes only, and might not show one-to-one zoning. Adjust the procedures for
your specific Campus installation.

v See Figure 58 on page 161 as you complete the steps in this procedure.
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v Begin the installation at the primary site. Repeat these steps for the secondary
site when instructed to do so.

v All connections are completed using Fibre Channel cables of appropriate length.
v If you are adding Remote Mirror Option hardware to an existing storage

subsystem environment that stops I/O from all host computers, begin with step
1. If this is a new storage subsystem installation, begin with step 2.

1. Power down all storage subsystems, host computers, Fibre Channel switches,
and all other hardware in the storage subsystem environment.

2. Make sure that the basic cabling between all storage subsystems and storage
expansion enclosures is complete.

Note: Depending on which site is configured, Switch 1 represents Switch 1A
for the primary site, and Switch 1B for the secondary site.

3. Connect the primary host bus adapter (Hx1) for each host at this site to an
available port in Zone 1 of Switch 1.

Note: You can connect the cables to any port in the proper zone of the switch.
4. Connect the secondary host bus adapter (Hx2) for each host at this site to an

available port in Zone 2 of Switch 1.
5. Connect controller port A1 of the storage subsystem to an available port in

Zone 1 of Switch 1.
6. Connect controller port B1 of the storage subsystem to an available port in

Zone 2 of Switch 1.
7. Connect controller port A2 of the storage subsystem to an available port in

Zone 3 of Switch 1.
8. Connect controller port B2 of the storage subsystem to an available port in

Zone 4 of Switch 1.

Note: Controller ports A2 and B2 are reserved for mirror relationship
synchronization when the Remote Mirror Option is activated. For more
information, see “Connectivity and I/O” on page 139.

9. The primary site cabling is now complete. If the secondary site cabling is
complete, go to step 10. Otherwise, repeat step 1 through step 8 for the
secondary site.

10. Complete the Fabric 1 environment by connecting Switch 1A with Switch 1B.
Connect each end of a long range Fibre Channel cable (that can support a
distance of up to 10 Km [6.25 mi]) to an unzoned port in each switch.

11. Cabling for this Campus configuration is complete. Repeat step 3 through step
9 for any additional storage subsystems that use the Remote Mirror Option.

12. Power on all storage subsystems, host computers, Fibre Channel switches, and
any other hardware at both sites that were powered down in step 1.

13. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to “Installing the
software” on page 168.

Intra-site configuration
This configuration is similar to the Campus configuration in that there are only
two Fibre Channel switches. However, no multiple-switch fabrics exist in this
configuration. This configuration is used in environments where a long distance
fabric is not required due to the close proximity of the host computers and storage
subsystems. The configuration is still redundant for host bus adapters, controllers,
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remote logical drive mirroring ports, and Fibre Channel switches, but is a single
point of failure for the site. For this reason, the Highest Availability Campus
configuration is preferred for total environment redundancy.

Important:

v A switch failure in this configuration does not affect data access; however, an
unsynchronized mirror state might occur as a result.

v Establish one-to-one zones between the storage subsystems in the mirrored pair.
The zoning and cabling procedures described in this section are for illustrative
purposes only, and might not show one-to-one zoning. Adjust the procedures for
your specific Intra-site installation.

Figure 59 shows the Intra-site configuration after installation is complete.

Switch zoning for Intra-site configuration
Intra-site configuration is designed for switch redundancy. However, the Fibre
Channel switches are not cascaded, and therefore are independent of each other.
This configuration provides a separate zone for each reserved port for the Remote
Mirror Option.

Figure 59. Intra-site configuration
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For an example of how to zone the Fibre Channel switches, see “Switch zoning for
the Highest Availability Campus configuration” on page 157. Remember that the
Intra-site configuration uses two Fibre Channel switches but does not use any
10Km (6.2 mi) ISLs.

Important: The Fibre Channel switches in Figure 59 on page 165 contain 16 ports
each, which leaves many unused ports per switch. If you are performing switch
zoning using the Fibre Channel host port number, instead of the WWNN of the
SAN fabric logged-in ports, do not include Fibre Channel switch ports with no
Fibre Channel connections in the zone definition. If you include these unused ports
in your zones, unauthorized access to the SAN might result.

Note: Figure 59 on page 165 illustrates that there is no relationship between Zone
A and Zone B in Switch 2 and Zone 1 and Zone 2 in Switch 1.

There are a total of four zones in this configuration.
v Zone 1 and Zone 2 exist on Switch 1
v Zone A and Zone B exist on Switch 2

Before proceeding to the next section, make sure that both Fibre Channel switches
are properly zoned. For more information about zoning Fibre Channel switches,
see “Switch zoning overview” on page 153.

Cabling examples for the intra-site configuration
Table 14 shows examples of the Fibre Channel cabling connections in the intra-site
configuration. See the examples before you complete the procedure in “Setting up
the Intra-site configuration” on page 167.

Important: Establish one-to-one zones between the storage subsystems in the
mirrored pair. The examples shown in these tables are for illustrative purposes
only, and do not show one-to-one zoning.

Table 14. Intra-site configuration connection

Switch 1 Switch 2

Zone Port Connection to and from: Zone Port Connection to and from:

1 0 Host 1, HBA 1 (HA1) A 0 Host 1, HBA 2 (HA2)

1 Controller port A1 (primary
storage subsystem)

1 Controller port B1 (primary
storage subsystem)

2 Host 2, HBA 1 (HB1) 2 Host 2, HBA 2 (HB2)

3 Controller port A1 (secondary
storage subsystem)

3 Controller port B1 (secondary
storage subsystem)

4 Host 3, HBA 1 (HC1) 4 Host 3, HBA 2 (HC2)

5 Additional host, HBA 1 (optional) 5 Additional host, HBA 2
(optional)

6 Host 4, HBA 1 (HD1) 6 Host 4, HBA 2 (HD2)

7 Additional host, HBA 1 (optional) 7 Additional host, HBA 2
(optional)
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Table 14. Intra-site configuration connection (continued)

Switch 1 Switch 2

2 8 Unused B 8 Unused

9 Controller port A2 (primary
storage subsystem - dedicated
remote mirror port)

9 Controller port B2 (primary
storage subsystem -
dedicated remote mirror
port)

10 Unused 10 Unused

11 Controller port A2 (secondary
storage subsystem - dedicated
remote mirror port)

11 Controller port B2 (secondary
storage subsystem -
dedicated remote mirror
port)

12 Unused 12 Unused

13 Unused 13 Unused

14 Unused 14 Unused

15 Unused 15 Unused

Setting up the Intra-site configuration
Complete the steps in this procedure to set up the Intra-site configuration for the
Remote Mirror Option.

Before you begin, note the following information:
v Establish one-to-one zones between the storage subsystems in the mirrored pair.

The zoning and cabling procedures described in this section are for illustrative
purposes only, and might not show one-to-one zoning. Adjust the procedures for
your specific Intra-site installation.

v See Figure 59 on page 165 as you complete the steps in this procedure.
v Begin the installation at the primary site. Repeat these steps for the secondary

site when instructed to do so.
v All connections are completed using Fibre Channel cables of appropriate length.
v If you are adding Remote Mirror Option hardware to an existing storage

subsystem environment that stops I/O from all host computers, begin with step
1. If this is a new storage subsystem installation, begin with step 2.

1. Power down all storage subsystems, host computers, Fibre Channel switches,
and all other hardware in the storage subsystem environment.

2. Make sure that the basic cabling between all storage subsystems and storage
expansion enclosures is complete on both storage subsystems.

3. Connect the primary host bus adapter for each host (Hx1) to an available port
in Zone 1 of Switch 1.

Note: You can connect the cables to any port in the proper zone of the switch.
4. Connect the secondary host bus adapter (Hx2) for each host to an available

port in Zone A of Switch 2.
5. Connect controller port A1 of the primary storage subsystem to an available

port in Zone 1 of Switch 1.
6. Connect controller port B1 of the primary storage subsystem to an available

port in Zone A of Switch 2.
7. Connect controller port A2 of the primary storage subsystem to an available

port in Zone 2 of Switch 1.
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8. Connect controller port B2 of the primary storage subsystem to an available
port in Zone B of Switch 2.

Note: Controller Ports A2 and B2 are reserved for mirror relationship
synchronization when the Remote Mirror Option is activated. For more
information, see “Connectivity and I/O” on page 139.

9. Connect controller port A1 of the secondary storage subsystem to an available
port in Zone 1 of Switch 1.

10. Connect controller port B1 of the secondary storage subsystem to an available
port in Zone A of Switch 2.

11. Connect controller port A2 of the secondary storage subsystem to an available
port in Zone 2 of Switch 1.

12. Connect controller port B2 of the secondary storage subsystem to an available
port in Zone B of Switch 2.

13. Cabling for this Intra-site configuration is complete. Repeat step 3 on page 167
through step 12 for any additional storage subsystems that use the Remote
Mirror Option.

14. Power on all storage subsystems, host computers, Fibre Channel switches and
any other hardware that was powered down in step 1 on page 167.

15. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to “Installing the
software.”

Installing the software
The Remote Mirror Option is a premium feature that is included as part of the
Storage Manager installation. You must purchase an Storage Manager Remote
Mirror Option for each storage subsystem in your remote mirror configuration.
This option contains a GenKey file that will enable the Remote Mirror Option. If
you want to purchase the Remote Mirror Premium Feature option, contact your
IBM technical-support representative.

Important: All storage subsystems participating in mirror relationships must have
firmware level 05.2x.xx.xx or later installed. For more information about upgrading
firmware and installing the storage-management software, see the appropriate IBM
System Storage DS® Storage Manager Version 10 Installation and Support Guide for
your operating system.

For a checklist to make sure that all the required software components are
configured properly, see “Hardware and software checklists” on page 171.

For more information about enabling or activating the Remote Mirror Option, see
“Enabling and activating the Remote Mirror Option.”

Enabling and activating the Remote Mirror Option
The Remote Mirror Option premium feature key must be purchased before you
can enable the option. The option must be activated with a GenKey program
before you can create any mirror relationships. First, determine the status of the
Remote Mirror Option. Then enable and activate it.

Determining Remote Mirror Option status
There are four possible statuses of the Remote Mirror Option:
v Disabled/Deactivated
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v Disabled/Activated

v Enabled/Deactivated

v Enabled/Activated

Important: The Remote Mirror Option must be in the Enabled/Activated state on
the secondary storage subsystem as well as the primary storage subsystem to
create and maintain mirror logical drive pairs.

You can determine the current status by hovering the mouse pointer over the
Remote Mirror option icon in the status area of the Subsystem Management
window, as shown in Figure 60.

Important: The Remote Mirror Option status for the primary storage subsystem is
managed independently from the secondary storage subsystem. To determine the
status for both storage subsystems, select each storage subsystem independently,
then determine the status.

The Remote Mirror Option statuses are as follows:

Disabled and deactivated
No function of the Remote Mirror Option can be performed. Full Remote
Mirror Option functionality is not available until the option is enabled and
activated. The icon for this state displays in the Premium Feature status
area as a cylinder with a mirrored reflection. The icon has a red slash
through it to show it is disabled and deactivated. An example of this state
is shown in Figure 60.

Disabled and activated

The Remote Mirror Option is disabled, preventing new mirror relationships
from being created. However, any pre-existing mirror relationships are
maintained with all functions of the Remote Mirror Option. The icon that
displays for this state is similar to the disabled and deactivated state,
because the red slash remains to show the option is disabled. However, the
cylinder and its reflection are green to show that the option is active.

Enabled and deactivated
The Remote Mirror Option is enabled, but not activated. The icon that
displays for this state is similar to the disabled and deactivated state,

Remote Logical Drive Mirroring - Disabled/Deactivated

Logical Drive Group 4 (RAID 5)

Logical Drive Group 5 (RAID 5)

5 (84.602 GB)

6 (67.681 GB)

SJ001117

Figure 60. Remote Mirror Option status
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because the cylinder and its reflection remain gray indicating that it is not
available. However, there is no red slash, indicating that the option is
enabled.

Enabled and activated
The Remote Mirror Option is enabled and active. You can create and
maintain mirror relationships. The icon for this state displays in the
Premium Feature status area as a green cylinder with a mirrored reflection.

Enabling the Remote Mirror Option
If the current status of the Remote Mirror Option is Disabled/Deactivated or
Disabled/Activated, complete the following steps to enable the Remote Mirror
Option.

To enable the Remote Mirror Option, you must complete the following two
procedures in the following order:
1. Obtain the feature enable identifier. This procedure is described in detail in

“Obtaining the feature enable identifier using firmware version 6.xx.xx or
earlier” on page 7.

2. Generate the feature key file and enable the Remote Mirror Option. This
procedure is described in detail in “Generating the feature key file” on page 8.

Before you begin, gather the following information:
v Your Feature Activation Code, which is printed on the IBM Remote Mirror

premium feature web activation instructions.
v Your controller unit IBM serial number, machine type, and model number, which

are printed on a black label on the front-left mounting flange of the controller.

Note: To see the mounting flange, you must remove the front bezel.
v The 32 alphanumeric-character feature enable identifier (see “Obtaining the

feature enable identifier using firmware version 6.xx.xx or earlier” on page 7).

To obtain the storage subsystem feature enable identifier, make sure that your
controller unit and storage expansion enclosures are connected, powered on, and
managed using the SMclient.

If the Remote Mirror Option has not been activated, go to “Activating the Remote
Mirror Option.” If the Remote Mirror Option is activated, go to “Creating mirror
relationships” on page 177.

For more detailed steps on how to enable the Remote Mirror Option, see “Enabling
the VolumeCopy feature” on page 94. For information on how to view a list of
those premium features that are enabled on your storage subsystem, see “Verifying
that the premium feature is enabled using firmware version 6.xx.xx or earlier” on
page 8.

Activating the Remote Mirror Option
Activating the Remote Mirror Option prepares the storage subsystem to create and
configure mirror relationships. When the option is activated, ports A2 and B2 of
the storage controller are reserved and dedicated to Remote Mirror Option usage.
In addition, a mirror repository logical drive is created for each controller in the
storage subsystem.

If the current status of the Remote Mirror Option is Enabled/Deactivated, complete
the following steps to activate the option:
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1. In the Subsystem Management window, click Storage subsystem → Remote
Mirroring → Activate.
The Activate Remote Logical Drive Mirroring - Introduction window opens.

Note: Click Back at any time to change the information in the previous
window.

2. Decide where the mirror repository logical drives will reside. Select one of the
following
v Use free capacity on existing arrays - If this option is selected, then a

corresponding logical drive must also be selected.
a. Select a logical drive.
b. Select Finish or Next.
c. Go to step 6.

v Create a new array using unconfigured capacity - If this option is selected,
more information must be collected about the new logical drive. Go to step
3.

3. In the Create New Array window, select the RAID level for the new logical
drive.

4. Under the drive selection choices, select one of the following:
v Automatic - The drives are chosen automatically according to available

capacity.
v Manual - This option gives you the option to specify which drives contain

the mirror repository logical drive.
a. Press and hold the Ctrl key and click to select the drives that you want to

include in your array.
b. Click Apply.
Important: If the RAID level for the new array is RAID 1, then the number of
drives must be an even number. If an odd number of drives are selected, an
error message displays when you click Apply.

5. Click Next.
6. Review the information in the Preview window and click Finish if all

information is satisfactory.
7. If the storage subsystem password is protected, type the password and click

OK.
If the storage subsystem password is not protected, go to step 8

8. Review the information in the Completed window and click OK to finish the
Remote Mirror Option activation.
The Remote Mirror Option must be enabled and activated on all storage
subsystems that are part of a remote mirror setup. When the Remote Mirror
Option is activated, the icon in the Premium Feature status area changes from
gray to green. If this is not the case, repeat the steps in “Enabling and
activating the Remote Mirror Option” on page 168 and step 1 through step 8 of
this procedure for each storage subsystem that has the remote mirror option
disabled and deactivated.

9. Continue with “Creating mirror relationships” on page 177.

Hardware and software checklists
Complete the hardware checklist in Table 15 on page 172 and the software checklist
in Table 16 on page 172 to make sure that all the required hardware and software
components are configured properly.
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Hardware checklist
Complete the tasks in Table 15 before you configure the Remote Mirror Option
using the storage management software.

Table 15. Hardware checklist

Task description Validation activity

Make sure that the minimum hardware requirements are met.
For a complete list of the hardware requirements, see “Hardware
requirements” on page 151.

h Completed

Configure your primary and secondary storage subsystems. See
the appropriate storage subsystem Installation and User’s Guide for
configuration information and see “Installing the hardware” on
page 155.

h Completed

Configure your Fibre Channel switches and cables. For more
information about configuring the Fibre Channel switches to use
with the Remote Mirror Option, see “Installing the hardware” on
page 155.

h Completed

Software checklist
Complete the tasks in Table 16 before you define mirror relationships in your
storage subsystems.

Table 16. Software checklist

Task description Validation activity

Back up all data on the primary and secondary storage
subsystems that are participating in remote logical drive
mirroring.

h Completed

Install the correct version of firmware and storage-management
software. For more information about upgrading firmware or
installing the storage management software, see the appropriate
Storage Manager Installation and Support Guide or the
Subsystem Management window online help.

h Completed

Enable the Remote Mirror Option on both the primary and
secondary storage subsystems. For information about enabling
the feature, see “Enabling and activating the Remote Mirror
Option” on page 168.

h Completed

Activate the Remote Mirror Option and create a mirror
repository logical drive for each controller on the primary
storage subsystem. For more information about activating the
Remote Mirror Option, see “Enabling and activating the Remote
Mirror Option” on page 168.

h Completed

Create the required primary and secondary logical drives on the
primary and secondary storage subsystems. For more
information about establishing a mirror relationship, see
Chapter 11, “Using the Enhanced Remote Mirroring Option,” on
page 175.

h Completed

Verifying installation and configuration
All hardware and software is now set up to support mirror relationships through
the Remote Mirror Option. However, before creating mirror relationships, make
sure that all required components are working properly.

172 IBM System Storage DS Storage Manager Version 10: Copy Services User's Guide



Complete the following procedure for each storage subsystem that is participating
in any aspect of a mirror relationship to verify correct configuration:
1. Start the storage management software. For more information about starting

the storage management software, see the IBM System Storage DS Storage
Manager Version 10 Installation and Support Guide for operating system specific
procedures.
If this is the first time that you have started the storage management software,
go to step 2. If this is not the first time that you have started the storage
management software, go to step 3.

2. If this is the first time that you have started the storage management software,
complete the following steps::
a. Click OK when prompted for Automatic Discovery of devices.
b. Make sure that all the storage subsystems that are designated to

participate in mirror relationships are displayed in the Device Tree view of
the Enterprise Management window.

Note: If the storage subsystems do not display, see Chapter 16,
“Troubleshooting the Enhanced Remote Mirroring Option,” on page 217.

3. If this is not the first time that you have started the storage management
software, complete the following steps:
a. In the Enterprise Management Window, click Tools → Automatic

Discovery.
b. Click OK.
c. Verify that all the storage subsystems that are designated to participate in

mirror relationships are displayed in the Device Tree view of the
Enterprise Management window.

Note: If the storage subsystems do not display, see Chapter 16,
“Troubleshooting the Enhanced Remote Mirroring Option,” on page 217.

4. In the Enterprise Management window, select a storage subsystem that will
participate in mirror relationships.

5. Click Tools → Manage Device to open the Subsystem Management window
for that storage subsystem.

6. In the Subsystem Management window, click Help → About.
7. Verify that the version of the storage management software is 08.3x.xx.xx or

later. If this requirement is not met, see the procedures to upgrade the storage
management software in the IBM System Storage DS Storage Manager Version 10
Installation and Support Guide for your operating system.

8. Click OK.
9. In the Subsystem Management window, click Storage Subsystem → View

Profile.
10. Click the All tab, and verify that the current firmware version is 05.2x.xx.xx or

later. If this requirement is not met, see the procedures to upgrade the
firmware in the IBM System Storage DS Storage Manager Version 10 Installation
and Support Guide for your operating system.
When your installation is completed, see the following online help systems:
v Enterprise Management window help - Use this online help system to learn

more about working with the entire management domain.
v Subsystem Management window help - Use this online help system to learn

more about managing individual storage subsystems and Remote Mirror
Option.
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You can access these help systems from within the SMClient. In either a
Enterprise Management or Subsystem Management window, click Help or
press F1.

11. Click Close.
12. Observe the Remote Mirror Option icon in the status area. The icon

represents the Disabled and Deactivated status of the Remote Mirror Option.
13. To begin working with mirror relationships, go to Chapter 11, “Using the

Enhanced Remote Mirroring Option,” on page 175.
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Chapter 11. Using the Enhanced Remote Mirroring Option

This chapter contains the procedures for completing the major tasks that are
associated with the Remote Mirroring Option:
v “Upgrading mirror repository logical drives”
v “Creating mirror relationships” on page 177
v “Maintaining mirror relationships” on page 179
v “Deactivating and disabling the Remote Mirror Option” on page 185

Upgrading mirror repository logical drives
In previous versions of Storage Manager, the maximum number of logical drives
that could participate in mirror relationships was 32. Storage Manager, in
conjunction with storage subsystem controller firmware version 06.10.xx.xx or later,
allows 64 logical drives to participate in mirror relationships. Therefore, to support
creating more than 32 logical drives in mirror relationships, you need to upgrade
any existing mirror repository logical drives on the storage subsystem to have a
minimum capacity of 128 MB (increased from 4 MB). Because two mirror
repository logical drives are required per storage subsystem, a maximum of 256M
of disk space will be needed.

Note: You do not need to complete the steps in this section if Storage Manager
9.1x is the first time you have activated the Remote Mirror Option. Upgrading the
mirror repository logical drives is only required if a previous version of Storage
Manager existed on your system, with the Remote Mirror Option feature installed,
before you installed Storage Manager 9.1x.

Use the Upgrade Mirror Repository Logical Drives Wizard to create new, larger
mirror repository logical drives on your storage subsystem, then to move any data
from the existing mirror repository logical drives to the new ones, and then to
delete the old mirror repository logical drives.

Important:

1. If there is not enough free capacity or unconfigured capacity available on your
storage subsystem, you will not be able to upgrade your mirror repository
logical drives. The Free Capacity or Unconfigured Capacity options you select
for the mirror repository logical drives must have a total of 256 MB capacity
available. Two mirror repository logical drives are created on this capacity: one
for each controller.

2. For each mirrored pair that you upgrade, leave a minimum of 0.25 GB free
capacity in the same array as the mirror repository logical drives. If you
someday deactivate the mirrored pair, this will make sure that you have
enough capacity to reestablish the mirrored pair from the deactivated state.
Otherwise, if there is no free capacity available on the storage subsystem, you
might not be able to reestablish the mirrored pair.

Complete the following steps to upgrade the mirror repository logical drives:
1. Select Storage Subsystems → Remote Mirroring → Upgrade Mirror Repository

Logical Drives.
The Upgrade Mirror Repository Logical Drives: Introduction dialog window
opens.
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2. In the Upgrade Mirror Repository Logical Drives: Introduction dialog window,
select one of the following options, based on where the upgraded mirror
repository logical drives will reside:
v Free capacity on same array (create individual logical drive) – You must

also select a corresponding array.
a. Select an array.
b. Select Next.
c. Go to step 5.

v Free capacity on different array (create individual logical drive) – You must
also select a corresponding array.
a. Select an array.
b. Select Next.
c. Go to step 5.

v Unconfigured capacity (create new array) – If you select this option, the
Create New Array dialog window opens. Go to step 3 to create a new array.

3. In the Create New Array dialog, select the RAID level for the new array.

Note: If you need more detailed information about the options in this dialog
window, select the Help button to launch the online help that is specific to this
dialog window.

4. Under the drive selection choices, select one of the following options:
v Automatic – The drives are chosen automatically according to available

capacity. Click Next; the Preview dialog window opens.
v Manual – The user specifies which drives contain the mirror repository

logical drive, as follows:
– Select the desired drives. You can select multiple drives by pressing and

holding Ctrl while you select.
– Click Add to move the drives to the Selected Drives panel.
– Click Next. The Preview dialog window opens.
Important: If the RAID level for the new array is RAID 1, then you must
select an even number of drives. If you select an odd number of drives, an
error message will display when you click Apply. RAID 0 is not an option;
therefore, the number of drives that you select must always be greater than
one for all RAID levels. RAID 3 and RAID 5 require a minimum of three
drives.

5. Review the information that displays in the Preview dialog window, then click
Finish if all information is satisfactory.

Note:

a. If prompted for a password, enter the password and select OK.
b. The upgrade process might take a minute or longer to complete, depending

on the current workload of the storage subsystem. Any I/O activity to the
storage subsystem might be delayed during the upgrade process.

The Completed dialog window opens.
6. Review the information that displays in the Completed dialog window, then

click OK. The mirror repository logical drives are now upgraded, and the
storage subsystem can support up to 64 mirror relationships.
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7. Repeat step 1 on page 175 through step 6 on page 176 for the secondary
storage subsystem, and for any additional storage subsystems that contain
mirror repository logical drives that have not yet been upgraded.

Creating mirror relationships
Before you create mirror relationships, be sure that the Remote Mirroring Option is
enabled and activated.

Note: The secondary host ports on the storage subsystems are reserved for data
synchronization between a primary and secondary logical drive of a mirror
relationship.

Creating logical drives for mirror relationships
Before you create mirror relationships, be sure that logical drives exist at both the
primary and secondary storage subsystems. The logical drive of the remote mirror
pair that is presented to the host is the primary logical drive. The storage
subsystem that the primary drive resides in is called the primary storage
subsystem. Similarly, the storage subsystem that the secondary logical drive resides
in is called the secondary storage subsystem.

If a primary or secondary logical drive does not exist, you must create one on the
corresponding storage subsystem.

Consider the following when creating a logical drive:
v Create the primary and secondary mirrors on the same primary path.
v The secondary logical drive must be of equal or greater size than the primary

logical drive.
v The RAID level of the secondary logical drive does not have to be the same as

that of the primary logical drive.

For more information about creating logical drives, see the Subsystem Management
window online help.

When logical drives exist at both sites, you can create mirror relationships with the
Create Remote Mirror wizard.

Creating a mirror relationship using the Create Remote Mirror
wizard

Using the Create Remote Mirror wizard, you can create a mirror relationship
between a primary logical drive and a secondary logical drive. Before beginning
the wizard, make sure that the following requirements are met:
v The Remote Mirroring Option is enabled on both storage subsystems in which

the primary and secondary logical drives will reside.
v The Remote Mirroring Option is activated on both subsystems.
v The storage subsystems are connected through a proper Fibre Channel fabric

configuration.
v The size of the secondary logical drive is equal to or greater than the primary

logical drive.
v There are management connections to both the primary and secondary storage

subsystems. The Enterprise Management window must display both primary
and secondary storage subsystems in the management domain.
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v The remote Fibre Channel switch connections are made between the primary
and secondary storage subsystems. The Fibre Channel switches are zoned so that
the controller host ports are by themselves.

When these requirements are met, complete the following steps to create a mirror
relationship:
1. In the Logical/Physical view of the Subsystem Management window, select

the logical drive that will become the primary logical drive in the mirror
relationship.

2. Click Logical Drive → Remote Mirroring → Create.
3. Click Next.
4. Follow the instructions in the Select Remote Storage subsystem window.

The Create Remote Mirror window opens and displays starting requirements
that are similar to those listed at the beginning of this section.
a. Select the proper storage subsystem. The wizard displays all available

storage subsystems within the management domain that have the Remote
Mirroring Option enabled and activated.

b. Click Next. The Select Secondary Logical Drive window displays.
5. Select the logical drive that will become the secondary logical drive in the

mirror relationship. If there are no logical drives listed, the secondary storage
subsystem that you selected does not have logical drives with enough
capacity available to mirror the selected logical drive.

6. Click Next. The Set Write Mode window displays.
7. Select one of the following write modes:

v Synchronous
v Asynchronous

If you select Asynchronous mode, the "Add to write consistency group" check
box becomes available. Select the "Add to write consistency group" check box
if you want to define a Global Mirroring mirror pair (makes sure that write
operations to the secondary storage subsystem are completed in the same
order as on the primary storage subsystem) instead of a Global Copy mirror
pair. For more detailed descriptions of each type of write mode, see “Write
options” on page 133.

Note:

a. Synchronous remote mirroring is referred to as Metro Mirroring.
b. Asynchronous remote mirroring with the consistency group option is

referred to as Global Mirroring; without the consistency group option, it is
referred to as Global Copy.

c. Adding the mirrored pair to a write consistency group (Global Mirroring)
might impact host I/O performance.

d. For more information about write consistency groups, see “Write
consistency groups” on page 135 or “Changing the write mode” on page
184.

8. Click Next. The Select Synchronization Settings window displays.
9. Select the synchronization priority level.

Note: For more information about the synchronization priority level, see
“Changing the synchronization settings” on page 181.

10. Select the resynchronization method.
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Note: For more information about resynchronization methods, see
“Resynchronization methods” on page 137.

11. Click Finish.
12. If the remote storage subsystem is password protected, type the password and

click OK.
If the remote storage subsystem is not password protected, go to step 13.

13. If you do not exceed the maximum number of mirrored logical drive pairs
that can be created for the storage subsystem, you are prompted to create
another mirror logical drive pair by the Create Remote Mirror wizard. If you
do not want to create another mirror logical drive pair, click No and go to
step 14. Otherwise, complete the following steps:
a. Select the logical drive that will become the next primary logical drive.
b. Click Next.
c. Repeat step 4 on page 178 through step 13 for each additional mirror

relationship.
14. Review the information in the Completed window, then click OK to complete

the Create Remote Mirror wizard.

The primary and secondary logical drives are now displayed with the mirror
relationship icons, which will change slightly when the data synchronization is
completed. The amount of time that is required for the data to be synchronized
between the two logical drives varies proportionally to the size of the logical drive
being mirrored and storage subsystem I/O loads. After the synchronization is
complete, the icons change to the optimal state mirror relationship icons. Figure 61
shows how the icons display during and after data synchronization.

Note: To view all the icons that are associated with the Remote Mirror Option and
a description of their purpose, see the Subsystem Management window online
help.

New mirror relationship
with synchronizing data

Optional mirror relationship
with fully synchronized data

Primary Logical Drive (5 GB) Primary Logical Drive (5 GB)

Secondary Logical Drive Secondary Logical Drive

SJ001118

The mirror relationship is now created and optimal.

Maintaining mirror relationships
When a mirror relationship is active, you can modify certain attributes of the
relationship at any time. This section describes how to view information about the
mirror relationship, how to change the synchronization priority level, how to
remove a mirror relationship, and how to delete logical drives that are
participating in a mirror relationship.

Figure 61. Synchronizing and optimal mirror relationship icons
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Viewing mirror relationships
The mirror relationship that exists between the primary logical drive and the
secondary logical drive can be examined by various methods, such as using the
storage subsystem profile, the Mirroring Properties window, and the View
Associated Components window.

Displaying the storage subsystem profile
The storage subsystem profile is the most efficient way to view information about
any or all components of the storage subsystem. Details for all logical drives, such
as the primary, secondary, and mirror repository logical drives can all be easily
viewed through the storage subsystem profile. The storage subsystem profile also
contains specific information about components that are associated with mirror
relationships.

To display the storage subsystem profile, complete the following steps:
1. In the Subsystem Management window click Storage Subsystem → View

Profile.
2. Click the Logical Drives tab.

v To view information about the mirror relationships that exist on this storage
subsystem, click the Mirrors tab.

v To view information about the mirror repository logical drive, click the
Repositories tab.

Note: Click Save As to save all of the information that is shown in the storage
subsystem profile as a text (.txt) file. The Save Profile window that opens provides
the option of saving the current window, multiple windows, or the entire storage
subsystem profile.

The Mirroring Properties window
The Mirroring Properties window displays all the physical characteristics of a
single logical drive in the mirror relationship.

The window displays the same information as the storage subsystem profile for the
selected logical drive, but is specific only to that logical drive. The synchronization
progress displays if the selected logical drive is synchronizing data with another
logical drive in a newly defined mirror relationship or in an existing mirror
relationship after the broken mirror link is restored.

Complete the following steps for each logical drive that needs to be examined in
the mirror relationship:
1. Select the primary or secondary logical drive.
2. Click Logical Drive → Properties.
3. Click the Mirroring tab.

You can also use this procedure to view the synchronization progress of a
recently-created mirror relationship.

The View Associated Components window
The View Associated Components window provides a graphical representation of
the logical drives that are participating in the mirror relationship. Details are
provided for all components, rather than just the logical drive that was initially
selected.
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Complete the following steps to view all the associated components in a mirror
relationship, including primary, secondary, and mirror repository logical drives:
1. Select the primary or secondary logical drive in a mirror relationship.
2. Right-click and select View Associated Components.

The View Associated Components window opens.
3. Click Close to exit the window.

Changing the synchronization settings
The synchronization priority level of a mirror relationship defines the amount of
system resources that are used to synchronize the data between the primary and
secondary logical drives of a mirror relationship. If you select the highest priority
level for a mirror relationship, the data synchronization uses a high amount of
system resources to increase mirror performance, but might decrease performance
for all other functions, including other mirror relationships. If you select the lowest
synchronization level, there is less impact on complete system performance, but the
mirror relationship synchronization might be slower.

The setting for the resynchronization method defines whether the communication
between the primary and secondary logical drives is restored manually or
automatically after a communication interrupted.

To change the synchronization settings for a mirror relationship, complete the
following steps:
1. In the Logical/Physical view of the Subsystem Management window, select a

primary logical drive of a mirror relationship.
2. Click Logical Drive → Remote Mirroring → Change → Synchronization Settings.

The Change Synchronization Settings window opens. The primary logical drive
that you chose in step 1 is selected by default in the Select Logical Drives
field.

3. Select one or more logical drives.
4. Select the synchronization priority level. The five levels are Lowest, Low,

Medium, High, and Highest. All selected logical drives will change to the same
synchronization priority level.
For more information about the performance impact of the five priority
settings, see “General performance considerations” on page 146.

5. Select the resynchronization method. You can select Manual or Automatic.
For more information about the resynchronization methods, see
“Resynchronization methods” on page 137.

6. Click OK.
7. Click Yes when the Confirmation window opens.
8. Click OK when the Completed window opens.

Suspending a mirror relationship
Use the Suspend option to stop data transfer between a primary logical drive and
a secondary logical drive participating in a mirror relationship, without removing
the mirror relationship.

Suspending a mirror relationship enables you to control when the data on the
primary and secondary logical drives is synchronized. This helps reduce any
performance impact to the host application that might occur while any changed
data on the primary logical drive is copied to the secondary logical drive.
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When a mirror relationship is in a Suspended state, no attempt is made to contact
the secondary logical drive. Any writes to the primary logical drive are persistently
logged in the mirror repository logical drives. After the mirror relationship is
resumed, only the modified regions of the primary logical drive are written to the
secondary logical drive. The Suspend option can be used to backup a secondary
logical drive.

Attention: If the mirrored pair that you select to suspend is part of a write
consistency group, the system automatically suspends all mirrored pairs in the
write consistency group. Use the command line interface to resume single
write-consistent mirrored pairs. For more information about using the command
line interface, see the Enterprise Management Window online help. For more
information about write consistency groups, see “Write consistency groups” on
page 135.

Note:

1. Suspending a mirror relationship removes any Needs Attention status resulting
from communication failure between the primary and secondary logical drives.

2. Any data that is written to the primary logical drive will be logged while the
mirror relationship is suspended and will automatically be written to the
secondary logical drive when the mirror relationship is resumed. A full
synchronization will not be required.

3. The state of the remote logical drive mirror remains suspended until you use
the Resume option to resume synchronization activity.

Figure 62 shows a mirror relationship in Suspended state.

To suspend a mirror relationship, complete the following procedure:
1. In the Logical/Physical view of the Array Management Window, select a

primary logical drive of a mirror relationship.
2. Select Logical Drive → Remote Mirroring → Suspend. The Suspend Mirrored

Pair window opens.
3. Select one or more mirror relationships to suspend.
4. Click Suspend.
5. Carefully review the information that is presented in the Confirmation window.
6. If the information in the Confirmation window is correct, type Yes and click

OK.
Important: If the mirrored pair that you select to suspend is part of a write
consistency group, the system automatically suspends all mirrored pairs in the
write consistency group. Use the command line interface to resume single
write-consistent mirrored pairs. For more information about using the
command line interface, see the Enterprise Management Window online help.
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Mirror Repository 1 (0.125 GB)

Primary_Logical_Drive (5 GB)

Secondary_Logical_Drive (5 GB)

Mirror Repository 2 (0.125 GB)

Mirror Repository 1 (0.125 GB)

Secondary_Logical_Drive (5 GB)

Free Capacity (130.113 GB)

Suspended mirror relationship at
primary site

Suspended mirror relationship at
secondary site

Figure 62. Suspended mirror relationships at primary site and secondary site
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For more information about write consistency groups, see “Write consistency
groups” on page 135. The Suspend Mirrored Pair - Progress window displays
while the selected mirrored logical drives are suspended. After all of the
selected mirrored pairs are suspended, the OK button becomes available.

7. Click OK. The Subsystem Management window opens, showing the primary
and secondary logical drives in an Optimal/Suspended state.
For information about icons used for mirror relationships, see the Subsystem
Management window online help.

Resuming a mirror relationship
Use the Resume option to restart data transfer between a primary logical drive and
secondary logical drive participating in a mirror relationship, after the mirror has
been suspended or unsynchronized.

This option enables you to control when the data on the primary logical drive and
secondary logical drive is resynchronized. This helps reduce any performance
impact to the host application that might occur while any changed data on the
primary logical drive is copied to the secondary logical drive.

After the mirrored pair is resumed, only the regions of the primary logical drive
that changed since the mirrored pair was suspended are written to the secondary
drive.

Attention: If the mirrored pair that you select to resume is part of a write
consistency group, the system automatically resumes all mirrored pairs in the write
consistency group. Use the command line interface to resume single
write-consistent mirrored pairs. For more information about using the command
line interface, see the Enterprise Management Window online help. For more
information about write consistency groups, see “Write consistency groups” on
page 135.

Complete the following procedure to resume a suspended mirror relationship:
1. In the Logical/Physical view of the Subsystem Management Window, select a

primary logical drive of a mirror relationship.
2. Select Logical Drive → Remote Mirroring → Resume. The Resume Mirrored Pair

window opens.
3. Select one or more mirror relationships to resume.
4. Click Resume.
5. Carefully review the information that is presented in the Confirmation window.
6. If the information in the Confirmation window is correct, click Yes to resume

data transfer to the mirrored pairs that you selected. The Resume Mirrored Pair
- Progress window displays while data transfer is resumed to the selected
mirrored pairs. After data transfer is resumed to the mirrored pairs, the OK
button becomes available.

7. Click OK. The Subsystem Management Window opens, showing the primary
and secondary logical drive in an Optimal or Synchronizing state.

Removing mirror relationships
Removing a mirror relationship between a primary and secondary logical drive
does not affect any of the existing data on either logical drive. The link between
the logical drives is removed, but the primary logical drive still continues normal
I/O operation.
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This method is not for backup routines. Instead, suspend the mirror relationship,
because suspend operation maintains the mirror relationship. See “Suspending a
mirror relationship” on page 181 for more information about the suspend
procedure.

A mirror relationship between the two logical drives can be re-created unless one
of the logical drives is deleted.

Complete the following steps to remove a mirror relationship between two logical
drives:
1. In the Subsystem Management window, select a local primary or local

secondary logical drive of a mirror relationship.
2. Click Logical Drive → Remote Mirror → Remove Mirror Relationship.

The Remove Mirror Relationship window displays all mirror relationships that
are associated with this storage subsystem.

3. Select one or more mirror relationships to be removed, and click Remove.
4. Carefully review the information that is presented in the Confirmation window.
5. If all the information in the Confirmation window is correct, click Yes.

Changing the write mode
You can select one of the following two write modes:

Synchronous
Synchronous write mode offers the best chance of full data recovery from
the secondary storage subsystem in the event of a disaster. Metro Mirror
provides slower host I/O performance than Global Copy.

Remote mirroring using Metro Mirror is referred to as Metro Mirroring.

Asynchronous
Global Copy offers faster host I/O performance than Metro Mirror, but it
does not guarantee that data is successfully written to the secondary
logical drive before indicating a successful write to the host system.

Remote mirroring using Global Copy with the consistency group option is
referred to as Global Mirroring. Remote mirroring using Global Copy
without the consistency group option is referred to as Global Copy.

Complete the following steps to change the write mode of a mirror relationship:
1. From the Subsystem Management window, select a local primary logical drive

of a mirror relationship.
2. Select Logical Drive → Remote Mirror → Change → Write Mode. The Change

Write Mode window opens.
3. Select one or more mirrored pairs.
4. Select one of the following write modes:

v Synchronous
v Asynchronous

If you select Asynchronous mode, the "Add to write consistency group" check
box becomes available. Do not select the "Add to write consistency group"
check box if you want to define a Global Copy mirror pair (in which write
operations to the secondary storage subsystem are not required to be completed
in the same order as on the primary storage subsystem) instead of a Global
Mirroring mirror pair. For more detailed descriptions of each type of write
mode, see “Write options” on page 133.
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Note:

a. Synchronous remote mirroring is referred to as Metro Mirroring.
b. Asynchronous remote mirroring with the consistency group option is

referred to as Global Mirroring; without the consistency group option, it is
referred to as Global Copy.

c. Adding the mirrored pair to a write consistency group (Global Mirroring)
might impact host I/O performance.

d. For more information about write consistency groups, see “Write
consistency groups” on page 135.

Deleting primary and secondary logical drives
Deleting a logical drive that is participating in a mirror relationship removes the
mirror relationship and completely deletes the logical drive from the storage
subsystem. The mirror relationship cannot be redefined until you create a new
logical drive or an alternate logical drive replaces the deleted logical drive.

You cannot delete a secondary logical drive that is actively participating in a
mirror relationship. When you delete a primary logical drive, the mirror
relationship is removed, and the secondary logical drive becomes a standard
logical drive, which you can then delete.

Complete the following steps to delete a primary or secondary logical drive from a
mirror relationship:

Attention:

v If you have data or logical drives that you want to keep, do not click Recovery →
Reset → Configuration. This resets the controller unit and deletes all
previously-configured logical drives.

v You must use Disk Administrator and delete operating system logical drives
before you delete logical drives or reset the configuration in Storage Manager.
This avoids damage to your registry information.

v The following steps will permanently remove data from the selected logical
drive.
1. In the Subsystem Management window for the primary site, select a primary

logical drive.
2. Select Logical Drive → Delete.
3. The Delete Logical Drives window opens.
4. Select one or more logical drives to delete.
5. Click OK. The confirmation window opens.
6. Carefully review the information in the confirmation window. If all the

information is correct, type Yes in the text area and click OK.
7. In the Subsystem Management window for the secondary site, repeat these

steps to remove the secondary logical drive, if required.

Deactivating and disabling the Remote Mirror Option
If no mirror relationships exist and the Remote Mirror Option is no longer
required, you can deactivate the option to reestablish normal use of dedicated
ports on both storage subsystems and delete both mirror repository logical drives.

The Remote Mirror Option can also be disabled. When the option is in the
Disabled/Active state, you can still maintain and manage previously existing
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mirrors; however, you cannot create any new mirror relationships. When in the
Disabled/Deactivated state, no Remote Mirror Option activity occurs.

Note: When all capacity on a storage subsystem is used (no free capacity is
available), attempts to re-enable or reactivate a disabled/deactivated remote mirror
might fail with an error message indicating that there is not enough space
available for creating the remote mirror repository logical drives. Therefore, it is
best practice to leave a minimum of 0.25 GB free capacity for each mirrored pair.
The free capacity must be within the same array as the mirrored logical drives.
Alternatively, you can add additional capacity to the storage array, or delete a
logical drive from the array to create more space.

Deactivating the Remote Mirror Option
Complete the following steps to change the Remote Mirror Option status from
Enabled/Activated to Enabled/Deactivated or from Disabled/Activated to
Disabled/Deactivated:
1. Verify that all mirror relationships are removed. For more information, see

“Removing mirror relationships” on page 183.
2. Click Storage subsystem → Remote Mirror →Deactivate.
3. Carefully review the information that is presented in the Confirmation window.
4. If the information in the Confirmation window is correct, click Yes.

Disabling the Remote Mirror Option
Complete the following steps to change the Remote Mirror Option status from
Enabled/Deactivated to Disabled/Deactivated or from Enabled/Activated to
Disabled/Activated:

Attention: After you disable the Remote Mirror Option, you will need the
Enhanced Remote Mirroring premium key file to re-enable the feature. Make sure
that you have this key file to re-enable the Remote Mirror Option after you disable
it. Do not disable the Remote Mirror feature if you do not have this key file.
1. In the Subsystem Management window, click Storage subsystem → Features →

Disable.
2. Click Remote Mirror.
3. Click OK.
4. Carefully review the information that is presented in the Confirmation window.
5. If the information in the Confirmation window is correct, click Yes.
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Chapter 12. Overview of Enhanced Global Mirroring

This chapter provides a functional overview of the Enhanced Global Mirroring
premium feature.

Enhanced Global Mirroring is shipped with the controller firmware release 7.84
and later. You can enable this feature using a premium feature key. Fibre Channel
and low-cost fabric connectivity (iSCSI) is enabled on this feature. It creates a
temporary image on the primary logical drive to periodically synchronize with the
secondary logical drive. This minimizes the impact on non-high-speed networking
during peak hours. DS3500, DCS3700, and DCS3700 storage subsystems with
Performance Module Controllers, with controller firmware 7.84 and later, supports
Enhanced Global Mirroring. The DS3500 and DCS3700 storage subsystems can
have up to 32 mirror pairs, while the DCS3700 storage subsystems with
Performance Module Controllers can have up to 128 mirror pairs.

Overview of Enhanced Global Mirroring
The Enhanced Global Mirroring feature provides a controller-level, firmware-based
mechanism for data replication between a local site and a remote site. Enhanced
Global Mirroring is managed separately for each individual logical drive, which
enables you to associate a distinct remote mirrored logical drive with primary
logical drives on a given storage subsystem.

When write operations are performed on the primary logical drive of an Enhanced
Global Mirrored Pair, the modified data region of the primary logical drive is
tracked. Periodically, the firmware creates a new point-in-time image of the
primary logical drive and sends the changed data regions to the secondary logical
drive. When data synchronization completes, the system uses the point-in-time
images on the secondary logical drive to ensure that the data is maintained in a
consistent state.

To maintain data on a remote site, as a point-in-time, consistent copy of data on a
local site, an active Enhanced Global Mirroring session automatically completes the
following steps:
1. Enhanced Global Mirror Groups consisting of logical drives are created at the

local site.
2. Increments of consistent data are sent to the remote site.
3. Point-in-time copy operations are performed at the remote site.

The steps are repeated according to the defined synchronization intervals.

Note: Enhanced Global Mirroring supports both iSCSI and Fibre Channel (FC)
connections between storage subsystems.

Enabling Enhanced Global Mirroring premium feature activation

To enable the Enhanced Global Mirroring premium feature, apply the key, which
you purchased from the Technical Support representative, through the premium
features dialog.
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You must enable the premium feature on both the primary storage subsystem and
the remote storage subsystem. You also must activate the premium feature after
you enable it. If you are using a Fibre Channel connection, one Fibre Channel (FC)
host side I/O port on each controller is solely dedicated to Enhanced Global
Mirroring operations.

Host-initiated I/O operations are not accepted by the dedicated port. Only remote
controllers that run mirror operations can send I/O requests to this port.

An Enhanced Global Mirror group
An Enhanced Global Mirror Group contains several mirrored pairs, which are
composed of two logical drives, a primary logical drive and a secondary logical
drive. The Enhanced Global Mirror Group is associated with a local storage
subsystem and a remote storage subsystem that are used for mirroring.
v The local storage subsystem will be the primary side of the mirror group, while

the remote storage subsystem will be the secondary side of the mirror group.
v All logical drives added to the mirror group on the local storage subsystem

would hold the primary role in the mirror relationship.
v All logical drives added to the mirror group on the remote storage subsystem

would hold the secondary role in the mirror relationship.

Because applications might need to use more than one logical drive, Enhanced
Global Mirror Groups must be mirrored as a pair. All members of the Enhanced
Global Mirror Group are synchronized as a coordinated data set to provide a
consistent backup at the remote site.

You create an Enhanced Global Mirror Group to define the synchronization
settings for all mirrored pairs within the mirror group. Each mirrored pair in an
Enhanced Global Mirror Group share synchronization settings, primary and
secondary roles, and write mode.

Connectivity and logical drive ownership

The controller that owns the primary logical drive determines the current owner of
the secondary logical drive. The primary and secondary logical drives in a
mirrored pair use the following ownership rules:
v If the primary logical drive is owned by controller A on the primary side, the

secondary logical drive is owned by controller A on the secondary side.
v If the primary logical drive is owned by controller B on the primary side, the

secondary logical drive is owned by controller B on the secondary side.
v If primary controller A cannot communicate with secondary controller A,

controller ownership does not change. A primary controller attempts to
communicate only with its matching controller in the secondary Enhanced
Global Mirror Group.

The next remote write processed command automatically triggers a matching
ownership change on the secondary side if one of these conditions exists:
v When an I/O path error causes a logical drive ownership change on the primary

side.
v If the storage administrator changes the current owner of the primary logical

drive.

For example, a primary logical drive is owned by controller A, and then you
change the controller owner to controller B. In this case, the next remote write
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process automatically changes the controller owner of the secondary logical drive
from controller A to controller B. Because controller ownership changes on the
secondary side are controlled by the primary side, they do not require any special
intervention by the storage administrator.

Controller resets and storage subsystem power cycles

Sometimes a remote write is interrupted by a controller reset or a storage
subsystem power cycle before it can be written to the secondary logical drive. The
storage subsystem controller does not need to perform a full synchronization of the
mirrored pair in this case.

A controller reset causes a controller ownership change on the primary side from
the preferred controller owner to the alternate controller in the storage subsystem.

When a remote write has been interrupted during a controller reset, the new
controller owner on the primary side reads information stored in a log file in the
mirror repository logical drive of the preferred controller owner. The new
controller owner then copies the affected data blocks from the primary logical
drive to the secondary logical drive, eliminating the need for a full synchronization
of the mirrored logical drives.

An Enhanced Global Mirrored Pair and a mirror repository
An Enhanced Global Mirrored Pair is composed of two logical drives, a primary
logical drive and a secondary logical drive, that contain identical copies of the
same data. The mirrored pair is a part of an Enhanced Global Mirror Group, which
enables the mirrored pair to synchronize at the same time as any other mirrored
pairs within the mirror group. Write operations are performed first to the primary
logical drive and then to the secondary logical drive.

The two logical drives comprising the mirrored pair function as a single entity. As
a result, you can run operations on the entire mirrored pair instead of doing so on
the two individual logical drives.

Special mirror repository logical drives are used to manage mirror data
synchronization. Mirror repository logical drives are required for both the primary
and secondary logical drives in a mirrored pair.

For the Enhanced Global Mirroring premium feature, a mirror repository logical
drive is required for both the primary and secondary logical drives in a mirrored
pair. However, the Enhanced Remote Mirroring premium feature requires only a
single mirror repository, which is created during activation. It is used for all
Enhanced Remote Mirroring relationships. The controller stores mirroring
information about the mirror repository logical drive, which includes information
about remote writes that are not yet complete. You can use this information to
recover information from controller resets and the accidental shutting down of
storage subsystems.

Requirements for using Enhanced Global Mirroring

Note: You must have a dual-controller hardware configuration to use Enhanced
Global Mirroring.

Requirements for using Enhanced Global Mirroring are as follows:
v You must have two storage subsystems.
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v You must have write access to both storage subsystems.
v You must have enough space on the remote site for the remote copy of

production data.
v Mirror repository logical drives are required for both the primary and secondary

logical drives in a mirrored pair.
v Inter-controller communication for the Enhanced Global Mirroring feature uses

the host-connected ports to initiate connections to the remote storage subsystem
and is only supported on controllers with Fibre Channel or iSCSI host-connect
ports.

v SAS and InfiniBand are not supported as inter-subsystem communication
channels.

v Fibre Channel connection requirements:
– You must attach dedicated Enhanced Global Mirroring ports to a Fibre

Channel fabric environment. In addition, these ports must support the Name
Service.

– You can use a fabric configuration that is dedicated solely to the Enhanced
Global Mirroring ports on each controller. In this case, host systems can
connect to the storage subsystems using fabric.

– Fibre Channel Arbitrated Loop (FC-AL), or point-to-point configurations are
not allowed for inter-subsystem connections. FC-AL/P2P is for host
connections only. These configurations are independent of the dedicated
Enhanced Global Mirroring fabric.

– You can use a single Fibre Channel fabric configuration for both the Enhanced
Global Mirroring connectivity and for the host I/O paths to the controllers.

– The maximum distance between the local site and the remote site is 10 km
(6.2 miles), using single-mode fibre gigabit interface converters (GBICs) and
optical long-wave GBICs.

v iSCSI connection considerations:
– iSCSI does not require dedicated Enhanced Global Mirroring ports when

using Enhanced Global Mirroring.
– The iSCSI inter-controller communication must use a host-connect port and

not the management Ethernet port.
– The controller maintains a list of the remote storage subsystems to which the

iSCSI initiator attempts to establish a session. The first port that successfully
establishes an iSCSI connection is used for all subsequent communication
with that remote storage subsystem. If communication fails, a new session is
attempted using available ports.

v FC connection and iSCSI connection considerations:
– If both storage subsystems are connected with FC and iSCSI channels, only

one channel is used for mirroring.
– There is no failover from one channel to the other.
– If both storage subsystems are connected with FC and iSCSI connections, one

Enhanced Global Mirror Group can be mirrored over FC and the other
Enhanced Global Mirror Group can be mirrored over iSCSI.

Restrictions for using Enhanced Global Mirroring

The following restrictions apply to mirrored logical drive candidates and storage
subsystem mirrors:
v RAID level, caching parameters, and segment size can be different on the two

mirrored logical drives.
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v The secondary logical drive must be at least as large as the primary logical
drive.

v Only a standard logical drive can be used in a mirror relationship. FlashCopy
logical drives, Enhanced FlashCopy logical drives, and thin logical drives cannot
be used.

v A primary logical drive can be a source logical drive or a target logical drive in
a VolumeCopy. A secondary logical drive cannot be a source logical drive or a
target logical drive unless a role reversal was initiated after the copy has
completed. If a role reversal is initiated while a copy is in process, the copy fails
and cannot be restarted.

v A given logical drive might be used in only one mirror relationship.
v A logical drive used in a copy request cannot be used in a mirrored secondary

logical drive.
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Chapter 13. Comparing the mirroring premium features

Overview of the premium features

Enhanced Global Mirroring is suitable for running 24x7 operations. It is
network-efficient for scheduled processes, such as backup and archiving.

Enhanced Remote Mirroring is suitable for continuous replication between few
systems for business continuity. However, unlike Enhanced Global Mirroring, it is
not suitable for scheduled processes such as backup and archiving.

Table 17. Comparison between mirroring features.

Enhanced Global Mirroring Enhanced Remote Mirroring

Replication Method

Point-in-time - Mirroring is done on
demand or automatically according to a
user-defined schedule. Schedules can be
defined in minutes.

Continuous - Mirroring is automatically
executed continuously, copying data from
every host write.

Repository

Multiple - A repository is required for each
mirrored pair.

Single - A single repository exists for all
mirrored logical drives.

Synchronization

Writes only changed data - Differences
between the current point-in-time image and
the previous one are copied to the remote
storage subsystem.

Writes all data - All writes captured on the
primary logical drive are copied to the
secondary logical drive.

Communication

iSCSI and Fibre channel - Supports iSCSI
and Fibre Channel interfaces between
storage subsystems.

Fibre channel - Supports only Fibre Channel
interfaces between storage subsystems.

Distance

Unlimited - Provides support for unlimited
distances between the local storage
subsystem and the remote storage
subsystem. The distance is typically limited
only by the capabilities of the network and
the channel extension technology.

Restricted - Typically must be within about
10 km (6.2 miles) of the local storage
subsystem to meet latency and
application-performance requirements.

Creating logical drives in a mirroring relationship
Before you can use either Enhanced Global Mirroring or Enhanced Remote
Mirroring, you must enable and activate the feature on both the local storage
subsystem and the remote storage subsystem. If a logical drive does not exist on
either the local storage subsystem or the remote storage subsystem, you must
create the logical drives. Both the local storage subsystem and the remote storage
subsystem must have a primary logical drive and a secondary logical drive.
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When the primary and secondary logical drives are available, you can create a
mirrored pair. When the remote mirrored logical drive is first created, a full
synchronization automatically occurs. Data from the primary logical drive is
copied to the secondary logical drive.

Prerequisites for creating a mirror relationship
Ensure the following are met before you create a mirror relationship between two
storage subsystems.

Enhanced Global Mirroring

v The Enhanced Global Mirroring premium feature must be enabled and activated
on the local and remote storage subsystem that is used for mirroring.

v The local storage subsystem and the remote storage subsystem must be
connected through a proper Fibre Channel fabric or iSCSI interface.

v The remote storage subsystem must contain a logical drive and a mirrored
logical drive of the same capacity, so that the mirrored logical drive can be used
as the primary logical drive on the local storage subsystem.

v Ensure that you know the password for the local and the remote storage
subsystem.

Enhanced Remote Mirroring

v The Enhanced Remote Mirroring premium feature must be activated.
v The local storage subsystem must contain two mirror repository logical drives.
v The local storage subsystem must contain the primary logical drive, and the

remote storage subsystem must contain the secondary logical drive. If either of
the logical drives do not exist, you must create it before you can create the
remote logical drive mirror.

v The secondary logical drive must meet the following requirements:
1. The RAID level of the secondary logical drive need not be the same as the

RAID level of the primary logical drive.
2. The capacity of the secondary logical drive must be equal to or greater than the

capacity of the primary logical drive.

About mirror repository logical drives
For the Enhanced Global Mirroring premium feature, a mirror repository logical
drive is required for both the primary and secondary logical drives in a mirrored
pair. However, the Enhanced Remote Mirroring premium feature requires only a
single mirror repository, which is created during activation and is used for all
Enhanced Remote Mirroring relationships. The controller stores mirroring
information about the mirror repository logical drive, which includes information
about remote writes that are not yet complete. You can use this information to
recover information from controller resets and the accidental shutting down of
storage subsystems.

Capacity of the mirror repository logical drive
v You can create the mirror repository logical drive from the unused capacity of a

logical drive group or a disk pool.
v You can create a new logical drive group or a new disk pool and its member

mirror repository logical drive from the unused capacity of the storage
subsystem.
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v The Enhanced Remote Mirroring activation process creates mirror repository
logical drives of equal capacity. In a dual controller storage subsystem, the
default capacity of both mirror repository logical drives is either 128 MB or 256
MB. You can neither increase nor decrease the capacity.

v When you activate the Enhanced Remote Mirroring premium feature and create
the logical drive group and mirror repository logical drives from the unused
capacity of the storage subsystem, you select the RAID level. However, when
you create the mirror repository logical drives from an existing storage
subsystem, you need not select the RAID level.

v The Enhanced Global Mirroring process uses mirror repository logical drives to
manage data synchronization.

v For Enhanced Global Mirroring, the minimum mirror repository size is 0.02
percent of the base logical drive capacity or 32 MB; the maximum mirror
repository size is 101 percent of the base logical drive capacity.

v For Enhanced Global Mirroring, primary and secondary mirror repository
logical drives are not required to be the same size. Mirror repository logical
drives can be created on separate logical drive groups with different RAID
levels. However, mirror repository logical drives must have compatible security,
T10PI, and quality of service of the associated mirrored logical drive.

Attention: Since the data stored on the mirror repository logical drives is critical,
do not create mirror repository logical drives in an existing logical drive group that
has RAID level 0. If you create a new logical drive group for the mirror repository
logical drives, do not select RAID level 0.

Resynchronizing logical drives in a mirror relationship
The controllers manage data replication between the primary and secondary logical
drives in a mirrored pair and are transparent to host machines and applications.
When the controller owner of the primary logical drive receives a write request
from a host, the controller first logs information about the write to a mirror
repository logical drive and then writes the data to the primary logical drive. The
controller then initiates a write operation to copy the data to the secondary logical
drive on the remote storage subsystem.

If a link interruption or a logical drive error prevents communication with the
remote storage subsystem, the current owner of the primary logical drive changes
the status of the mirrored pair to Unsynchronized. The controller then sends an
I/O completion to the host that sent the write request. The host can continue to
issue write requests to the primary logical drive, but remote writes to the
secondary logical drive do not take place.

Resynchronization is done once connectivity between the controller owner of the
primary logical drive, and the controller owner of the secondary logical drive is
restored. Only the blocks of data that have changed on the primary logical drive
when the link was interrupted are copied to the secondary logical drive.

The following table describes two resynchronization methods:
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Table 18. Resynchronizing logical drives in a mirror relationship.

Method Description

Manual v This is the recommended method because
it enables you to manage the
resynchronization process in a way that
provides the best opportunity for
recovering data.

v For Enhanced Global Mirroring, manual
resynchronization causes immediate
resynchronization of data on all of the
mirrored pairs within the Enhanced
Global Mirror Group. For Enhanced
Remote Mirroring, manual
resynchronization causes immediate
resynchronization of data on the remote
mirror.

v If you choose Manual as the
synchronization method, you must use the
Manual Resynchronization option to
send updates of modified data from the
local storage subsystem to the remote
storage subsystem.

Automatic v The time specified in minutes from the
beginning of the previous update to the
beginning of the next update. For
example, if the synchronization interval is
set at 30 minutes, and the synchronization
process starts at 4:00 pm, the next one
starts at 4:30 pm. To change the automatic
synchronization interval from the default
of every 10 minutes, you can edit the
interval value, which is defined in
minutes.

v If a communication between the local
storage subsystem and the remote storage
subsystem fails, and a synchronization
interval was missed during that time
period, the controller owner of the
primary logical drive starts the
resynchronization process immediately
after communication has been restored.

Note: If you choose Automatic as the
synchronization method, you also can also
manually synchronize at any time using the
Manual Resynchronization option.

You might need to periodically test the communication between the primary and
secondary logical drives in a mirrored pair, especially after resynchronizing the
logical drives.

Reversing the roles in a mirror relationship
Enhanced Global Mirroring
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Use the Change Role option to perform a role reversal between Enhanced Global
Mirror Groups. You can either promote the selected Enhanced Global Mirror
Group to a primary role or change the selected Enhanced Global Mirror Group to a
secondary role.
v A suspended Enhanced Global Mirror Group resumes during the change role

operation.
v The role reversal change affects all mirrored pairs within the selected Enhanced

Global Mirror Group. For example, when a primary Enhanced Global Mirror
Group is changed to a secondary role, all the primary logical drives of the
mirrored pairs in that mirror group are also changed to secondary logical drives.

v If you are changing a primary Enhanced Global Mirror Group to a secondary
role and the current secondary Enhanced Global Mirror Group can be contacted,
the secondary Enhanced Global Mirror Group is automatically promoted to a
primary role in the mirror relationship. Likewise, if you are promoting a
secondary Enhanced Global Mirror Group to a primary role and the current
primary Enhanced Global Mirror Group can be contacted, the primary Enhanced
Global Mirror Group is automatically changed to a secondary role in the mirror
relationship.

v You also can use the Change Role option while using Recovery Guru to set a
dual primary Enhanced Global Mirroring option. To avoid dual primary
Enhanced Global Mirroring, wait until the connection between the storage
subsystems is operational to perform the role reversal.

Enhanced Remote Mirroring

If the primary logical drive in a remote logical drive mirror fails, you can reverse
the roles of the primary and secondary logical drives to transfer the data to the
restored logical drive. Reversing the roles promotes the secondary logical drive to
the role of primary logical drive and changes the primary logical drive to the role
of secondary logical drive in a remote logical drive mirror.

Attention: If you try to reverse roles between the secondary logical drive and the
primary logical drive while a logical drive copy is in progress, the role reversal
succeeds, but the logical drive copy fails and cannot be restarted.

Remember the following guidelines when performing a role reversal between
mirror groups:
v You cannot perform a VolumeCopy on a secondary logical drive in a remote

logical drive mirror. To create a logical drive copy of a secondary logical drive,
you must reverse the roles of the secondary logical drive and the primary logical
drive, and then perform the VolumeCopy on the new primary logical drive.

v While a remote logical drive mirror is synchronizing, you cannot perform a
VolumeCopy on either the primary or secondary logical drive.

v You can reverse roles from a primary to a secondary logical drive if the
secondary drive is smaller than the primary drive. However, the usable capacity
of the new secondary logical drive would equal the total capacity of the new
primary logical drive (which is the original secondary logical drive).

Removing the mirror relationship
Enhanced Global Mirroring

Use the Remove Mirrored Pair option to remove the mirror relationship between
the two logical drives in an Enhanced Global Mirroring relationship.
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Removing an Enhanced Global Mirrored Pair from an Enhanced Global Mirror
Group breaks the mirror relationship between the primary logical drive on the
local storage subsystem and the secondary logical drive on the remote storage
subsystem. Data on the logical drives is not affected. As a result of this operation,
the primary and secondary logical drives become standard, host-accessible,
non-mirrored logical drives.

Remember these guidelines when removing an Enhanced Global Mirrored Pair:
v This option is not available unless the Enhanced Global Mirror Group contains

mirrored pairs.
v This option is available either by selecting the individual mirrored pair itself, or

by selecting the associated Enhanced Global Mirror Group.
v The mirror relationship is first removed on the local storage subsystem and then

on the remote storage subsystem. Sometimes, the mirror relationship is
successfully removed on the local storage subsystem but cannot be removed on
the remote storage subsystem because of a communication problem. In this case,
an error message displays, which contains the names of the remote storage
subsystem with the orphaned mirrored pair and logical drive. To resolve the
problem, open the subsystem Management Window for the remote storage
subsystem, select the orphaned mirrored pair, and remove the mirror
relationship.

v Sometimes, the mirror relationship is successfully removed from the remote
storage subsystem, but not from the local storage subsystem. In this case, the
next synchronization operation from the primary logical drive to the secondary
logical drive causes the synchronization process to pause. The Logical pane of
the primary subsystem Management Window also shows an unresponsive
remote secondary logical drive. Remove the mirror relationship on the local
storage subsystem to correct the problem.

Enhanced Remote Mirroring

Use the Remove Mirror Relationship option to remove the mirror relationship
between the two logical drives in a Enhanced Remote Mirroring relationship.

Remember these guidelines when removing the mirror relationship between the
two logical drives.
v This option is not available unless defined mirror relationships exist on the

storage subsystem.
v This option does not delete the primary logical drive, secondary logical drive, or

the mirror repository logical drives that support Enhanced Remote Mirroring for
the storage subsystems. Data on the logical drives is not affected. As a result of
this operation, the primary and secondary logical drives become standard,
host-accessible, non-mirrored logical drives.

v This option is available only for the local logical drive (primary or secondary)
that is present in the storage subsystem that you are currently managing. This
option is not available if you select a remote secondary logical drive in the
Logical pane.

v The mirror relationship is first removed on the local storage subsystem and on
the remote storage subsystem. Sometimes, the mirror relationship is successfully
removed on the local storage subsystem but cannot be removed on the remote
storage subsystem because of a communication problem. In this case, an error
message displays the following information:
The name of the remote storage subsystem with the orphaned mirrored logical
drive
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The name of the logical drive
v To resolve the problem, open the subsystem Management Window for the

remote storage subsystem, select the specified logical drive, and remove the
mirror relationship.
Sometimes, the mirror relationship is successfully removed from the secondary
drive, but not the primary drive. In this case, the first I/O write to the primary
logical drive causes the mirror state to change to Unsynchronized. The Logical
pane of the primary subsystem Management Window also shows an
unresponsive remote secondary drive. Remove the mirror relationship on the
primary storage subsystem to correct the problem.
Sometimes, the mirror relationship is successfully removed on the primary drive,
but not on the secondary drive. In this case, there is no change to the
representation of the secondary logical drive in the secondary Logical pane in
the subsystem Management Window. Remove the mirror relationship on the
auxiliary storage subsystem to correct the problem, and make the logical drive
accessible by hosts.

Attention: Do not remove a mirror relationship to back up a mirrored logical
drive. To perform backups of either the primary or secondary logical drive,
suspend the remote logical drive mirror so that the mirror relationship is not
broken.

Suspending a mirrored pair
Enhanced Global Mirroring

Use the Suspend option to suspend data transfer between all mirrored pairs in an
Enhanced Global Mirror Group without removing the mirror relationship.

The Suspend option lets you suspend the synchronization of data on all mirrored
pairs at the Enhanced Global Mirror Group level. This option is more efficient than
suspending mirrored pairs individually. It helps to reduce any performance impact
on the host application that might occur while any changed data on the local
storage subsystem is copied to the remote storage subsystem.

When an Enhanced Global Mirror Group is suspended, no attempt is made to copy
data from the primary logical drives to the secondary logical drives of the mirrored
pairs. Any writes to the primary side of the Enhanced Global Mirror Group are
persistently logged in its associated mirror repository logical drives. After the
Enhanced Global Mirror Group is resumed, only the modified regions of the
primary logical drives are written to the secondary logical drives.

Note: The Suspend Enhanced Global Mirror Group option is available on the local
storage subsystem only. This option is not available on the remote storage
subsystem.
Remember these guidelines when you suspend an Enhanced Global Mirror Group:
v Any data that is written to the primary side of the Enhanced Global Mirror

Group is logged while the mirror group is suspended and is written
automatically to the secondary side of the Enhanced Global Mirror Group when
the mirror group is resumed. A full synchronization is not required.

v The state of the Enhanced Global Mirror Group and mirrored pairs stays
suspended until you use the Resume option to resume synchronization activity.

Enhanced Remote Mirroring
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Use the Suspend option to suspend data transfer between a primary logical drive
and a secondary logical drive without removing the mirror relationship.

The Suspend option lets you control data synchronization between the primary
and secondary logical drives. This option helps to reduce any performance impact
to the host application that might occur while any changed data on the primary
logical drive is copied to the secondary logical drive.

When a remote mirror is in a Suspended status, no attempt is made to contact the
secondary logical drive. Any writes to the primary logical drive are persistently
logged in the mirror repository logical drives. After the mirrored pair is resumed,
only the modified regions of the primary logical drive are written to the secondary
logical drive.

Attention: If the selected mirrored pair is part of a write consistency mode group,
all mirrored pairs are automatically suspended in the write consistency mode
group. Use the command line interface to resume single write-consistent mirrored
pairs.

Remember these guidelines when you suspend a mirrored pair:
v Any data that is written to the primary logical drive will be logged while the

mirrored pair is suspended, and will be written automatically to the secondary
logical drive when Enhanced Remote Mirroring is resumed. A full
synchronization is not required.

v The state of the remote mirror stays suspended until you use the Resume
Mirrored Pair option to resume synchronization activity.

Resuming a mirrored pair
Enhanced Global Mirroring

Use the Resume Enhanced Global Mirror Group option to resume data transfer
between all mirrored pairs in an Enhanced Global Mirror Group. Data written to
the primary logical drives while the Enhanced Global Mirror Group was
suspended is written to the secondary logical drives immediately. Periodic
synchronization resumes if an automatic synchronization interval has been set. The
Resume Enhanced Global Mirror Group option enables the user to resume
synchronization of data for all mirrored pairs at the Enhanced Global Mirror
Group level. After an Enhanced Global Mirror Group is resumed, only the
modified regions of the primary logical drives are written to the secondary logical
drives.

The Resume Enhanced Global Mirror Group option is available on the local
storage subsystem only. This option is not available on the remote storage
subsystem.

Enhanced Remote Mirroring

Use the Resume Enhanced Remote Mirroring dialog to resume data transfer
between a primary logical drive and a secondary logical drive participating in
Enhanced Remote Mirroring, after the mirror has been suspended or
unsynchronized. When a remote logical drive mirror is suspended, data continues
to read to the primary logical drive, but the data is not written to the secondary
logical drive. Writes to the primary logical drive are persistently logged into the
mirror repository logical drives
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After communications are restored in a remote logical drive mirror, data transfer
between the primary and secondary logical drives must be resynchronized. After
the remote logical drive mirror resumes, data is automatically written to the
secondary logical drive. Only the regions of the primary logical drive that changed
since the mirrored pair was suspended are written to the secondary logical drive.

Attention: When you resume a remote logical drive mirror, and either the
primary or secondary logical drive is a member of a write consistency group, all
other suspended remote logical drive mirrors for mirrored pairs in the write
consistency group also resumed.

Note: When the write mode is synchronous, you do not need to resynchronize the
primary and secondary logical drives after you resume the remote logical drive
mirror

Using other premium features with mirroring
You can use the mirroring premium features with the following premium features
that are enabled and active on the primary storage subsystem.
v SANshare Storage Partitioning
v FlashCopy logical drive
v VolumeCopy
v Dynamic Volume Expansion (DVE)

Using the SANshare storage partitioning premium feature with
Enhanced Remote Mirroring

The SANshare Storage Partitioning premium feature lets hosts share access to
logical drives in a storage subsystem. A storage partition is created when you
define a collection of hosts (a host group) or a single host, and then define a logical
drive-to-logical unit number (LUN) mapping. This mapping lets you define which
host group or host will have access to a particular logical drive in the storage
subsystem.

The storage partition definitions for the local storage subsystem and the remote
storage subsystem are independent of each other. If these definitions are put in
place while the secondary logical drive is in a secondary role, it reduces the
administrative effort that is associated with site recovery if it becomes necessary to
promote the logical drive to a primary role.

Using the FlashCopy logical drive premium feature with
mirroring

A FlashCopy logical drive is a point-in-time image of a logical drive. Do not mount
a FlashCopy logical drive on the same server on which the primary logical drive is
mounted in a remote logical drive mirror.

Using the VolumeCopy premium feature with mirroring

Attention: If a role reversal is started while a VolumeCopy is in progress, the
VolumeCopy will fail and cannot be restarted.

The VolumeCopy premium feature copies data from a source logical drive to a
target logical drive within the same storage subsystem.
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v A primary logical drive in a remote logical drive mirror can be either a source
logical drive or a target logical drive in a logical drive copy.

v You can create a VolumeCopy on the primary logical drive in a mirrored pair,
but you cannot create a VolumeCopy on a secondary logical drive in a mirrored
pair. You can make a copy of a secondary logical drive in two ways:
Promote the secondary logical drive to the role of primary logical drive.
Create a FlashCopy logical drive of the secondary logical drive, and then
perform a VolumeCopy on the FlashCopy logical drive.

Using the Dynamic Volume Expansion premium feature with
mirroring

Dynamic Volume Expansion (DVE) increases the capacity of a logical drive. The
increased capacity is achieved by using the free capacity that is available on the
logical drive group of the standard logical drive or the FlashCopy repository
logical drive.

Performing a DVE operation does not interrupt access to data on logical drive
groups, logical drives, or drives.

You can perform a DVE operation on a primary logical drive or a secondary
logical drive of a mirrored pair. However, you cannot perform a DVE operation on
a mirror repository logical drive.

Note: To perform a DVE operation, the remote logical drive mirror must be in
Optimal status. The Properties pane in the Logical view shows the status of a
logical drive.
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Chapter 14. Using the Enhanced Global Mirroring option

Note: Before creating mirror relationships, ensure that the Enhanced Global
Mirroring option is enabled.

Check mirroring connectivity result
1. In the Subsystem Management window, click Copy Services > Mirroring >

View Mirroring Port Connections.
2. Select the subsystem would be used in the remote storage subsystem.

Note: The remote storage subsystem name would be displayed if it is detected
from the fabric and followed by fabric name for Fibre or iSCSI.

3. Click Start to validate the connections.

4. A green check and the storage subsystem connectivity topology will be
displayed in the results screen, if the setup environment is qualified for
Enhanced Global Mirroring.

5. Close the window to complete the check.
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Figure 63. Viewing mirroring port connections
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Activate Enhanced Global Mirroring
1. In Subsystem Management Window, click Copy Services > Mirroring >

Activate.
2. Select Enhanced Global Mirroring then click Finish to complete the activation.

3. Repeat the procedure on the secondary storage subsystem.

Create Enhanced Global Mirroring group
1. In the Storage & Copy Services view, right-click Enhanced Global Mirror

Groups then click the Create option.
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Figure 64. Enhanced Global Mirroring activated pop-up window
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2. Type the name for the mirror group or leave it as default and select the remote
storage subsystem in the Choose the remote storage subsystem option.

3. Click View synchronization settings to set Automatic or Manual for Interval
method.
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Figure 65. Creating an Enhanced Mirror Group
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4. Click OK to complete the Enhanced Global Mirroring group creation.

Create Enhanced Global Mirroring pairs
1. In Storage & Copy Services view, right-click a logical drive that would be used

to create the pair.

Note: This selected logical drive will be assigned to a primary logical drive in
the pair.

2. Select Create > Enhanced Global Mirrored Pairs.
3. Select a group name that is listed in Mirror groups or select a new enhanced

global mirror name to create a new group, then click Next.
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Figure 66. Enhanced Mirror Group - configuring automatic and manual settings
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v If a new enhanced global mirror name is selected, see “Create Enhanced
Global Mirroring group” on page 204 to create a new Enhanced Global
Mirroring group.

4. Select Automatic or Manual for repository settings.
a. Select Automatic then click Finish to create the Enhanced Global Mirroring

pair.
b. Select Manual then click Next to start the advanced options setup.

5. Specify the repository candidate capacity preference for primary logical drives,
then click Finish to complete the creation.
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Figure 67. Selecting an Enhanced Global Mirror group
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6. Go to the secondary Subsystem Management window then click the mirror
group on Enhanced Global Groups. The paired logical drives would be listed in
Associated mirrored pairs and status displayed is Incomplete.
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Figure 68. Editing an individual member repository
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7. Click Complete mirrored pair to initiate the mirror activity.
a. Type the name in the Logical Drive name field of Automatically create a

secondary logical drive and repository and select the desired Disk Pool
or Array, then click Finish to start the synchronization.

b. Select Manually choose an existing logical drive and define repository
parameters, then click Next.

8. Select the desired existing logical drive in the list.
a. Select Automatic in Choose a repository selection method then click

Finish to start the synchronization.
b. Select Manual for the advanced options setup, then click Next.

9. Specify the repository candidate capacity preference for secondary logical
drives, then click Finish to start the synchronization.
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Figure 69. Enhanced Global Mirror Group summary screen
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Chapter 15. Disaster recovery

This chapter describes the actions to take to prepare for a disaster, the actions to
take if a hardware component failure occurs, and the actions to take if a complete
site failure occurs.

As businesses increasingly require around-the-clock data access, you are required
to make sure that critical data is safeguarded against potential disasters. In
preparing for a potential disaster, you must develop a disaster recovery plan that
details the procedures to prepare for and prevent disasters, and the actions that
you need to take to respond to and recover from disasters if they occur.

Recovering from switch failures
The Campus configuration and the Intra-Site configuration are the two
configurations where each switch is a single point of failure. In the Highest
Availability Campus configuration, if a switch fails, at least one other switch is
configured to be an alternate path for all I/O. The single switch at each site is not
only responsible for the communication between the two sites for the Remote
Mirror Option, but for all host-to-storage subsystem I/O as well.

If a switch fails in the Campus configuration or the Intra-Site configuration, you
must decide whether or not to do a complete site failover. This decision must be
based on the immediate availability of a backup switch or the time it will take to
receive a replacement.
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Figure 70. Manual creation of a secondary logical drive and repository
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If a replacement switch is not readily available, you will need to use one of the
following temporary scenarios until the switch is replaced.
v Direct connection between host computers and storage subsystems - This

bypasses the switch and allows normal I/O to continue. All mirror relationships
are suspended until a normal configuration is resumed. Since the storage
subsystems have a finite number of host connections, all host computers might
not be able to access the storage subsystem. For information about how to
directly connect host computers and storage subsystems, see the IBM System
Storage DS Storage Manager Version 10 Installation and Support Guide for your
operating system.

v Entire site failover - The switch at the secondary site is still functional, which
enables all host computers to access the switch and storage subsystems. Mirror
relationships are suspended until the primary storage subsystem is recovered. If
a complete site failover is needed to continue normal operations, see
“Performing an entire site failover.”

Recovering from storage subsystem failures
This section provides procedures for recovering storage systems when one of the
following situations has occurred:
v The primary storage subsystem is damaged or destroyed
v The entire primary site is damaged or destroyed

Both situations require a complete site failover from the primary site to the
secondary site so that normal operations can continue. For a secondary site failure,
no site failover is necessary. If the primary logical drive is not damaged, then a full
synchronization occurs when the site is recovered. If the primary storage
subsystem is damaged, follow the procedure in “Rebuilding a damaged site” on
page 213.

Attention: You must complete the procedures in this section in the order that
they are presented to make sure that the affected site or storage subsystem is
recovered successfully.

Performing an entire site failover
Entire site failover is necessary when an event occurs that inhibits normal
operation to the primary site for an extended period of time.

Complete the following steps to complete an entire site failover:
1. Manually reverse the role of the primary logical drive of the mirror relationship

to the secondary role. For more information, see “Reversing the roles of
primary and secondary logical drives” on page 214.

2. If storage partitioning is preconfigured so that hosts can access the logical
drives, go to step 4. Otherwise, continue with step 3.

3. Configure the storage partitioning so that host to logical drive access is
identical to the primary site configuration. When configured, continue to step 4.
For more information about storage partitioning, see “Using other premium
features with the Remote Mirror Option” on page 147 and the Subsystem
Management window online help.

4. If the host computers at the secondary site are properly configured for host
failover, go to step 6 on page 213. Otherwise, continue with step 5 on page 213.
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5. Reinstall the host software and reconfigure the settings as needed. For more
information about installing and configuring host software, see the
documentation that comes with the software.

6. Run the Hot_add utility on hosts that have only mapped logical drives from
the secondary storage subsystem. Restart all hosts that have logical drive
mappings from the primary and secondary storage subsystems. Then resume
normal operation with the secondary site acting as a new, fully-functioning
primary site.

7. The entire site failover is complete. The primary site must now be reconfigured
and the remote mirror environment must be re-created. The next step depends
on the resulting status of the storage subsystem.

8. If the storage subsystem and all of the contained data is recovered and fully
operational, go to “Recreating a mirror relationship.” Otherwise, go to
“Rebuilding a damaged site.”

Rebuilding a damaged site
If a disaster occurs to the primary or secondary site that renders the storage
subsystem or all data on the storage subsystem irreparable, then the site needs to
be rebuilt with new hardware.

Complete the following steps to rebuild a damaged site:
1. Obtain new storage subsystems and any host computers and hardware that are

needed to properly use the Remote Mirror Option. Be sure that the new
hardware has the same level of specifications as the damaged hardware.

2. Depending on the configuration, complete the switch zoning and hardware
installation procedures for this site only. See “Installing the hardware” on page
155.

3. Define a logical drive to replace the mirrored logical drive that was damaged
on the original storage subsystem. Be sure that the new logical drive is identical
to the specifications of the damaged logical drive.

4. Make sure that storage partitioning is properly defined so that it can take over
normal operation from the secondary site. For more information about storage
partitioning, see “Using other premium features with the Remote Mirror
Option” on page 147 and the Subsystem Management window online help.

5. Make sure that the host software is properly configured so that the host
computers can take over I/O from the secondary site host computers. For more
information about installing and configuring host software, see the
documentation that comes with the software.

6. The site is recovered and is now ready to resume any mirror relationships that
were active before the failure. Go to “Recreating a mirror relationship.”

Recreating a mirror relationship
After the damaged site is back online and properly configured, mirror relationships
can be resumed.

Complete the following steps to re-create a mirror relationship:
1. From the active secondary site, define a mirror relationship using the logical

drive on the recovered primary site as the secondary logical drive. For more
information, see “Creating mirror relationships” on page 177.

2. Make sure that storage partitioning is properly defined on the recovered
primary site so that it can take over normal operation from the secondary site.
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For more information about storage partitioning, see “Using other premium
features with the Remote Mirror Option” on page 147 and the Subsystem
Management window online help.

3. Make sure that the host software is properly configured so that the host
computers at the recovered primary site can take over I/O from the secondary
site host computers. For more information about installing and configuring host
software, see the documentation provided with the software.

4. Complete a manual role reversal so that the recovered primary site now
possesses the active primary logical drive, and the secondary logical drive now
exists on the secondary site. For more information, see “Reversing the roles of
primary and secondary logical drives.”

5. The remote mirror configuration is now optimal.

Reversing the roles of primary and secondary logical drives
A role reversal is the process of promoting the secondary logical drive to be the
primary logical drive within the mirrored logical drive pair, and demoting the
primary logical drive to be the secondary logical drive.

A role reversal is performed using one of the following methods:

Changing a secondary mirrored logical drive to a primary logical drive
This method promotes a selected secondary logical drive to become the
primary logical drive of the mirrored pair, and is used when an
unrecoverable error has occurred. For step-by-step instructions, see
“Changing a secondary logical drive to a primary drive.”

Changing a primary mirrored logical drive to a secondary logical drive
This method demotes a selected primary logical drive to become the
secondary logical drive of the mirrored pair, and is used during normal
operating conditions. For step-by-step instructions, see “Changing a
primary logical drive to a secondary drive” on page 215.

Role reversals can also be performed using the Set command in the Storage
Manager Script window or the CLI. For more information, see the Enterprise
Management window online help.

Changing a secondary logical drive to a primary drive
A secondary logical drive is usually promoted to a primary logical drive role when
an unrecoverable error has occurred on the storage subsystem that contains the
primary logical drive. The secondary logical drive needs to be promoted so that
host computers can access data and normal operations can continue.

This method is not available unless the Remote Mirror Option is activated.

Note: When the secondary logical drive becomes a primary logical drive, any host
computers that are accessing the logical drive through a logical drive-to-LUN
mapping are now able to read or write to the logical drive. This condition applies
if the host did not have the same logical-drive-to-LUN mapping as the LUN in the
primary logical drive that was demoted to secondary logical drive. If it did, you
must restart the host for the newly-promoted-to-primary (secondary) logical drive
to replace the demoted (primary) logical drive.

If a communication problem between the secondary site and the primary site
prevents the demotion of the primary logical drive, an error message displays.
However, you are given the opportunity to proceed with the promotion of the
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secondary logical drive, even though this leads to a Dual Primary Remote Mirror
status condition. The recovery for this condition occurs when the remote mirror
pairs are re-created. If you attempt to change the role of one of the primary drives,
an error occurs.

Complete the following steps to promote a secondary logical drive to the primary
logical drive role:
1. Select the secondary logical drive in the Logical view of the secondary

Subsystem Management window. Then, either click Logical Drive → Remote
Mirroring → Change → Role to Primary, or right-click the drive and click
Change → Role to Primary. The Change to Primary window opens.

2. Click Yes. The secondary logical drive is promoted to the primary logical drive
role in the remote logical drive mirror.
When the controller owner of the primary logical drive is contacted, the
primary logical drive is automatically demoted to the secondary logical drive
role in the remote logical drive mirror.

Changing a primary logical drive to a secondary drive
Changing a primary logical drive to the secondary logical drive is used for role
reversals during normal operating conditions. You can also use this option during
a recovery procedure when a Dual Primary Remote Mirror status condition occurs.

Role reversal does not occur unless the Remote Mirror Option is activated.

Important: After the role reversal, any host computers that are accessing the
primary logical drive through a logical drive-to-LUN mapping are no longer able
to read or write to the logical drive. When the primary logical drive becomes a
secondary logical drive, only remote write requests initiated by the primary
controller are written to the logical drive.

If a communication problem between the primary and secondary sites prevents the
demotion of the primary logical drive, an error message displays. However, you
are given the opportunity to proceed with the demotion of the primary logical
drive even though this leads to a Dual Secondary Remote logical drive mirror
status condition. The recovery this status condition occurs when the remote mirror
pairs are re-created. If you attempt to change the role of one of the primary drives,
an error occurs.

Attention: If the selected primary logical drive has associated FlashCopy logical
drives, demoting this logical drive to a secondary role causes the associated
FlashCopy logical drives to fail.

Complete the following steps to demote a primary logical drive to the secondary
logical drive role:
1. Select the primary logical drive in the Logical view of the primary Subsystem

Management window. Then, either click Logical Drive → Remote Mirror →
Change → Role to Secondary, or right-click the drive and click Change → Role
to Secondary. The Change to Secondary window opens.

2. Click Yes. The primary logical drive is demoted to be the secondary logical
drive in the remote logical drive mirror.
When the controller owner of the primary logical drive is contacted, the
secondary logical drive is automatically promoted to the primary logical drive
role in the remote logical drive mirror.
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Chapter 16. Troubleshooting the Enhanced Remote Mirroring
Option

This chapter provides information about some problems that are commonly
encountered when using the Remote Mirror Option and how to resolve them.

The following troubleshooting topics are included in this chapter:
v Testing communication between primary and secondary logical drives
v General remote logical drive mirroring problems
v Inappropriate Fibre Channel fabric configurations
v Problems with storage subsystem components that are involved in remote

logical drive mirroring
v Basic switch troubleshooting

Also provided is a list of the critical events that might be generated, and
instructions for upgrading future versions of controller firmware.

Locate the section that directly relates to your problem or consult the section
describing general troubleshooting techniques. If your problem is not discussed in
any of the sections in this chapter, contact your IBM technical-support
representative.

Testing communication between primary and secondary logical drives
Use the Test Communication dialog to diagnose possible communication problems
between a primary logical drive and secondary logical drive participating in a
mirror relationship. After the communication test has been completed, the dialog
will display either a Passed, Warning, or Failed status together with values for the
following:
v Test data round trip time
v Maximum allowed round trip time
v Average round trip time

Important: If the communication test returns a Failed status, the test will continue
to run after you close the Test Communication dialog until communication
between the mirrored pair is restored. If you have enabled automatic
resynchronization, the mirrored pair will automatically synchronize. Otherwise,
select Logical Drive → Remote Mirroring Option → Resume to manually start
resynchronization.

To run the Test Communication function, follow the steps below:
1. Select a primary logical drive or secondary logical drive in the Logical View.
2. Select Logical Drive → Remote Mirroring Option → Test Communication.
3. The Communication Test dialog displays.If the communication test returns a

Passed with Caution status, the primary logical drive and secondary logical
drive are communicating correctly; however, the test data round trip time is
approaching the maximum allowed. This indicates that you will need to take
some kind of action to fix this problem. If the communication test returns a
Failed status, the reason for the failure is indicated, and you are directed to
reference the Recovery Guru to correct the problem.
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4. Review the information displayed in the dialog, and click OK to return to the
Storage Subsystem Management window.

General troubleshooting
Table 19 describes some of the usual problems that you might encounter when
using the Remote Mirror Option. The information is presented in order from the
time the option is enabled and activated, to problems that might be encountered as
you use the Remote Mirror Option.

Information about the probable cause and how you can resolve each problem is
provided. If your problem is not addressed in this section, see the remaining
sections in this chapter before you contact your IBM technical-support
representative.

Table 19. General Remote Mirror Option problems

Problem Cause Resolution

The Remote Mirror menu
options in the Subsystem
Management window are not
available.

The Remote Mirror Option is not
enabled or activated.

1. Enable the Remote Mirror Option. A
premium feature key is required to enable
premium features.

2. Activate the Remote Mirror Option.

The Remote Mirror Option is a premium
feature option. Contact your IBM
technical-support representative for purchase
information. For step-by-step instructions to
enable and activate the Remote Mirror Option,
see “Enabling and activating the Remote Mirror
Option” on page 168 or the Subsystem
Management window online help.

The Remote Mirror icon in the
premium feature status area is
marked with a red line and is
not available.

The Remote Mirror Option is not
enabled or activated.

1. Enable the Remote Mirror Option. A
premium feature key file is required to
enable the feature.

2. Activate the Remote Mirror Option.

The Remote Mirror Option is a premium
feature option. Contact your IBM
technical-support representative for purchase
information. For step-by-step instructions to
enable and activate the Remote Mirror Option,
see “Enabling and activating the Remote Mirror
Option” on page 168 or the Subsystem
Management window online help.
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Table 19. General Remote Mirror Option problems (continued)

Problem Cause Resolution

When creating a remote logical
drive mirror, the following
error message is received:

Error 158 - The operation
cannot complete because the
selected logical drive is not
a a valid candidate for
Remote Mirroring

The secondary logical drive
candidate was participating in a
mirror relationship with a
different logical drive on this
storage subsystem. The mirror
relationship was successfully
removed from the other storage
subsystem. However, a
communication error prevented
the successful removal of the
mirror relationship on this
storage subsystem.

A logical drive on this storage subsystem still
has a mirror relationship defined with the
secondary logical drive.

1. Click View → Storage subsystem profile.
Click the Logical Drives tab, and then click
the Mirrors tab.

2. Locate the logical drive that is still
participating in the mirror relationship with
the secondary logical drive candidate and
remove the mirror relationship. For
step-by-step instructions, see “Removing
mirror relationships” on page 183 or the
Subsystem Management window online
help.

3. Re-create the intended remote logical drive
mirror using the original candidate logical
drives. For step-by-step instructions, see
“Creating mirror relationships” on page 177
or the Subsystem Management window
online help.

The primary logical drive is
showing a Synchronization-in-
Progress status.

A full synchronization, between
the primary and secondary
logical drives participating in a
mirror relationship, is in
progress. Data available on the
primary logical drive is copied
in its entirety to its associated
secondary logical drive.

Wait for the full synchronization to complete.
When full synchronization has finished copying
data from the primary logical drive to the
secondary logical drive, the mirrored logical
drive pair transitions to a Synchronized status.

For more information about monitoring the
status of a remote logical drive mirror, see the
Subsystem Management window online help.
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Table 19. General Remote Mirror Option problems (continued)

Problem Cause Resolution

Both the primary and
secondary logical drive are
displayed as being the primary
logical drive.

A disaster or unrecoverable error
has occurred on the storage
subsystem that contains the
primary logical drive, and the
secondary logical drive is
promoted to the primary logical
drive role.

The primary storage subsystem
is now operational, but
unreachable because of a link
failure. A forced promotion of
the secondary logical drive has
resulted in both the primary and
secondary logical drives being
displayed in the primary logical
drive role.

If the mirror logical drive pair status is
Synchronized, complete step 1 and step 2.
Otherwise, complete step 3 and step 4.

1. Determine which of the logical drives in the
mirrored logical drive pair must be the
primary logical drive.

2. Choose the logical drive that must be in the
secondary logical drive role, then click
Storage subsystem → Change → Role to
Secondary. A resynchronization
automatically occurs.

3. Delete the mirror relationship from either
storage subsystem. Select either primary
logical drive in its respective Subsystem
Management window and click Logical
Drive → Remote Mirroring → Remove
Mirror Relationship.
Note: The mirror relationship for the
remote logical drive is not removed if there
is a connection problem between the two
storage subsystems. If the mirror
relationship remains on the remote logical
drive after the previous action, select that
logical drive from its respective Subsystem
Management window and click Logical
Drive → Remote Mirroring → Remove
Mirror Relationship.

4. In its respective Subsystem Management
window, select the logical drive that you
want to be the primary logical drive. Click
Logical Drive → Remote Mirroring → Create.
Follow the instructions in the Create Remote
Mirror wizard to re-create the mirror
relationship

For step-by-step instructions, see “Changing a
primary logical drive to a secondary drive” on
page 215 or the Subsystem Management
window online help.
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Table 19. General Remote Mirror Option problems (continued)

Problem Cause Resolution

Both the primary and
secondary logical drives are
displayed as being the
secondary logical drive.

In response to a dual primary
logical drive condition, a role
reversal was carried out and the
primary logical drive was
demoted to the secondary logical
drive role. The secondary storage
subsystem is operational, but
unreachable because of a link
failure. The forced demotion of
the primary logical drive has
resulted in both the primary and
secondary logical drives being
displayed in the secondary
logical drive role.

If the mirror logical drive pair status is
Synchronized, complete step 1 and step 2.
Otherwise, complete step 3 and step 4.

1. Determine which of the logical drives in the
mirrored logical drive pair must be the
primary logical drive.

2. Choose the logical drive that must be in the
primary logical drive role, then click
Storage Subsystem → Change → Role to
Primary. A resynchronization automatically
occurs.

3. Delete the mirror relationship from either
storage subsystem. Select either secondary
logical drive in its respective Subsystem
Management window and click Logical
Drive → Remote Mirroring → Remove
Mirror Relationship.
Note: The mirror relationship for the
remote logical drive is not removed if there
is a connection problem between the two
storage subsystems. If the mirror
relationship remains on the remote logical
drive after the previous action, select that
logical drive from its respective Subsystem
Management window and click Logical
Drive → Remote Mirroring → Remove
Mirror Relationship.

4. In its respective Subsystem Management
window, select the logical drive that you
want to be the secondary logical drive. Click
Logical Drive→ Remote Mirroring → Create.
Follow the instructions in the Create Remote
Mirror wizard to re-create the mirror
relationship.

For step-by-step instructions, see “Changing a
secondary logical drive to a primary drive” on
page 214 or the Subsystem Management
window online help.
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Table 19. General Remote Mirror Option problems (continued)

Problem Cause Resolution

The primary logical drive or
secondary logical drive displays
as missing.

A physical logical drive that a
remote logical drive mirror
depends on (primary logical
drive, secondary logical drive) is
removed, and the logical drive is
now displayed under the
missing logical drives node in
the Logical view of the
Subsystem Management
window.

If missing logical drives are detected because
drives have accidentally been removed, or are
detected as missing because of a loss of power
to the storage expansion enclosures. You can
recover these logical drives by completing the
following steps:

1. Reinsert the drives back into the storage
expansion enclosure.

2. Make sure that the storage expansion
enclosure power supplies are properly
connected to an operating power source and
have an Optimal status.

For more information, see the Recovery Guru
or contact your IBM technical-support
representative.

If the missing logical drive is no longer
required, it can be deleted.

Attention: Deleting a missing logical drive is
a permanent action. Any associated logical
drives or logical drive-to-LUN mappings are
also deleted. For more information, see the
Recovery Guru or the Subsystem Management
window online help.

The mirror relationship was
removed successfully from the
primary side, but not from the
secondary side.

When removing a mirror
relationship, a link failure
occurred between the primary
and secondary storage
subsystems and an error
message displays.

The Subsystem Management
window for the primary storage
subsystem indicates that the
mirror relationship was removed
successfully; however, the
Subsystem Management window
for the secondary storage
subsystem indicates that the
mirror relationship still exists.

Open the Subsystem Management window for
the secondary storage subsystem and remove
the mirror relationship.

For step-by-step instructions, see “Removing
mirror relationships” on page 183 or the
Subsystem Management window online help.

222 IBM System Storage DS Storage Manager Version 10: Copy Services User's Guide



Table 19. General Remote Mirror Option problems (continued)

Problem Cause Resolution

The mirror relationship was
removed successfully from the
secondary side, but not from
the primary side.

When removing a mirror
relationship, a link failure
occurred between the primary
and secondary storage
subsystems.

The Subsystem Management
window for the secondary
storage subsystem indicates that
the mirror relationship is
removed successfully; however,
the Subsystem Management
window for the primary storage
subsystem indicates that the
mirror relationship still exists,
with the primary logical drive
showing an Unresponsive status.

Open the Subsystem Management window for
the primary storage subsystem and remove the
mirror relationship.

For step-by-step instructions, see “Removing
mirror relationships” on page 183 or the
Subsystem Management window online help.

The primary logical drive is
showing an Unsynchronized
status.

The remote logical drive mirror
is in an Unsynchronized status
because the data that is mirrored
between the primary logical
drive and the secondary logical
drive is no longer identical.
Usual causes for this status
include link errors, a failed
primary logical drive or
secondary logical drive, or a
dual primary or dual secondary
error condition.

While the remote logical drive
mirror is in an Unsynchronized
status, no mirroring activity
takes place.
Note:

1. The remote mirror link and
the mirror logical drive pair
status depends on I/O
requests, especially I/O write
requests to the primary
logical drive. If there are no
I/O requests, the displayed
status of the mirror link and
the mirror logical drive pair
in the Storage Manager client
might be incorrect.

2. Generate I/O write requests
to the primary logical drive
to force the storage
subsystems updating the
remote mirror status.

When the controller owner of the primary
logical drive can communicate with the
controller owner of the secondary logical drive
and the logical drive is online and optimal, a
full synchronization automatically takes place.
When a full synchronization begins, the remote
logical drive mirror transitions to a mirror
Synchronization-in-Progress status.

For information about monitoring the status of
a remote logical drive mirror, see the Subsystem
Management window online help.
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Table 19. General Remote Mirror Option problems (continued)

Problem Cause Resolution

An error message indicates that
the Remote Mirror Option is
out of compliance.

The Remote Mirror Option is out
of compliance. This normally
occurs if a storage subsystem
with logical drives that are
participating in remote logical
drive mirroring is moved into
the primary storage subsystem
and one of the following
conditions now exists:

v The Remote Mirror Option is
not enabled on the selected
storage subsystem.

v The Remote Mirror Option is
enabled, but the current
number of remote logical
drive mirrors that are defined
on the primary storage
subsystem exceeds the number
of mirror relationships that are
allowed for this storage
subsystem.

If the Remote Mirror Option is not enabled for
the primary storage subsystem:

1. Obtain a premium feature key for this
feature from your IBM technical-support
representative.

2. Enable the Remote Mirror Option. For
step-by-step instructions, see “Enabling the
Remote Mirror Option” on page 170, or the
Subsystem Management window online
help.

If the Remote Mirror Option is enabled, but the
current number of mirror relationships on the
storage subsystem exceeds the number of
mirror relationships that are allowed for the
storage subsystem, reduce the number of mirror
relationships to equal or less than the number
of mirror relationships allowed. The maximum
number of mirror relationships that are allowed
is 64.

For step-by step instructions, see “Removing
mirror relationships” on page 183 or the
Subsystem Management window online help.

The remote logical drive
candidate is unresponsive and
cannot be updated.

The primary storage subsystem
is unable to notify the secondary
storage subsystem that its
worldwide name (WWN) has
changed.

This might be the result of a
controller in the primary storage
subsystem being swapped or
removed. Storage subsystem
recovery procedures that result
in configurations being reset and
can also cause a change to the
WWN.

The first write operation to the
primary logical drive causes the
mirrored logical drive pair to
transition into an Unsynchronized
status.

1. Remove all the existing mirror relationships
from the primary storage subsystem. For
step-by-step instructions, see “Removing
mirror relationships” on page 183 or the
Subsystem Management window online
help.

2. Reestablish the required mirror
relationships. For step-by step instructions,
see “Creating mirror relationships” on page
177 or the Subsystem Management window
online help.

There is a long boot time for
Windows 2000 hosts with
secondary volumes mapped.

A Windows 2000 host can take
up to two hours to boot if all of
the following statements are
true:

v The storage management
software is installed on the
host.

v The Remote Volume Mirroring
premium feature is enabled.

v One or more secondary
volumes are mapped to the
host.

Do not map the secondary volumes to the host
until they are needed for data access. If the host
needs to be restarted, and the secondary
volumes are mapped to that host, unmap the
secondary volumes until the host has
completed the restart. Remap the secondary
volumes only when they are needed for data
access.

Because Windows does not allow mounting the
file system as read-only, do not mount the
secondary logical drive to the Windows hosts.
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General switch troubleshooting
Table 20 describes some of the common switch-related problems that you might
encounter when using the Remote Mirror Option. The troubleshooting information
provided relates to switches that are supported for use with Storage Manager. For
a list of supported switches, see the IBM System Storage DS Storage Manager Version
10 Installation and Support Guide for your operating system.

Information about the probable cause and how you can resolve for each problem is
provided. If your problem is not addressed in this section, see the remaining
sections in this chapter before contacting your IBM technical-support
representative.

Table 20. General switch problems

Problem Cause Resolution

The host is unable to detect primary
and secondary storage subsystems
that are participating in remote
logical drive mirroring.

When two or more switches are
cascaded together and have the same
domain ID, host computers are
unable to locate the target device.
Each switch must have a unique
domain ID when attempting to
cascade two switches together.

Change the domain ID of one or
more of your switches, ensuring that
each one is unique. A domain ID
must be a unique number between 1
and 239, which is used to identify the
switch to a Fibre Channel fabric. For
more information about setting
domain IDs, see your switch
documentation.

Inappropriate Fibre Channel fabric configurations
Table 21 describes Fibre Channel fabric configuration problems that you might
encounter after you have configured your storage subsystems and have activated
and enabled the Remote Mirror Option.

Information about the probable cause and how you can resolve each problem is
provided. If your problem is not addressed in this section, see the remaining
sections in this chapter before you contact your IBM technical-support
representative.

Table 21. Fibre Channel fabric configuration problems

Problem Cause Resolution

The primary logical drive is
unable to contact the Fibre
Channel fabric.

Usually, this error occurs because of a
failed Fibre Channel fabric or because
of cabling problems between the
primary and secondary storage
subsystems that are participating in a
remote logical drive mirror.

v If the Fibre Channel fabric has failed,
repair or replace the failed fabric.

v If the Fibre Channel fabric is operational,
check the configuration cabling. The cable
must not go through a hub or be
connected directly between storage
subsystems. Make sure that the cable is
attached through a switch.

For step-by-step instructions to configure
storage subsystems for remote logical drive
mirroring, see Chapter 10, “Installing
hardware and software for the Enhanced
Remote Mirroring Option,” on page 151.
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Table 21. Fibre Channel fabric configuration problems (continued)

Problem Cause Resolution

The primary logical drive is
unable to communicate with
the secondary storage
subsystem. The primary
storage subsystem can still
communicate with the fabric.

Usually, this error occurs when the
secondary storage subsystem has lost
power or when network problems
exist between the secondary storage
subsystem and the fabric.

v The secondary storage subsystem has no
power. If the secondary storage subsystem
has no power and is not operational,
restore power to the storage subsystem.
For information about powering on
storage subsystems, see your hardware
documentation.

v The secondary storage subsystem has
power and is operational. Check the
network status. Make sure that the
secondary storage subsystem is visible on
the network. Make sure that the cables are
correctly connected.

For step-by-step instructions to configure
storage subsystems for remote logical drive
mirroring, see Chapter 10, “Installing
hardware and software for the Enhanced
Remote Mirroring Option,” on page 151.

Storage subsystem component failures
Table 22 describes how physical or logical storage subsystem component failures
can impact remote logical drive mirroring functionality. Information about the
probable cause and how you can resolve each problem is provided. If your
problem is not addressed in this section, see the remaining sections in this chapter
before you contact your IBM technical-support representative.

Table 22. Storage subsystem component failures

Problem Cause Resolution

A FlashCopy logical drive that was
created for a primary logical drive
indicates that it has failed, after its
role in the remote mirroring
relationship has been changed to
secondary.

The base logical drive for the FlashCopy
logical drive is a primary logical drive that is
involved in a mirror relationship. A role
reversal was performed, which demoted the
primary logical drive to secondary logical
drive status, resulting in a FlashCopy logical
drive on the secondary logical drive.

The base logical drive for a FlashCopy logical
drive cannot be a candidate for the secondary
logical drive role in a remote logical drive
mirror. Therefore, the FlashCopy logical drive
has failed.

Complete a role reversal to
promote the secondary logical
drive to the primary logical
drive role. After the role
reversal is complete, the
FlashCopy logical drive returns
to Optimal status.

For step-by-step instructions,
see “Changing a secondary
logical drive to a primary
drive” on page 214 or the
Subsystem Management
window online help.
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Table 22. Storage subsystem component failures (continued)

Problem Cause Resolution

The primary storage subsystem
controller indicates that it has
failed.

Failure of the owning controller on the
primary storage subsystem usually causes the
associated multipath driver on the attached
host computer to transfer ownership of the
alternate controller on the primary storage
subsystem.

When this occurs, the alternate controller on
the primary storage subsystem begins
forwarding newly-written data to its peer on
the secondary storage subsystem. The
secondary controller takes ownership of the
logical drive from its (secondary) peer
controller. This is a reactive event; it occurs
because of the arrival of a write request from
the primary storage subsystem to the
non-owning controller on the secondary
storage subsystem.

Allow the ownership transfer
to complete. Operations
continue in a normal fashion,
with the alternate (usually the
non-preferred) controller on the
primary storage subsystem
interacting with the alternate
controller on the secondary
storage subsystem.

Failure of the non-owning
controller on the primary
storage subsystem has no direct
impact on the status of the
remote logical drive mirrors.

The secondary storage subsystem
controller indicates that it has
failed.

One of the following scenarios has occurred:

v Controller A on the secondary storage
subsystem has failed while Controller A is
the owner of the primary logical drive.

v Controller B on the secondary storage
subsystem has failed while Controller B is
the owner of the primary logical drive.

In both scenarios, the mirrored logical drive
pair transitions to the Unsynchronized status.

Restore the failed controller. For
detailed recovery procedures,
see the Recovery Guru. After
the failed controller is restored,
the primary storage subsystem
automatically transitions to a
Synchronizing status.

Remote Mirror critical events
Critical major event log (MEL) events are generated when an error occurs that can
affect data availability or that results in a degraded mode of operation. The storage
management software responds by alerting the appropriate administrators by
email, SNMP trap, or other configured devices. Because administrative action is
required to correct the problem, the storage subsystem generally enters a Needs
Attention status. This causes the appropriate indications to be presented through
the storage management software and an associated Recovery Guru procedure to
be displayed when requested by the end user.

Critical events table
Table 23 provides a description of critical MEL events, with a brief explanation of
what caused the event to be triggered, and how you can resolve the problem. If
your problem is not addressed in this section, see the remaining sections in this
chapter before you contact your IBM technical-support representative.

Table 23. Remote Mirror critical events

Problem Cause Resolution

Mirrored pair becomes
unsynchronized.

This event is logged when a remote
logical drive mirror transitions to an
Unsynchronized status, from either a
Synchronizing or Optimal status.

See the associated Recovery Guru
message for specific recovery
procedures.
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Table 23. Remote Mirror critical events (continued)

Problem Cause Resolution

Dual-role conflict detected. This event is logged when a dual-role
conflict is detected, and is usually the
result of a role reversal. Because both
sides of the mirrored logical drive
pair are in the same primary or
secondary logical drive role, both the
primary and secondary storage
subsystems will report this MEL
event.

See the associated Recovery Guru
message for specific recovery
procedures.

Communication error with the
secondary logical drive on the
secondary remote storage subsystem.

This event is logged when an
interruption in the link that cannot be
recovered by the firmware Fibre
Channel device driver is detected.
Error codes and recovery procedures
assist you in finding the exact cause
of the communication problem
between storage subsystems that are
participating in a mirror relationship.

See the associated Recovery Guru
message for specific recovery
procedures.

Worldwide name (WWN) change
notification failed.

This event is logged when a storage
subsystem detects during startup
processing that its WWN has
changed. The WWN can only change
if both controllers of the array are
exchanged while the array is
powered off.

When the firmware detects this name
change, it attempts to notify any
remote storage subsystem that had
previously been participating in a
mirroring relationship with any
logical drive on the array.

See the associated Recovery Guru
message for specific recovery
procedures.

Problem resolution scenarios
The following scenarios present resolutions or workarounds to potential problems
when using Remote Mirroring:

Problem:
When you create a remote mirror of a FlashCopy base logical drive, the
following scenario is possible.
v First, you have created a FlashCopy of a base logical drive and the base

logical drive is receiving I/O.
v Second, you decide to create a remote mirror relationship, using the base

logical drive as the primary logical drive in the remote mirror pair.
v As you create the remote mirror relationship, the FlashCopy logical

drive fails.

Workaround:
Quiesce I/O to the base logical drive while you are creating the remote
mirror relationship. Alternatively, if the remote mirror relationship is
created before you create the FlashCopy logical drive, this event will not
occur.
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Problem:
When alternately switching the roles of the logical drives in a remote
mirrored relationship back and forth, Windows NT 4.0 and Windows 2000
might cache the file or files on the logical drive (disk) in memory and use
the cached data instead of going out to the disk to get the data. This
Windows operating system behavior might make the data look like it was
not synchronized between logical drives in a remote mirror relationship.

Resolution:
Unmount the primary logical drive in the server before demoting it to the
secondary role. In a Microsoft Windows environment, shut down the
server that the primary logical drive is mapped to. Then, promote the
secondary logical drive to the primary role and hot_add it to the
appropriate server.

If the logical drive is of the Dynamic Disk type, you might be able to
resolve the situation without shutting down the server. Complete the
following steps:
1. In the server that has the primary logical drive, run the SMrepassist

program in the Storage Manager utility directory with the -f option to
flush the cached data to disk.

2. Promote the secondary logical drive and hot_add it to the appropriate
server.

3. Before you promote the logical drive to the primary role in the original
server, force a failure to the disk by running chkdsk on the disk.

4. Promote the logical drive to primary role in the original server and
hot_add it.

5. You might have to reactivate the disk after it is hot_added to the server.

If the server environment prevents the server from being restarted and the
logical drive is of the Basic Disk type, complete the following steps:
1. In the server that has the primary logical drive, run the SMrepassist

program in the Storage Manager util directory with the -f option to
flush the cached data to disk.

2. Use the Storage Manager to remove the LUN mapping of the logical
drive that had the primary role from its server (host computer).

3. Promote the secondary role LUN to the primary role and hot_add it in
the appropriate server assuming that the LUN mapping is already
defined for this server in the storage subsystem.

4. Before you promote the logical drive to the primary role in the original
server, run the Hot_add program or initiate a Scan for Hardware
Changes task in the original server. This removes the logical drive from
the available disks. In Windows 2000, you might see Unsafe Removal of
Devices messages.

5. Use the Storage Manager to add the LUN mapping of the logical drive
that will be promoted to primary role to the original server (host
computer).

6. Promote the logical drive to primary role and hot_add it in the original
server. If you are unable to hot_add the logical drive or the data still
seems to be mismatched, you must restart the server.
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Appendix A. Upgrading controller firmware

The Remote Mirror Option is designed so that it is not necessary for the primary
storage subsystem and the secondary storage subsystem to run exactly the same
controller firmware level. All inter-controller operations (including those needed
for propagation of newly-written data from the primary logical drive to the
secondary logical drive) are implemented so as to support mixed firmware levels
to the greatest extent possible. This allows firmware upgrades to be performed on
both the primary and secondary storage subsystems without any loss of data. This
is also true in the case that the controller firmware of the storage subsystem at the
primary site is version 06.10.xx.xx and the controller firmware of the one at the
secondary site is version 05.xx.xx.xx and vice versa. The capabilities of the remote
mirror depend on the version of the controller firmware installed at the storage
subsystem where the primary logical drive of remote mirror located.

The key data availability operations, including promotion from the secondary
logical drive to the primary logical drive, are allowed in mixed firmware levels.
However, to avoid restrictions in Remote Mirroring configuration operations due to
a mixed primary and secondary storage subsystem controller firmware
environment, always upgrade the firmware to the same levels. In a mixed
firmware level environment, the following configuration requests are the only ones
that can be completed: mirror deletion, changing the logical drive user label, and
changing the synchronization priority. All other mirror configuration functions are
not allowed.

Important: Make sure that the storage subsystems are in Optimal state before
attempting controller firmware and NVSRAM download. Use the Recovery Guru
in the Storage Manager subsystem window to correct any problems before
downloading the firmware.

Upgrades to controller firmware are completed in different ways depending on
whether the primary controller currently has the Enhanced Remote Mirroring
Option, or the earlier Remote Mirror Option installed. Follow the steps below,
based on the remote mirroring version installed.

Upgrading controller firmware with Enhanced Remote Mirroring
installed

This section describes the procedure that you must follow to upgrade controller
firmware (version 05.2xx.xx or later) if you are currently running the Enhanced
Remote Mirroring Option on the primary controller. Performing firmware upgrades
on storage subsystems that are participating in mirror relationships in sequence
detailed in the steps below.
1. Download the firmware to the primary storage subsystem.
2. Download firmware to the secondary storage subsystem.

The Enhanced Remote Mirroring controller firmware will cache the write I/Os
during the unsynchronized period and will complete these cached writes only after
the secondary storage subsystem has completed the firmware download.
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Note: For more information about upgrading controller firmware, including
detailed procedures, see the IBM DS Storage Manager 9 Installation and Support
Guide for your operating system.

Upgrading controller firmware with the previous Remote Mirror Option
installed

This section describes the procedure that you must follow to upgrade controller
firmware (version 05.2xx.xx or later) if the storage subsystems are using the earlier
version of the Remote Mirror Option. The sequence for firmware upgrades on
storage subsystems that are participating in mirror relationships is detailed in the
steps below.

Important: By following this sequence, it is possible to avoid transitions of the
mirrored logical drive pair to an Unsynchronized status, avoiding the need for a
full resynchronization afterwards. The secondary array is offline for some interval
while the firmware updates are performed (using the previous Remote Mirror
functionality), which will cause the remote mirror status to change to
Unsynchronized. This will require full resynchronization when the firmware
download operation is complete. To minimize the resynchronization process, one
has to stop I/Os to the primary storage subsystem while upgrading the secondary
storage subsystem.
1. Stop I/O to programs that operate on all the affected primary logical drives

that are temporarily inactive.
2. Download firmware to the secondary storage subsystem.

Resume program access to the primary logical drives. You can operate the
primary storage subsystem with a different firmware level than the secondary
storage subsystem for a time, but the inter-controller protocols for data
replication do not support such interactions.

3. Download the firmware to the primary storage subsystem.

Resynchronization of the primary and secondary storage subsystems will then be
initiated.
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Appendix B. Accessibility

This section provides information about alternate keyboard navigation, which is a
Storage Manager accessibility feature. Accessibility features help a user who has a
physical disability, such as restricted mobility or limited vision, to use software
products successfully.

With the alternate keyboard operations that are described in this section, you can
use keys or key combinations to complete Storage Manager tasks and initiate many
menu actions that can also be done with a mouse.

Note: In addition to the keyboard operations that are described in this section, the
Storage Manager version 9.14 - 10.10 (and later) software installation packages for
Windows include a screen reader software interface.

To enable the screen reader, select Custom Installation when using the installation
wizard to install Storage Manager 9.14 - 10.10 (or later) on a Windows
host/management station. Then, in the Select Product Features window, select
Java™ Access Bridge, in addition to the other required host software components.

Table 24 defines the keyboard operations that enable you to navigate, select, or
activate user interface components. The following terms are used in the table:
v Navigate means to move the input focus from one user interface component to

another.
v Select means to choose one or more components, typically for a subsequent

action.
v Activate means to carry out the action of a particular component.

Note: In general, navigation between components requires the following keys:
v Tab - Moves keyboard focus to the next component or to the first member of the

next group of components
v Shift-Tab - Moves keyboard focus to the previous component or to the first

component in the previous group of components
v Arrow keys - Move keyboard focus within the individual components of a

group of components

Table 24. DS Storage Manager alternate keyboard operations

Short cut Action

F1 Open the Help.

F10 Move keyboard focus to main menu bar and post first
menu; use the arrow keys to navigate through the
available options.

Alt+F4 Close the management window.

Alt+F6 Move keyboard focus between dialogs (non-modal) and
between management windows.
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Table 24. DS Storage Manager alternate keyboard operations (continued)

Short cut Action

Alt+ underlined letter
Access menu items, buttons, and other interface
components with the keys associated with the
underlined letters.

For the menu options, select the Alt + underlined letter
combination to access a main menu, and then select the
underlined letter to access the individual menu item.

For other interface components, use the Alt +
underlined letter combination.

Ctrl+F1 Display or conceal a tool tip when keyboard focus is on
the toolbar.

Spacebar Select an item or activate a hyperlink.

Ctrl+Spacebar
(Contiguous/Non-contiguous)
AMW Logical/Physical View

Select multiple drives in the Physical View.

To select multiple drives, select one drive by pressing
Spacebar, and then press Tab to switch focus to the next
drive you want to select; press Ctrl+Spacebar to select
the drive.

If you press Spacebar alone when multiple drives are
selected then all selections are removed.

Use the Ctrl+Spacebar combination to deselect a drive
when multiple drives are selected.

This behavior is the same for contiguous and
noncontiguous selection of drives.

End, Page Down Move keyboard focus to the last item in the list.

Esc Close the current dialog. Does not require keyboard
focus.

Home, Page Up Move keyboard focus to the first item in the list.

Shift+Tab Move keyboard focus through components in the
reverse direction.

Ctrl+Tab Move keyboard focus from a table to the next user
interface component.

Tab Navigate keyboard focus between components or select
a hyperlink.

Down arrow Move keyboard focus down one item in the list.

Left arrow Move keyboard focus to the left.

Right arrow Move keyboard focus to the right.

Up arrow Move keyboard focus up one item in the list.
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Appendix C. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you.

Use this information to obtain additional information about IBM and IBM
products, determine what to do if you experience a problem with your IBM system
or optional device, and determine whom to call for service, if it is necessary.

Before you call
Before you call, make sure that you have taken these steps to try to solve the
problem yourself.

If you believe that you require IBM to perform warranty service on your IBM
product, the IBM service technicians will be able to assist you more efficiently if
you prepare before you call.
v Check for updated firmware and operating-system device drivers for your IBM

product. The IBM Warranty terms and conditions state that you, the owner of
the IBM product, are responsible for maintaining and updating all software and
firmware for the product (unless it is covered by an additional maintenance
contract). Your IBM service technician will request that you upgrade your
software and firmware if the problem has a documented solution within a
software upgrade.
You can obtain the latest downloads for your IBM product from
http://www.ibm.com/support/fixcentral/systemx/
groupView?query.productGroup=ibm%2FSystemx ..

v If you have installed new hardware or software in your environment, check
http://www.ibm.com/systems/info/x86servers/serverproven/compat/us/ to
make sure that the hardware and software is supported by your IBM product.

v Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your IBM product. Information about diagnostic
tools is in the Problem Determination and Service Guide on the IBM Documentation
CD that comes with your product.

v Go to http://www.ibm.com/systems/support/ to check for information to help
you solve the problem.

v Gather the following information to provide to IBM service. This data will help
IBM service quickly provide a solution to your problem and ensure that you
receive the level of service for which you might have contracted.
– Hardware and Software Maintenance agreement contract numbers, if

applicable
– Machine type number (IBM 4-digit machine identifier)
– Model number
– Serial number
– Current system UEFI (or BIOS) and firmware levels
– Other pertinent information such as error messages and logs

v Go to http://www.ibm.com/support/electronic/ to submit an Electronic Service
Request. Submitting an Electronic Service Request will start the process of
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determining a solution to your problem by making the pertinent information
available to IBM service quickly and efficiently. IBM service technicians can start
working on your solution as soon as you have completed and submitted an
Electronic Service Request.

Using the documentation
Information about your IBM system and preinstalled software, if any, or optional
device is available in the documentation that comes with the product. That
documentation can include printed documents, online documents, readme files,
and help files.

See the troubleshooting information in your system documentation for instructions
for using the diagnostic programs. The troubleshooting information or the
diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to http://www.ibm.com/systems/support/ .

You can find the most up-to-date information for System x products at
http://www.ibm.com/systems/x/ .

Getting help and information from the World Wide Web
On the World Wide Web, up-to-date information about IBM systems, optional
devices, services, and support is available at http://www.ibm.com/systems/
support/ .

You can find the most up-to-date product information for System x products at
http://www.ibm.com/systems/x/ .

Software service and support
Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with your IBM products.

For more information about Support Line and other IBM services, see
http://www.ibm.com/services/us/index.wss or see http://www.ibm.com/
planetwide/ for support telephone numbers. In the U.S. and Canada, call
1-800-IBM-SERV (1-800-426-7378).

Hardware service and support
You can receive hardware service through your IBM reseller or IBM Services.

To locate a reseller authorized by IBM to provide warranty service, go to
http://www.ibm.com/partnerworld/ and click Find Business Partners on the
right side of the page. For IBM support telephone numbers, see
http://www.ibm.com/planetwide/ . In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).

In the U.S. and Canada, hardware service and support is available 24 hours a day,
7 days a week. In the U.K., these services are available Monday through Friday,
from 9 a.m. to 6 p.m.
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Taiwan contact information

This topic contains the product service contact information for Taiwan.
IBM Taiwan Product Service Contact Information:
IBM Taiwan Corporation
3F, No 7, Song Ren Rd., Taipei Taiwan
Tel: 0800-016-888
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Almaden Research
650 Harry Road
Bldg 80, D3-304, Department 277
San Jose, CA 95120-6099
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:
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This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs.

© Copyright IBM Corp. _enter the year or years_.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at Copyright and
trademark information at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Important notes
Processor speed indicates the internal clock speed of the microprocessor; other
factors also affect application performance.
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This product is not intended to be connected directly or indirectly by any means
whatsoever to interfaces of public telecommunications networks, nor is it intended
to be used in a public services network.

CD or DVD drive speed is the variable read rate. Actual speeds vary and are often
less than the possible maximum.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for 1024 bytes, MB stands for 1,048,576 bytes, and GB stands for
1,073,741,824 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1,000,000 bytes, and GB stands for 1,000,000,000 bytes. Total user-accessible
capacity can vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the
largest currently supported drives that are available from IBM.

Maximum memory might require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software might differ from its retail version (if available) and might not
include user manuals or all program functionality.

Particulate contamination
Attention: Airborne particulates (including metal flakes or particles) and reactive
gases acting alone or in combination with other environmental factors such as
humidity or temperature might pose a risk to the device that is described in this
document.

Risks that are posed by the presence of excessive particulate levels or
concentrations of harmful gases include damage that might cause the device to
malfunction or cease functioning altogether. This specification sets forth limits for
particulates and gases that are intended to avoid such damage. The limits must not
be viewed or used as definitive limits, because numerous other factors, such as
temperature or moisture content of the air, can influence the impact of particulates
or environmental corrosives and gaseous contaminant transfer. In the absence of
specific limits that are set forth in this document, you must implement practices
that maintain particulate and gas levels that are consistent with the protection of
human health and safety. If IBM determines that the levels of particulates or gases
in your environment have caused damage to the device, IBM may condition
provision of repair or replacement of devices or parts on implementation of
appropriate remedial measures to mitigate such environmental contamination.
Implementation of such remedial measures is a customer responsibility.
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Table 25. Limits for particulates and gases

Contaminant Limits

Particulate v The room air must be continuously filtered with 40% atmospheric
dust spot efficiency (MERV 9) according to ASHRAE Standard 52.21.

v Air that enters a data center must be filtered to 99.97% efficiency or
greater, using high-efficiency particulate air (HEPA) filters that meet
MIL-STD-282.

v The deliquescent relative humidity of the particulate contamination
must be more than 60%2.

v The room must be free of conductive contamination such as zinc
whiskers.

Gaseous v Copper: Class G1 as per ANSI/ISA 71.04-19853

v Silver: Corrosion rate of less than 300 Å in 30 days

1 ASHRAE 52.2-2008 - Method of Testing General Ventilation Air-Cleaning Devices for
Removal Efficiency by Particle Size. Atlanta: American Society of Heating, Refrigerating
and Air-Conditioning Engineers, Inc.

2 The deliquescent relative humidity of particulate contamination is the relative humidity
at which the dust absorbs enough water to become wet and promote ionic conduction.

3 ANSI/ISA-71.04-1985. Environmental conditions for process measurement and control
systems: Airborne contaminants. Instrument Society of America, Research Triangle Park,
North Carolina, U.S.A.

Documentation format
The publications for this product are in Adobe Portable Document Format (PDF)
and should be compliant with accessibility standards. If you experience difficulties
when you use the PDF files and want to request a web-based format or accessible
PDF document for a publication, direct your mail to the following address:

Information Development
IBM Corporation
205/A015
3039 E. Cornwallis Road
P.O. Box 12195
Research Triangle Park, North Carolina 27709-2195
U.S.A.

In the request, be sure to include the publication part number and title.

When you send information to IBM, you grant IBM a nonexclusive right to use or
distribute the information in any way it believes appropriate without incurring any
obligation to you.

Electronic emission notices

Federal Communications Commission statement
This explains the Federal Communications Commission's (FCC) statement.

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
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radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, might cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at
his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. IBM is not responsible for any radio or television
interference caused by using other than recommended cables and connectors, or by
unauthorized changes or modifications to this equipment. Unauthorized changes
or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device might not cause harmful interference, and
(2) this device must accept any interference received, including interference that
might cause undesired operation.

Industry Canada compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conform à la norme NMB-003 du
Canada.

Australia and New Zealand Class A Statement
Attention: This is a Class A product. In a domestic environment this product
might cause radio interference in which case the user might be required to take
adequate measures.

European Union Electromagnetic Compatibility Directive
This product is in conformity with the protection requirements of European Union
(EU) Council Directive 2004/108/EC on the approximation of the laws of the
Member States relating to electromagnetic compatibility. IBM cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM
option cards.

Attention: This is an EN 55022 Class A product. In a domestic environment this
product might cause radio interference in which case the user might be required to
take adequate measures.

Responsible Manufacturer:

International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
914-499-1900

European community contact:

IBM Deutschland GmbH
Technical Regulations, Department M372
IBM-Allee 1, 71139 Ehningen, Germany
Tele: +49 7032 15 2941

e-mail: lugi@de.ibm.com
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Germany Electromagnetic compatibility directive
Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie
zur Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie
2004/108/EG zur Angleichung der Rechtsvorschriften über die elektromagnetische
Verträglichkeit in den EU-Mitgliedsstaaten und hält die Grenzwerte der EN 55022
Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu
installieren und zu betreiben. Des Weiteren dürfen auch nur von der IBM
empfohlene Kabel angeschlossen werden. IBM übernimmt keine Verantwortung für
die Einhaltung der Schutzanforderungen, wenn das Produkt ohne Zustimmung der
IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung der IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:

"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im
Wohnbereich Funk-Störungen verursachen; in diesem Fall kann vom Betreiber
verlangt werden, angemessene Mabnahmen zu ergreifen und dafür
aufzukommen."

Deutschland: Einhaltung des Gesetzes über die elektromagnetische
Verträglichkeit von Geräten

Dieses Produkt entspricht dem "Gesetz über die elektromagnetische Verträglichkeit
von Geräten (EMVG)." Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in
der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die
elektromagnetische Verträglichkeit von Geräten (EMVG) (bzw. der EMC EG
Richtlinie 2004/108/EG) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in übereinstimmung mit dem Deutschen EMVG das
EG-Konformitätszeichen - CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk,New York 10504
Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:

IBM Deutschland GmbH
Technical Regulations, Abteilung M372
IBM-Allee 1, 71139 Ehningen, Germany
Tele: +49 7032 15 2941
e-mail: lugi@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse
A.
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Japan Voluntary Control Council for Interference (VCCI) Class
A Statement

Japan Electronics and Information Technology Industries
Association (JEITA) Statement (less than or equal to 20 A per
phase)

Korean Communications Commission (KCC) Class A
Statement

Russia Electromagnetic Interference (EMI) Class A Statement

People's Republic of China Class A Electronic Emission
statement
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Taiwan Class A compliance statement
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Glossary

This glossary provides definitions for the
terminology and abbreviations used in IBM
System Storage DS4000 and DS5000 publications.

If you do not find the term you are looking for,
see the IBM Glossary of Computing Terms located at
the following website:

www.ibm.com/ibm/terminology

This glossary also includes terms and definitions
from:
v Information Technology Vocabulary by

Subcommittee 1, Joint Technical Committee 1,
of the International Organization for
Standardization and the International
Electrotechnical Commission (ISO/IEC
JTC1/SC1). Definitions are identified by the
symbol (I) after the definition; definitions taken
from draft international standards, committee
drafts, and working papers by ISO/IEC
JTC1/SC1 are identified by the symbol (T) after
the definition, indicating that final agreement
has not yet been reached among the
participating National Bodies of SC1.

v IBM Glossary of Computing Terms. New York:
McGraw-Hill, 1994.

The following cross-reference conventions are
used in this glossary:

See Refers you to (a) a term that is the
expanded form of an abbreviation or
acronym, or (b) a synonym or more
preferred term.

See also
Refers you to a related term.

Abstract Windowing Toolkit (AWT)
A Java graphical user interface (GUI).

accelerated graphics port (AGP)
A bus specification that gives low-cost 3D
graphics cards faster access to main
memory on personal computers than the
usual peripheral component interconnect
(PCI) bus. AGP reduces the overall cost of
creating high-end graphics subsystems by
using existing system memory.

access logical drive
A special logical drive that allows the

host-agent to communicate with the
controllers in the storage subsystem.

adapter
A printed circuit assembly that transmits
user data input/output (I/O) between the
internal bus of the host system and the
external Fibre Channel (FC) link and vice
versa. Also called an I/O adapter, host
adapter, or FC adapter.

advanced technology (AT) bus architecture
A bus standard for IBM compatibles. It
extends the XT bus architecture to 16 bits
and also allows for bus mastering,
although only the first 16 MB of main
memory are available for direct access.

agent A server program that receives virtual
connections from the network manager
(the client program) in a Simple Network
Management Protocol-Transmission
Control Protocol/Internet Protocol
(SNMP-TCP/IP) network-managing
environment.

AGP See accelerated graphics port.

AL_PA
See arbitrated loop physical address.

arbitrated loop
One of three existing Fibre Channel
topologies, in which 2 - 126 ports are
interconnected serially in a single loop
circuit. Access to the Fibre
Channel-Arbitrated Loop (FC-AL) is
controlled by an arbitration scheme. The
FC-AL topology supports all classes of
service and guarantees in-order delivery
of FC frames when the originator and
responder are on the same FC-AL. The
default topology for the disk array is
arbitrated loop. An arbitrated loop is
sometimes referred to as a Stealth Mode.

arbitrated loop physical address (AL_PA)
An 8-bit value that is used to uniquely
identify an individual port within a loop.
A loop can have one or more AL_PAs.

array A collection of Fibre Channel or SATA
hard drives that are logically grouped
together. All the drives in the array are
assigned the same RAID level. An array is
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sometimes referred to as a "RAID set." See
also redundant array of independent disks
(RAID), RAID level.

Global Copy
In remote mirroring, an option that allows
the primary controller to return a write
I/O request completion to the host server
before data has been successfully written
by the secondary controller. See also
Global Copy, remote mirroring, Global
Copy,Global Mirroring.

AT See advanced technology (AT) bus
architecture.

ATA See AT-attached.

AT-attached
Peripheral devices that are compatible
with the original IBM AT computer
standard in which signals on a 40-pin
AT-attached (ATA) ribbon cable followed
the timings and constraints of the
Industry Standard Architecture (ISA)
system bus on the IBM PC AT computer.
Equivalent to integrated drive electronics
(IDE).

auto-volume transfer/auto-disk transfer
(AVT/ADT)

A function that provides automatic
failover in case of controller failure on a
storage subsystem.

AVT/ADT
See auto-volume transfer/auto-disk transfer.

AWT See Abstract Windowing Toolkit.

basic input/output system (BIOS)
The personal computer code that controls
basic hardware operations, such as
interactions with diskette drives, hard
disk drives, and the keyboard.

BIOS See basic input/output system.

BOOTP
See bootstrap protocol.

bootstrap protocol (BOOTP)
In Transmission Control Protocol/Internet
Protocol (TCP/IP) networking, an
alternative protocol by which a diskless
machine can obtain its Internet Protocol
(IP) address and such configuration
information as IP addresses of various
servers from a BOOTP server.

bridge A storage area network (SAN) device that
provides physical and transport

conversion, such as Fibre Channel to
small computer system interface (SCSI)
bridge.

bridge group
A bridge and the collection of devices
connected to it.

broadcast
The simultaneous transmission of data to
more than one destination.

cathode ray tube (CRT)
A display device in which controlled
electron beams are used to display
alphanumeric or graphical data on an
electroluminescent screen.

client A computer system or process that
requests a service of another computer
system or process that is typically referred
to as a server. Multiple clients can share
access to a common server.

command
A statement used to initiate an action or
start a service. A command consists of the
command name abbreviation, and its
parameters and flags if applicable. A
command can be issued by typing it on a
command line or selecting it from a
menu.

community string
The name of a community contained in
each Simple Network Management
Protocol (SNMP) message.

concurrent download
A method of downloading and installing
firmware that does not require the user to
stop I/O to the controllers during the
process.

CRC See cyclic redundancy check.

CRT See cathode ray tube.

CRU See customer replaceable unit.

customer replaceable unit (CRU)
An assembly or part that a customer can
replace in its entirety when any of its
components fail. Contrast with field
replaceable unit (FRU).

cyclic redundancy check (CRC)
(1) A redundancy check in which the
check key is generated by a cyclic
algorithm. (2) An error detection
technique performed at both the sending
and receiving stations.
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dac See disk array controller.

dar See disk array router.

DASD
See direct access storage device.

data striping
See striping.

default host group
A logical collection of discovered host
ports, defined host computers, and
defined host groups in the
storage-partition topology that fulfill the
following requirements:
v Are not involved in specific logical

drive-to-LUN mappings
v Share access to logical drives with

default logical drive-to-LUN mappings

device type
Identifier used to place devices in the
physical map, such as the switch, hub, or
storage.

DHCP See Dynamic Host Configuration Protocol.

direct access storage device (DASD)
A device in which access time is
effectively independent of the location of
the data. Information is entered and
retrieved without reference to previously
accessed data. (For example, a disk drive
is a DASD, in contrast with a tape drive,
which stores data as a linear sequence.)
DASDs include both fixed and removable
storage devices.

direct memory access (DMA)
The transfer of data between memory and
an input/output (I/O) device without
processor intervention.

disk array controller (dac)
A disk array controller device that
represents the two controllers of an array.
See also disk array router.

disk array router (dar)
A disk array router that represents an
entire array, including current and
deferred paths to all logical unit numbers
(LUNs) (hdisks on AIX operating system).
See also disk array controller.

DMA See direct memory access.

domain
The most significant byte in the node port
(N_port) identifier for the Fibre Channel

(FC) device. It is not used in the Fibre
Channel-small computer system interface
(FC-SCSI) hardware path ID. It is required
to be the same for all SCSI targets
logically connected to an FC adapter.

DRAM
See dynamic random access memory.

Dynamic Host Configuration Protocol (DHCP)
A protocol defined by the Internet
Engineering Task Force that is used for
dynamically assigning Internet Protocol
(IP) addresses to computers in a network.

dynamic random access memory (DRAM)
A storage in which the cells require
repetitive application of control signals to
retain stored data.

ECC See error correction coding.

EEPROM
See electrically erasable programmable
read-only memory.

EISA See Extended Industry Standard Architecture.

electrically erasable programmable read-only
memory (EEPROM)

A type of memory chip which can retain
its contents without consistent electrical
power. Unlike the PROM which can be
programmed only once, the EEPROM can
be erased electrically. Because it can only
be reprogrammed a limited number of
times before it wears out, it is appropriate
for storing small amounts of data that are
changed infrequently.

electrostatic discharge (ESD)
The flow of current that results when
objects that have a static charge come into
close enough proximity to discharge.

environmental service module (ESM) canister
A component in a storage expansion
enclosure that monitors the environmental
condition of the components in that
enclosure. Not all storage subsystems
have ESM canisters.

E_port See expansion port.

error correction coding (ECC)
A method for encoding data so that
transmission errors can be detected and
corrected by examining the data on the
receiving end. Most ECCs are
characterized by the maximum number of
errors they can detect and correct.
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ESD See electrostatic discharge.

ESM canister
See environmental service module canister.

EXP See storage expansion enclosure.

expansion port (E_port)
A port that connects the switches for two
fabrics.

Extended Industry Standard Architecture (EISA)
A bus standard for IBM compatibles that
extends the Industry Standard
Architecture (ISA) bus architecture to 32
bits and allows more than one central
processing unit (CPU) to share the bus.
See also Industry Standard Architecture.

fabric A Fibre Channel entity which
interconnects and facilitates logins of
N_ports attached to it. The fabric is
responsible for routing frames between
source and destination N_ports using
address information in the frame header.
A fabric can be as simple as a
point-to-point channel between two
N-ports, or as complex as a frame-routing
switch that provides multiple and
redundant internal pathways within the
fabric between F_ports.

fabric port (F_port)
In a fabric, an access point for connecting
a user's N_port. An F_port facilitates
N_port logins to the fabric from nodes
connected to the fabric. An F_port is
addressable by the N_port connected to it.
See also fabric.

FC See Fibre Channel.

FC-AL See arbitrated loop.

feature enable identifier
A unique identifier for the storage
subsystem, which is used in the process
of generating a premium feature key. See
also premium feature key.

Fibre Channel (FC)
A set of standards for a serial
input/output (I/O) bus capable of
transferring data between two ports at up
to 100 Mbps, with standards proposals to
go to higher speeds. FC supports
point-to-point, arbitrated loop, and
switched topologies.

Fibre Channel-Arbitrated Loop (FC-AL)
See arbitrated loop.

Fibre Channel Protocol (FCP) for small computer
system interface (SCSI)

A high-level Fibre Channel mapping layer
(FC-4) that uses lower-level Fibre Channel
(FC-PH) services to transmit SCSI
commands, data, and status information
between a SCSI initiator and a SCSI target
across the FC link with FC frame and
sequence formats.

field replaceable unit (FRU)
An assembly that is replaced in its
entirety when any one of its components
fails. In some cases, a field replaceable
unit might contain other field replaceable
units. Contrast with customer replaceable
unit (CRU).

FlashCopy
A premium feature for DS4000 and
DS5000 that can make an instantaneous
copy of the data in a logical drive.

F_port See fabric port.

FRU See field replaceable unit.

GBIC See gigabit interface converter

gigabit interface converter (GBIC)
A transceiver that performs serial,
optical-to-electrical, and
electrical-to-optical signal conversions for
high-speed networking. A GBIC can be
hot swapped. See also small form-factor
pluggable.

Global Copy
Refers to a remote logical drive mirror
pair that is set up using Global Copy
without the write consistency group
option. This is also referred to as
"Enhanced Global Mirroring without
Consistency Group." Global Copy does
not make sure that write requests to
multiple primary logical drives are
carried out in the same order on the
secondary logical drives as they are on
the primary logical drives. If it is critical
that writes to the primary logical drives
are carried out in the same order in the
appropriate secondary logical drives,
Global Mirroring must be used instead of
Global Copy. See also asynchronous write
mode, Global Mirroring, remote mirroring,
Metro Mirroring.

Global Mirroring
Refers to a remote logical drive mirror
pair that is set up using Global Copy with
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the write consistency group option. This
is also referred to as "Enhanced Global
Mirroring with Consistency Group."
Global Mirroring makes sure that write
requests to multiple primary logical
drives are carried out in the same order
on the secondary logical drives as they
are on the primary logical drives,
preventing data on the secondary logical
drives from becoming inconsistent with
the data on the primary logical drives.
See also asynchronous write mode, Global
Copy, remote mirroring, Metro Mirroring.

graphical user interface (GUI)
A type of computer interface that presents
a visual metaphor of a real-world scene,
often of a desktop, by combining
high-resolution graphics, pointing devices,
menu bars and other menus, overlapping
windows, icons, and the object-action
relationship.

GUI See graphical user interface.

HBA See host bus adapter.

hdisk An AIX term representing a logical unit
number (LUN) on an array.

host A system that is directly attached to the
storage subsystem through a Fibre
Channel input/output (I/O) path. This
system is used to serve data (typically in
the form of files) from the storage
subsystem. A system can be both a
management station and a host
simultaneously.

host bus adapter (HBA)
An interface between the Fibre Channel
network and a workstation or server.

host computer
See host.

host group
An entity in the storage partition
topology that defines a logical collection
of host computers that require shared
access to one or more logical drives.

host port
Ports that physically reside on the host
adapters and are automatically discovered
by the Storage Manager software. To give
a host computer access to a partition, its
associated host ports must be defined.

hot swap
To replace a hardware component without
turning off the system.

hub In a network, a point at which circuits are
either connected or switched. For
example, in a star network, the hub is the
central node; in a star/ring network, it is
the location of wiring concentrators.

IBMSAN driver
The device driver that is used in a Novell
NetWare environment to provide
multipath input/output (I/O) support to
the storage controller.

IC See integrated circuit.

IDE See integrated drive electronics.

in-band
Transmission of management protocol
over the Fibre Channel transport.

Industry Standard Architecture (ISA)
Unofficial name for the bus architecture of
the IBM PC/XT personal computer. This
bus design included expansion slots for
plugging in various adapter boards. Early
versions had an 8-bit data path, later
expanded to 16 bits. The "Extended
Industry Standard Architecture" (EISA)
further expanded the data path to 32 bits.
See also Extended Industry Standard
Architecture.

initial program load (IPL)
The initialization procedure that causes an
operating system to commence operation.
Also referred to as a system restart,
system startup, and boot.

integrated circuit (IC)
A microelectronic semiconductor device
that consists of many interconnected
transistors and other components. ICs are
constructed on a small rectangle cut from
a silicon crystal or other semiconductor
material. The small size of these circuits
allows high speed, low power dissipation,
and reduced manufacturing cost
compared with board-level integration.
Also known as a chip.

integrated drive electronics (IDE)
A disk drive interface based on the 16-bit
IBM personal computer Industry Standard
Architecture (ISA) in which the controller
electronics reside on the drive itself,
eliminating the need for a separate
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adapter card. Also known as an
Advanced Technology Attachment
Interface (ATA).

Internet Protocol (IP)
A protocol that routes data through a
network or interconnected networks. IP
acts as an intermediary between the
higher protocol layers and the physical
network.

Internet Protocol (IP) address
The unique 32-bit address that specifies
the location of each device or workstation
on the Internet. For example, 9.67.97.103
is an IP address.

interrupt request (IRQ)
A type of input found on many
processors that causes the processor to
suspend normal processing temporarily
and start running an interrupt handler
routine. Some processors have several
interrupt request inputs that allow
different priority interrupts.

IP See Internet Protocol.

IPL See initial program load.

IRQ See interrupt request.

ISA See Industry Standard Architecture.

Java Runtime Environment (JRE)
A subset of the Java Development Kit
(JDK) for end users and developers who
want to redistribute the Java Runtime
Environment (JRE). The JRE consists of
the Java virtual machine, the Java Core
Classes, and supporting files.

JRE See Java Runtime Environment.

label A discovered or user entered property
value that is displayed underneath each
device in the Physical and Data Path
maps.

LAN See local area network.

LBA See logical block address.

local area network (LAN)
A computer network located on a user's
premises within a limited geographic
area.

logical block address (LBA)
The address of a logical block. Logical
block addresses are typically used in
hosts' I/O commands. The SCSI disk

command protocol, for example, uses
logical block addresses.

logical partition (LPAR)
A subset of a single system that contains
resources (processors, memory, and
input/output devices). A logical partition
operates as an independent system. If
hardware requirements are met, multiple
logical partitions can exist within a
system.

A fixed-size portion of a logical drive. A
logical partition is the same size as the
physical partitions in its array. Unless the
logical drive of which it is a part is
mirrored, each logical partition
corresponds to, and its contents are stored
on, a single physical partition.

One to three physical partitions (copies).
The number of logical partitions within a
logical drive is variable.

logical unit number (LUN)
An identifier used on a small computer
system interface (SCSI) bus to distinguish
among up to eight devices (logical units)
with the same SCSI ID.

loop address
The unique ID of a node in Fibre Channel
loop topology sometimes referred to as a
loop ID.

loop group
A collection of storage area network
(SAN) devices that are interconnected
serially in a single loop circuit.

loop port
A node port (N_port) or fabric port
(F_port) that supports arbitrated loop
functions associated with an arbitrated
loop topology.

LPAR See logical partition.

LUN See logical unit number.

MAC See medium access control.

management information base (MIB)
The information that is on an agent. It is
an abstraction of configuration and status
information.

man pages
In UNIX-based operating systems, online
documentation for operating system
commands, subroutines, system calls, file
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formats, special files, stand-alone utilities,
and miscellaneous facilities. Invoked by
the man command.

MCA See micro channel architecture.

media scan
A media scan is a background process
that runs on all logical drives in the
storage subsystem for which it has been
enabled, providing error detection on the
drive media. The media scan process
scans all logical drive data to verify that it
can be accessed, and optionally scans the
logical drive redundancy information.

medium access control (MAC)
In local area networks (LANs), the
sublayer of the data link control layer that
supports medium-dependent functions
and uses the services of the physical layer
to provide services to the logical link
control sublayer. The MAC sublayer
includes the method of determining when
a device has access to the transmission
medium.

Metro Mirroring
This term is used to refer to a remote
logical drive mirror pair which is set up
with Metro Mirror. See also remote
mirroring, Global Mirroring.

MIB See management information base.

micro channel architecture (MCA)
Hardware that is used for PS/2 Model 50
computers and above to provide better
growth potential and performance
characteristics when compared with the
original personal computer design.

Microsoft Cluster Server (MSCS)
MSCS, a feature of Windows NT Server
(Enterprise Edition), supports the
connection of two servers into a cluster
for higher availability and easier
manageability. MSCS can automatically
detect and recover from server or
application failures. It can also be used to
balance server workload and provide for
planned maintenance.

mini hub
An interface card or port device that
receives shortwave Fibre Channel GBICs
or SFPs. These devices enable redundant
Fibre Channel connections from the host
computers, either directly or through a
Fibre Channel switch or managed hub,

over optical fiber cables to the storage
server controllers. Each controller is
responsible for two mini hubs. Each mini
hub has two ports. Four host ports (two
on each controller) provide a cluster
solution without use of a switch. Two
host-side mini hubs are shipped as
standard. See also host port, gigabit
interface converter (GBIC), small form-factor
pluggable (SFP).

mirroring
A fault-tolerance technique in which
information on a hard disk is duplicated
on additional hard disks. See also remote
mirroring.

model The model identification that is assigned
to a device by its manufacturer.

MSCS See Microsoft Cluster Server.

network management station (NMS)
In the Simple Network Management
Protocol (SNMP), a station that runs
management application programs that
monitor and control network elements.

NMI See non-maskable interrupt.

NMS See network management station.

non-maskable interrupt (NMI)
A hardware interrupt that another service
request cannot overrule (mask). An NMI
bypasses and takes priority over interrupt
requests generated by software, the
keyboard, and other such devices and is
issued to the microprocessor only in
disastrous circumstances, such as severe
memory errors or impending power
failures.

node A physical device that allows for the
transmission of data within a network.

node port (N_port)
A Fibre Channel defined hardware entity
that performs data communications over
the Fibre Channel link. It is identifiable by
a unique worldwide name. It can act as
an originator or a responder.

nonvolatile storage (NVS)
A storage device whose contents are not
lost when power is cut off.

N_port
See node port.

NVS See nonvolatile storage.
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NVSRAM
Nonvolatile storage random access
memory. See nonvolatile storage.

Object Data Manager (ODM)
An AIX proprietary storage mechanism
for ASCII stanza files that are edited as
part of configuring a drive into the
kernel.

ODM See Object Data Manager.

out-of-band
Transmission of management protocols
outside of the Fibre Channel network,
typically over Ethernet.

partitioning
See storage partition.

parity check
A test to determine whether the number
of ones (or zeros) in an array of binary
digits is odd or even.

A mathematical operation on the
numerical representation of the
information communicated between two
pieces. For example, if parity is odd, any
character represented by an even number
has a bit added to it, making it odd, and
an information receiver checks that each
unit of information has an odd value.

PCI local bus
See peripheral component interconnect local
bus.

PDF See portable document format.

performance events
Events related to thresholds set on storage
area network (SAN) performance.

peripheral component interconnect local bus
(PCI local bus)

A local bus for PCs, from Intel
Corporation, that provides a high-speed
data path between the CPU and up to 10
peripherals (video, disk, network, and so
on). The PCI bus coexists in the PC with
the Industry Standard Architecture (ISA)
or Extended Industry Standard
Architecture (EISA) bus. ISA and EISA
boards plug into an IA or EISA slot, while
high-speed PCI controllers plug into a
PCI slot. See also Industry Standard
Architecture, Extended Industry Standard
Architecture.

polling delay
The time in seconds between successive
discovery processes during which
discovery is inactive.

port A part of the system unit or remote
controller to which cables for external
devices (such as display stations,
terminals, printers, switches, or external
storage units) are attached. The port is an
access point for data entry or exit. A
device can contain one or more ports.

portable document format (PDF)
A standard specified by Adobe Systems,
Incorporated, for the electronic
distribution of documents. PDF files are
compact; can be distributed globally by
email, the web, intranets, CD-ROM or
DVD-ROM; and can be viewed with the
Acrobat Reader, which is software from
Adobe Systems that can be downloaded
at no cost from the Adobe Systems home
page.

premium feature key
A file that the storage subsystem
controller uses to enable an authorized
premium feature. The file contains the
feature enable identifier of the storage
subsystem for which the premium feature
is authorized, and data about the
premium feature. See also feature enable
identifier.

private loop
A freestanding arbitrated loop with no
fabric attachment. See also arbitrated loop.

program temporary fix (PTF)
A temporary solution or bypass of a
problem diagnosed by IBM Corporation
in a current unaltered release of the
program.

PTF See program temporary fix.

RAID See redundant array of independent disks
(RAID).

RAID level
An array RAID level is a number that
refers to the method used to achieve
redundancy and fault tolerance in the
array. See also array, redundant array of
independent disks (RAID).

RAID set
See array.

RAM See random-access memory.
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random-access memory (RAM)
A temporary storage location in which the
central processing unit (CPU) stores and
executes its processes. Contrast with
DASD.

RDAC
See redundant disk array controller.

read-only memory (ROM)
Memory in which stored data cannot be
changed by the user except under special
conditions.

recoverable virtual shared disk (RVSD)
A virtual shared disk on a server node
configured to provide continuous access
to data and file systems in a cluster.

redundant array of independent disks (RAID)
A collection of disk drives (array) that
appears as a single logical drive to the
server, which is fault tolerant through an
assigned method of data striping,
mirroring, or parity checking. Each array
is assigned a RAID level, which is a
specific number that refers to the method
used to achieve redundancy and fault
tolerance. See also array, parity check,
mirroring, RAID level, striping.

redundant disk array controller (RDAC)
(1) In hardware, a redundant set of
controllers (either active/passive or
active/active). (2) In software, a layer that
manages the input/output (I/O) through
the active controller during normal
operation and transparently reroutes I/Os
to the other controller in the redundant
set if a controller or I/O path fails.

remote mirroring
Online, real-time replication of data
between storage subsystems that are
maintained on separate media. The
Enhanced Remote Mirror Option is a
DS4000 and DS5000 premium feature that
provides support for remote mirroring.
See also Global Mirroring, Metro Mirroring.

ROM See read-only memory.

router A computer that determines the path of
network traffic flow. The path selection is
made from several paths based on
information obtained from specific
protocols, algorithms that attempt to
identify the shortest or best path, and
other criteria such as metrics or
protocol-specific destination addresses.

RVSD See recoverable virtual shared disk.

SAI See Storage Array Identifier.

SA Identifier
See Storage Array Identifier.

SAN See storage area network.

SATA See serial ATA.

scope Defines a group of controllers by their
Internet Protocol (IP) addresses. A scope
must be created and defined so that
dynamic IP addresses can be assigned to
controllers on the network.

SCSI See small computer system interface.

segmented loop port (SL_port)
A port that allows division of a Fibre
Channel private loop into multiple
segments. Each segment can pass frames
around as an independent loop and can
connect through the fabric to other
segments of the same loop.

sense data
(1) Data sent with a negative response,
indicating the reason for the response. (2)
Data describing an I/O error. Sense data
is presented to a host system in response
to a sense request command.

serial ATA
The standard for a high-speed alternative
to small computer system interface (SCSI)
hard drives. The SATA-1 standard is
equivalent in performance to a 10 000
RPM SCSI drive.

serial storage architecture (SSA)
An interface specification from IBM
Corporation in which devices are
arranged in a ring topology. SSA, which is
compatible with small computer system
interface (SCSI) devices, allows
full-duplex packet multiplexed serial data
transfers at rates of 20 Mbps in each
direction.

server A functional hardware and software unit
that delivers shared resources to
workstation client units on a computer
network.

server/device events
Events that occur on the server or a
designated device that meet criteria that
the user sets.

SFP See small form-factor pluggable.
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Simple Network Management Protocol (SNMP)
In the Internet suite of protocols, a
network management protocol that is
used to monitor routers and attached
networks. SNMP is an application layer
protocol. Information on devices managed
is defined and stored in the application's
Management Information Base (MIB).

SL_port
See segmented loop port.

SMagent
The Storage Manager optional Java-based
host-agent software, which can be used
on Microsoft Windows, Novell NetWare,
HP-UX, and Solaris host systems to
manage storage subsystems through the
host Fibre Channel connection.

SMclient
The Storage Manager client software,
which is a Java-based graphical user
interface (GUI) that is used to configure,
manage, and troubleshoot storage servers
and storage expansion enclosures in a
storage subsystem. SMclient can be used
on a host system or on a management
station.

SMruntime
A Java compiler for the SMclient.

SMutil
The Storage Manager utility software that
is used on Microsoft Windows, HP-UX,
and Solaris host systems to register and
map new logical drives to the operating
system. In Microsoft Windows, it also
contains a utility to flush the cached data
of the operating system for a particular
drive before creating a FlashCopy.

small computer system interface (SCSI)
A standard hardware interface that
enables a variety of peripheral devices to
communicate with one another.

small form-factor pluggable (SFP)
An optical transceiver that is used to
convert signals between optical fiber
cables and switches. An SFP is smaller
than a gigabit interface converter (GBIC).
See also gigabit interface converter.

SNMP
See Simple Network Management Protocol
and SNMPv1.

SNMP trap event

An event notification sent by the SNMP
agent that identifies conditions, such as
thresholds, that exceed a predetermined
value. See also Simple Network
Management Protocol.

SNMPv1
The original standard for SNMP is now
referred to as SNMPv1, as opposed to
SNMPv2, a revision of SNMP. See also
Simple Network Management Protocol.

SRAM
See static random access memory.

SSA See serial storage architecture.

static random access memory (SRAM)
Random access memory based on the
logic circuit know as flip-flop. It is called
static because it retains a value as long as
power is supplied, unlike dynamic
random access memory (DRAM), which
must be regularly refreshed. It is however,
still volatile, meaning that it can lose its
contents when the power is turned off.

storage area network (SAN)
A dedicated storage network tailored to a
specific environment, combining servers,
storage products, networking products,
software, and services. See also fabric.

Storage Array Identifier (SAI or SA Identifier)
The Storage Array Identifier is the
identification value used by the Storage
Manager host software (SMClient) to
uniquely identify each managed storage
server. The Storage Manager SMClient
program maintains Storage Array
Identifier records of previously-discovered
storage servers in the host resident file,
which allows it to retain discovery
information in a persistent fashion.

storage expansion enclosure (EXP)
A feature that can be connected to a
system unit to provide additional storage
and processing capacity.

storage management station
A system that is used to manage the
storage subsystem. A management station
does not need to be attached to the
storage subsystem through the Fibre
Channel input/output (I/O) path.

storage partition
Storage subsystem logical drives that are

258 IBM System Storage DS Storage Manager Version 10: Copy Services User's Guide



visible to a host computer or are shared
among host computers that are part of a
host group.

storage partition topology
In the Storage Manager client, the
Topology view of the Mappings window
displays the default host group, the
defined host group, the host computer,
and host-port nodes. The host port, host
computer, and host group topological
elements must be defined to grant access
to host computers and host groups using
logical drive-to-LUN mappings.

striping
Splitting data to be written into equal
blocks and writing blocks simultaneously
to separate disk drives. Striping
maximizes performance to the disks.
Reading the data back is also scheduled
in parallel, with a block being read
concurrently from each disk then
reassembled at the host.

subnet
An interconnected but independent
segment of a network that is identified by
its Internet Protocol (IP) address.

sweep method
A method of sending Simple Network
Management Protocol (SNMP) requests
for information to all the devices on a
subnet by sending the request to every
device in the network.

switch A Fibre Channel device that provides full
bandwidth per port and high-speed
routing of data with link-level addressing.

switch group
A switch and the collection of devices
connected to it that are not in other
groups.

switch zoning
See zoning.

Metro Mirror
In remote mirroring, an option that
requires the primary controller to wait for
the acknowledgment of a write operation
from the secondary controller before
returning a write I/O request completion
to the host. See also asynchronous write
mode, remote mirroring, Metro Mirroring.

system name
Device name assigned by the third-party
vendor software.

TCP See Transmission Control Protocol.

TCP/IP
See Transmission Control Protocol/Internet
Protocol.

terminate and stay resident program (TSR
program)

A program that installs part of itself as an
extension of DOS when it is executed.

topology
The physical or logical arrangement of
devices on a network. The three Fibre
Channel topologies are fabric, arbitrated
loop, and point-to-point. The default
topology for the disk array is arbitrated
loop.

TL_port
See translated loop port.

transceiver
A device that is used to transmit and
receive data. Transceiver is an
abbreviation of transmitter-receiver.

translated loop port (TL_port)
A port that connects to a private loop and
allows connectivity between the private
loop devices and off loop devices (devices
not connected to that particular TL_port).

Transmission Control Protocol (TCP)
A communication protocol used in the
Internet and in any network that follows
the Internet Engineering Task Force (IETF)
standards for internetwork protocol. TCP
provides a reliable host-to-host protocol
between hosts in packed-switched
communication networks and in
interconnected systems of such networks.
It uses the Internet Protocol (IP) as the
underlying protocol.

Transmission Control Protocol/Internet Protocol
(TCP/IP)

A set of communication protocols that
provide peer-to-peer connectivity
functions for both local and wide-area
networks.

trap In the Simple Network Management
Protocol (SNMP), a message sent by a
managed node (agent function) to a
management station to report an
exception condition.
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trap recipient
Receiver of a forwarded Simple Network
Management Protocol (SNMP) trap.
Specifically, a trap receiver is defined by
an Internet Protocol (IP) address and port
to which traps are sent. Presumably, the
actual recipient is a software application
running at the IP address and listening to
the port.

TSR program
See terminate and stay resident program.

uninterruptible power supply
A source of power from a battery that is
installed between a computer system and
its power source. The uninterruptible
power supply keeps the system running if
a commercial power failure occurs, until
an orderly shutdown of the system can be
performed.

user action events
Actions that the user takes, such as
changes in the storage area network
(SAN), changed settings, and so on.

worldwide port name (WWPN)
A unique identifier for a switch on local
and global networks.

worldwide name (WWN)
A globally unique 64-bit identifier
assigned to each Fibre Channel port.

WORM
See write-once read-many.

write-once read many (WORM)
Any type of storage medium to which
data can be written only a single time, but
can be read from any number of times.
After the data is recorded, it cannot be
altered.

WWN See worldwide name.

zoning
In Fibre Channel environments, the
grouping of multiple ports to form a
virtual, private, storage network. Ports
that are members of a zone can
communicate with each other, but are
isolated from ports in other zones.

A function that allows segmentation of
nodes by address, name, or physical port
and is provided by fabric switches or
hubs.
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